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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
+ To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-5250.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.
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Changes to serve you more quickly

Print sections directly from the information center navigation

PDF books are provided as a convenience format for easy printing, reading, and offline use. The
information center is the official delivery format for IBM WebSphere Application Server documentation. If
you use the PDF books primarily for convenient printing, it is now easier to print various parts of the
information center as needed, quickly and directly from the information center navigation tree.

To print a section of the information center navigation:

1. Hover your cursor over an entry in the information center navigation until the Open Quick Menu icon
is displayed beside the entry.

2. Right-click the icon to display a menu for printing or searching your selected section of the navigation
tree.

3. If you select Print this topic and subtopics from the menu, the selected section is launched in a
separate browser window as one HTML file. The HTML file includes each of the topics in the section,
with a table of contents at the top.

4. Print the HTML file.

For performance reasons, the number of topics you can print at one time is limited. You are notified if your
selection contains too many topics. If the current limit is too restrictive, use the feedback link to suggest a
preferable limit. The feedback link is available at the end of most information center pages.

Under construction!

The Information Development Team for IBM WebSphere Application Server is changing its PDF book
delivery strategy to respond better to user needs. The intention is to deliver the content to you in PDF
format more frequently. During a temporary transition phase, you might experience broken links. During
the transition phase, expect the following link behavior:

» Links to Web addresses beginning with http:// work
» Links that refer to specific page numbers within the same PDF book work
* The remaining links will not work. You receive an error message when you click them

Thanks for your patience, in the short term, to facilitate the transition to more frequent PDF book updates.

© Copyright IBM Corp. 2011 Xix
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Chapter 1. Developing ActivitySessions

This page provides a starting point for finding information about ActivitySessions, a WebSphere extension
for reducing the complexity of commitment rules and limitations that are associated with one-phase commit
resources.

Use ActivitySessions to extend the scope and group multiple local transactions. With this capability, you
can commit these transactions based on either deployment criteria or through explicit program logic. More
introduction...

Developing an enterprise application to use ActivitySessions

This topic provides an overview of the high-level tasks for using ActivitySessions in enterprise applications.
About this task

Before you use ActivitySessions in enterprise applications, consider the following points:

* An application that is accessed under an ActivitySession context can receive a
javax.transaction.InvalidTransactionException RemoteException, thrown by the Enterprise JavaBeans
(EJB) container when servicing any application method. This exception occurs when an instance of an
enterprise bean that has an ActivitySession-based activation policy becomes involved with concurrent
global and local transactions.

« To enable an enterprise bean to participate in an ActivitySession context and support
ActivitySession-based operations, it must be configured with an ActivationPolicy of
ACTIVITY_SESSION. A bean configured with ActivationPolicy of either TRANSACTION or ONCE
cannot participate in an ActivitySession context.

* A session bean can either use container-managed ActivitySessions or implement bean-managed
ActivitySessions; entity beans can use only container-managed ActivitySessions. A bean is deployed to
be bean-managed or container-managed with respect to ActivitySession management by setting its
transaction type deployment attribute to be bean-managed or container-managed when you deploy the
enterprise bean. A bean that uses bean-managed transactions can use bean-managed ActivitySessions;
a bean that uses container-managed transactions can use container-managed ActivitySessions.

+ If you want a session bean or an enterprise application client to manage its own ActivitySessions, you
must write the code that explicitly demarcates the boundaries of an ActivitySession, as described in
[Developing an enterprise bean or J2EE client to manage ActivitySessions]

The following high level tasks illustrate how to use an ActivitySession in an enterprise application:

Procedure

» Develop an enterprise application that uses one or more enterprise beans that are persisted to
non-transactional data stores. Use this approach for an application that needs to coordinate multiple
one-phase resource managers, for example, for two or more entity enterprise beans whose persistence
is delegated to LocalTransaction resource adapters.

In this scenario, the enterprise beans that the application uses have an Activation policy of
ActivitySession and a local transaction containment policy with a boundary of ActivitySession and
resolution-control of ContainerAtBoundary. The container synchronizes the EJB state data with the
one-phase resource managers at ActivitySession completion, and no application code needs to be
aware of ActivitySession support.

» Develop an enterprise application in which an enterprise bean accesses a resource manager multiple
times in different business methods. Use this approach for an application that needs to extend a
resource manager local transaction (RMLT) over several business methods of an enterprise bean
instance.

In this scenario, the enterprise beans that the application uses have an Activation policy of
ActivitySession and a local transaction containment policy with a boundary of ActivitySession and
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resolution-control of Application. The application logic starts and ends the RMLTs, for example, using the
javax.resource.cci.LocalTransaction interface offered by a LocalTransaction Connector, but is not
constrained to start and commit the LocalTransaction in the same method.

» Develop an enterprise client application to use an ActivitySession to scope EJB activation and
load-balancing. Use this approach for an application client that needs to access an entity bean instance
several times in the same client session, either without needing to run under a transaction context, or
with the need to run under a number of distinct and serially-executed transactions.

In this scenario, the enterprise beans that the application uses have an Activation policy of
ActivitySession and a local transaction containment policy appropriate to the function of the enterprise
bean. The enterprise client application can represent a period of user activity, for example a signon
period, during which a number of interactions occur with one or more enterprise beans. If the enterprise
client application begins an ActivitySession and invokes the enterprise beans within the scope of the
unit of work (UOW) that the ActivitySession represents, the container on the ActivitySession boundary
activates the enterprise bean instances. The instances remain in the active state until the container
passivates them at the end of the ActivitySession. Workload affinity management based on the
ActivitySession is a platform quality of service. Global transactions can begin and end within the
ActivitySession, if they are wholly encapsulated by the ActivitySession and run serially. EJB instances
that are activated at the ActivitySession boundary remain active across the serial global transactions.

» Develop a Web application client to participate in an ActivitySession context. A Web application that
runs in the WebSphere® Web container can participate in an ActivitySession context. Web applications
can use the UserActivitySession interface to begin and end an ActivitySession context. Also, the
ActivitySession can be associated with an HttpSession, thereby extending access to the ActivitySession
over multiple HTTP invocations and supporting EJB activation periods that can be determined by the
lifecycle of the Web HTTP client.

The Web container manages ActivitySessions based on deployment descriptor attributes associated
with the Web application module.

Example

For examples of using ActivitySessions in enterprise applications, see the topic about ActivitySessions
samples.

Developing an enterprise bean or enterprise application client to
manage ActivitySessions

Use this task to write the code needed by a session EJB or enterprise application client to manage an
ActivitySession, based on the example code extract provided.

About this task

In most situations, an enterprise bean can depend on the EJB container to manage ActivitySessions within
the bean. In these situations, all you need to do is set the appropriate ActivitySession attributes in the EJB
module deployment descriptor, as described in the topic about configuring EJB module ActivitySession
deployment attributes.. Further, in general, it is practical to design your enterprise beans so that all
ActivitySession management is handled at the enterprise bean level.

However, in some cases you may need to have a session bean or enterprise application client participate
directly in ActivitySessions. You then need to write the code needed by the session bean or enterprise
application client to manage its own ActivitySessions.

Note: Session beans that use BMT and have an Activate at setting of Activity session can manage

ActivitySessions. Entity beans cannot manage ActivitySessions; the EJB container always manages
ActivitySessions within entity beans.
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When preparing to write code needed by a session bean or enterprise application client to manage
ActivitySessions, consider the points described in the topic about ActivitySession and transaction contexts.

To write the code needed by a session EJB or enterprise application client to manage an ActivitySession,
complete the following steps, based on the following example code extract.

Procedure
1. Get an initial context for the ActivitySession.

2. Get an implementation of the UserActivitySession interface, by a JNDI lookup of the URL
java:comp/websphere/UserActivitySession. The UserActivitySession interface is used to begin and end
ActivitySessions and to query various attributes of the active ActivitySession associated with the
thread.

3. Set the timeout, in seconds, after which any subsequently started ActivitySessions are automatically
completed by the ActivitySession service. If the session bean or enterprise application client does not
specifically set this value, the default timeout (300 seconds) is used.

The default timeout can also be overridden for each application server, on the server-> Activity
Session Service panel of the administrative console.

4. Start the ActivitySession, by calling the beginSession() method of the UserActivitySession.

5. Within the ActivitySession, call business methods to do the work needed. You can also call other
methods of UserActivitySession to manage the ActivitySession; for example, to get the status of the
ActivitySession or to checkpoint all the ActivitySession resources involved in the ActivitySession.

6. End the ActivitySession, by calling the endSession() method of the UserActivitySession.
Example

The following code extract provides a basic example of using the UserActivitySession interface:

// Get initial context
InitialContext ic = new InitialContext();

// Lookup UserActivitySession
UserActivitySession uas =
(UserActivitySession)ic.lookup("java:comp/websphere/UserActivitySession");

// Set the ActivitySession timeout to 60 seconds
uas.setSessionTimeout (60);

// Start a new ActivitySession context
uas.beginSession();

// Do some work under this context
MyBeanA beanA.doSomething();

MyBeanB beanB.doSomethingElse();
// End the context
uas.endSession(EndModeCheckpoint);

ActivitySession service application programming interfaces

The ActivitySession service provides an application programming interface that is available to Web
applications, session Enterprise JavaBeans (EJBs), and Java platform for enterprise applications client
applications for application-managed demarcation of ActivitySession context.

Applications use the UserActivitySession interface, which provides demarcation scope methods.
ActivitySession API

The ActivitySession service provides the UserActivitySession interface for use by EJB Session beans
using bean-managed context demarcation, Web application components that are configured with the
ActivitySession control attribute set to Web Application, and Java platform for enterprise applications
client applications. This UserActivitySession interface defines the set of ActivitySession operations that are
available to an application component. To obtain an implementation of this interface, use a Java Naming
and Directory Interface (JNDI) lookup of the URL java:comp/websphere/UserActivitySession. The
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UserActivitySession interface is used to begin and end ActivitySessions and to query various attributes of
the active ActivitySession that is associated with the thread.

For more information about the ActivitySession API, see the application programming interface (API)
reference information.

The ActivitySession API and the implementation of its interfaces is contained in the
com.ibm.websphere.ActivitySession package.

Programming Examples

The following code extract provides a basic example of using the UserActivitySession interface:

// Get initial context
InitialContext ic = new InitialContext();

// Lookup UserActivitySession
UserActivitySession uas =
(UserActivitySession)ic.lookup("java:comp/websphere/UserActivitySession");

// Set the ActivitySession timeout to 60 seconds
uas.setSessionTimeout (60);

// Start a new ActivitySession context
uas.beginSession();

// Do some work under this context
MyBeanA beanA.doSomething();

MyBeanB beanB.doSomethingElse();
// End the context
uas.endSession(EndModeCheckpoint);

Assembling applications that use ActivitySessions

You can set the ActivitySession deployment attributes for an enterprise bean or a Web application.
About this task

For an enterprise bean, you can set the ActivitySession deployment attributes so that the bean can
participate in an ActivitySession context and support ActivitySession-based operations.

For a Web application, you can set the ActivitySession deployment attributes so that the application can
start UserActivitySessions and perform work scoped within ActivitySessions.

Procedure
+ |Set EJB module ActivitySession deployment attributes |
Set Web module ActivitySession deployment attributes.|

Setting EJB module ActivitySession deployment attributes

Use this task to set the ActivitySession deployment attributes for an enterprise bean to enable the bean to
participate in an ActivitySession context and support ActivitySession-based operations.

Before you begin

This task description assumes that you have an Enterprise Archive (EAR) file, which contains an
application enterprise bean that can be deployed in WebSphere Application Server. For more details, see
the topic about assembling applications.

About this task

You configure the deployment attributes of an application by using an assembly tool. This topic describes
the use of Rational® Application Developer to configure the ActivitySession deployment attributes. These
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attributes are in addition to other deployment attributes, for example, “Load at”, which specifies when the
bean loads its state from the database. For details about the fields in the assembly tool, and for
associated task help, refer to the Rational Application Developer information.

To set the ActivitySession deployment attributes for an enterprise bean, complete the following steps:

Procedure

1.
2.

o

Start the assembly tool. For more information, refer to the Rational Application Developer information.
Create or edit the application EAR file.

Note: Ensure that you set the target server as WebSphere Application Server Version 7.0.

For example, to change attributes of an existing application, use the Import wizard to import the EAR
file into the assembly tool. To start the Import wizard:

a. Click File > Import > EAR file.

b. Click Next, then select the EAR file.

c. In the Target server field, select WebSphere Application Server v7.0.
d. Click Finish.

In the Project Explorer view of the Java EE perspective, right-click the EJB module for the enterprise
bean instance, then click Open With > Deployment Descriptor Editor. A property dialog notebook
for the enterprise bean instance is displayed in the property pane.

In the property pane, select the Beans tab.
Select the bean that you want to change.

In the WebSphere Extensions section, under Bean Cache, set the Activate at attribute to
ActivitySession:

An enterprise bean with this activation policy is activated and passivated as follows:

* On an ActivitySession boundary, if an ActivitySession context is present on activation.

* On a transaction boundary, if a transaction context, but no ActivitySession context, is present on
activation.

« Otherwise, on an invocation boundary.

In the Local Transactions group box, set the Boundary attribute to ActivitySession: When this
setting is used, the local transaction must be resolved within the scope of any ActivitySession in
which it was started or, if no ActivitySession context is present, within the same bean method in which
it was started.

A setting of ActivitySession does not apply to any EJB home methods, for example, create or finder
methods. EJB home methods cannot participate in an ActivitySession because this situation might
cause deadlocks.

For entity beans, or session beans, set the ActivitySession properties for each EJB method.
a. In the property pane, select the ActivitySession tab.

b. In the Configure ActivitySession policies field, click Add or Edit to set the ActivitySession
kind attribute for methods of the enterprise bean. This specifies how the container must manage
the ActivitySession boundaries when delegating a method invocation to an enterprise bean's
business method:

Never The container invokes bean methods without an ActivitySession context.
 If the client invokes a bean method from within an ActivitySession context, the
container throws an InvalidActivityException exception, which is a
javax.rmi.RemoteException.
 If the client invokes a bean method from outside an ActivitySession context, the
container behaves in the same way as if the Not Supported value was set. The client
must call the method without an ActivitySession context.
Mandatory
The container always invokes the bean method within the ActivitySession context
associated with the client. If the client attempts to invoke the bean method without an
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ActivitySession context, the container throws an ActivityRequiredException exception to
the client. The ActivitySession context is passed to any EJB object or resource accessed
by an enterprise bean method.

The ActivityRequiredException exception is javax.rmi.RemoteException.

Requires new
The container always invokes the bean method within a new ActivitySession context,
regardless of whether the client invokes the method within or outside an ActivitySession
context. The new ActivitySession context is passed to any enterprise bean objects or
resources that are used by this bean method.

Any received ActivitySession context is suspended for the duration of the method and
resumed after the method ends. The container starts a new ActivitySession before
method dispatch and completes it after the method ends.

Required
The container invokes the bean method within an ActivitySession context. If a client
invokes a bean method from within an ActivitySession context, the container invokes the
bean method within the client ActivitySession context. If a client invokes a bean method
outside an ActivitySession context, the container creates a new ActivitySession context
and invokes the bean method from within that context. The ActivitySession context is
passed to any enterprise bean objects or resources that are used by this bean method.

Not supported
The container invokes bean methods without an ActivitySession context. If a client
invokes a bean method from within an ActivitySession context, the container suspends the
association between the ActivitySession and the current thread before invoking the
method on the enterprise bean instance. The container then resumes the suspended
association when the method invocation returns. The suspended ActivitySession context
is not passed to any enterprise bean objects or resources that are used by this bean
method.

Supports
If the client invokes the bean method within an ActivitySession, the container invokes the
bean method within an ActivitySession context. If the client invokes the bean method
without a ActivitySession context, the container invokes the bean method without an
ActivitySession context. The ActivitySession context is passed to any enterprise bean
objects or resources that are used by this bean method.

c. Click Next.
d. Select the methods to which the ActivitySession kind policy is to be applied.
e. Click Finish.

How the container manages the ActivitySession boundaries when delegating a method invocation
depends on both the ActivitySession kind set here, and the Container transaction type, as
described in the topic about configuring transactional deployment attributes. For more detail about the
relationship between these two properties, see the topic about ActivitySession and transaction
container policies in combination.

9. Save your changes to the deployment descriptor.
a. Close the Deployment Descriptor Editor.
b. When prompted, click Yes to save changes to the deployment descriptor.

10. Verify the archive files. For more information about verifying files using Rational Application
Developer, refer to the Rational Application Developer information.

11. From the popup menu of the project, click Deploy to generate EJB deployment code.

12. Optional: Test your completed module on a WebSphere Application Server installation. Right-click a
module, click Run on Server, and follow the instructions in the displayed wizard.
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Important: Use Run On Server for unit testing only. The assembly tool controls the WebSphere
Application Server installation and, when an application is published remotely, the
assembly tool overwrites the server configuration file for that server. Do not use the Run
On Server option on production servers.

What to do next

After assembling your application, use a systems management tool to deploy the EAR file onto the
application server that is to run the application. For example, to use the administrative console, see the
topic about deploying and administering enterprise applications.

Setting Web module ActivitySession deployment attributes

Use this task to set the ActivitySession deployment attributes for a Web application to start
UserActivitySessions and perform work scoped within ActivitySessions.

Before you begin

This task assumes that you have an Enterprise Archive (EAR) file that contains an application enterprise
bean that can be deployed in WebSphere Application Server. For more details, see the topic about
assembling applications.

About this task

You can configure the deployment attributes of an application by using an assembly tool. This topic
describes the use of Rational Application Developer to configure the deployment attributes.

To set the ActivitySession deployment attributes for a Web application, complete the following steps:

Procedure
1. Start the assembly tool. For more information, refer to the Rational Application Developer information.

2. Create or edit the Web module. For example, to change attributes of an existing module, click File >
Open, then select the archive file for the module. For example, to change attributes of an existing
module, use the Import wizard to import the EAR or WAR file into the assembly tool. To start the
Import wizard:

a. Click File > Import.
b. Expand the Web folder, click WAR file, then click Next.
c. Select the WAR file, then click Finish.

3. In the Project Explorer view of the Java EE perspective, right-click the component instance, right-click
Deployment Descriptor Editor, then click Open With . A property dialog notebook for the Web
module is displayed in the property pane.

4. In the property pane, select the Extended services tab.
5. Select the servlet that you want to change.

6. In the ActivitySession section, set the ActivitySession control kind attribute to Application,
Container, or None.
Application

The Web application is responsible for starting and ending ActivitySessions, as follows:

» If an HitpSession is active when an application begins an ActivitySession, the container
associates the ActivitySession with the HttpSession.

» If an ActivitySession is started in the absence of an HttpSession, the application must
ensure it is completed before the dispatched method completes; otherwise, an exception
results.

» |If an HitpSession is associated with a request dispatched to an application with this
ActivitySession control value, and if that HttpSession has an ActivitySession associated
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10.
11.

with it, the container dispatches the request in the context of that ActivitySession. For
example, the container resumes the ActivitySession context onto the thread before the
dispatch.

* A Web application can use both transactions and ActivitySessions. Any transactions started
within the scope of an ActivitySession must be ended by the Web component that started
them and within the same request dispatch.

Container

None

A servlet has no access to UserActivitySessions. Any HttpSession started by the servlet has
an ActivitySession automatically associated with it by the container, and this ActivitySession is
put onto the thread of execution. If such a servlet is dispatched by a request that has an
HttpSession containing no ActivitySession, then the container starts an ActivitySession and
associates it with the HttpSession and the thread.

A Web application can use both transactions and ActivitySessions. Any transactions started
within the scope of an ActivitySession must be ended by the Web component that started
them and within the same request dispatch.

A servlet has no access to UserActivitySession. An HitpSession started by the servlet does
not have an ActivitySession automatically associated with it by the container. If such a servlet
is dispatched by a request that has an HttpSession containing an ActivitySession, then the
container dispatches the request in the context of that ActivitySession. For example, the
container resumes the ActivitySession context onto the thread before the dispatch.

To apply the changes and close the assembly tool, click OK. Otherwise, to apply the values but keep
the property dialog open for additional edits, click Apply.

Save your changes to the deployment descriptor.
a. Close the deployment descriptor editor.
b. When prompted, click Yes to save changes to the deployment descriptor.

Verify the archive files. For more information about verifying files using Rational Application
Developer, refer to the Rational Application Developer information.

From the popup menu of the project, click Deploy to generate EJB deployment code.

Optional: Test your completed module on a WebSphere Application Server installation. Right-click a
module, click Run on Server, and follow the instructions in the displayed wizard.

Important: Use Run On Server for unit testing only. The assembly tool controls the WebSphere

Application Server installation and, when an application is published remotely, the
assembly tool overwrites the server configuration file for that server. Do not use the Run
On Server option on production servers.

What to do next

After assembling your application, use a systems management tool to deploy the WAR file. For example,
to use the administrative console, see the topic about deploying and administering enterprise applications.
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Chapter 2. Developing Application profiling

This page provides a starting point for finding information about application profiling, a WebSphere
extension for defining strategies to dynamically control concurrency, prefetch, and read-ahead.

Application profiling and access intent provide a flexible method to fine-tune application performance for
enterprise beans without impacting source code. Different enterprise beans, and even different methods in
one enterprise bean, can have their own intent to access resources. Profiling the components based on
their access intent increases performance in the application server run time.

Using the TaskNameManager interface

Using the TaskNameManager interface, you can programmatically set the current task name. It enables
both overriding of the current task associated with the thread of execution and resetting of the current task
with the original task.

About this task

Except for J2EE 1.3 applications that are running on a server where the 5.x Compatibility Mode attribute is
selected, this interface cannot be used within Enterprise JavaBeans that are configured for
container-managed transactions or container-managed ActivitySessions because units of work can only be
associated with a task at the exact time that the unit of work is initiated. The call to set the task name
must therefore be invoked before the unit of work is begun. Units of work cannot be named after they are
begun. Calls on this interface during the execution of a container-managed unit of work are simply ignored.

Application profiling does not support queries of the task that is in operation at run time. Instead,
applications interact with logical task names that are declaratively configured as application managed
tasks. Logical references enable the actual task name to be changed without having to recompile
applications.

Wherever possible, avoid setting tasks programmatically. The declarative method results in more portable
function that can be easily adjusted without requiring redevelopment and recompilation.

Note: If you select the 5.x Compatibility Mode attribute on the Application Profile Service's console page,
then tasks configured on J2EE 1.3 applications are not necessarily associated with units of work
and can arbitrarily be applied and overridden. This is not a recommended mode of operation and
can lead to unexpected deadlocks during database access. Tasks are not communicated on
requests between applications that are running under the Application Profiling 5.x Compatibility
Mode and applications that are not running under the compatibility mode.

For a Version 6.0 client to interact with applications run under the Application Profiling 5.x
Compatibility Mode, you must set the appprofileCompatibility system property to true in the client
process. You can do this by specifying the -CCDappprofileCompatibility=true option when invoking
the launchClient command.

Procedure

1. Configure application-managed tasks. Application profiling requires that a task name reference be
declared for any task that is to be set programmatically. Task name references introduce a level of
indirection so that the actual task set at run time can be adjusted by reassembly without requiring
recoding or recompilation. Any attempt to set a task name that is undeclared as a task reference
results in the raising of an exception. If a unit of work has already begun when a task name is set,
then that existing unit of work is not associated with the task name. Only units of work that are begun
after the task name is set are associated with the task.
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Configure application-managed tasks as described in the following topics. To complete these tasks see
the assembly tool information center:

» Configure application managed tasks for web components.
» Configure application managed tasks for application clients.
» Configure application managed tasks for Enterprise JavaBeans.
2. Perform a Java Naming and Directory Interface (JNDI) lookup on the TaskNameManager interface:

InitialContext ic = new InitialContext();
TaskNameManager tnManager = ic.lookup
("java:comp/websphere/AppProfile/TaskNameManager");

The TaskNameManager interface is not bound into the namespace if the application profiling service is
disabled.

3. Set the task name:

try {
tnManager.setTaskName ("updateAccount");

}
catch (I11egalTaskNameException e) {
// task name reference not configured. Handle error.

}
/...
//

The name passed to the setTaskName() method ("updateAccount" in this example) is actually a task
name reference that you configured in step one.

4. Begin a UserTransaction

Note: If you are using a J2EE 1.3 application with the 5.x Compatibility mode set, the task name set
in step 3 is now the active task name and you can disregard this step.

If you are using a J2EE application and the compatibility mode is not set, or if you are using a J2EE
1.4 application, you must begin a transaction for the task name to become active. A task name can
only be associated with a transaction. Furthermore, it is associated with a transaction when that
transaction is begun, and that task name is associated with the transaction for the life of the
transaction. Therefore, the task name set above is not active at this point. You must begin a
UserTransaction as the following code snippet illustrates:
try{

InitialContext initCtx = new InitialContext();

userTran = (UserTransaction) initCtx.lookup("java:comp/UserTransaction");

userTran.begin();

}

catch(Exception e){

}
...
/1

Notice the resetTaskName() method on the TaskNameManager interface. Resetting the task name has
no effect unless called by a J2EE 1.3 application running on a server for which the 5.x Compatibility
Mode attribute is selected on the Application Profile Service's console page. This is not a
recommended mode of operation and can lead to unexpected deadlocks during database access. A
call to resetTask( ) should only be used by J2EE 1.3 applications when the 5.x Compatibility mode is
set to undo the effects of any setTaskName() method operations and reestablish whatever task name
was current when the component began execution. If the setTaskName() method has not been called,
the resetTaskName() method has no effect.
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TaskNameManager interface

The TaskNameManager is the programmatic interface to the application profiling function. Because on rare
occasions it may be necessary to programmatically set the current task name, the TaskNameManager
interface enables both overriding of the current task associated with the thread of execution and resetting
of the current task with the original task.

Application profiling enables you to identify particular units of work to the WebSphere Application Server
runtime environment. The run time can tailor its support to the exact requirements of that unit of work.
is currently the only runtime component that makes use of the application profiling
functionality. For example, you can configure one transaction to load an entity bean with strong update
locks and configure another transaction to load the same entity bean without locks.

Application profiling introduces two concepts in order to achieve this function: tasks and profiles.

A task is a configurable name for a unit of work. Unit of work in this case means either a transaction or an
ActivitySession.

A profile is simply a mapping of a task to a set of access intent policies that are configured on entity
beans. When an invocation on a bean (whether by a finder method, a container managed relationship
(CMR) getter, or a dynamic query) requires data to be retrieved from the back end system, the task of the
active unit of work associated with the request is used to determine the exact requirement of the
transaction. The same bean loads and behaves differently in the context of the task-to-profile mapping.
Each profile provides the developer an opportunity to reconfigure the application's access intent.

Except for J2EE 1.3 applications that are executing on a server where the 5.x Compatibility Mode attribute
is selected, this interface cannot be used within Enterprise JavaBeans that are configured for
container-managed transactions or container-managed ActivitySessions because units of work can only be
associated with a task at the exact time that the unit of work is initiated. The call to set the task name
must therefore be started before the unit of work is begun. Units of work cannot be named after they are
begun. Calls on this interface during the execution of a container-managed unit of work are simply ignored.

The TaskNameManager interface is available to all J2EE components using the following Java Naming
and Directory Interface (JNDI) lookup:

java:comp/websphere/AppProfile/TaskNameManager
package com.ibm.websphere.appprofile;

[**

The TaskNameManager is the programmatic interface
to the application profiling function. Using this interface,
programmers can set the current task name on the
thread of execution. The task name must have been
configured in the deployment descriptors as a task
reference associated with a task. The set task
name's scope is the duration of the method
invocation in the EJB and Web components and for
the duration of the client process, or until the
resetTaskName() method is invoked.

*

EE S R R

*/
public interface TaskNameManager {

[x%

* Set the thread's current task name to the specified

* parameter. The task name must have been configured as

* a task reference with a corresponding task or the

* ITlegalTaskName exception is thrown.

*/

public void setTaskName(String taskName) throws I1legalTaskNameException;

[**
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* %k X X

*/

Sets the thread's task name to the value that was set
at, or imported into, the beginning of the method
invocation (for EJB and Web components) or process
(for J2EE clients).

public void resetTaskName();

}

Assembling applications for application profiling

To enable application profiling, you must configure tasks, create an application profile, and declaratively
configure a unit of work on necessary methods.

Before you begin

Application profiling enables multiple access intent policies to be configured on the same entity bean, each
specified for a particular unit of work. You can use the one of the default policies or create your own. To
create your own access intent policy, see the topic, Creating a custom access intent policy, in the
assembly tool information center.

Procedure

1.

Configure tasks. Declaratively configure tasks as described in the following topics that are located in
the assembly tool information center:

» Configuring container-managed tasks for Enterprise Java Beans.

» Configuring container-managed tasks for web components.

« Configuring container-managed tasks for application clients.

On rare occasions, you might find it necessary to configure tasks programmatically. Application
profiling supports this requirement with a simple interface that enables a task name to be set before a
unit of work is programmatically initiated. Setting a task name and then initiating a transaction or
ActivitySession causes the task to be associated with the new unit of work. This interface cannot be
used within Enterprise JavaBeans that are configured for container-managed transactions or
container-managed ActivitySessions because units of work can only be associated with a task at the
exact time that the unit of work is initiated. The call to set the task name must therefore be invoked
before the unit of work is begun. Units of work cannot be named after they are begun. See the topic,
Using the TaskNameManager interface.

Note: If you select the 5.x Compatibility Mode attribute on the Application Profile Service's console
page, then tasks configured on J2EE 1.3 applications are not necessarily associated with units
of work and can arbitrarily be applied and overridden. This is not a recommended mode of
operation and can lead to unexpected deadlocks during database access. Tasks are not
communicated on requests between applications that are running under the Application Profiling
5.x Compatibility Mode and applications that are not running under the compatibility mode.

For a Version 6.0 client to interact with applications run under the Application Profiling 5.x
Compatibility Mode, you must set the appprofileCompatibility system property to true in the
client process. You can do this by specifying the -CCDappprofileCompatibility=true option when
invoking the launchClient command.

Create an application profile. See the assembly tool information center to complete this task.

Declaratively configure a unit of work on necessary methods. In step one of this article, you defined a
task on a method. The task defined on a method only becomes active when a unit of work is begun on
that method's behalf. The method must begin a new unit of work for the configured task to be applied.
If the method runs under an imported unit of work, then the configured task on the method is ignored
and the task (if any) associated with the imported unit of work is used. If the container begins a new
unit of work when the method executes, then it is associated with the configured task name. Therefore,
the last step in assembling applications for application profiling is to define a unit of work on any
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method that has a task name (and eventually an Application Profile) associated with it. A unit of work
can either be a transaction or an ActivitySession. See the topic, Defining container transactions for EJB
modules, for a description on how to configure a transaction on an EJB module. The topic, Configuring
transactional deployment attributes, describes how to define other transaction attributes. The topic,
Using the ActivitySession service, describes how to use and create an ActivitySession unit of work. For
more information about the relationships between tasks and units of work, see the topic, Tasks and
units of work considerations.

What to do next

To complete the following tasks using assembly tools see the assembly tool documentation. The following
tasks can be done using assembly tools:

» Automatic configuration of application profiling

The assembly tool includes a static analysis engine that can assist you in configuring application
profiling. The tool examines the compiled classes and the deployment descriptor of a Java EE
application to determine the entry point of transactions, calculate the set of entities enlisted in each
transaction, and determine whether the entities are read or updated during the course of each identified
transaction.

» Automatically configure application profiles and tasks.

Automatically configure application profiling for an application through static analysis.
* Apply profile-scoped access intent policies to entity beans.

Configure entities with access intent for an application profile.
» Create a custom access intent policy.

Define a custom access intent policy, which can be configured for Enterprise JavaBeans (EJB) 2.x and
3.0 entity beans.

» Create an application profile.

An application profile contains a set of access intent policies applied to an application's entity beans.
The access intent policies are only applied for requests that are associated with tasks configured on the
application profile.

» Configure container-managed tasks for application clients.

For application clients that programmatically begin either a transaction or ActivitySession only, you must
configure an application client's container-managed task to associate requests from the client with an
application profile.

» Configure container-managed tasks for Web components.

For Web components that programmatically set the configured task and then programmatically begin
either a transaction or ActivitySession only, you can configure Web components application-managed
tasks to associate requests from a servlet or JavaServer Pages (JSP) file with application profiles.

» Configure container-managed tasks for Enterprise JavaBeans.

For methods that cause a new transaction or ActivitySession to be started either by the container or
programmatically by the EJB developer, you can configure an enterprise bean's container-managed
tasks to associate requests from the bean with application profiles.

» Configure container-managed tasks for application clients.

For application clients that programmatically begin either a transaction or ActivitySession only, you must
configure an application client's container-managed task to associate requests from the client with an
application profile.

» Configure application-managed tasks for Web components.

For Web components that programmatically begin either a transaction or ActivitySession only, you can
configure a Web component's container-managed task to associate requests from a servlet or JSP file
with an application profile.

» Configure application-managed tasks for Enterprise JavaBeans.

Chapter 2. Developing Application profiing 13



For Enterprise JavaBeans that programmatically set the configured task and then programmatically
begin either a transaction or ActivitySession only, you can configure EJB application-managed tasks to
associate requests from the bean with application profiles.
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Chapter 3. Developing Asynchronous beans
This page provides a starting point for finding information about asynchronous beans.

Asynchronous beans and asynchronous scheduling facilities offer performance enhancements for
resource-intensive tasks by enabling single tasks to run as multiple tasks.

Developing work objects, event listeners, and asynchronous scopes

Developing work objects to run code in parallel

You can run work objects in parallel, or in a different Java Platform, Enterprise Edition (Java EE) context,
by wrapping the code in a work object.

Before you begin

Your administrator must have configured at least one work manager using the administrative console.
About this task

To run code in parallel, wrap the code in a work object.

Procedure
1. Create a work object.

A work object implements the com.ibm.websphere.asynchbeans.Work interface. For example, you can
create a work object that dynamically subscribes to a topic and any component that has access to the
event source can add an event on demand:

class SampleWork implements Work
{

boolean released;

Topic targetTopic;

EventSource es;
TopicConnectionFactory tcf;

public SampleWork(TopicConnectionFactory tcf, EventSource es, Topic targetTopic)
{

released = false;

this.targetTopic = targetTopic;

this.es = es;

this.tcf = tcf;

}

synchronized boolean getReleased()

{

return released;

}

public void run()
{
try
{
// setup our JMS stuff.
TopicConnection tc = tcf.createConnection();
TopicSession sess = tc.createSession(false, Session.AUTOACK);
tc.start();

MessagelListener proxy = es.getEventTrigger(MessagelListener.class, false);
while(!getReleased())
{
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// block for up to 5 seconds.

Message msg = sess.receiveMessage(5000);
if(msg != null)

{

// fire an event when we get a message
proxy.onMessage (msg) ;

}

tc.close();
catch (JMSException ex)

// handle the exception here
throw ex;

}
finally

{
if (tc !'= null)

try
{

tc.close();

1
catch (JMSExceptin exl)

{

// handle exception
}
}
}
}

// called when we want to stop the Work object.
public synchronized void release()

{

released = true;
1
}

As a result, any component that has access to the event source can add an event on demand, which
allows components to subscribe to a topic in a more scalable way than by simply giving each client
subscriber its own thread. The previous example is fully explored in the WebSphere Trader Sample.
Refer to the Samples section of the Information Center for details.

Determine the number of work managers needed by this application component.

Look up the work manager or managers using the work manager resource reference (or logical name)
in the java:comp namespace. (For more information on resource references, refer to the References
topic.)

InitialContext ic = new InitialContext();
WorkManager wm = (WorkManager)ic.lookup("java:comp/env/wm/myWorkManager");

The resource reference for the work manager (in this case, wm/myWorkManager) must be declared as a
resource reference in the application deployment descriptor.
Call the WorkManager.startWork() method using the work object as a parameter. For example:

Work w = new MyWork(...);
WorkItem wi = wm.startWork(w);

The startWork() method can take a startTimeout parameter. This specifies a hard time limit for the
Work object to be started. The startWork() method returns a work item object. This object is a handle
that provides a link from the component to the now running work object.

[Optional] If your application component needs to wait for one or more of its running work objects to
complete, call the WorkManager.join() method. For example:
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WorkItem wiA = wm.start(workA);

WorkItem wiB = wm.start(workB);

ArrayList 1 = new ArrayList();

1.add(wiA);

1.add(wiB);

if(wm.join(1, wm.JOIN_AND, 5000)) // block for up to 5 seconds
{

// both wiA and wiB finished
}

else

{
// timeout

// we can check wiA.getStatus or wiB.getStatus to see which, if any, finished.

}

This method takes an array list of work items which your component wants to wait on and a flag that
indicates whether the component will wait for one or all of the work objects to complete. You also can
specify a timeout value.

6. Use the release() method to signal the unit of work to stop running. The unit of work then attempts to
stop running as soon as possible. Typically, this action is completed by toggling a flag using a
thread-safe approach like the following example:
public synchronized void release()

{

released = true;

}

The Work.run() method can periodically examine this variable to check whether the loop exits or not.

Work objects

A work object is a type of asynchronous bean used by application components to run code in parallel or in
a different Java Platform, Enterprise Edition (Java EE) context.

A work object implements the com.ibm.websphere.asynchbeans.Work interface. A work object is
essentially a java.lang.Runnable object that is serializable and provides additional methods. For details,
refer to the Interface Work in the generated APl documentation.

A component wanting to run work in parallel, or in a different Java EE context, locates a work manager in
Java™ Naming and Directory Interface (JNDI), then calls the WorkManager.startWork() method using the
work object as a parameter.

The startWork() method returns a work item object. This object is a handle that provides a link from the
component to the now running work object. The work item object is typically used when the component
needs to wait for one or more of its running work objects to complete. The WorkManager.join() method
takes an array list of work items that the component wants to wait on, and a flag indicating whether the
component will wait for all or one of the work objects to complete. A timeout can be specified, which
prevents the component from waiting indefinitely.

The application does not create Java SE Development Kit 6 (JDK 6) threads because they are not
managed threads. Plus, these threads are not affiliated with the Java EE environment, which makes them
useless inside an application server. In addition, these threads have no Java EE context (for example, a
java:comp) and are not authenticated when they fire. Work object threads are fully supported by the
application server and have the same properties as other asynchronous beans.

Example: Creating work objects
You can create a work object that dynamically subscribes to a topic and any component that has access
to the event source can add an event on demand.
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The following is an example of a work object that dynamically subscribes to a topic:
class SampleWork implements Work

{

boolean released;

Topic targetTopic;
EventSource es;
TopicConnectionFactory tcf;

public SampleWork(TopicConnectionFactory tcf, EventSource es, Topic targetTopic)
{

released = false;

this.targetTopic = targetTopic;

this.es = es;

this.tcf = tcf;

}

synchronized boolean getReleased()

{

return released;

}

public void run()

{
try

// setup our JMS stuff.

TopicConnection tc = tcf.createConnection();

TopicSession sess = tc.createSession(false, Session.AUTOACK);
tc.start();

MessagelListener proxy = es.getEventTrigger(MessagelListener.class, false);
while(!getReleased())

// block for up to 5 seconds.
Message msg = sess.receiveMessage(5000);
if(msg = null)

{

// fire an event when we get a message
proxy.onMessage(msg) ;

tc.close();

}
catch (JMSException ex)

// handle the exception here
throw ex;

}
finally
{

if (tc != null)
{
try

{

tc.close();

catch (JMSExceptin ex1)
{
// handle exception
1
1
}
!

// called when we want to stop the Work object.
public synchronized void release()
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{

released = true;
}
1

As a result, any component that has access to the event source can add an event on demand, which
allows components to subscribe to a topic in a more scalable way than by simply giving each client
subscriber its own thread. The previous example is fully explored in the WebSphere Trader Sample. See
the Samples section of the Information Center for details.

Developing event listeners

Application components that listen for events can use the EventSource.addListener() method to register an
event listener object (a type of asynchronous bean) with the event source to which the events will be
published. An event source also can fire events in a type-safe manner using any interface.

About this task

Notifications between components within a single EAR file are handled by a special event source. See the
Using the application notification service topic for more information about notifications.

Procedure
1. Create an event listener object, which can be any type. For example, see the following interface code:

interface SampleEventGroup

{
void finished(String message);

}

class myListener implements SampleEventGroup

{

public void finished(String message)

// This will be called when we 'finish'.
}
1

2. Register the event listener object with the event source. For example, see the following code:

InitialContext ic = ...;

EventSource es = (EventSource)ic.lookup("java:comp/websphere/ApplicationNotificationService");
myListener 1 = new myListener();

es.addListener(1);

This enables the myListener.finished() method to be called whenever the event is fired. The following
code example shows how this event might be fired:

InitialContext ic = ...;

EventSource es = (EventSource)ic.lookup("java:comp/websphere/ApplicationNotificationService");

myListener proxy = es.getEventTrigger(myListener.class);

// fire the 'event' by calling the method

// representing the event on the proxy
proxy.finished("done");

Example

You can fire a listenerCountChanged event that produces a proxy for the interface on which the method
fires. Calling the method corresponding to the event on the proxy implements the EventSourceEvents
interface. The same proxy can be used to send multiple events simultaneously.

The following code example demonstrates how to fire a listenerCountChanged event:

// Imagine this snippet inside an EJB or serviet method.

// Make an inner class implementing the required event interfaces.
EventSourceEvents listener = new Object() implements EventSourceEvents.class
{

void TistenerCountChanged(EventSource es, int old, int newCount)
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{
try

InitialContext ic = new InitialContext();
// Here, the asynchronous bean can access an environment variable of
// the component which created it.

int i = (Integer)ic.lookup("java:comp/env/countValue").intValue());
if(newCount == 1)
{

// do something interesting

// call this event when the following code executes:

1
catch(NamingException e)
{
}
1
void listenerExceptionThrown( EventSource es, Object listener,
String methodName, Throwable exception)
{

}
void unexpectedException(EventSource es, Object runnable, Throwable exception)
{
1
}
// register it.
es.addListener(listener);

// now fire an event which the previous listener receives.
EventSourceEvents proxy = (EventSourceEvents)
es.getEventTrigger(EventSourceEvents.class, false);

proxy.listenerCountChanged(es, 0, 1);

// now, fire another event, you can call any of the methods.
proxy.listenerCountChanged(es, 4, 5);

The output in this example is a proxy for the interface on which the method fires. Then, call the method
corresponding to the event on the proxy. This action causes the same method with the same parameters
to be called on any event listeners that implement the EventSourceEvents interface and that were
previously registered with the EventSource "es". The same proxy can be used to send multiple events
simultaneously.

The boolean parameter on the getEventTrigger() method is sameTransaction. When the sameTransaction
parameter is false, a new transaction is started for each event listener invoked and these event listeners
can be called in parallel to the caller. However, the event() method is blocked until all of the event listeners
are notified. If the sameTransaction parameter is true, then the current transaction (if any) on the thread is
used for all of the event listeners. The event listeners share the transaction of the method that fired the
event. For that reason, all event listeners must run serially in an undetermined order. The order that
listeners are called is undefined, and the order in which listeners are registered does not act as a guide for
the order used at run time. The method on the proxy does not return until all of the event listeners are
called, which means that this action is a synchronous operation.

The parameters that references and listeners pass do not interfere with the function of these references,
unless you configure the method to do so. For example, event listeners can be used as collaborators and
add data to a map, which was a parameter. Each event listener runs on its own transaction, independent
of any transaction that is active on the thread. Extreme care must be taken when the sameTransaction
parameter is false because the parameters can be accessed by multiple threads.
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Using the application notification service

During the application lifetime, individual J2EE components (servlets or enterprise beans) within a single
EAR file might need to signal each other. There is an event source in the java:comp namespace that is
bound into all components within an EAR file that can be used for notification.

About this task

The JNDI name for this event source, in the java:comp namespace that is bound into all components
within an EAR file, is:

java:comp/websphere/ApplicationNotificationService

Components within the same application can fire asynchronous events and register event listeners using
this application notification service. Startup beans can be used to register these event listeners at
application startup or they can be registered dynamically at run time.

Procedure

To have your enterprise bean or servlet use the application notification service, write code similar to the
following example:

InitialContext ic = new InitialContext();

EventSource appES = (EventSource)
ic.lookup("java:comp/websphere/ApplicationNotificationService");

// now, the application can add a Tistener using the EventSource.addListener method.

// MyEventType is an interface.

MyEventType myListener = ...;

AppES.addListener(myListener);

// later another component can fire events as follows
InitialContext ic = new InitialContext();

EventSource appES = (EventSource)
ic.lookup("java:comp/websphere/ApplicationNotificationService");

// This highlights a constant string on the EventSource interface which

// specifies the 'java:comp/websphere/ApplicationNotificationService' string.
ic.Tookup(appES.APPLICATION_NOTIFICATION_EVENT_SOURCE)

// now, the application can add a Tistener using the EventSource.addListener method.
MyEventType proxy = appES.getEventTrigger(MyEventType.class, false);

proxy.someEvent (someArguments) ;

Example

Example: Firing a listenerCountChanged event

You can fire a listenerCountChanged event that produces a proxy for the interface on which the method
fires. Calling the method corresponding to the event on the proxy implements the EventSourceEvents
interface. The same proxy can be used to send multiple events simultaneously.

The following code example demonstrates how to fire a listenerCountChanged event:

// imagine this snippet inside an EJB or servlet method.
// Make an inner class implementing the required event interfaces.
EventSourceEvents Tistener = new Object() implements EventSourceEvents.class

{
void TistenerCountChanged(EventSource es, int old, int newCount)
{
try
{
InitialContext ic = new InitialContext();
// Here, the asynchronous bean can access an environment variable of
// the component which created it.
int i = (Integer)ic.lookup("java:comp/env/countValue").intValue());
if(newCount == i)

{
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// do something interesting

// call this event when the following code executes:

}

catch(NamingException e)
{
}
1

void TistenerExceptionThrown( EventSource es, Object Tistener,
String methodName, Throwable exception)
{

}

void unexpectedException(EventSource es, Object runnable, Throwable exception)
{
}

}
// register it.
es.addListener(Tistener);

// now fire an event which the previous listener receives.
EventSourceEvents proxy = (EventSourceEvents)
es.getEventTrigger(EventSourceEvents.class, false);

proxy.listenerCountChanged(es, 0, 1);

// now, fire another event, you can call any of the methods.
proxy.listenerCountChanged(es, 4, 5);

The output in this example is a proxy for the interface on which the method fires. Then, call the method
corresponding to the event on the proxy. This action causes the same method with the same parameters
to be called on any event listeners that implement the EventSourceEvents interface and that were
previously registered with the EventSource "es". The same proxy can be used to send multiple events
simultaneously.

The boolean parameter on the getEventTrigger() method is sameTransaction. When the sameTransaction
parameter is false, a new transaction is started for each event listener invoked and these event listeners
can be called in parallel to the caller. However, the event() method is blocked until all of the event listeners
are notified. If the sameTransaction parameter is true, then the current transaction (if any) on the thread is
used for all of the event listeners. The event listeners share the transaction of the method that fired the
event. For that reason, all event listeners must run serially in an undetermined order. The order that
listeners are called is undefined, and the order in which listeners are registered does not act as a guide for
the order used at run time. The method on the proxy does not return until all of the event listeners are
called, which means that this action is a synchronous operation.

The parameters that references and listeners pass do not interfere with the function of these references,
unless you configure the method to do so. For example, event listeners can be used as collaborators and
add data to a map, which was a parameter. Each event listener runs on its own transaction, independent
of any transaction that is active on the thread. Extreme care must be taken when the sameTransaction
parameter is false because the parameters can be accessed by multiple threads.

Developing asynchronous scopes

Asynchronous scopes are units of scoping that comprise a set of alarms, subsystem monitors, and child
asynchronous scopes. You can create asynchronous scopes, starting with the parent.

About this task

Using asynchronous scopes can involve some or all of the following steps:
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Procedure

1. Create asynchronous scopes. Create the parent asynchronous scope object by using a unique
parameter name that calls the AsynchScopeManager.createAsynchScope() method. You can store
properties in an asynchronous scope object. This storage provides Java 2 Enterprise Edition (J2EE)
applications with a way to store a non-serializable state that otherwise cannot be stored in a session
bean. You also can create child asynchronous scopes, which is useful for scoping data beneath the
parent.

2. Listen for alarm notifications

a.

b.

Create a listener object by implementing the AlarmListener interface. For more information, refer to
the AlarmListener interface in the generated APl documentation.

Supply this object to the AlarmManager.create() method, as the target for the alarm. The create()
method takes the following parameters:
Target for the alarm
The target on which the fired() method is called when the alarm is fired.
Context
The context object for the alarm. This object is useful for supplying alarm-specific data to
the listener and supports a single listener for multiple alarms.
Interval
The number of milliseconds before the alarm fires.

After the specified interval, the alarm fires and the fired() method of the listener is called with the
firing alarm as a parameter. The alarm object is returned. By calling methods on this object, you
can cancel or reschedule the alarm.

3. Monitor remote systems.

a.

Implement a mechanism for detecting messages sent from the remote system. For example,
publish and subscribe messaging.

Create a subsystem manager object by calling the SubsystemMonitorManager.create() method with
the following parameters:
Name Each subsystem monitor must have a unique name.
Heartbeat interval

The expected interval, in milliseconds, between heartbeats.
Missed heart beats until stale or suspect

The number of heartbeats that can be missed before the subsystem is marked as stale.
Missed heart beats until dead

The number of heartbeats that can be missed before the system is marked as dead.

Create an object that implements the SubsystemMonitorEvents interface. For more information, see
the SubsystemMonitorEvents in the generated API documentation.

Add an instance of this object to the subsystem monitor using the SubsystemMonitor.addListener()
method.

Whenever a heartbeat message arrives from the remote system, call the SubsystemMonitor ping()
method.

The subsystem monitor configures alarms to track the heartbeat status of the remote system. When
the ping() method is called, the alarms are reset. If an alarm fires, the ping() method is not called; that
is, the application did not receive a heartbeat from the monitored subsystem.

Example

Asynchronous scopes are useful in stateful server applications. An application can have a startup bean
that creates an asynchronous scope on a named work manager. The application also might create
subsystem monitors to monitor the health of any remote systems on which the application is dependent.

When a client attaches to the server, the application creates a child asynchronous scope that is owned by
the application asynchronous scope for the client and named using the client ID. A subsystem monitor for
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monitoring the client might be created on the client asynchronous scope. If the client times out, a callback
can clean up the client state on the server. Callbacks can be attached to the application subsystem
monitors, on behalf of the client. When a remote system becomes unavailable, the client code in the
server is notified and an event is sent to the client to warn that a critical remote system has failed. For
example, the failure might be a data feed in an electronic trading application.

Asynchronous scopes
An asynchronous scope (AsynchScope object) is a unit of scoping provided for use with asynchronous
beans.

Asynchronous scopes are collections of alarms, subsystem monitors, and child asynchronous scopes that
enable a relationship to form. Each asynchronous scope uses a single work manager.

Each AsynchScope object owns and controls the life cycle of the following objects:

Child asynchronous scopes
Each AsynchScope object extends the AsynchScopeManager interface, which is a factory for
AsynchScope objects. (For more information on the AsynchScopeManager interface, refer to the
generated API documentation). Any asynchronous scope can therefore create named
asynchronous scopes (children). Child asynchronous scopes can be useful for scoping data
underneath the parent. All of the child asynchronous scopes must be uniquely named. These
children are destroyed if the parent asynchronous scope is destroyed.

Alarms
Each asynchronous scope has an associated alarm manager. All of the alarms created by the
alarm manager are automatically cancelled if the associated asynchronous scope is destroyed.

Subsystem monitors
Each asynchronous scope has a subsystem monitor manager, which manages a set of subsystem
monitors associated with the asynchronous scope. When the asynchronous scope is destroyed, all
of the associated subsystem monitors also are destroyed.

In summary, asynchronous scopes can be organized into an acyclic tree. The life cycle of each
asynchronous scope is directly coupled to that of its parent asynchronous scope. Each asynchronous
scope is associated with a set of alarms and subsystem monitors, and an optional set of child
asynchronous scopes. These objects are cancelled and destroyed when the asynchronous scope is
destroyed.

Asynchronous scope state

Each asynchronous scope has an associated map, in which applications can store their state in the form
of name and value pairs.

Asynchronous scope events

Each asynchronous scope is also an event source. Applications can therefore register event listeners
against the asynchronous scope. The event listeners can receive notification if, for example, the
AsynchScope object is about to be destroyed.

Applications also can use this event source to fire events only to listeners of this asynchronous scope. For
example, an AsynchScope object created for a client session might be used to fire asynchronous events to
parties interested in that client.

Alarms
An alarm runs Java Platform, Enterprise Edition (Java EE) context-aware code at a given time interval.
Alarm objects are fine-grained, nonpersistent, transient, and can fire at millisecond intervals.
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Alarms are run using a thread pool associated with the work manager that owns the associated
asynchronous scope. You must create a work manager instance to create an alarm. Refer to the
Configuring work managers topic for more information.

The AlarmManager.createAlarm() method takes an application-written object that implements the
AlarmListener interface. For more information on the AlarmListener interface, refer to the generated API
documentation. The fired method is called when the alarm expires. The createAlarm() method returns a
non-serializable handle, which can be used to cancel or reset the alarm. All of the pending alarms are
cancelled when its associated AsynchScope object is destroyed.

best-practices: The Java SE Development Kit 6 (JDK6 )already has a timer mechanism, so why create a
new one? The JDK 6 is a Java Platform, Standard Edition (Java SE) feature that knows
nothing about the Java EE environment. Timers fired by the Java SE feature do not run
on a managed thread and are therefore unusable inside an application server. These
timers also lack a Java EE context (that is, a java:comp value) and are not authenticated
when they fire. The asynchronous scope alarms are fully supported by the product and
have the same properties as any other asynchronous bean.

Alarm performance

The alarm subsystem is designed to handle a large number of alarms. However, do not expect alarms to
process heavy loads when they are firing because this activity slows the processing of later alarms. If an
alarm needs to process a heavy load, design a work object that is activated by a work manager. This
procedure moves the heavy processing to a different thread and enables the alarm threads to process
alarms unhampered. All of the alarms owned by asynchronous scopes that are owned by a single work
manager share a common thread pool. The properties of this thread pool can be tuned at the work
manager level using the administrative console.

Subsystem monitors
A subsystem monitor is an object that monitors the health of a remote system. It uses an event source to
inform all registered listeners of the health of the system.

AdvancedJava Platform, Enterprise Edition (Java EE) applications often rely on remote, non-managed,
non-Java EE systems. These remote systems can periodically send clients a message to indicate that they
are working. A subsystem monitor is a set of alarms that tracks indicator messages or heart beats from a
remote system.

An application creates a subsystem monitor by calling the SubsystemMonitorManager.create() method with
the following parameters:
Name Each subsystem monitor must be uniquely named.
Heart beat interval
The time period, in milliseconds, between arriving heart beat messages.
Missed heart beats until stale or suspect
The number of heart beats that can be missed before the subsystem is marked as stale. This
designation indicates that the subsystem might be having problems.
Missed heart beats until dead
The number of heart beats that can be missed before the system is considered down. The system
then is marked as dead.

The subsystem monitor configures alarms to track the heart beat status. Whenever the ping() method is
called, the alarms are reset. If an alarm fires, the ping() method has not been called; that is, the
application did not receive a heart beat from the monitored subsystem. When the number of Missed heart
beats until stale value has elapsed without a ping, a stale event is fired. Later, if the number of Missed
heart beats until dead value elapses without a ping, a dead event is fired. If a ping is received after a
stale or dead notification, a fresh event is sent, which indicates that the subsystem is alive again.
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Make the Missed heart beats until dead value greater or equal to the Missed heart beats until stale
value. If Missed heart beats until stale value equals the Missed heart beats until dead value, then a
stale event is not published. Only a dead event is published.

You can register a listener that implements the SubsystemMonitorEvents interface for applications that
require notification of events. For more information on the SybsystemMonitorEvents interface, refer to the
generated APIl documentation.

Heart beat messages can be transmitted using a variety of mechanisms. The application must call the
SubsystemMonitor ping() method whenever a heart beat message arrives from a remote system, but the
method used to detect these messages is up to the application. For example, you might use a Java
Message Service (JMS) publish or subscribe implementation or even a third-party Java messaging product
that does not implement JMS.

Asynchronous scopes: Dynamic message bean scenario

Java Platform, Enterprise Edition (Java EE) now supports message-driven beans, but the beans are static.
This scenario provides information about how to set up the environment to enable the dynamic message
bean.

All of the message sources must be known in advance and bound at deployment time. This action is not
always viable, especially in fluid messaging environments such as those found in brokerages. Some
environments have publish-subscribe topic spaces that are continually changing and clients need servers
that can subscribe on demand to an arbitrary topic.

An asynchronous bean application can create a work object that performs a blocking receive on a Java
Message Service (JMS) topic and then publishes the message as an event on an application-defined
event source. Clients requiring a subscription to that message can add an event listener to the event
source. The event source can inform the work object when there are no listeners. Then, the event source
can shut down and make the JMS and thread resources available. The work object registers a listener
with its own event source. When the count is one again, the work object knows that it is the only listener
and it is time to shut down the work object. The WebSphere Trader Sample uses this pattern to
dynamically subscribe to JMS topics at run time to gather stock prices. For more information, see the
overview of the samples.

How does the server catch clients that disconnect or crash? It creates a subsystem monitor to watch the
client and adds an event listener to catch dead events. When a dead event occurs, the server application
can clean up the client server state. For example, the server application can remove the client event
listener from the dynamic message bean, thereby allowing the server to subscribe to a dynamic topic only
when it is needed.

Assembling timer and work managers

Assembling applications that use work managers and timer managers

The work manager and timer manager objects are both supported for assembling applications that
implement the asynchronous bean technology. You can assemble either work managers or time managers.

Before you begin

Configure at least one work manager or timer manager using the administrative console.
About this task

Complete the steps to either assemble work managers or time managers.
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Procedure

1. |Assemble applications that use asynchronous beans work managers}|
2. [Assemble applications that use CommonJ work managers.

3. [Assemble applications that use CommondJ timer managers}

Assembling applications that use a CommonJ WorkManager

When a work manager has been configured, if it references a logical work manager it must be bound to a
physical work manager using an assembly tool. Then resources can be created and bound to a physical
work manager.

Before you begin
Your administrator needs to configure at least one work manager using the administrative console.
About this task

If your application references one or more logical work managers, the logical work managers must be
bound to one or more physical work managers using an assembly tool, such as Rational Application
Developer.

Procedure

1. Declare a resource reference for each work manager (required action by the application developer).
This forms an EAR file. (For more information on resource references, refer to the References. topic)

2. Bind each resource reference to a physical work manager, using an assembly tool, such as Rational
Application Developer.

3. Add a resource reference with the type commonj.work.WorkManager to the application deployment
descriptor. The application can look up this work manager using its resource reference name in
java:comp. Now, you can use an assembly tool or Rational Application Developer to specify which
resource references are bound to the physical commonj.work.WorkManager.

Attention: The previous steps outline the same process used for data sources.

Assembling applications that use timer managers

When a work manager has been configured, if it references a logical work manager it must be bound to a
physical work manager using an assembly tool. Then resources can be created and bound to a physical
timer.

Before you begin
Your administrator needs to configure at least one timer manager using the administrative console.
About this task

If your application references one or more logical timer managers, the logical timer managers must be
bound to one or more physical timer managers using an assembly tool, such as the Rational Application
Developer.

Procedure

1. Declare a resource reference for each timer manager (required action by the application developer).
This forms an EAR file. (For more information on resource references, refer to the References topic.)

2. Bind each resource reference to a physical timer manager, using an|assembly tool

3. Add a resource reference with the type commonj.timers. TimerManager to the application deployment
descriptor. The application then can look up this timer manager using its resource reference name in
java:comp. The assembly tool can specify which resource references are bound to a physical timer
manager.
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Attention: The previous steps outline the same process used for data sources.

Assembling applications that use asynchronous beans work managers

When a work manager has been configured, if it references a logical work manager it must be bound to a
physical work manager using an assembly tool. Then resources can be created and bound to a physical
work managers.

Before you begin
Your administrator needs to configure at least one work manager using the administrative console.
About this task

If your application references one or more logical work managers, the logical work managers must be
bound to one or more physical work managers using an assembly tool.

The Commond 1.1 interfaces are supported. Both asynchronous beans and Commond interfaces can use
one configuration work manager object. The type of interface implemented is resolved during the JNDI
lookup time. The type of interface used is determined by the one specified in the resource-reference,
instead of the one specified in the configuration object. So, there can be one resource-reference for each
interface, per configuration object. Each resource-reference lookup returns the appropriate type of
instance. For example, there are two resource-references defined for the wm/MyWorkManager: wm/ABWorkMgr
and wm/CommonJWorkMgr. The WebSphere Application Server run time returns the correct interface for each
resource-reference lookup.

Procedure

1. Declare a resource reference for each work manager (required action by the application developer).
This action results in an EAR file. For more information on resource references, refer to the
References topic.

2. Use an assembly tool to bind each resource reference to a physical work manager.

3. Add a resource reference with the type com.ibm.websphere.asynchbeans.WorkManager to the
application deployment descriptor. The application then can look up this work manager using its
resource reference name in java:comp. The assembly tool or Rational Application Developer then can
specify which resource references are bound to a physical work manager.

Attention: Use the same previous steps to configure data sources.
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Chapter 4. Developing batch applications

You can develop a compute-intensive or transactional batch application, deploy it, then submit the batch
application using one of the available methods.

Developing batch applications

This section covers such areas as a procedure for developing batch applications, xJCL elements, and
sample batch applications.

Transactional batch and compute-intensive batch programming
models

The product provides a transactional batch programming model and a compute-intensive programming
model.

Both the transactional batch and compute-intensive programming models are implemented as Java
objects. They are packaged into an enterprise archive (EAR) file for deployment into the application server
environment. The individual programming models provide details on how the life cycle of the application
and jobs submitted to it are managed by the grid endpoints. Central to all batch applications is the concept
of a job to represent an individual unit of work to be run.

Note: The Java Platform, Enterprise Edition (Java EE) applications that the application server hosts
typically perform short, lightweight, transactional units of work. In most cases, an individual request
can be completed with seconds of processor time and relatively little memory. Many applications,
however, must complete batch work that is computational and resource intensive. The batch
function extends the application server to accommodate applications that must perform batch work
alongside transactional applications. Batch work might take hours or even days to finish and uses
large amounts of memory or processing power while it runs.

Developing a simple compute-intensive application

You can write a simple compute-intensive application using a compute-intensive job controller, the
command line, or the Apache ANT tool.

Procedure
» Create a compute-intensive job using a compute-intensive job controller.
1. Create a compute-intensive job step.
a. Create a Java class that implements the com.ibm.websphere.ci.CIWork interface.
b. Implement business logic.
2. Declare a compute-intensive job controller.

a. Add a stateless session bean to your deployment descriptor and point to the implementation
class that the product provides.

Do so by specifying com.ibm.ws.ci.CIControllerBean as the bean class. Do this specification only
once per compute-intensive application.

b. Use com.ibm.ws.ci.ClControllerHome for the remote home interface class and
com.ibm.ws.ci.ClController for the remote interface class.

3. Configure the EJB deployment descriptor.

a. Configure a resource reference on the controller bean to the WorkManager wm/ClWorkManager
default of the type commonj.work.WorkManager.

» Create compute-intensive jobs using the command line.
1. Create a compute-intensive job step.
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a. Create a Java class that implements the com.ibm.websphere.ci.CIWork interface.
b. Implement business logic.

2. Open a command prompt and ensure that the directory where your Java executable program is
located is included in your PATH variable so that you can run the Java command.

3. Issue the following command.

java -jar pgcbatchpackager.jar -appname=<application name>
-jarfile=<jarfile containing P0JO step classes> -earfile=<name of the output ear file without .ear>
[-utilityjars=<semicolon separated list of utility jars>] [-debug] [-gridjob]

For example for batch jobs, issue

java —jar pgcbatchpackager.jar —appname=SimpleCI —jarfile=SimpleCIEJBs.jar
-earfile=SimpleCIl —gridjob=true

» Create compute-intensive jobs using ANT.
1. Create the compute-intensive job step.
a. Create a Java class that implements the com.ibm.websphere.ci.CIWork interface.
b. Implement business logic.
2. For a compute-intensive job, ensure that the pgcbatchpackager.jar is on the class path.
3. Declare the task.
Use the following command to declare the task:

<taskdef name="pgcpackager" classname="com.ibm.ws.batch.packager.PGCPackager"
classpath="${FEBaseDir}/grid.pgc.packager/build/Tib/pgcbatchpackager.jar" />

4. After compiling the Java files in your application, invoke the pgcpackager task.

<pgcpackager appname="<appname>" earFile="<location name of EAR file to generate>"
jarfile="Tocation of the P0JO jar file" gridJob="true"/>

Results

You have developed a simple compute-intensive application using a compute-intensive job controller, the
command line, or ANT.

What to do next

Install the compute-intensive application and configure WebSphere grid endpoints.

Compute-intensive programming model

Compute-intensive applications are applications that perform computationally intensive work that does not
fit comfortably into the traditional Java Platform, Enterprise Edition (Java EE) request and response
paradigm.

Compute-intensive applications

There are a number of characteristics that can make these applications unsuitable for traditional Java EE
programming models:

* The need for asynchronous submission and start of work
* The need for work to run for extended periods of time
» The need for individual units of work to be visible to and manageable by operators and administrators

The compute-intensive programming model provides an environment that addresses these needs. The
compute-intensive programming model is centered around two basic concepts:

1. The use of jobs to submit and manage work asynchronously

2. A minor extension to the asynchronous beans programming model to support work that runs for an
extended period
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The following sections provide additional information about the extensions to the asynchronous beans
programming model.

Controller bean

The controller bean is a stateless session bean defined in the compute-intensive application deployment
descriptor that allows the runtime environment to control jobs for the application. The implementation of
this stateless session bean is provided by the application server. The application includes the stateless
session bean, shown in the following definition, in the deployment descriptor of one of its enterprise bean
modules. Exactly one controller bean must be defined for each compute-intensive application. Since the
implementation of the controller bean is provided in the application server runtime, application deployers
do not request deployment of enterprise beans during deployment of compute-intensive applications.
<session id="supply a suitable name here">

<ejb-name>CIController</ejb-name>

<home>com. ibm.ws.ci.CIControllerHome</home>

<remote>com.ibm.ws.ci.CIController</remote>

<ejb-class>com.ibm.ws.ci.CIControllerBean</ejb-class>

<session-type>Stateless</session-type>

<transaction-type>Bean</transaction-type>

<resource-ref id="WorkManager ResourceRef">

<description>
WorkManager that is used to execute jobs.

<res-ref-name>wm/CIWorkManager</res-ref-name>
<res-type>commonj.work.WorkManager</res-type>
<res-auth>Container</res-auth>
<res-sharing-scope>Shareable</res-sharing-scope>

Packaging a compute-intensive application

The logic for a compute-intensive application with some number of CIWork objects plus the classes to
support those CIWork objects, is packaged in an enterprise bean module in a Java EE application
Enterprise Archive (EAR) file. The deployment descriptor for the enterprise bean module must contain the
definition of the stateless session bean previously described. If the application itself uses other enterprise
beans or resources, then the definitions for those beans and resources might also be in the deployment
descriptor. You can use Java EE development tools such as IBM® Rational Application Developer to
develop and package compute-intensive applications in the same way that they are used to construct Java
EE applications containing enterprise bean modules and asynchronous beans. You can also use the
pgcpackager task to package compute-intensive applications.

Life cycle of a compute-intensive application

A compute-intensive application is started by the application server in the same way as other Java EE
applications. If the application defines any start-up beans, then those beans are run when the application
server starts. When a job arrives for the application to run, the compute-intensive execution environment
invokes the ClControllerBean stateless session bean defined in the application EJB module deployment
descriptor. The Java Naming and Directory Interface (JNDI) name of this stateless session bean is
specified in the XML Job Control Language (xJCL) for the job. For each job step, the ClControllerBean
stateless session bean completes the following actions:

1. Instantiates the application CIWork object specified by the class name element in the xJCL for the job
step using the no-argument constructor of the CIWork class.

2. Invokes the setProperties() method of the CIWork object to pass any properties defined in the xJCL for
the job step.

3. Looks up the work manager defined in the deployment descriptor of the enterprise bean module and
uses it to asynchronously call the run() method of the CIWork object.
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If the job is canceled before the run() method returns, then the ClControllerBean invokes the CIWork
object release() method on a separate thread. It is up to the developer of the long-running application to
arrange for logic in the release() method to cause the run() method to return promptly. The job remains in
a cancel pending state until the run() method returns.

If the job is not canceled and the run() method returns without returning an exception, then the job
completed successfully. If the run() method returns an exception, then the job status is execution failed.
After the run() method returns either successfully or with an exception, no further calls are made to the
ClIWork object. All references to the run() method are dropped.

Compute-intensive job step

Unlike other batch jobs, compute-intensive jobs consist of one job step. This job step is represented by an
instance of a class that implements the com.ibm.websphere.ci.CIWork interface. The ClWork interface
extends the commonj.Work work interface from the application server asynchronous beans programming
model and Java Specification Request (JSR) 237. These extensions consist of two methods that provide a
way to pass the job-step-specific properties specified in the job to the CIWork object.

See the APl documentation for more details.

To learn about asynchronous beans, go to|Using asynchronous beans| section of the WebSphere
Application Server Information Center.

Developing a simple transactional batch application

You can write a simple batch application using a batch job controller and Enterprise JavaBeans (EJB) data
stream, the command line, or the Apache ANT tool.

About this task

Note: If the batch step uses a batch data stream (BDS) whose data is local to the file system of the
application server to which the batch application is deployed, then certain steps must be followed to
support job restart scenarios. If such a batch application is deployed to application servers that can
run on multiple machines, then there is no guarantee that the restart request is accepted by the
machine on which the batch job originally ran. This occurs when the batch application is deployed
to a cluster, and if a batch job that runs against such an application is canceled and then restarted.
In this scenario, the deployment might send the restart request to an application server that runs on
a different machine. Therefore, in cases where file-based affinity is required, you can apply the
following solutions to support the job restart scenario:

* Ensure that the data is equally available to every machine on which the batch application can be
started. Use a network file system for this example. This action might reduce performance of
application.

» Deploy the application on application servers that can only run on the machine where the local
data exists. Complete this action by deploying the application to a cluster that exists in a node
group that has only one member node.

Note: The batch application developer must ensure that transactional work done in the batch step
callback methods inherits the global transaction started by the grid endpoints. This action ensures
that work performed under a batch step only gets committed at every checkpoint and rolls back if
the step fails.

Some commands are split on multiple lines for printing purposes.
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Procedure
» Create batch jobs using a batch job controller and an EJB data stream.
1. Create batch job steps.
a. Create a Java class that implements the com.ibm.websphere.BatchJobStepinterface interface.
b. Implement business logic.

If your step has one input and one output stream you can alternatively use the Generic batch
step of GenericXDBatchStep.

2. Create batch data streams.
a. Create a Java Class that implements the interface com.ibm.websphere.batch.BatchDataStream.

Batch data streams are accessed from the business logic, for example, from the batch job steps
by calling BatchDataStreamMgr with jobID and stepID. JobID and steplID are retrieved from the
step bean properties list using keys BatchConstants.JOB_ID and BatchConstants.STEP_ID.

b. Map BatchConstants.JOB_ID to com.ibm.websphere.batch.JobIlD and map
BatchConstants.STEP_ID to com.ibm.websphere.batch.SteplD.

You should already have access to the BatchConstants class.

The batch datastream framework provides several ready-to-use patterns to work with different
types of datastreams such as file and database. To use the batch datastream framework,
complete the following steps.

1) ldentify the data stream type with which you want to operate, such as TextFile, ByteFile,
JDBC, or z/OS® stream.

2) Identify whether you would read from the stream or write to the stream.

3) See the table in the batch data stream framework and patterns. Select the class from the
supporting classes column that matches your data stream type and operation. For example,
if you want to read data from a text file, then select TextFileReader.

4) Implement the interface listed in the pattern name column that corresponds to the supporting
class you selected in the previous step. The supporting class handles all the book keeping
activities related to the stream and the batch programming model. The implementation class
focuses on the stream processing logic.

5) Declare the supporting class and your implementation class in the xJCL.
6) Repeat this procedure for each datastream required in your step.
3. Define batch data streams in xJCL.

<batch-data-streams>
<bds>

<logical-name>inputStream</logical-name>
<props>

<prop name="PATTERN_IMPL_CLASS" value="MyBDSStreamImplementationClass"/>
<prop name="file.encoding" value="8859_1"/>

<prop name="FILENAME" value="${inputDataStream}" />

<prop name="PROCESS_HEADER" value="true"/>

<prop name="AppendJobIdToFileName" value="true"/> </props>
<impT-class>com.ibm.websphere.batch.devframework.datastreams.patterns.FileByteReader
</impl-class>
</bds>

The PATTERN_IMPL_CLASS class denotes the user implementation of the BDS framework pattern
and the impl-class property denotes the supporting class.

4. Declare a batch job controller.

a. Add a stateless session bean to your deployment descriptor and point to the implementation
class that the product provides. Do so by specifying com.ibm.ws.batch.BatchJobControllerBean
as the bean class. Do this specification only once per batch application.

b. Use com.ibm.ws.batch.BatchJobControllerHome for the remote home interface class and
com.ibm.ws.batch.BatchJobController for the remote interface class.

5. Configure the EJB deployment descriptor.
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a. Configure a resource reference on the Controller bean to the default WorkManager
wm/BatchWorkManager of the type commonj.work.WorkManager.

Note: You must declare the deployment descriptor of the batch controller bean in the Enterprise
JavaBeans (EJB) deployment descriptor of a batch application. Only one controller bean can
be defined per batch application.

» Create batch jobs using the command line.
1. Create batch job steps.
a. Create a Java class that implements the com.ibm.websphere.BatchJobSteplinterface interface.
b. Implement business logic.

If your step has exactly one input and one output stream you could alternatively use the Generic
batch step of GenericXDBatchStep.

2. Create batch data streams.
a. Create a Java Class that implements the interface com.ibm.websphere.batch.BatchDataStream.

Batch data streams are accessed from the business logic, for example, from the batch job steps
by calling BatchDataStreamMgr with jobID and stepID. JobID and steplID are retrieved from the
step bean properties list using keys BatchConstants.JOB_ID and BatchConstants.STEP_ID.

b. Map BatchConstants.JOB_ID to com.ibm.websphere.batch.JobID and map
BatchConstants.STEP_ID to com.ibm.websphere.batch.StepID.

You should already have access to the BatchConstants class.

The batch datastream framework provides several ready-to-use patterns to work with different
types of datastreams such as file and database. To use the batch datastream framework,
complete the following steps.

1) Identify the data stream type with which you want to operate, such as TextFile, ByteFile,
JDBC, or z/OS stream.

2) Identify whether you would read from the stream or write to the stream.

3) See the table in the batch data stream framework and patterns. Select the class from the
supporting classes column that matches your data stream type and operation. For example,
if you want to read data from a text file, then choose TextFileReader.

4) Implement the interface listed in the pattern name column that corresponds to the supporting
class you selected in the previous step. The supporting class handles all the book keeping
activities related to the stream and the batch programming model. The implementation class
focuses on the stream processing logic.

5) Declare the supporting class and your implementation class in the xJCL.
6) Repeat this procedure for each datastream required in your step.

3. Open a command prompt and ensure that Java is on the path.

4. lIssue the following command, all on a single line.

java -cp ${WAS_INSTALL_ROOT}/plugins/com.ibm.ws.batch.runtime.jar
com.ibm.ws.batch.packager.WSBatchPackager
-appname=<Application_Name>
-jarfile=<jarfile containing the P0JO batch steps>
-earfile=<name of the output EAR file without the .ear extension>
[-utilityjars=<semicolon separated Tist of utility jars>]
[-debug]
[-gridJob]

For example, for batch jobs, issue

java -cp ${WAS_INSTALL ROOT}/plugins/com.ibm.ws.batch.runtime.jar
com.ibm.ws.batch.packager.WSBatchPackager

-appname=XDCGIVT

-jarfile=XDCGIVTEJBs.jar

-earfile=XDCGIVT

» Create batch jobs using ANT.
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1. Create batch job steps.
a. Create a Java class that implements the com.ibm.websphere.BatchJobSteplnterface interface.
b. Implement business logic.

If your step has exactly one input and one output stream you could alternatively use the Generic
batch step of GenericXDBatchStep.

2. Create batch data streams.
a. Create a Java Class that implements the interface com.ibm.websphere.batch.BatchDataStream.

Batch data streams are accessed from the business logic, for example, from the batch job steps
by calling BatchDataStreamMgr with jobID and stepID. JoblID and steplID are retrieved from the
step bean properties list using keys BatchConstants.JOB_ID and BatchConstants.STEP_ID.

b. Map BatchConstants.JOB_ID to com.ibm.websphere.batch.JoblD and map
BatchConstants.STEP_ID to com.ibm.websphere.batch.StepID.

You should already have access to the BatchConstants class.

The batch datastream framework provides several ready-to-use patterns to work with different
types of datastreams such as file and database. To use the batch datastream framework,
complete the following steps.

1) Identify the data stream type with which you want to operate, such as TextFile, ByteFile,
JDBC, or z/OS stream.

2) Identify whether you would read from the stream or write to the stream.

3) See the table in the batch data stream framework and patterns. Select the class from the
supporting classes column that matches your data stream type and operation. For example,
if you want to read data from a text file, then select TextFileReader.

4) Implement the interface listed in the pattern name column that corresponds to the supporting
class you selected in the previous step. The supporting class handles all the book keeping
activities related to the stream and the batch programming model. The implementation class
focuses on the stream processing logic.

5) Declare the supporting class and your implementation class in the xJCL.
6) Repeat this procedure for each datastream required in your step.
3. For a batch job, ensure the com.ibm.ws.batch.runtime.jar file is on the class path.
4. Declare the task.
Use the following command to declare the task:

<taskdef name="pgcpackager" classname="com.ibm.ws.batch.packager.PGCPackager"
classpath="${WAS_INSTALL _ROOT}/plugins/com.ibm.ws.batch.runtime.jar" />

5. After compiling the Java files in your application, invoke the WSBatchPackager task.

<WSBatchPackager appname="<appname>" earFile="<location name of EAR file to generate>"
jarfile="location of the P0JO jar file"/>
Results

You have developed a simple transactional batch application using a batch job controller and Enterprise
JavaBeans (EJB) data stream, the command line, or the ANT tool.

What to do next

Install the compute-intensive application and configure WebSphere grid endpoints.

Components of a batch application
The batch application developer and the batch run time environment provide the components of a batch
application.

The following tables describe the components of a batch application.
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Table 1. Components of a batch application that are provided by the batch application developer. The table includes
the component, type, implementation, and provider.

Component Type Implementation Provider
Batch job step POJO com.ibm.websphere.BatchJobStepinterface Batch application
Checkpoint algorithm POJO com.ibm.wsspi.batchCheckpointAlgorithm Batch application (can use runtime-provided

implementation instead)

Results algorithm POJO com.ibm.wsspi.batchResultsAlgorithm Batch application (can use runtime-provided
implementation instead)

Table 2. Components of a batch application that are provided by the batch run time environment. The table includes
the component, type, implementation, and provider.

Component Type Implementation Provider

Batch job controller Session bean Batch run time environment

Checkpoint algorithm POJO Batch run time environment (applications can provide their own)
Results algorithm POJO Batch run time environment (applications can provide their own)

The batch programming model

Batch applications are Enterprise JavaBeans (EJB) based Java 2 Platform Enterprise Edition (J2EE)
applications. These applications conform to a few well-defined interfaces that allow the batch runtime
environment to manage the start of batch jobs destined for the application.

Batch job steps
A batch job can be composed of one or more batch steps. All steps in a job are processed
sequentially. Dividing a batch application into steps allows for separation of distinct tasks in a
batch application. You can create batch steps by implementing the
com.ibm.websphere.batch.BatchJobSteplinterface interface. This interface provides the business
logic of the batch step that the batch run time starts to run the batch application.

Batch controller bean
A batch application includes a stateless session bean that the product run time provides. This
stateless session bean acts as a job step controller. The controller stateless session bean is
declared in the application deployment descriptor once per batch application.

Batch data streams
Methods on the BatchDataStream interface allow the batch runtime environment to manage the
data stream being used by a batch step. For example, one of the methods retrieves current cursor
information from the stream to track how much data has been processed by the batch step.

Checkpoint algorithms
The batch runtime environment uses checkpoint algorithms to decide how often to commit global
transactions under which batch steps are started. The XML Job Control Language (xJCL) definition
of a batch job defines the checkpoint algorithms to be used. Properties specified for checkpoint
algorithms in xJCL allow for checkpoint behavior, such as transaction timeouts and checkpoint
intervals, to be customized for batch steps. The product provides time-based and record-based
checkpoint algorithms. A checkpoint algorithm SPI is also provided for building additional custom
checkpoint algorithms.

Results algorithm
Results algorithms are an optional feature of the batch programming model. Results algorithms are
applied to batch steps through XML Job Control Language (xJCL). The algorithms are used to
manipulate the return codes of batch jobs. Additionally, these algorithms are place holders for
triggers based on step return codes.

Batch job return codes
Batch job return codes fall into two groups named system and user. System return codes are
defined as negative integers. User application return codes are defined as positive integers. Both
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system and user ranges include the return code of zero (0). If a user application return code is
specified in the system return code range, a warning message is posted in the job and system

logs.

Batch job steps:

You can separate tasks of a batch application into batch steps. Batch steps are implemented as Plain Old
Java Object (POJO) classes that implement the interface,
com.ibm.websphere.batch.BatchJobSteplinterfance. Batch job steps are performed sequentially.

Callback methods in the BatchJobSteplinterface allow the grid endpoints to run batch steps when it runs a

batch job.

A batch step contains the batchable business logic to run for a portion of the batch job. Typically, a batch
step contains code to read a record from a batch data stream, perform business logic with that record and
then continue to read the next record. The processJobStep method of a batch step class is called by the
grid endpoints in a batch loop. This method contains all the logic that can be batched to perform on data.

The grid endpoints invoke batch step class methods in a global transaction. This global transaction is
managed by the grid endpoints. The behavior of the transaction, such as transaction timeout or transaction
commit interval, is controlled by the checkpoint algorithm associated with the batch job to which the step

belongs.

The following grid endpoints callback methods exist on the BatchJobSteplinterface that are invoked by the

grid endpoints:

Table 3. Callback methods for grid endpoints. The table includes the callback method and a description.

Callback method

Description

setProperties(java.util.Properties properties)

Makes properties defined in XML Job Control Language
(xJCL) available to batch step in a java.util.Properties
object. This method is invoked in a global transaction.

void createJobStep()

Indicates to the step that it has been initialized.
Initialization logic, such as retrieving a handle to a batch
data stream, can be placed here. This method is invoked
in a global transaction.

int processJobStep()

Repeatedly invoked by grid endpoints in a batch loop until
the return code integer of this method indicates that the
step has finished processing. Review BatchConstants in
the batch API to see which return codes can be returned.
A return code of BatchConstants.STEP_CONTINUE
signals to the grid endpoints to continue calling this
method in the batch loop. A return code of
BatchConstants.STEP_COMPLETE indicates to the grid
endpoints that the step has finished and to call
destroyJobStep.

int destroyJobStep()

Indicates to the step that completion has occurred. The
integer return code of this method is arbitrary and can be
chosen by the batch application developer. This return
code is saved in the grid endpoints database and
represents the return code of the batch step. If the results
algorithm is associated with the batch job, then this return
code is passed to it. If there is a return code-based
conditional logic in the xJCL of the batch job, then the
grid endpoints use this return code to evaluate that logic.
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The getProperties() method on the BatchJobSteplnterface is not currently called by the grid endpoints. The
method is included in the interface for symmetry and possible later use.

Batch return codes:

The batch job return code is retrieved by using the getBatchJobRC EJB interface, the get BatchJobRC
web services interface, or the Ircmd getBatchJobRC command option.

The following table lists the system batch job return codes that the batch environment uses. Do not
confuse the batch job return code with either the job status constants (see the
com.ibm.websphere.longrun.JobStatusConstants API) or the job scheduler constants (see the
com.ibm.websphere.longrun.JobSchedulerConstants API). The JobStatusConstants represent the status of
the job such as submitted, ended, restartable, canceled, or execution failed.

The job status can be obtained by using the getJobStatus EJB interface, the getJobStatus web services
interface, or through the job management console. The JobSchedulerConstants represent operating
conditions returned by the job scheduler on requests involving multiple jobs. For example,

Gnt[] cancelJob( String[] jobid )) )

. These conditions include:

1. Job does not exist

2. Job is in an invalid state

3. Database exception has occurred.

Table 4. Batch job return codes. The table includes each return code with an explanation.

Return code Explanation

0 Job ended normally

-1 Internal protocol error - WSGrid utility

-2 Input parameter error - WSGrid utility

-4 Job was suspended

-8 Job was canceled

-10 Job was forcibly canceled (z/OS only)

-12 Job failed and is in restartable state

-14 Job failed and is in execution failed state**
-16 Catastrophic failure - WSGrid utility

Note: This return code value does not apply in the case where the application returns
BatchConstants.STEP_COMPLETE_EXECUTION_FAILED from the processJobStep method. In
this case, the return code is determined by the application.

There are two options that are used to report an error in a batch application. The first option is for the
application to produce an exception when an error is encountered. This results in termination of the job
with a batch job return code of -12 and a batch job status of

Gestartab] e )

. The second option is for the application to return a
BatchConstants.STEP_COMPLETE_EXECUTION_FAILED return code (see the
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com.ibm.websphere.batch.BatchConstants API) from the processJobStep method and return an
application-specific error return code from the destroyJobStep method. This results in termination of the
job and a batch job status of

Cexecution failed )

. The step return code set in the destroyJobStep method is passed to any results algorithm specified on
the job step and is used to influence the return code of the job to indicate the specific cause of the failure.

Batch controller bean:

In its deployment descriptor, a batch application is required to declare a special stateless session bean.
This bean acts as a batch job controller.

Each application can include only a single controller bean. You can only include a controller bean in a
single work class, and a batch application can only have a single work class defined. This single work
class is created when the application is installed. You can associate this work class with any service policy
that has discretionary or queue-time goal type. The implementation of this bean is provided by WebSphere
Application Server, not by the batch application. The bean must be declared in the batch application
deployment descriptor. Only one controller bean per batch application can be defined. The resource
references and EJB references declared on the controller bean are available to batch data streams of the
batch application in which the controller bean is declared. For example, if a batch data stream in the
application needs access to a WebSphere Application Server data source, then a resource reference to
that data source can be declared on the controller bean, and the batch data stream can look up the data
source at run time in the java:comp/env name space.

Restrictions:

* The home interface must be com.ibm.ws.batch.BatchJobControllerHome.

* The remote interface must be com.ibm.ws.batch.BatchJobController.

* The EJB class must be com.ibm.ws.batch.BatchJobControllerBean.

* The transaction type can be bean or container.

* The session type must be stateless.

» There can be at most one batch controller stateless session bean per batch application.

The following example deployment descriptor illustrates a batch controller stateless session bean:

<session id="BatchController>
<ejb-name>BatchController</ejb-name>
<home>com. ibm.ws.batch.BatchJobControllerHome</home>
<remote>com.ibm.ws.batch.BatchJobController</remote>
<ejb-class>com.ibm.ws.batch.BatchJobControllerBean</ejb-class>
<session-type>Stateless</session-type>
<transaction-type>Bean</transaction-type>
<resource-ref id="ResourceRef_1117024737807">
<description></description>
<res-ref-name>wm/BatchWorkManager</res-ref-name>
<res-type>commonj.work.WorkManager</res-type>
<res-auth>Container</res-auth>
<res-sharing-scope>Shareable</res-sharing-scope>
</resource-ref>
</session>

Batch data streams:
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Batch data streams (BDS) are Java objects that provide an abstraction for the data stream processed by a
batch step. A batch step can have one or more BDS objects associated with it. The grid endpoints make
the BDS associated with the batch step available at run time. The grid endpoints also manages the life
cycle of a BDS by invoking batch-specific callbacks.

A BDS object implements the com.ibm.websphere.batch.BatchDataStream interface. This interface is
server agnostic. The implementing object can retrieve data from any type of data source, for example, files
and databases. Call back methods on the BatchDataStream interface allow the grid endpoints to manage
the BDS at run time. One of the key features of a BDS is its capability to convey its current position in the
stream to the grid endpoints, and the capability to move itself to a given location in the data stream. This
feature allows the grid endpoints to record (in the grid endpoints database) how much data a batch step
has processed. This information is recorded on every checkpoint. Therefore, the grid endpoints can restart
a batch job from a recorded position in the data stream if the job is canceled or fails in a recoverable
manner.

The following main methods exist for the BatchDataStream interface. See the API for the
BatchDataStream interface for additional information.

+ void open(): Called by grid endpoints to open the BDS
» void close(): Called by grid endpoints to close the BDS

 void initialize(String ilogicalname, String ijobstepid): Called by grid endpoints to initialize the BDS and let
it know its logical name and batch step ID.

+ String externalizeCheckpointinformation(): Called by grid endpoints right before a checkpoint to record
the current cursor of the BDS

» void internalizeCheckpointinformation(String chkpointinfo(): Called by grid endpoints to inform the BDS
of the previously recorded cursor, chkpointinfo. Typically, the positionAtCurrentCheckpoint is called after
this call to move the BDS to this cursor.

» void positionAtCurrentCheckpoint(): Called by grid endpoints after calling
internalizeCheckpointinformation to move the BDS to the cursor indicated by the chkpointinfo passed in
through the internalizeCheckpointinformation call.

The BatchDataStream interface does not have methods for retrieving or writing data. There are no
getNextRecord and putNextRecord methods defined on the interface that a batch step calls to read or
write to the BDS object. Methods for passing data between the batch step and the BDS object are left up
to the implementation of the BDS object. Review the batch Samples that this product supports to see
examples of how to implement batch data streams.

Transaction environment
All methods of a BDS object are called in a global transaction. There is no guarantee that any
consecutive method calls made to a BDS object happen in the same transaction because the
transaction is owned by the grid endpoints, not the BDS object.

Checkpoint algorithms:

The grid endpoints use checkpoint algorithms to determine when to commit global transactions under
which batch steps are invoked. These algorithms are applied to a batch job through the XML Job Control
Language (xJCL) definition. Properties specified for checkpoint algorithms in xJCL allow for checkpoint
behavior, such as transaction timeouts and checkpoint intervals, to be customized for batch steps. The
product provides both a time-based checkpoint algorithm and a record-based algorithm, and defines a
service provider interface (SPI) for building additional custom checkpoint algorithms.

On each batch step iteration of the processJobStep method, the common batch container consults the
checkpoint algorithm applied to that step if it commits the global transaction or not. Call back methods on
the checkpoint algorithms allow the common batch container to inform the algorithm when a global
transaction is committed or started. This behavior enables the algorithm to tracks the global transaction life
cycle. On each iteration of the processJobStep method, the common batch container calls the
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ShouldCheckpointBeExecuted callback method on the algorithm to determine if the transaction is
committed. The algorithm controls the checkpoint interval through this method.

Review the batch API for the checkpoint algorithm SPI, located in the Information Center reference
section, for the checkpoint algorithm SPI that you can use to create custom checkpoint algorithms. The
class name is com.ibm.wsspi.batch.CheckpointPolicyAlgorithm.

The product supports two checkpoint algorithms: the time-based algorithm and the record based algorithm.
Both are explained in the following sections.

Time-based algorithm

The time-based checkpoint algorithm commits global transactions at a specified time interval. The following
example declares a time-based algorithm in xJCL:
<checkpoint-algorithm name="timebased">
<classname>com.ibm.wsspi.batch.checkpointalgorithms.timebased</classname>
<props>
<prop name="interval" value="15" />
<prop name="TransactionTimeOut" value="30" />
</props>
</checkpoint-algorithm>

The units of interval and TransactionTimeOut properties in the previous example are expressed in
seconds.

Record-based algorithm

The record-based checkpoint algorithm commits global transactions at a specified number of iterations of
the processJobStep method of batch step. Each call to the processJobStep method is treated as iterating
through one record. The processJobStep method can retrieve multiple records from a batch data stream
on each call. However, for this checkpoint algorithm one record is the equivalent one call to the
processJobStep method.

The following example declares a record-based algorithm in xJCL:

<checkpoint-algorithm name="recordbased">
<classname>com.ibm.wsspi.batch.checkpointalgorithms.recordbased</classname>
<props>
<prop name="recordcount" value="1000" />
<prop name="TransactionTimeOut" value="60" />
</props>
</checkpoint-algorithm>

The unit of the TransactionTimeOut property in the previous example is expressed in seconds.

If not specified in xJCL, the default transaction timeout is 60 seconds and the default record count is
10000.

Applying a checkpoint algorithm to a batch step

Checkpoint algorithms are applied to a batch job through xJCL. You can declare multiple checkpoint
algorithms in xJCL, and you can apply a different algorithm to each batch step. You can apply no more
than one checkpoint algorithm to a batch step.

The following example applies checkpoint algorithms in xJCL:
<job name="PostingsSampleEar">

<checkpoint-algorithm name="timebased">
<classname>com.ibm.wsspi.batch.checkpointalgorithms.timebased</classname>
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<props>
<prop name="interval" value="15" />
<prop name=" TransactionTimeQut" value="30" />
</props>
</checkpoint-algorithm>

<checkpoint-algorithm name="recordbased">
<classname>com.ibm.wsspi.batch.checkpointalgorithms.recordbased</classname>
<props>
<prop name="recordcount" value="1000" />
<prop name="TransactionTimeOut" value="60" />
</props>
</checkpoint-algorithm>

<job-step name="Stepl">
<checkpoint-algorithm-ref name="timebased" />
</job-step>

<job-step name="Step2">

<checkpoint-algorithm-ref name="recordbased" />
</job-step>
</job>

Results algorithms:
Results algorithms are an optional feature of the batch programming model.

A results algorithm allows for two types of actions to occur at the end of a batch step:

» To influence the return code of the batch job based on the return code of the batch step that just ended.
There are two types of return codes: The return code of an individual batch step and the return code of
the batch job to which the step belongs.

» To provide a place holder for triggers or actions to take based on various step return codes.

Results algorithms are applied to a batch job through XML Job Control Language (xJCL). These
algorithms are declared in xJCL and then applied to batch steps.

At the end of a batch step, the grid endpoints check the xJCL of the batch job to determine which results
algorithm to invoke. For each results algorithm specified, the grid endpoints pass to the algorithm the
return code of the batch step, which is the integer returned by the destroyJobStep method of the step, and
the current return code of the batch job in the grid endpoints database. The results algorithm can then act
based on the return codes passed in. The algorithm then passes a return code for the batch job back to
the grid endpoints, which is persisted to the grid endpoints database as the current return code of the
batch job. This return code can be the same as the return code that the grid endpoints passed to the
results algorithm initially, or the return code can be different, depending on logic coded into the results
algorithm. If a results algorithm is not specified on a batch step, the job return code is that of the results
algorithm from the previous step. If no results algorithms are specified, the job return code is zero (0).

A results algorithm system programming interface (SPI) is also provided, which you can use to write your
own algorithms and apply them to batch jobs.

The jobsum results algorithm

The jobsum results algorithm returns the highest return code of job steps to the grid endpoints. For
example, there are three steps in the job (step1, step2, step3) where the following conditions exist:

» step1 returned 5
» step2 returned 8

» step3 returned 2. The jobsum algorithm ensures that 8 is passed to the grid endpoints as the final
return code of the job.
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Example of applying a jobsum and custom results algorithm to steps
<job name="PostingSampleEar">

<results-algorithms>

<results-algorithm name="jobsum">
<classname>com.ibm.wsspi.resultsalgorithms.jobsum</classname>

</results-algorithm>

<results-algorithm name="custom_algorithm">
<classname>my_custom_algorithm</classname>

</results-algorithm>

</results-algorithms>

<job-step name="Stepl">

<results-ref name="jobsum">
</job-step>

<job-step name="Step2">

<results-ref name="custom_algorithm">
</job-step>

</job>

Using the batch data stream (BDS) framework
This topic shows you an example of how to use the batch data stream (BDS) framework.

Before you begin
Identify the correct pattern to use. Select a pattern based on what type of data stream you need. For

example, if you want to read text from a file, then select the FileReaderPattern. See[‘Batch data stream|
framework and patterns” on page 45| for a selection of patterns.

Procedure
1. Implement the pattern interface:
<codebTock>package com.ibm.websphere.samples;

import java.io.BufferedReader;
import java.io.IOException;
import java.util.Properties;

import com.ibm.websphere.batch.devframework.configuration.BDSFWLogger;
import com.ibm.websphere.batch.devframework.datastreams.patternadapter.FileReaderPattern;

// Implement the FileReaderPattern

public class TransactionListStream implements FileReaderPattern {
private Properties properties;

private BDSFWLogger Togger;

[x*
Save properties specified in the xJCL
*/

public void initialize(Properties props) {
// create logger
logger = new BDSFWLogger(props);

if (Togger.isDebugEnabled())

logger.debug("entering TransactionListInputStream.initialize()");
properties = props;
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// This method is where you should add the business logic of processing the read //string
public Object fetchRecord(BufferedReader reader) throws IOException {

String str = null;

Posting posting = null;

if (logger.isDebugEnabled())
logger.debug ("Entering TransactionListInputStream.fetchRecord");

if(reader.ready()) {

str = reader.readlLine();

}
if(str !'= null) {
posting = _generateRecord(str);

}

if (logger.isDebugEnabled())
logger.debug ("Exiting TransactionListInputStream.fetchRecord with " + posting);
return posting;

}

// Helper method that parses the read string and creates an internal object for use
// by other parts of the code
private Posting _generateRecord(String str) {

Posting post = null;

String [] tokens = str.split(",", 3);

if(tokens.length == 3) {

String txTypeStr = tokens[0];
String actNoStr = tokens[1];
String amtStr = tokens[2];

int txType = Integer.parselnt(txTypeStr);
double amt = Double.parseDouble(amtStr);
post = new Posting(txType,actNoStr,amt);

} else {
logger.error("Invalid csv string" + str);

if(logger.isDebugEnabled())
logger.debug("Loaded posting record " + post);
return post;

}

public void processHeader(BufferedReader reader) throws IOException {
// NO OP for this sample

</codeblock>
2. Reference the class that you created in the previous step, along with the supporting class in the xJCL.

xJCL example

<codebTock><batch-data-streams>
<bds>
<logical-name>txlististream</logical-name>
<props>
<prop name="IMPLCLASS" value= "com.ibm.websphere.samples.TransactionListStream"/>
<prop name="FILENAME" value="/opt/inputfile.txt"/>
<prop name="debug" value="true"/>
</props>
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<impl-class> com.ibm.websphere.batch.devframework.datastreams.patterns.TextFileReader </impl-class>
</bds>
</batch-data-streams>

</codeblock>
What to do next

Install the application.

Batch data stream framework and patterns

The batch environment provides a batch data stream (BDS) framework that includes pre-built code to work
with streams such as text, byte, database, and data sets. You can implement an interface where the
business logic for processing the stream is added. The pre-built code manages actions such as opening,
closing, and externalizing and internalizing checkpoints.

BDS framework patterns

A BDS framework pattern is a simple Java TM interface for a particular type of data stream that a user
implements to insert business logic. The BDS framework has several supporting classes for each pattern
that do most of the mundane tasks related to stream management. The following table shows the patterns
that the batch environment provides:

Table 5. BDS framework patterns. The table includes the pattern name, description, and supporting classes.

Pattern name Description Supporting classes

[*JDBCReaderPattern” on page 46| Us_ed to retrieve data f_rom a database |. | ocalJDBCReader
using a JDBC connection.
- JDBCReader

¢ CursorHoldableJDBCReader

[‘'JDBCWriterPattern” on page 48| U;ed to write data to a database « LocalJDBCWriter
using a JDBC connection. . JDBCWriter

[‘ByteReaderPattern” on page 50| Used to read byte data from a file. FileByteReader
|‘ByteWriterPattern” on page 51| Used to write byte data from a file. FileByteWriter
|‘FileReaderPattern” on page 53] Used to read a text file. TextFileReader
[“FileWriterPattern” on page 54 Used to write to a text file. TextFileWriter

Used to read a z/OS data set. + ZFileStreamOrientedTextReader

» ZFileStreamOrientedByteReader
» ZFileRecordOrientedDataReader

Used to write to a z/OS data set. + ZFileStreamOrientedTextWriter
e ZFileStreamOrientedByteWriter
» ZFileRecordOrientedDataReader

[‘'JPAReaderPattern” on page 55 Used to retrieve data from a database | JPAReader
using OpenJPA

|‘JPAWriterPattern” on page 57| Used to write data to a database JPAWriter
using a Java Persistence API (JPA)
connection.

BDS framework steps

BDS framework steps minimize the amount of work to create a batch step by performing the bookkeeping
tasks related to step management and delegating the business logic to a class implemented by the user.
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Table 6. BDS framework steps. The table includes the framework step and description.

Step Description

[“lmplementing the generic batch step| A simple step that uses one input and one output stream.

|(GenericXDBatchStep)” on page 61|

[“Implementing the error tolerant step” on page 62 A simple step that uses one input, one output stream, and
one error stream.

ThresholdPolicies
Table 7. ThresholdPolicies. The table includes the step and description.

Step Description

[‘Declaring the record based threshold policy| This policy provides a batch implementation of the
|(RecordBasedThresholdPolicy)” on page 64] ThresholdPolicy interface.

|“Declaring the percentage-based threshold policy| This policy provides a batch implementation of the
|(PercentageBasedThresholdPolicy)” on page 64| ThresholdPolicy interface
JDBCReaderPattern:

This pattern is used to retrieve data from a database using a Java Database Connectivity (JDBC)
connection.

Supporting classes

1. CursorHoldableJDBCReader
This class is referenced when the usage pattern of your JDBC input stream retrieves a set of results at
the beginning of the step, and then iterates over them throughout the step-processing logic. The
CursorHoldableJDBCReader uses a stateful session bean with a cursor holdable, non-XA data source.
A cursor holdable JDBCReader is a pattern that is implemented in such a way that the cursor is not
lost when the transaction is committed. As a result, ResultSets do not need to be repopulated after
every checkpoint, which improves performance. To use CursorHoldableJDBCReader, package the
CursorHoldableSessionBean in your application. To create the package, add the
nonxadsjndiname=jndi_name_of a_non-XA_data_source_to_database property to the properties file that
is used by the BatchPackager. For example, nonxadsjndiname=jdbc/nonxads. If you want to add
multiple non-XA data sources enter the following: nonxadsjndiname=<jndi namel>;<jndi name2>...

Restriction: Currently, the resource reference name of the JDBC data source is the same as the Java
Naming and Directory Interface (JNDI) name.

2. JDBCReader

This class is referenced when the usage pattern of your JDBC input stream retrieves a single result
from a query, which is used and discarded after every iteration of the step.

3. LocalJDBCReader
This class is referenced when data is read from a local database.

Required properties

The following properties are required for the pattern.

Table 8. Required properties. The table includes each required property, its value, and whether the
LocalJDBCReader class, the CursorHoldableJDBCReader class, or the JDBCReader class is applicable.

Property Value LocalJDBCReader | CursorHoldableJDBCReader | JDBCReader

PATTERN_IMPL_CLASS | Class implementing Applicable Applicable Applicable
JDBCReaderPattern interface

ds_jndi_name Datasource JNDI name. Applicable Not applicable Applicable
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Table 8. Required properties (continued). The table includes each required property, its value, and whether the
LocalJDBCReader class, the CursorHoldableJDBCReader class, or the JDBCReader class is applicable.

Property Value LocalJDBCReader | CursorHoldableJDBCReader | JDBCReader

jdbc_url The JDBC URL. For example, Applicable Not applicable Not applicable
jdbc:derby:C:\\mysampTe\\
CREDITREPORT.

jdbc_driver The JDBC driver. For example, Applicable Not applicable Not applicable
org.apache.derby.jdbc.EmbeddedDriver

userid The user ID for the database. For Applicable Not applicable Not applicable
example, Myid

pswd User password. For example, mypwd. Applicable Not applicable Not applicable
LocalJDBCReader only.

Optional properties

The following properties are optional for the pattern.

Table 9. Optional properties. The table includes each optional property, its value and description, and whether the
LocalUDBCReader class, the CursorHoldableJDBCReader class, or the JDBCReader class is applicable.

Property name Value Description LocalJDBCReader | CursorHoldableJDCReader | JDBCReader
debug true or Enables detailed Applicable Applicable Applicable
false tracing on this batch
(default is | datastream.
false)
EnablePerformanceMeasurement true or Calculates the total Applicable Applicable Applicable
false time spent in the
(default is | batch data-streams
false) and the
processRecord
method, if you are
using the
GenericXDBatchStep.
EnableDetailedPerformanceMeasurement | true or Provides a more Applicable Applicable Applicable
false detailed breakdown
(default is | of time spent in each
false) method of the batch
data-streams.

Interface definition
public interface JDBCReaderPattern {

[**

* This method is invoked during the job setup phase.
*

* @param props properties provided in the xJCL

*/

public void initialize(Properties props);

[ x%

* This method should retrieve values for the various columns for the current row from the given resultset
* object. Typically this data would be used to populate an intermediate object which would be returned
* @param resultSet

* @return

*/

public Object fetchRecord(ResultSet resultSet);

[ x*

* This method should return a SQL query that will be used during setup of the stream to retrieve all
* relevant data that would be processed part of the job steps

* @return object to be used during process step.

*/

public String getInitiallLookupQuery();

[**
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* This method gets called during Job Restart. The restart token should be used to create an SQL query
* that will retrieve previously unprocessed records. Typically the restart token would be the primary
* key in the table and the query would get all rows with

* primary key value > restarttoken

* @param restartToken

* @return The restart query

*
/

public String getRestartQuery(String restartToken);

[**

* This method gets called just before a checkpoint is taken.

* @return The method should return a string value identifying the last record read by the stream.
*/

public String getRestartTokens();

CursorHoldableJDBCReader xJCL example

<batch-data-streams>

<bds>

<logical-name>inputStream</logical-name>

<props>

<prop name="PATTERN_IMPL CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoReader"/>
<prop name="ds_jndi_name" value="jdbc/fvtdb"/>

<prop name="debug" value="true"/>

<prop name="DEFAULT_APPLICATION_NAME" value="XDCGIVT"/>

</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.CursorHoldableJDBCReader</impl-class>
</bds>

</batch-data-streams>

LocalJDBCReader xJCL example

<batch-data-streams>

<bds>

<logical-name>inputStream</logical-name>

<props>

<prop name="PATTERN_IMPL_CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoReader"/>
<prop name="jdbc_url" value="jdbc:derby:C:\\mysample\\CREDITREPORT"/>

<prop name="jdbc_driver" value="org.apache.derby.jdbc.EmbeddedDriver"/>

<prop name="user_id" value="myuserid"/>

<prop name="pswd" value="mypswd"/>

<prop name="debug" value="true"/>

</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.LocalJDBCReader</impl-class>
</bds>

</batch-data-streams>

JDBCWriterPattern:
This pattern is used to write data to a database using a JDBC connection.

Supporting classes
1. JDBCWriter
2. LocaldJDBCWriter

Required properties

The following properties are required for the pattern.

Table 10. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value LocalJDBCWriter JDBCWriter

PATTERN_IMPL_CLASS Class implementing JDBCWriterPattern Applicable Applicable
interface

ds_jndi_name Datasource JNDI name. Applicable Not applicable
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Table 10. Required properties (continued). The table includes the name and value of each required property for the

pattern.

Property name Value LocalJDBCWriter JDBCWriter

jdbc_url The JDBC URL. For example, Applicable Not applicable
jdbc:derby:C:\\mysamp1e\\CREDITREPORT.

jdbc_driver The JDBC driver. For example, Applicable Not applicable
org.apache.derby.jdbc.EmbeddedDriver

user_id The user ID for the database. For Applicable Not applicable
example, Myid

pswd User password. For example, mypwd. Applicable Not applicable
LocalJDBCReader only.

Optional properties

The following properties are optional for the pattern.

Table 11. Optional properties.
pattern.

The table includes the name, value, and description of each optional property for the

Make the value less
than the checkpoint
interval for
record-based
checkpointing.

to batch before committing.

Property name Value Description LocalJDBCReader | JDBCWriter
debug true or false (default is | Enables detailed tracing on this batch | Applicable Applicable
false) datastream.
EnablePerformanceMeasurement true or false (default is | Calculates the total time spent in the | Applicable Applicable
false) batch data-streams and the
processRecord method, if you are
using the GenericXDBatchStep.
EnableDetailedPerformanceMeasurement | true or false (default is | Provides a more detailed breakdown | Applicable Applicable
false) of time spent in each method of the
batch data-streams.
batch_interval Default value is 20. Denotes the number of SQL updates | Applicable Applicable

Interface definition

public interface JDBCWriterPattern {

public void initialize(Properties props);

[**

* This is typically an Update query used to write data into the DB

* @return
*/
public String getSQLQuery();

[**

@param pstmt
@param record
@return

L

*/

The parent class BDSJDBCWriter creates a new preparedstatement and
passes it to this method. This method populates the preparedstatement
with appropriate values and returns it to the parent class for execution

public PreparedStatement writeRecord(PreparedStatement pstmt, Object record);

}

JDBCWriter xJCL example

<batch-data-streams>
<bds>

<logical-name>outputStream</logical-name>

<props>

<prop name="PATTERN_IMPL_CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoWriter"/>
<prop name="ds_jndi_name" value="jdbc/fvtdb"/>
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<prop name="debug" value="true"/>

</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.JDBCWriter</impl-class>
</bds>

</batch-data-streams>

LocalJDCBWriter xJCL example

<batch-data-streams>

<bds>

<logical-name>outputStream</logical-name>

<props>

<prop name="PATTERN_IMPL CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoWriter"/>
<prop name="jdbc_url" value="jdbc:derby:C:\\mysamp1e\\CREDITREPORT" />

<prop name="jdbc_driver" value="org.apache.derby.jdbc.EmbeddedDriver"/>

<prop name="user_id" value="myuserid"/>

<prop name="pswd" value="mypswd"/>

<prop name="debug" value="true"/>

</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.LocalJDBCWriter</impl-class>
</bds>

</batch-data-streams>

ByteReaderPattern:

This pattern is used to read byte data from a file.

Supporting classes

The FileByteReader class provides the logic for opening and reading byte data from the given file.
Required properties

The following properties are required for the pattern.

Table 12. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value
PATTERN_IMPL_CLASS Class implementing ByteReaderPattern interface
FILENAME Complete path to the input file

Optional properties

The following properties are optional for the pattern.

Table 13. Optional properties. The table includes the name, value, and description of each optional property for the

pattern.

Property name Value Description

debug true or false (default is false) Enables detailed tracing on this batch data
stream.

EnablePerformanceMeasurement true or false (default is false) Calculates the total time spent in the batch data
streams and the processRecord method, if you
are using the GenericXDBatchStep.

EnableDetailedPerformanceMeasurement true or false (default is false) Provides a more detailed breakdown of time
spent in each method of the batch data streams.

file.encoding Encoding of the file. For example, 8859_1

AppendJobldToFileName true or false (default is false) Appends the JobID to the file name before
loading the file.
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Interface definition

public interface ByteReaderPattern {

[**

* Is called by the framework during Step setup stage
* @param props

*/

public void initialize(Properties props);

[ x*

*

* @param reader

* @throws IOException

*/
public void processHeader(BufferedInputStream reader) throws IOException;

[**

* Get the next record from the input stream

* @param reader

* @return

* @throws IOException

*/

public Object fetchRecord(BufferedInputStream reader) throws IOException;
}

xJCL example

<batch-data-streams>

<bds>

<logical-name>inputStream</logical-name>

<props>

<prop name="PATTERN_IMPL_CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoReader"/>
<prop name="file.encoding" value="8859 1"/>

<prop name="FILENAME" value="/opt/txlist.txt" />

<prop name="debug" value="true"/>

</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.FileByteReader</impl-class>
</bds>

</batch-data-streams>

ByteWriterPattern:

This pattern is used to write byte data to a file.

Supporting classes

The FileByteWriter class provides the logic to open and write bytes to the given file. It can either append
or overwrite existing content, depending on the properties specified. During a restart, the file is always
opened in append mode.

Required properties

The following properties are required for the pattern.

Table 14. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value
PATTERN_IMPL_CLASS Class implementing ByteWriterPattern interface
FILENAME Complete path to the input file
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Optional properties

The following properties are optional for the pattern.

Table 15. Optional properties. The table includes the name, value, and description of each optional property for the

pattern.

Property name Value Description

debug true or false (default is false) Enables detailed tracing on this batch
datastream.

EnablePerformanceMeasurement true or false (default is false) Calculates the total time spent in the batch
data-streams and the processRecord method, if
you are using the GenericXDBatchStep.

EnableDetailedPerformanceMeasurement true or false (default is false) Provides a more detailed breakdown of time
spent in each method of the batch data-streams.

file.encoding Encoding of the file For example, 8859_1

AppendJobldToFileName true or false (default is false) Appends the JobID to the file name before
loading the file.

append true or false (default is true) Determines whether to open the file in append
mode.

Important: During a restart, the file is always
opened in append mode.

Interface definition
public interface ByteWriterPattern {

[**

* Invoked during the step setup phase
* @param props

*/

public void initialize(Properties props);

[x*

Writes the given object onto the given outputstream. Any processing
that needs to be done before writing can be added here

@param out

@param record

@throws IOException

* X ok ¥ %

*/
public void writeRecord(BufferedOutputStream out, Object record) throws IOException;

[**
* Write header information if any
* @param out
* Othrows IOException
*
/

public void writeHeader(BufferedOutputStream out) throws IOException;

[ x*
* This method can be optionally called during process step to explicity
* initialize and write the header.
* @param header
*/
public void writeHeader(BufferedOutputStream out, Object header) throws IOException;

}

xJCL example

<batch-data-streams>
<bds>
<logical-name>outputStream</logical-name>
<props>
<prop name="PATTERN_IMPL_CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoWriter"/>
<prop name="file.encoding" value="8859 1"/>
<prop name="FILENAME" value="/opt/txlist.txt" />
<prop name="debug" value="true"/>
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</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.FileByteWriter</impl-class>
</bds>

</batch-data-streams>

FileReaderPattern:

This pattern is used to read text data from a file.

Supporting classes

The TextFileReader class provides the logic to open and read text data line by line.
Required properties

The following properties are required for the pattern.

Table 16. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value
PATTERN_IMPL_CLASS Class implementing FileReaderPattern interface
FILENAME Complete path to the input file

Optional properties

The following properties are optional for the pattern.

Table 17. Optional properties. The table includes the name, value, and description of each optional property for the

pattern.

Property name Value Description

debug true or false (default is false) Enables detailed tracing on this batch
datastream.

EnablePerformanceMeasurement true or false (default is false) Calculates the total time spent in the batch
data-streams and the processRecord method, if
you are using the GenericXDBatchStep.

EnableDetailedPerformanceMeasurement true or false (default is false) Provides a more detailed breakdown of time
spent in each method of the batch data-streams.

file.encoding Encoding of the file. For example, 8859_1

AppendJobldToFileName true or false (default is false) Appends the JoblD to the file name before
loading the file.

Interface definition

public interface FileReaderPattern {

[**

* Invoked during the step setup phase

* @param props

*/

public void initialize(Properties props);

[ x%

* This method is invoked only once. It should be used
* to read any header data if necessary.

* @param reader

* @throws IOException

*/

public void processHeader(BufferedReader reader) throws IOException;

[ x*
* This method should read the next line from the reader
* and return the data in suitable form to be processed
* by the step.

* @param reader
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* @return

* @throws IOException

*/

public Object fetchRecord(BufferedReader reader) throws IOException;

[x*

* This method can be optionally invoked from the process step

* to obtain the header data that was previously obtained during the processHeader
* call

* @return

*/

public Object fetchHeader();

xJCL example

<batch-data-streams>
<bds>
<logical-name>inputStream</logical-name>
<props>
<prop name="PATTERN IMPL CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoReader"/>
<prop name="file.encoding" value="8859 1"/>
<prop name="FILENAME" value="/opt/txlist.txt" />
<prop name="debug" value="true"/>
</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.TextFileReader</impl-class>
</bds>
</batch-data-streams>

FileWriterPattern:

The FileWriterPattern pattern is used to write text data to a file.

Supporting classes

The TextFileWriter class provides the logic to open and write string data to the given file. The file is
opened either in append or overwrite mode, depending on the properties specified. The file is always
opened in append mode during a job restart.

Required properties

The following properties are required for the pattern.

Table 18. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value
PATTERN_IMPL_CLASS Class that implements the FileWriterPattern interface
FILENAME Complete path to the input file

Optional properties

The following properties are optional for the pattern.

Table 19. Optional properties. The table includes the name, value, and description of each optional property for the
pattern.

Property name Value Description

debug true or false (default is false) Enables detailed tracing on this batch
datastream.

EnablePerformanceMeasurement true or false (default is false) Calculates the total time spent in the batch

data-streams and the processRecord method, if
you are using the GenericXDBatchStep.

EnableDetailedPerformanceMeasurement true or false (default is false) Provides a more detailed breakdown of time
spent in each method of the batch data-streams.
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Table 19. Optional properties (continued). The table includes the name, value, and description of each optional
property for the pattern.

Property name Value Description

file.encoding Encoding of the file For example, 8859_1

AppendJobldToFileName true or false (default is false) Appends the JobID to the file name before
loading the file.

append true or false (default is true) Determines whether to open the file in append
mode.

Important: During a restart, the file is always
opened in append mode.

Interface definition

public interface FileWriterPattern {

[**

* Invoked during step setup phase
* @param props

*/

public void initialize(Properties props);

[**
* This method should write the given record
* object to the bufferedwriter.
* @param out
* @param record
* @throws IOException
*
/

public void writeRecord(BufferedWriter out, Object record) throws IOException;

[**
* This method is invoked only once just after the bufferedwriter
* is opened. It should be used to write any header information
* @param out
* Othrows IOException
*
/

public void writeHeader(BufferedWriter out) throws IOException;

[**
* This method can be optionally called during process step to explicity
* initialize and write the header.
* @param header
* @throws IOException
*
/

public void writeHeader(BufferedWriter out, Object header) throws IOException;

}

xJCL sample

<batch-data-streams>
<bds>
<logical-name>outputStream</logical-name>
<props>
<prop name="PATTERN_IMPL CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoWriter"/>
<prop name="file.encoding" value="8859 1"/>
<prop name="FILENAME" value="/opt/txlist.txt" />
<prop name="debug" value="true"/>
</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.TextFileWriter</impl-class>
</bds>
</batch-data-streams>

JPAReaderPattern:

This pattern is used to retrieve data from a database using OpenJPA.
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Supporting classes

The JPAReader class performs the tasks of obtaining an entity manager, running user provided queries,
and iterating over the results of the query. A persistence.xml file needs to be packaged with the user

application.

Required properties

The following properties are required for the pattern.

Table 20. Required properties. The table includes the name and value of each required property for the pattern.

Property name

Value

PATTERN_IMPL_CLASS

Class implementing JPAReader Pattern interface

PERSISTENT_UNIT

The OpendPA persistent unit name.

Optional properties

The following properties are optional for the pattern.

Table 21. Optional properties. The table includes the name, value, and description of each optional property for the

pattern.

Property name

Value

Description

debug

true or false (default is false)

Enables detailed tracing on this batch data
stream.

openjpa.Log

DefaultLevel=WARN,SQL=TRACE

JPA log settings

EnablePerformanceMeasurement

true or false (default is false)

Calculates the total time spent in the batch data
streams and the processRecord method, if you
are using the GenericXDBatchStep.

EnableDetailedPerformanceMeasurement

true or false (default is false)

Provides a more detailed breakdown of time
spent in each method of the batch data streams.

Interface definition
public interface JPAReaderPattern {

[**

* This method is invoked during the job setup phase.

*

* @param props properties provided in the xJCL

*/

public void initialize(Properties props);

[**

* This method should retrieve values for the various columns for the current row from
* the given Iterator object. Typically this data would be used to populate an intermediate

* object which would be returned.
* @param TistIt
* @return

*/

public Object fetchRecord(Iterator TistIt);

[**

* This method should return a JPQL query that will be used during setup of the stream to
* retrieve all relevant data that would be processed part of the job steps.
* @return object to be used during process step.

*/

public String getInitiallLookupQuery();

[**

* This method gets called during Job Restart. The restart token should be used to create
* a JPQL query that retrieves previously unprocessed records. Typically the restart token

* is the primary key in the table and the query would get all rows with

* primary key value > restarttoken

56 Developing WebSphere applications




* @param restartToken

* @return The restart query

*/

public String getRestartQuery(String restartToken);

[ x*

* This method gets called just before a checkpoint is taken.

* @return The method should return a string value identifying the last record read by the stream.
*/

public String getRestartTokens();

}

xJCL example

<batch-data-streams>

<bds>

<logical-name>inputStream</logical-name>

<props>

<prop name="PERSISTENT_UNIT" value="hellojpa"/>

<prop name="debug" value="true"/>

<prop name="PATTERN_IMPL CLASS" value="com.ibm.websphere.samples.JPAInputStream"/>
</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.JPAReader</impl-class>
</bds>

</batch-data-streams>

JPAWriterPattern:
This pattern is used to write data to a database using a Java Persistence API (JPA) connection.
Supporting classes

The JPAWriter class implements the basic JPA operations of obtaining an EntityManager class and joining,
beginning, and committing transactions. By default the JPAWriter joins an existing global transaction.

Package a persistence.xml file that sets the transaction-type attribute to JTA and declares a
jta-data-source element. Optionally configure the JPAWriter class to begin and commit transactions in
synchronization with the global transactions. These transactions are used with non-jta-data-source
elements and connection URLs. In this case the persistence.xml file sets the transaction-type to
RESOURCE_LOCAL and declare a non-jta-data-source element or connection URLs.

Required properties

The following properties are required for the pattern.

Table 22. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value

PATTERN_IMPL_CLASS Class implementing JPAWFriterPattern interface
PERSISTENT_UNIT The OpendPA persistent unit name

JPA properties that you set on the EntityManager class The value of these properties
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Optional properties

The following properties are optional for the pattern.

Table 23. Optional properties. The table includes the name, value, and description of each optional property for the
pattern.

Property name Value Description

debug true or false (The default is false.) Enables detailed tracing on this batch data
stream.

use_JTA_transactions true or false (The default is true.) If you use the non-jta-data-source element
or connection URLs, set the value to
false.

EnablePerformanceMeasurement true or false (The default is false.) Calculates the total time spent in the batch
data-streams and the processRecord
method, if you are using the
GenericXDBatchStep.

Interface definition
public interface JPAWriterPattern {

[**

* This method is invoked during create job step to allow the JPAWriter stream to
* initialize.

* @param props Properties passed via xJCL

*/

public void initialize(Properties props);

[**

* This method is invoked to actually persist the passed object to the database
* using JPA EntityManager

* @param manager

* @param record

*/

public void writeRecord(EntityManager manager, Object record);

}

xJCL example

<batch-data-streams>

<bds>

<logical-name>outputStream</logical-name>

<props>

<prop name="PATTERN_IMPL_CLASS" value="com.ibm.websphere.batch.samples.tests.bds.EchoWriter"/>
<prop name="PERSISTENT UNIT" value="mypersistentU"/>

<prop name="debug" value="true"/>

</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.JPAWriter</impl-class>
</bds>

</batch-data-streams>

PureQueryWriterPattern:

Use this pattern to write data to a database using IBM Optim™ pureQuery Runtime. The batch data stream
(BDS) framework completes the administrative tasks of opening and closing connections.

Supporting classes

The PureQueryWriter class implements the basic operations of opening and closing database connections,
obtaining the PureQuery data interface, and batching operations.
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Required properties

The following properties are required for the pattern.

The table includes the name and value of each required property for the pattern.

Table 24. Required properties.

Property name

Value

PATTERN_IMPL_CLASS

Class implementing PureQueryWriterPattern interface

PQ_DATA_BEAN_INTERFACE

PureQuery data bean interface

ds_jndi_name

Java Naming and Directory Interface (JNDI) name of the data source to access the database

Optional properties

The following properties are optional for the pattern.

Table 25. Optional properties. The table includes the name, value, and description of each optional property for the

pattern.

Property name

Value

Description

debug

true or false (The default is false.)

Enables detailed tracing on this batch data
stream.

DB_SCHEMA

null

Database schema name

EnablePerformanceMeasurement

true or false (The default is false.)

Calculates the total time spent in the batch
data-streams and the processRecord method, if
you are using the GenericXDBatchStep

force_connection_recycle

false

Forces the connection to be closed and
reopened during checkpoint processing

Batch_interval

20

Number of operations to batch

Interface definition

The PureQueryWriterPattern Interface definition shows the methods that you must implement to support
the PureQueryWriterPattern interface.

public interface PureQueryWriterPattern {

public void initialize(Properties props);

[**

* The parent class passes the record to be written, the data interface, or the data interface

* user method in order to update the database. The application might use the data interface to
* run the pureQuery API method for in-line style or the data interface method for annotation style.
* The parent class passes the record to be written and the
* Data interface that may be used by the application to execute the pureQuery API method
* (for in-Tine style ) or the Data interface user method ( for annotation style ) in order

* to update the database.
* @param

* @param record

* @return

*/

public void writeRecord(Data datalnterface, Object record);

}

xJCL example

The example shows xJCL that you can use to define a batch data stream which implements the
PureQueryWriterPattern interface in your application.

<batch-data-streams>
<bds>

<logical-name>outputStream</logical-name>

<props>

<prop name="PATTERN-IMPL-CLASS" value="com.ibm.MyWriterPattern"/>

<prop name="jdbc_url" value="jdbc:derby:C:\\mysampTe\\CREDITREPORT" />
<prop name="jdbc_driver" value="org.apache.derby.jdbc.EmbeddedDriver"/>
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<prop name="user_id" value="myid"/>

<prop name="pswd" value="mypwd"/>

<prop name="debug" value="true"/>

<prop name="DB_SCHEMA" value="PQDS"/>

<prop name="PQ_DATA BEAN_INTERFACE" value="com.ibm..MyEmployeeData"/>

</props>
<imp1-class>com.ibm.websphere.batch.devframework.datastreams.patterns.PureQueryWriter</impl-class>

</bds>
</batch-data-streams>

PureQueryReaderPattern:

Use this pattern is used to read data from a database using IBM Optim pureQuery Runtime. The batch
data stream (BDS) framework completes the administrative tasks of opening and closing connections.

Supporting classes

The PureQueryReader class implements the basic operations of opening and closing database
connections and obtaining the IBM Optim pureQuery Runtime data.

Required properties

The following properties are required for the pattern.

Table 26. Required properties. The table includes the name and value of each required property for the pattern.

Property name Value

PATTERN_IMPL_CLASS Class implementing PureQueryReaderPattern interface

PQ_DATA_BEAN_INTERFACE PureQuery data bean interface

ds_jndi_name Java Naming and Directory Interface (JNDI) name of the data source to access the database

Optional properties

The following properties are optional for the pattern.

Table 27. Optional properties. The table includes the name, value, and description of each optional property for the

pattern.

Property name Value Description

debug true or false (The default is false.) Enables detailed tracing on this batch data
stream

DB_SCHEMA null Database schema name

EnablePerformanceMeasurement true or false (The default is false.) Calculates the total time spent in the batch
data-streams and the processRecord method, if
you are using the GenericXDBatchStep

Interface definition

The PureQueryReaderPattern Interface definition shows the methods that you must implement to support
the PureQueryReaderPattern interface.
public interface PureQueryReaderPattern

{

[x%
* This method is called by the batch container during step setup. The properties passed

* in are the ones that you provide in the xJCL BDS level properties.
* @param properties
*/

public void initialize(Properties properties);

[**
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* Invoked by the container during each iteration of the batch loop. This code obtains
* the next record using the given iterator object.

* @param iterator

* @return

*/

public Object fetchRecord(Iterator iterator);

/%

* Returns the iterator based on the passed data object that is used to iterate
* over the records

* @param data

* @return

*/

public Iterator getInitiallterator(Data data);

[**

* Returns the iterator based on the passed data object repositioned based on the restart
* token of restartToken.

* @param data

* @param s

* @return

*/

public Iterator getRestartIterator(Data data, String restartToken);

[**

* Invoked before a checkpoint is taken to save the restart token that is used in case
* of a restart

* @return

*/

public String getRestartTokens();

xJCL example

The example shows xJCL that you can use to define a batch datastream which implements the
PureQueryReaderPattern interface in your application.
<batch-data-streams>
<bds>
<logical-name>outputStream</logical-name>
<props>
<prop name="IMPLCLASS" value="com.ibm.MyWriterPattern"/>
<prop name="ds_jndi_name" value="jdbc/crreport"/>
<prop name="debug" value="true"/>
<prop name="DB_SCHEMA" value="PQDS"/>
<prop name="PQ_DATA BEAN_INTERFACE" value="com.ibm.MyEmployeeData"/>
</props>
<impl-class>com.ibm.websphere.batch.devframework.datastreams.patterns.PureQueryReader</impl-class>
</bds></batch-data-streams>

Implementing the generic batch step (GenericXDBatchStep)

A generic batch step works with one input and one output stream. This step during each iteration of the
batch loop reads a single entry from the BDS Input Stream passes it to the BatchRecordProcessor for
processing. The BatchRecordProcessor returns the processed data which is then passed to the BDS
output stream.

About this task

Use the following properties to implement the generic batch step.

Table 28. Required properties. The table includes the property name, property value, and property description.
Property name Value Description

BATCHRECORDPROCESSOR Java class name Class implementing the
BatchRecordProcessor interface
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Table 29. Optional properties. The table includes the property name, property value, and property description.

Property Value Description
debug true or false (default is false) Enable tracing and debugging on
the step
EnablePerformanceMeasurement true or false (default is false)
Measure time spent within the step

Procedure

1. Implement the
interfacecom.ibm.websphere.batch.devframework.steps.technologyadapters.BatchRecordProcessor to
provide the business logic for the step. In the xJCL for the step, declare a property
BATCHRECORDPROCESSOR with the value set to the implementation of the interface. For example:
<props>

<prop name="BATCHRECORDPROCESSOR"

value="com.ibm.websphere.batch.samples.tests.steps.InfrastructureVerificationTest"/>
</props>

2. Set the BDS input stream logical name to inputStream and a BDS output stream logical name to
outputStream. The logical names are declared in the xJCL. For example:

<batch-data-streams>
<bds>
<logical-name>inputStream</logical-name>
<props>

</bds>
<bds>
<logical-name>outputStream</logical-name>
<props>

"</bds>
</batch-data-streams>
3. While using the BatchPackager for packaging, the application for the job step class, jobstepclass, must
be set to com.ibm.websphere.batch.devframework.steps.technologyadapters.GenericXDBatchStep. For
example:

ejbname.1=IVTStepl
jndiname.l=ejb/GenericXDBatchStep
jobstepclass.l=com.ibm.websphere.batch.devframework.steps.technologyadapters.GenericXDBatchStep

Implementing the error tolerant step

An error tolerant generic batch step works with one input, one output stream, and one error stream. This
step during each iteration of the batch loop reads a single entry from the batch data stream (BDS) input
stream and passes it to the BatchRecordProcessor property for processing.

Before you begin

The BatchRecordProcessor property might either return a valid data object or a null value in a tolerable
error. If the returned value is null, the record read from the input stream is logged on to the error stream
and the invalidRecordEncountered method is invoked on the ThresholdPolicy interface. The threshold
policy determines whether the error tolerance threshold has been reached. If so, it returns
STEP_CONTINUE_FORCE_CHECKPOINT_BEFORE_PROCESSING_CANCEL, which forces a
checkpoint and puts the job in the restartable state. Otherwise, the job continues as normal. If the data
returned by BatchRecordProcessor.processRecord is valid, then the data is passed to the BDS output
stream.
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About this task

Use the following properties to implement the error tolerant step.

Table 30. Required properties. The table includes the property name, value, and description.

Property name Value Description

threshold_policy Java class name Class implementing the
com.ibm.websphere.batch.devframework.thresholdpolicies. ThresholdPolicy
interface

BATCHRECORDPROCESSOR Java class name Class implementing the BatchRecordProcessor interface

Table 31. Optional properties. The table includes the property name, value, and description.

Property Value Description

debug true or false (default is false) Enable tracing and debugging on the step

EnablePerformanceMeasurement

true or false (default is false) Measure time spent within the step

Procedure

1.

Implement the

interfacecom. ibm.websphere.batch.devframework.steps.technologyadapters.BatchRecordProcessor to
provide the business logic for the step. In the xJCL for the step, declare a property
BATCHRECORDPROCESSOR with the value set to the implementation of the interface. For example:
<props>

<prop name="BATCHRECORDPROCESSOR"

value="com.ibm.websphere.batch.samples.tests.steps.InfrastructureVerificationTest"/>
</props>

Implement the interface com.ibm.websphere.batch.devframework.thresholdpolicies.ThresholdPolicy to
provide the threshold policy for the step. You can also use the product implementations such as
com.ibm.websphere.batch.devframework.thresholdpolicies.PercentageBasedThresholdPolicy or
com.ibm.websphere.batch.devframework.thresholdpolicies.RecordBasedThresholdPolicy. Declare the
ThresholdPolicy to use in the xJCL as shown in the following code snippet:
<props>

<prop name="threshold_policy"

value="com.ibm.websphere.batch.devframework.thresholdpolicies.PercentageBasedThresholdPolicy"/>
</props>

Set the BDS input stream logical name to inputStream and a BDS output stream logical name to
outputStream and the BDS output stream for errors to errorStream. The logical names are declared in
the xJCL. For example:
<batch-data-streams>

<bds>

<logical-name>inputStream</logical-name>
<props>

</bds>
<bds>
<logical-name>outputStream</logical-name>
<props>

</bds>

<bds>
<logical-name>errorStream</logical-name>
<props>

</bds>
</batch-data-streams>
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4. While using the BatchPackager for packaging, the application for the job step class, jobstepclass, must
be set to com.ibm.websphere.batch.devframework.steps.technologyadapters. ThresholdBatchStep. For

example:

ejbname.1=IVTStepl
jndiname.1l=ejb/MyThresholdBatchStep
jobstepclass.l=com.ibm.websphere.batch.devframework.steps.technologyadapters.ThresholdBatchStep

Declaring the percentage-based threshold policy
(PercentageBasedThresholdPolicy)
This policy provides a batch implementation of the ThresholdPolicy interface.

Before you begin
The percentageBasedThresholdPolicy is applicable only if the ThresholdBatchStep is used. It calculates

the percentage of the number of error records processed to the total number processed. If the result is
greater than the threshold, it forces the job to go into restartable state.

About this task

Optionally use the following properties when you declare the percentage-based threshold policy.

Table 32. Optional properties. The table includes the property name, property value, and property description.

Property Value Description
debug true or false (default is false) Enable tracing and debugging on the step
minimum_threshold_sample_size
Integer value (default is 20) The minimum number of records to process before
checking for threshold breach.
threshold_threshold Double value (default is 0.1) The acceptable percentage of errors.
Procedure

Declare the threshold policy to use in the xJCL as a property of the step as follows:

<props>
<prop name="threshold_poTlicy"
value="com.ibm.websphere.batch.devframework.thresholdpolicies.PercentageBasedThresholdPolicy"/>

</props>

Declaring the record based threshold policy (RecordBasedThresholdPolicy)
This policy provides a batch implementation of the ThresholdPolicy interface.

Before you begin

The record based threshold policy of RecordBasedThresholdPolicy is applicable only if the threshold batch
step of ThresholdBatchStep is used. It counts the number of error records processed. If the result is
greater than the threshold, it forces the job to go into restartable state.

About this task

Optionally use the following properties when you declare the record based threshold policy.

Table 33. Optional properties. The table includes the property name, property value, and property description.
Property Value Description

debug true or false (default is false) Enable tracing and debugging on the step

minimum_threshold_size
Integer value (default is 20) The minimum number of records to process before
checking for threshold breach.
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Table 33. Optional properties (continued). The table includes the property name, property value, and property
description.

Property Value Description
error_threshold Double value (default is 100) The number of error records.
Procedure

Declare the threshold policy to use in the xJCL as a property of the step as follows:

<props>
<prop name="threshold_poTlicy"
value="com.ibm.websphere.batch.devframework.thresholdpolicies.RecordBasedThresholdPolicy"/>

</props>

Deploying batch applications

This section covers such areas as packaging Enterprise JavaBeans (EJB) 3.0 modules and installing
batch applications.

Packaging EJB 3.0 modules in a batch application using Rational

Application Developer
Use Rational Application Developer 8.0.1 or later to package Enterprise JavaBeans (EJB) 3.0 modules.

Before you begin
Develop a batch application.

Procedure
1. Import your batch application EAR file into Rational Application Developer. Click File > Import.
a. Select Java EE - EAR file. Click Next.
Enter the location of your EAR file in the EAR file field.
Set the Target run time to a WebSphere Application Server Version 8 run time.
Clear everything on the EAR Module and Utility JAR Projects page (third page).
. Click Finish.
2. Link in your EJB 3.0 JAR file.
Right-click on the newly created EAR project.
Select Properties > Java EE Module Dependencies
Click Add External JARs....
Select your EJB3 JAR file.
. Click OK.
3. Export your EAR file.
a. Right-click on the EAR project.
b. Click Export > EAR file.
c. Enter a value in the Destination field.
d. Click Finish.

®ooC

©® a0 op

Installing the batch application

Now you can install the batch application itself. The batch application is installed exactly like Java
Platform, Enterprise Edition (Java EE) transactional applications.
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Before you begin

Develop a compute-intensive application or a transactional batch application. You can develop a compute
intensive application using a compute-intensive job controller, the command line, or the Apache ANT tool.
You can develop a transactional batch application using a batch job controller and Enterprise JavaBeans
(EJB) data stream, the command line, or the ANT tool.

About this task

When mapping modules of the batch application to servers, select the server or cluster that you created
previously for the enterprise bean modules that contain the logic for a batch job.

Procedure
See the topic on installing applications for details on how to install your batch application.
What to do next

Configure the job scheduler and submit batch jobs using the job scheduler.

Submitting batch jobs

You can submit batch applications using the job scheduler Enterprise JavaBeans (EJB) interface or the job
scheduler web services interface.

xJCL elements

Jobs are expressed using an Extensible Markup Language XML dialect called xJCL (XML Job Control
Language). This dialect has constructs for expressing all of the information needed for both
compute-intensive and batch jobs, although some elements of xJCL are only applicable to
compute-intensive or batch jobs. See the xJCL provided with the Sample applications, the xJCL table, and
xJCL XSD schema document for more information about xJCL. The xJCL definition of a job is not part of
the batch application, but is constructed separately and submitted to the job scheduler for to run. The job
scheduler uses information in the xJCL to determine where and when to run the job.

xJCL elements

The following table summarizes the xJCL elements.

Table 34. xJCL elements. The table includes xJCL elements, whether each xJCL element applies to
compute-intensive or batch jobs, and subelements, attributes, and descriptions for each xJCL element.

Java
Platform,
Enterprise
Edition (Java
EE) Compute- | Java EE

Element intensive Batch Subelement Attributes Description

job Y Y Scopes the description of a batch
job.

job Y Y name Name of the job. This name must
match the name of the batch
application

job Y Y accounting Optional accounting information
attribute.

job Y Y class Optional job class attribute, which

identifies the job class under
which the job runs.
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Table 34. xJCL elements (continued). The table includes xJCL elements, whether each xJCL element applies to
compute-intensive or batch jobs, and subelements, attributes, and descriptions for each xJCL element.

Element

Java
Platform,
Enterprise
Edition (Java
EE) Compute-
intensive

Java EE
Batch

Subelement

Attributes

Description

job

Y

Y

default-application-name

The application name to be used
when no job step
application-name attribute is
found.

job

jndi-name

JNDI name that is given to the
job controller stateless session
bean when the batch application
is deployed into WebSphere
Application Server.

job

job-scheduling criteria

required-capability

The required-capability of the job,
which must be defined on an
endpoint for the job to be
dispatched to that endpoint.

job

step-scheduling
criteria

See step-scheduling-criteria
element

job

checkpoint algorithm

See checkpoint-algorithm
element

job

results-algorithm

See results-algorithms element

job

substitution-props++

See prop element

The required-capability of the job,
which must be defined on an
endpoint for the job to be
dispatched to that endpoint

job-step

v

name

Optional name of the step. This
information is returned on
operational commands.

job-step

v

application-name

Optional name of the application
run by the step. The attribute
name is used if application-name
is omitted and the job level
attribute default-application-name
is omitted.

job-step

step-scheduling

See step-scheduling element

Allows for conditional logic based
on return codes of steps that
determines whether the batch
step is invoked.

job-step

classname

Fully-qualified name of class that
implements the compute intensive
job.

job-step

checkpoint-algorithm-
ref

Specifies the checkpoint algorithm
to use for the batch job step.

job-step

results-ref

See results-ref element

Specifies the results algorithm to
use for the conditional batch job
step execution.

job-step

batch-data-streams

See batch-data-streams
element

A sequence of bds elements.
Each bds is the configuration
information necessary to create a
batch data stream.

job-step

props

See props element

Name-value properties to pass to
the step.

job-step

exec

See exec element

Identifies the executable
associated with the job step.

job-step

env-entries

See env-entries element

Identifies the environmental
properties associated with the job
step.

prop

Single instance of a name value
pair, that serves as a property.

prop

name

Name of the property.

prop

value

Value of the property.
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Table 34. xJCL elements (continued). The table includes xJCL elements, whether each xJCL element applies to
compute-intensive or batch jobs, and subelements, attributes, and descriptions for each xJCL element.

Element

Java
Platform,
Enterprise
Edition (Java
EE) Compute-
intensive

Java EE
Batch

Subelement

Attributes

Description

props

Y

Y

prop

See prop element

env-entries

N

N

Series of prop elements that are
used to pass name-value pair
properties to steps, bds,
checkpoint algorithms, and results
algorithms.

env-entries

env-var

See env-var element

exec

Series of prop elements that are
used to pass name-value pair
properties to steps, bds,
checkpoint algorithms, and results
algorithms.

exec

executable

The name of the executable
associated with the job step.

exec

arg

See line element

line

Command-line arguments passed
to the job step executable.

bds

Single instance of a batch data
stream implementation made
available to the batch job.

bds

logical-name

A string that is embedded in
batch step, which uses it to query
the batch runtime environment for
a specific batch data stream
instance.

bds

impl-class

Fully- qualified class name of the
batch data stream implementation
class.

bds

props

See props elements

List of properties that are passed
to the batch data stream
implementation class.

batch-data-streams

Series of bds elements

batch-data-streams

bds

See bds element

step-scheduling

Applies to job-steps to create
return code-based conditional
flows for a batch job. Compares
values of return codes defined for
this batch job to decide whether a
step is invoked or not while
processing a batch job. The
values of return codes are
compared using the
returncode-expression element.

step-scheduling

returncode-
expression

see returncode-expression

Returncode- expression to
evaluate.

step-scheduling

condition

If there is more than one
returncode-expression element in
the step-scheduling element,
conditional operators are applied
to them. Conditional operators
supported are: AND, OR.

returncode-expression

Used under step-scheduling tags
to decide whether a batch job
step runs based on return codes
of other job steps.

returncode-expression

step

Name of step whose return code
is to be compared in this
expression.
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Table 34. xJCL elements (continued). The table includes xJCL elements, whether each xJCL element applies to
compute-intensive or batch jobs, and subelements, attributes, and descriptions for each xJCL element.

Element

Java
Platform,
Enterprise
Edition (Java
EE) Compute-
intensive

Java EE
Batch

Subelement

Attributes

Description

returncode-expression

N

Y

operator

Operator to use for the return
code expression. The supported
operators are eq for equals, It for
less than, gt for greater than, le
for less than or equal to, and ge
for greater than or equal to.

returncode-expression

value

The value with which to compare
the return code.

step-scheduling-criteria

Describes the sequence in which
the job steps are processed.
Currently sequential scheduling is
supported; for example, steps get
invoked in the order in which they
exist in xJCL.

step-scheduling-criteria

scheduling-mode

Sequence in which to invoke
steps, only possible value is
sequential right now.

checkpoint-algorithm

Declares a checkpoint algorithm
that can be used for a batch job
step.

checkpoint-algorithm

name

Name of algorithm.

checkpoint-algorithm

classname

Class that implements this
algorithm.

checkpoint-algorithm

props

See props element

Sequence of prop elements for
the checkpoint algorithm.

checkpoint-algorithm-ref

Reference to a checkpoint
algorithm element.

checkpoint-algorithm-ref

name

Name of checkpoint algorithm to
which you are referring.

checkpoint-algorithm-ref

props

See props element.

Sequence of prop elements for
the checkpoint algorithm.

++ The xJCL element substitution-props is discussed in the following section.

xJCL substitution-props

The job xJCL can contain symbolic variables. A symbolic variable is an expression of the form
${variable-name}, which is found outside a comment in an otherwise well-formed document. For example:

<checkpoint-algorithm-ref name="$§{checkpoint}" />

The xJCL element, substitution-props, defines a default name and value pairs for symbolic variables.
Following is an example of the substitution-props element, taken from the postingSampleXJCL.xml

document:

<substitution-props>

<prop name="wsbatch.count" value="5" />

<prop name="checkpoint" value="timebased" />

<prop name="checkpointInterval" value="15" />
<prop name="postingsDataStream" value="§{was.install.root}${file.separator}temp§{file.separator}postings" />

</substitution-props>

Substitution for symbolic variables occurs at run time. At run time, the string ${variable-name} is replaced
with the value of the property when the xJCL is submitted for execution. Using the properties in the
previous example, the string ${checkpoint} is replaced with the string time-based before the job is

submitted.
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Symbolic variables can be indirect. For example: name=FILENAME value=${${filename}} used with the
name/value pair filename=postingsDataStream yields the same result as specifying name=FILENAME
value=${postingsDataStream}.

Symbolic variables can also be compound. For example, name=postingsDataStream
value=${was.install.root}${file.separator}temp${file.separator}postings.

The name/value pairs do not have to be defined in the job document substitution-props element. The
props name and value pairs defined in the substitution-props element are default values for the named
variables. If not defined in the substitution-props element, name/value pairs must be either passed in via
the job scheduler APIs when the job is submitted or defined in the system properties for the JVM. Every
symbolic variable defined in the body of a job document must be resolved for the xJCL to be considered
valid. Every name/value pair defined in the job document must resolve to a symbolic variable which is
found in the body of the xJCL for the xJCL to be considered valid.

If name/value pairs are both defined in the xJCL document and passed to the job scheduler APIs at job
submission time, the name/value pairs passed via the Job Scheduler APIs override the default values
defined in the xJCL document. If name/value pairs are neither passed in via the job scheduler APIs nor
defined as defaults in the xJCL document, name/value pairs for the symbolic variables must be defined in
the system JVM properties for the xJCL to be considered valid.

Symbolic variables are resolved by the job scheduler before job submission, except for the following
special variables, which are resolved at the grid endpoint. The following special variables all must be
defined as JVM system properties. They are:

* ${was.install.root}
+ ${user.install.root}
+ ${agent.home}

The batch job state table

As the job scheduler and grid endpoint process a grid batch job, the job state updates in the job scheduler
database. The diagram shows the relationship between states, and the following table lists the possible
batch job states and the events that trigger transitions between states. You can view the current state of a
batch job from the job management console, or retrieve it using the command line or Enterprise
JavaBeans (EJB) interface. If a failure occurs before a batch step initializes, then the batch job goes into
execution failed state. Otherwise, it goes into restartable state.
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Table 35. Batch job states. The table includes each batch start state with its client command, system action, special
condition, return code, and end state.
Start State Client Command | SystemAction Special Condition Numeric return codes End State
non-existent (delayed submit n/a Not applicable pending submit
submit)
non-existent submit n/a Not applicable submitted
submitted n/a dispatch Not applicable 0 executing
submitted cancel n/a Not applicable 0 restartable
executing stop n/a Not applicable 0 restartable
executing cancel n/a Not applicable 4 cancel_pending
executing n/a caught Not applicable 4 restartable

application error*
executing n/a n/a Infrastructure problem** 4 restartable/unknown
executing suspend n/a Not applicable 4 suspend_pending
executing n/a job completed Not applicable 4 ended
executing n/a n/a Infrastructure problem in job | 4 restartable

setup™*

suspend_pending n/a checkpoint Not applicable suspended
suspend_pending n/a n/a Infrastructure problem** restartable/unknown
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Table 35. Batch job states (continued). The table includes each batch start state with its client command, system
action, special condition, return code, and end state.

Start State Client Command | SystemAction Special Condition Numeric return codes End State
suspended resume n/a n/a 5 resume_pending
suspended cancel n/a n/a 5 cancel_pending
suspended Not applicable n/a Infrastructure problem** 5 restartable/unknown
resume_pending Not applicable job resumed Not applicable 2 executing
resume_pending Not applicable Not applicable Infrastructure problem** 2 restartable/unknown
restartable restart Not applicable Not applicable 8 submitted
cancel_pending Not applicable job canceled Not applicable 1 restartable
cancel_pending Not applicable Not applicable Infrastructure problem** 1 restartable/unknown
restartable purge Not applicable Not applicable 8 non-existent
execution_failed purge Not applicable Not applicable 9 non-existent

ended purge Not applicable Not applicable 7 non-existent

Table 36. Notes for the batch job states table.

The table includes each note with a description.

Note

Description

* Application error

The batch application failed at run time. The grid endpoints detected this failure.

** Infrastructure problem

An unexpected error has occurred. See the following example for infrastructure problem in job setup.

setup

*** Infrastructure problem in job

An unexpected error that occurs when a batch job is set up for the first time by the grid endpoints. For example, if
there is an unexpected database failure, the job goes into execution_failed state.

In this condition, the batch job is run for the first time and no steps are processed yet. Batch jobs go into the
restartable state under most failure conditions so that they can restart from checkpointed positions if the failure
condition can be overcome. However, in this instance of a failure condition, a batch job goes into execution_failed
state and cannot be restarted. Since this situation is a job setup scenario and work is not yet processed by the
batch job, batch work is not lost as a result of failure.

If jobs are in a non-final state on the endpoint, the scheduler puts the jobs into an unknown state under two
conditions. The conditions are that the endpoint loses communications or the endpoint goes down. If the endpoint
comes back up, the scheduler synchronizes the job status with the endpoint. If the endpoint goes down, all batch
jobs are put into a restartable state and all compute- intensive jobs in an execution failed state. If the endpoint
has only lost communication with the scheduler and the jobs continue to run, the scheduler updates its status.
The status update is the final state of the jobs running on the endpoint at that point.

Submitting batch jobs using the job scheduler EJB interface

The job scheduler Enterprise JavaBeans (EJB) interface is used to programmatically submit and
manipulate a batch job. You can use the EJB interface with the base scheduler in WebSphere Application
Server to perform calendar-based submission of a batch job.

Before you begin

The job scheduler supports programmatic access to its functions over both an EJB interface for Java
Platform, Enterprise Edition (Java EE) applications and a web services interface for both Java EE and
non-Java EE applications. The EJB interface for the job scheduler is described by the interfaces found in
the API documentation. Consult this documentation for further information.

Develop and install your batch applications.

About this task

This topic describes how to submit a batch job to the job scheduler using the base scheduler in
WebSphere Application Server. It includes a code example that demonstrates how to invoke the job

scheduler EJB.
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Procedure

1. Create and configure a scheduler. Read about how to create and configure a scheduler in the topic on
developing and scheduling tasks.

2. Create a scheduler task for submitting batch work.

This scheduler task invokes the job scheduler EJB to submit a batch job. Read the instructions for
creating a task that invokes an EJB in the topic on developing a task that calls a session bean. This
topic also includes instructions for using the calendaring feature of the WebSphere scheduler. The
following example demonstrates on how to invoke the job scheduler EJB:

// These are the import statements needed by the task
import javax.naming.=;

import com.ibm.websphere.Tongrun.JobScheduler;
import com.ibm.websphere.longrun.JobSchedulerHome

private JobSchedulerHome zjsHome = null;
private JobScheduler zjs = null;

public void process(TaskStatus task) ()
try{

//Ensure that the xJCL can be placed in a string, for example, by reading an xJCL
//File into a string
String xJCL = <xJCL as a string>;

//0Obtain cell-level naming context
InitialContext ctxt = new InitialContext();
Hashtable env = new Hashtable();

env.put (Context.INITIAL_CONTEXT_FACTORY,
"com.ibm.websphere.naming.WsnInitialContextFactory");

env.put (Context.PROVIDER URL,"corbaloc:rir:/NameServiceCellRoot");
ctxt = new InitialContext(env);

//To ook up the LRS EJB from the cell context in the namespace,

//The name context to the application server or cluster to which the LRS
//Application is deployed has to be provided

//Eg: "nodes/myNode/servers/myServer" or "clusters/myCluster".

String longRunningContext = <long_running_context>;

zjsHome = (JobSchedulerHome) ctxt.lookup(longRunningContext +
"/ejb/com/ibm/websphere/longrun/JobSchedulerHome") ;

zjs = zjsHome.create();

zjs.submitdob( xJCL );

}catch (Exception e) {
System.out.printin(e.getMessage());

3. Run the program to submit batch work.
Read the topic on submitting a task to a scheduler.

The job scheduler EJB interfaces
The job scheduler Enterprise JavaBeans (EJB) interface is used to programmatically submit a batch job to
the job scheduler and manipulate the job.

The following code is the remote interface to the job scheduler EJB. The code produces application
programming interfaces.
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Some code is split on multiple lines for printing purposes.

~
*
*

This is the remote interface for the Job Scheduler EJB.

Clients of this interface can programmatically submit and manipulate

jobs to the Job Scheduler. Code similar to the following can be used to Tookup and invoke
the remote Job Scheduler EJB interface:

<p>

InitialContext ctxt = new InitialContext(); <br>
Hashtable env = new Hashtable(); <br>

env.put (Context.INITIAL_CONTEXT_FACTORY,
"com.ibm.websphere.naming.WsnInitialContextFactory"); <br>

env.put (Context.PROVIDER URL,
"corbaloc:iiop:<schedulerHostName>:<schedulerBootstrapPort>/NameServiceCellRoot"); <br>
ctxt = new InitialContext(env); <br>

// In order to lookup the Job Scheduler EJB from the cell context in the namespace, <br>
// the name context to the application server or cluster to which the Job Scheduler <br>
// application is deployed has to be provided. <br>

// Eg: "nodes/myNode/servers/myServer" or "clusters/myCluster". <br> <br>

String jobSchedulerContext = clusters/myCluster; <br> <br>

JobSchedulerHome zjsHome = (JobSchedulerHome)
PortableRemoteObject.narrow(ctxt.lookup(jobSchedulerContext +
"/ejb/com/ibm/websphere/Tongrun/JobSchedulerHome"),JobSchedulerHome.class); <br>

JobScheduler js = zjsHome.create(); <br>

E R N B R T R I R I R T I I I R R I . I I

@ibm-api
*/
public interface JobScheduler extends javax.ejb.EJBObject {

[*%

Note: The following code is not supported.

Submits the specified job, saved in the xJCL repository, to the job scheduler
@param job The name of the job that was stored to the xJCL repository
@return the job ID assigned by the job scheduler to the submitted job

@throws InvalidJobNameException if job is not found in the xJCL repository.
@throws SchedulerException if an unexpected error is thrown by the
job scheduler while submitting the job
@throws JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job
* @throws java.rmi.RemoteException

*

/
public String submitJobFromRepository( String job ) throws
InvalidJobNameException,
SchedulerException,
JCLException,
JobSubmissionException,
java.rmi.RemoteException;

* Ok X X Sk X X X X F

~
*
*

Submits the job, which is defined by the xJCL, to the job scheduler

@Gparam xJCL The xJCL for the job
@return the job ID assigned by the job scheduler to the submitted job

@throws SchedulerException if an unexpected error is thrown by the

job scheduler while submitting the job

@throws JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job

@throws java.rmi.RemoteException

* % X X 2k X X X X X %

*
~
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pub

/%

*

X% ok Xk 3k X F 3k X X 2k X X X X X 2k X X %

*/
pub

[**
*
*
*
*
*
*
*
*
*

*/
pub

~
*
*

E I R T R

*/
pub

lic String submitJdob( String xJCL ) throws
SchedulerException,

JCLException,

JobSubmissionException,
java.rmi.RemoteException;

Note: The following code is not supported.

Submits the job specified by the xJCL passed in to the job scheduler and
saves the xJCL to the xJCL repository.

@param xJCL The xJCL for the job

@param job The name given to the saved job in the xJCL repository.

This name can be used when invoking the submitJobFromRepository

method.

@Gparam replace A boolean indicating if the xJCL in the repository should
be replaced, in case a job by that name already exists

in the xJCL repository.

@return the job ID assigned by the job scheduler to the submitted job

@throws InvalidOperationException if the job already exists in the xJCL repository
and the replace parameter specified is false

Othrows SchedulerException if an unexpected error is thrown by the job scheduler
while submitting the job

@throws JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job

@throws java.rmi.RemoteException

lic String saveJobToRepositoryAndSubmit( String xJCL, String job, boolean replace ) throws
InvalidOperationException,

SchedulerException,

JCLException,

JobSubmissionException,

java.rmi.RemoteException;

Purges the job, identified by the job ID, from the job scheduler and the grid endpoint
environments.

@throws InvalidJobIDException if no job by the specified job ID exists in the job scheduler
O@throws SchedulerException if an unexpected error is thrown by the job scheduler while
purging the job

@throws java.rmi.RemoteException

@param jobid The ID of the job to be purged

lic void purgedob( String jobid ) throws
InvalidJobIDException,
SchedulerException,
java.rmi.RemoteException;

Cancels the job identified by the job ID

Othrows InvalidOperationException if the operation is currently not allowed on the job
@throws InvalidJobIDException if no job by the specified job id exists in the

job scheduler

Othrows SchedulerException if an unexpected error is thrown by the job scheduler

while canceling the job

@throws java.rmi.RemoteException

@param jobid The ID of the job
lic void canceldob( String jobid ) throws
InvalidOperationException,

InvalidJobIDException,
SchedulerException,
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java.rmi.RemoteException;

[**
* Note: The following code is not supported.

Forcibly cancels the job identified by the job ID

Supported on z/0S only. The forcedCancelJob request will be processed as a
cancelJob request on distributed platforms.

@throws InvalidOperationException if the operation is currently not allowed on the job
@throws InvalidJobIDException if no job by the specified job ID exists in the

job scheduler

Othrows SchedulerException if an unexpected error is thrown by the job scheduler
while canceling the job

@throws java.rmi.RemoteException

E o R R R A N R

* @param jobid The ID of the job
*
/

public void forcedCancelJob( String jobid ) throws
InvalidOperationException,
InvalidJobIDException,
SchedulerException,
java.rmi.RemoteException;

/%

* Restarts the job identified by the job ID. Only jobs in the restartable state can be

* restarted.

*

* @throws InvalidJobIDException if no job by the specified job ID exists in the

* job scheduler

* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws SchedulerException if an unexpected error is thrown by the job scheduler while
* restarting the job

* @throws JCLException if the xJCL for the job is corrupted or not valid.

* @throws JobSubmissionException if an error occurs while submitting the job

* @throws java.rmi.RemoteException

*

* @param jobid The ID of the job
*
/

public void restartJob( String jobid ) throws
InvalidJobIDException,
InvalidOperationException,
SchedulerException,
JCLException,
JobSubmissionException,
java.rmi.RemoteException;

~
*
*

Returns the job status for the given job ID. Refer to {@link JobStatusConstants
JobStatusConstants} for a
list of the job status codes returned by this method.

@Gparam jobid The ID of the job

@throws InvalidJobIDException if no job by the specified job ID exists in the
job scheduler

@throws SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command

@throws java.rmi.RemoteException

R I R I R T I S

* @return the status of the job

*/

public int getJobStatus( String jobid ) throws
InvalidJobIDException,
SchedulerException,
java.rmi.RemoteException;

[**

* Returns the job output for a given job ID that displays the job's progress. This only
* applies to batch jobs.
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@param jobid The ID of the job

@throws InvalidJobIDException if no job by the specified job ID exists in the job scheduler
Othrows SchedulerException if an unexpected error is thrown by the job scheduler while
processing the command

Othrows java.rmi.RemoteException

E I T

@return the job output of the job

*/

public String getJobOutput( String jobid ) throws
InvalidJobIDException,

SchedulerException,

java.rmi.RemoteException;

Returns the job details for the given job ID.

*

*

* @throws InvalidJobIDException if no job by the specified job ID exists in the job scheduler
* @throws SchedulerException if an unexpected error is thrown by the job scheduler while

* processing the command

* @throws java.rmi.RemoteException

*
*

@return the details of the job such as job ID, status text, submitter and job type

public String getJobDetails(String jobid) throws
InvalidJobIDException,SchedulerException,java.rmi.RemoteException;

[**
* Note: The following code is not supported.

Saves the xJCL passed in to the xJCL Repository.

@Gparam xJCL The xJCL for the job

@Gparam job The name given to the saved job in the xJCL repository. This name can
be used when invoking the submitJobFromRepository

method.

Oparam replace A boolean indicating if the xJCL in the repository should be
replaced, in case a job by that name already exists

in the xJCL repository.

Othrows InvalidOperationException if the job already exists in the xJCL

repository and the replace parameter specified is false

@throws SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command

@throws JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws java.rmi.RemoteException

E o I R R R S R I

*
/
public void saveJobToRepository( String xJCL, String job, boolean replace ) throws
InvalidOperationException,
SchedulerException,
JCLException,
java.rmi.RemoteException;

[**

*

Note: The following code is not supported.
Returns the xJCL from the xJCL repository for the given job name.

@Gparam job The name given to the saved job in xJCL repository. This name can be used
when invoking the submitJobFromRepository
method.

@throws InvalidJobNameException if job is not found in the xJCL repository.
@throws SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command

@throws java.rmi.RemoteException

* %k X ok 3k X X X X X F

Chapter 4. Developing batch applications

77



*

*/

@return the xJCL for the given job

public String showJobFromRepository( String job ) throws

[ **

*

*
*
*
*
*
*
*
*

*/

InvalidJobNameException,
SchedulerException,
java.rmi.RemoteException;

Note: The following code is not supported.

Removes the xJCL for the specifed job from the xJCL repository

@param job The name given to the saved job in the xJCL repository.

Othrows InvalidJobNameException if the job is not found in the xJCL repository.
@throws SchedulerException if an unexpected error is thrown by the job scheduler

while processing the command
@throws java.rmi.RemoteException

public void removeJobFromRepository( String job ) throws

/%

*
*

* %k

* %k * X

*/

InvalidJobNameException,
SchedulerException,
java.rmi.RemoteException;

Shows all jobs in the job scheduler
@return the 1list of job IDs of all jobs in the job scheduler
Othrows SchedulerException if an unexpected error is thrown by the job scheduler

while processing the command
Othrows java.rmi.RemoteException

public String[] showAl1Jobs() throws

[**

* 0% kX 3k kX X X X X X % X

*/

SchedulerException,
java.rmi.RemoteException;

Suspends the specified job for the number of seconds specified. Once the time period
is up, the job automatically
resumes. This only applies to batch jobs.

@param jobid The ID of the job to suspend
@param seconds The number of seconds to suspend the job

@throws InvalidJobIDException if no job by the specified job ID exists in the job scheduler
Othrows InvalidOperationException if the operation is currently not allowed on the job
@throws SchedulerException if an unexpected error is thrown by the job scheduler

while suspending the job

@throws java.rmi.RemoteException

public void suspendJob( String jobid, String seconds ) throws

[**

*

*

* %k X X *

InvalidOperationException,
InvalidJobIDException,
SchedulerException,
java.rmi.RemoteException;

Resumes execution of the specified job. This only applies to batch jobs.
@Gparam jobid The ID of the job to resume

@throws InvalidJobIDException if no job by the specified job ID exists in the
job scheduler

Othrows InvalidOperationException if the operation is currently not allowed on the job
@throws SchedulerException if an unexpected error is thrown by the job
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* scheduler while resuming the job

* @throws java.rmi.RemoteException

*

*/

public void resumedob( String jobid ) throws
InvalidOperationException,
InvalidJobIDException,
SchedulerException,
java.rmi.RemoteException;

~
*
*

Returns the return code of the Batch job.

@param jobid The ID of the job
@return the return code of the Batch job

@throws InvalidJobIDException if no job by the specified job ID exists in the job scheduler
@throws InvalidOperationException if the operation is currently not allowed on the job
@throws SchedulerException if an unexpected error is thrown by the job scheduler

while processing the command

@throws java.rmi.RemoteException

E R I R R T I R

*/
public int getBatchJobRC(String jobid) throws InvalidOperationException,
InvalidJobIDException, SchedulerException, java.rmi.RemoteException;

[**
* Note: The following code is not supported.

Submits the job, which is defined by the xJCL, to the job scheduler at the specified
start time.

@Gparam xJCL The xJCL for the job
@Gparam startTime The time at which the job will be submitted. The format of the
submit time is yyyy-mm-dd hh:mm:ss.
@return the job ID assigned by the job scheduler to the submitted job
@throws SchedulerException if an unexpected error is thrown by the job scheduler
while submitting the job
@throws JCLException if the xJCL for the job is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job
Othrows InvalidStartDateTimeFormatException if the start date and/or time is
not in the required format
Othrows StaleTimeException if the start date and/or time is in the past based on
current time
* @throws java.rmi.RemoteException
*
/
public String submitDelayedJob( String xJCL, String startTime ) throws
SchedulerException,
JCLException,
JobSubmissionException,
InvalidStartDateTimeFormatException,
StaleTimeException,
java.rmi.RemoteException;

E R S R

[**
* Note: The following code is not supported.

Submits the job, saved in the xJCL repository, to the job scheduler at the specified
start time.

@Gparam job The name of the job that was stored to the job repository

@param startTime The time at which the job will be submitted. The format of the submit
time is yyyy-mm-dd hh:mm:ss.

@return the job ID assigned by the job scheduler to the submitted job

@throws InvalidJobNameException if job is not found in the xJCL repository.

Othrows SchedulerException if an unexpected error is thrown by the job scheduler

while submitting the job

@throws JCLException if the xJCL for the job is corrupted or not valid.

* %k X ok 3k X X X X X F
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* @throws JobSubmissionException if an error occurs while submitting the job
* @throws InvalidStartDateTimeFormatException if the start date and/or time is
* not in the required format
* @throws StaleTimeException if the start date and/or time is in the past based
* on current time
* @throws java.rmi.RemoteException
*
/
public String submitDelayedJobFromRepository( String job, String startTime ) throws
InvalidJobNameException,
SchedulerException,
JCLException,
JobSubmissionException,
InvalidStartDateTimeFormatException,
StaleTimeException,
java.rmi.RemoteException;

/%

* Note: The following code is not supported.

Submits the delayed job specified by the xJCL passed in to the job scheduler and
saves the xJCL to the xJCL repository.

@param xJCL The xJCL for the job

@Gparam startTime The time at which the job will be submitted. The format of the
submit time is yyyy-mm-dd hh:mm:ss.

@param job The name given to the saved job in the xJCL repository. This name can

be used when invoking the submitJobFromRepository

method.

@param replace A boolean indicating if the xJCL in the repository should be replaced,
in case a job by that name already exists

in the job repository.

@return the job ID assigned by the job scheduler to the submitted job

Othrows InvalidOperationException if the operation is currently not allowed on the job
@throws SchedulerException if an unexpected error is thrown by the job scheduler while
submitting the job

@throws JCLException if the xJCL for the job is corrupted or not valid.

@throws JobSubmissionException if an error occurs while submitting the job

@throws InvalidStartDateTimeFormatException if the start date and/or time is not in
the required format

Othrows StaleTimeException if the start date and/or time is in the past based on
current time

@throws java.rmi.RemoteException

E S R I S . R R

*
/
public String saveDelayedJobToRepositoryAndSubmit( String xJCL, String job, boolean
replace, String startTime ) throws
InvalidOperationException,
SchedulerException,
JCLException,
JobSubmissionException,
InvalidStartDateTimeFormatException,
StaleTimeException,
java.rmi.RemoteException;

[**
* Note: The following code is not supported.

* Creates a job schedule to submit the job, defined by the xJCL, at the specified time and
* interval.
*
* @param reqld The name of the recurring job request
* @param xJCL The xJCL for the job
* @param startTime The time at which the first job will be submitted. The format of the
*submit time is yyyy-mm-dd hh:mm:ss.
* @param interval The time interval between jobs (For example daily, weekly, monthly)
*
* Othrows InvalidOperationException if the operation is currently not allowed on the job
* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while submitting the job
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@throws JCLException if the xJCL for the job is corrupted or not valid.
@throws InvalidStartDateTimeFormatException if the start date and/or time is not
in the required format
Othrows StaleTimeException if the start date and/or time is in the past
based on current time
@throws InvalidIntervalException if the interval specified is not one of the
* supported time interval
* @throws java.rmi.RemoteException
*
/
public void submitRecurringRequest( String reqld, String xJCL, String startTime,
String interval ) throws
InvalidOperationException,
SchedulerException,
JCLException,
InvalidStartDateTimeFormatException,
InvalidIntervalException,
StaleTimeException,
java.rmi.RemoteException;

* %k X X Ok X

[**
* Note: The following code is not supported.

* Creates a job schedule to submit the specified job, saved in the xJCL repository, at the
* specified time and interval.

@param jobName The name of the job that was stored to the job repository

@param reqld The name of the recurring job request

@param startTime The time at which the job will be submitted. The format of the
* submit time is yyyy-mm-dd hh:mm:ss..
% @param interval The time interval between jobs (For example daily, weekly, monthly)
*
* Othrows InvalidOperationException if the operation is currently not allowed on the job

* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while submitting the job
Othrows JCLException if the xJCL for the job is corrupted or not valid.
@throws InvalidStartDateTimeFormatException if the start date and/or time is not
in the required format
@throws StaleTimeException if the start date and/or time is in the
past based on current time
@throws InvalidIntervalException if the interval specified is not one of the supported
* time interval
* Othrows InvalidJobNameException if job is not found in the xJCL repository.
* @throws java.rmi.RemoteException

*

/
pubTic void submitRecurringRequestFromRepository

(String jobName, String reqld, String startTime,
String interval) throws

InvalidOperationException,

SchedulerException,

JCLException,

InvalidStartDateTimeFormatException,

InvalidIntervalException,

StaleTimeException,

InvalidJobNameException,

java.rmi.RemoteException;

* % %

* % 3k X X %

[**
* Note: The following code is not supported.

Cancel an existing job schedule

@param reqld The name of the job schedule
@throws InvalidOperationException if the operation is currently not allowed on the job
@throws SchedulerException if an unexpected error is thrown by the job scheduler while
* canceling the job
* @throws java.rmi.RemoteException
*
/
public void cancelRecurringRequest( String reqld ) throws
InvalidOperationException,
SchedulerException,

* % X %k %
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java.rmi.RemoteException;

[**

* Returns details of an existing job schedule.

*

* @param reqld The name of the job schedule to be returned

* @return information about the schedule such as schedule name, job name, start time and
* interval

* @throws SchedulerException if an unexpected error is thrown by the job scheduler while
* processing the command

* @throws InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException

*
/

public String getRecurringRequestDetails(String reqld) throws

SchedulerException,

InvalidOperationException,

java.rmi.RemoteException;

[**
* * Note: The following code is not supported.

Modify an existing job schedule.

@param reqld The name of the job schedule to be modified
@param xJCL The xJCL for the job
@param startTime The time at which the first job will be submitted. The format of the
* submit time is yyyy-mm-dd hh:mm:ss.
% @param interval The time interval between jobs (For example daily, weekly, monthly)
* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while processing the command
* @throws JCLException if the xJCL for the job is corrupted or not valid.

* ok ok Ok O

* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws InvalidStartDateTimeFormatException if the start date and/or time is not in the
* required format
% @throws StaleTimeException if the start date and/or time is in the past based on
* current time
* @throws InvalidIntervalException if the interval specified is not one of the supported
* time interval
* @throws java.rmi.RemoteException

*

/

public void modifyRecurringRequest(String reqld, String xJCL, String startTime,
String interval) throws

SchedulerException,

JCLException,

InvalidOperationException,

InvalidStartDateTimeFormatException,

StaleTimeException,

InvalidIntervalException,

java.rmi.RemoteException;

[**

* Note: The following code is not supported.

Lists all existing job schedules

L

@return a Tist of all job schedules currently in the system
@throws SchedulerException if an unexpected error is thrown by the job scheduler while
* processing the command
* @throws java.rmi.RemoteException
*
/
public String[] showAllRecurringRequests() throws
SchedulerException,
java.rmi.RemoteException;

[**
Show all jobs in the specified job schedule

@param reqld the name of the job schedule
@return the Tist of job IDs of jobs in the specified job schedule

L
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* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while processing the command
* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws java.rmi.RemoteException
*
/
public String[] showRecurringJobs(String reqld) throws
SchedulerException,
InvalidOperationException,
java.rmi.RemoteException;

[**
Returns job status in XML format for the given job IDs.

@param jobid List of job IDs

*
*
*
*
* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while processing the command
* @throws java.rmi.RemoteException
*
* @return Job status such as job ID, return code, status code and status text in XML format
*
/
public String getJobsStatus(String[] jobid) throws
SchedulerException,
java.rmi.RemoteException;

~
*
*

Returns a list of job IDs that match the specified criteria. ATl conditions must apply
for a match to occur.

@param jobFilter SQL filter value to apply to the job ID (For example Postings% )
@param submitterFilter SQL filter value to apply to the submitter

Oparam nodeFilter SQL filter value to apply to the names of the nodes where the
jobs executed (For example node_ )

Oparam appServerFilter SQL filter value to apply to the names of the application
servers where the jobs executed

Oparam stateFilter List of job states. Refer to {@link JobStatusConstants
JobStatusConstants} for a

list of the possible job states.

@param sortBy - Field used to sort results (For example JOBID, STATUS, APPSERVER)
@param ascending - flag indicating whether the results should be returned in
ascending or descending order

of the sortBy field.

@return the Tist of job IDs that match the specified criteria

O@throws SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command
* @throws java.rmi.RemoteException
*
/
public String[] getJobsId(String jobFilter, String submitterFilter,
String nodeFilter, String appServerFilter, Integer[] stateFilter, String sortBy,
boolean ascending) throws
SchedulerException,
java.rmi.RemoteException;

* 5% kX ok 3k X Sk 3k X X 3k X X X X X X X X F

[**

* Cancels the jobs identified by the 1list of job IDs

*

* @throws SchedulerException if an unexpected error is thrown by the job scheduler

* while canceling the job

* @throws java.rmi.RemoteException

*

* @param jobid The list of job IDs to cancel

* @return List of return codes. Refer to {@1ink JobSchedulerConstants JobSchedulerConstants}

* for a Tist of the possible return codes.

*/

public int[] cancelJob( String[] jobid ) throws
SchedulerException,
java.rmi.RemoteException;

[**

* Purges the jobs, identified by the Tist of job IDs, from the job scheduler and the
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* grid endpoint environments.

*

* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while purging the job

* @throws java.rmi.RemoteException

*

* @param jobid The list of job IDs to purge

* @return List of return codes. Refer to

* {@1ink JobSchedulerConstants JobSchedulerConstants} for a list of the possible
* return codes.

*/

public int[] purgedob( String[] jobid ) throws

SchedulerException,

java.rmi.RemoteException;

[**

* Restarts the jobs identified by the 1ist of job IDs. Only jobs in the
restartable state can be restarted.

*

*

* @throws SchedulerException if an unexpected error is thrown by the
* job scheduler while restarting the job

* @throws java.rmi.RemoteException
*
*
*
*

@param jobid The list of job IDs to restart
@return List of return codes. Refer to {@link JobSchedulerConstants
JobSchedulerConstants} for a Tist of the possible return codes.
*
/
public int[] restartJob( String[] jobid ) throws
SchedulerException,
java.rmi.RemoteException;

[**

* Resumes execution of the jobs identified by the Tist of job IDs. This only
* applies to batch jobs.

*

* @param jobid The Tist of job IDs to resume

* @return List of return codes. Refer to {@1ink JobSchedulerConstants

% JobSchedulerConstants} for a list of the possible return codes.

*

*

@throws SchedulerException if an unexpected error is thrown by the job
* scheduler while resuming the job

* @throws java.rmi.RemoteException

*

*/

public int[] resumedob( String[] jobid ) throws

SchedulerException,

java.rmi.RemoteException;

[**

* Suspends the specified jobs for the number of seconds specified. Once the
* time period is up, the jobs automatically

* resume. This only applies to batch jobs.

*

* @param jobid The ID of the job to suspend

* @param seconds The number of seconds to suspend the job

* @return List of return codes. Refer to {@1ink JobSchedulerConstants

% JobSchedulerConstants} for a list of the possible return codes.

*

* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws SchedulerException if an unexpected error is thrown by the

* job scheduler while suspending the job

* @throws java.rmi.RemoteException

*

x/

public int[] suspendJob( String[] jobid, String seconds ) throws
SchedulerException,

InvalidOperationException,
java.rmi.RemoteException;

[**
* Note: The following code is not supported.

* Submits the specified job, saved in the xJCL repository, and any name/value pairs
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*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*

*/

specified to the job scheduler at the specified
start time.

@param job  The name of the job that was stored to the xJCL repository

@param startTime The time at which the job will be submitted. The format of the submit
time is yyyy-mm-dd hh:mm:ss.

@Gparam nameValuePairs The space delimited name=value pairs which are used to

modify the xJCL For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded with an
encoding scheme of UTF-8 before being passed in on the request.

@return the job ID assigned by the job scheduler to the submitted job

Othrows InvalidJobNameException if the job is not found in the xJCL repository.
@throws SchedulerException if an unexpected error is thrown by the job scheduler
while submitting the job

Othrows JCLException if the xJCL for the job is corrupted or not valid.

@throws JobSubmissionException if an error occurs while submitting the job
@throws InvalidStartDateTimeFormatException if the start date and/or time is not
in the required format

Othrows StaleTimeException if the start date and/or time is in the past

based on current time

@throws java.rmi.RemoteException

public String submitModifiableDelayedJobFromRepository( String job, String startTime,

String nameValuePairs )

throws InvalidJobNameException, SchedulerException, JCLException, JobSubmissionException,

[**

*

E o TR R I R R S R . N

*
~

InvalidStartDateTimeFormatException, StaleTimeException, java.rmi.RemoteException;

Note: The following code is not supported.

Submits the job, which is defined by the xJCL and any name/value pairs specified, to
the job scheduler at the specified
start time.

@Gparam xJCL The xJCL for the job

@param startTime The time at which the job will be submitted. The format of the
submit time is yyyy-mm-dd hh:mm:ss.

@param nameValuePairs The space delimited name=value pairs which are used to
modify the xJCL For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded with

an encoding scheme of UTF-8 before being passed in on the request.

@return the job ID assigned by the job scheduler to the submitted job

@throws SchedulerException if an unexpected error is thrown by the job
scheduler while submitting the job

@throws JCLException if the xJCL for the job is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job
Othrows InvalidStartDateTimeFormatException if the start date and/or time is
not in the required format

@throws StaleTimeException if the start date and/or time is in the past
based on current time

@throws java.rmi.RemoteException

public String submitModifiableDelayedJob
( String xJCL, String startTime, String nameValuePairs )
throws SchedulerException, JCLException, JobSubmissionException,

InvalidStartDateTimeFormatException, StaleTimeException, java.rmi.RemoteException;

[**

*

*
*
*
*
*
*

Note: The following code is not supported.

Submits the delayed job, which is defined by the xJCL and any name/value pairs
specified, to the job scheduler and

saves the xJCL to the xJCL repository.

@param xJCL The xJCL for the job
@param startTime The time at which the job will be submitted. The format of the
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submit time is yyyy-mm-dd hh:mm:ss.

@param job  The name given to the saved job in the xJCL repository. This name
can be used when invoking the submitJobFromRepository

method.

@param replace A boolean indicating if the xJCL in the repository should be
replaced, in case a job by that name already exists

in the job repository.

@Gparam nameValuePairs The space delimited name=value pairs which are used
to modify the xJCL For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded
with an encoding scheme of UTF-8 before being passed in on the request.

@return the job ID assigned by the job scheduler to the submitted job

@throws InvalidOperationException if the operation is currently not allowed on the job
Othrows SchedulerException if an unexpected error is thrown by the job scheduler

while submitting the job

@throws JCLException if the xJCL for the job is corrupted or not valid.

@throws JobSubmissionException if an error occurs while submitting the job

@throws InvalidStartDateTimeFormatException if the start date and/or time is

not in the required format

Othrows StaleTimeException if the start date and/or time is in the past based

on current time

@throws java.rmi.RemoteException

F 0% ok k% 3k X X 3k 3k F Sk X X % X X X X X X X X %

*
~

public String saveModifiableDelayedJobToRepositoryAndSubmit
( String xJCL, String job, boolean replace, String startTime, String nameValuePairs )
throws InvalidOperationException, SchedulerException, JCLException, JobSubmissionException,
InvalidStartDateTimeFormatException, StaleTimeException, java.rmi.RemoteException;

[**
* Note: The following code is not supported.

Creates a job schedule to submit jobs at the specified time interval. The jobs
are defined by the xJCL and any name/value pairs specified.

@Gparam reqld The name of the job schedule

@Gparam xJCL The xJCL for the job

@param startTime The time at which the job will be submitted. The format of

the submit time is yyyy-mm-dd hh:mm:ss.

@param interval The time interval between jobs (For example daily, weekly, monthly)
Oparam nameValuePairs The space delimited name=value pairs which are used to
modify the xJCL For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded

with an encoding scheme of UTF-8 before being passed in on the request.

@throws InvalidOperationException if the operation is currently not
allowed on the job

@throws SchedulerException if an unexpected error is thrown by the

job scheduler while submitting the job

@throws JCLException if the xJCL for the job is corrupted or not valid.
@throws InvalidStartDateTimeFormatException if the start date and/or time
is not in the required format

Othrows StaleTimeException if the start date and/or time is in the past
based on current time

@throws InvalidIntervalException if the interval specified is not one of
the supported time interval

@throws java.rmi.RemoteException

¥ 0% ok X 3k 3k X X 3k X F 3k X 3k 3k X X X X F F X X X X

*
~

public void submitModifiableRecurringRequest
( String reqld, String xJCL, String startTime, String interval, String nameValuePairs )
throws InvalidOperationException, SchedulerException, JCLException,
InvalidStartDateTimeFormatException,

InvalidIntervalException, StaleTimeException, java.rmi.RemoteException;

[**
* Note: The following code is not supported.

* Creates a job schedule to submit jobs at the specified time interval. The jobs
* are defined by the xJCL stored in the xJCL repository
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*
~

and any name/value pairs specified.

@param jobName The name of the job that was stored to the job repository

Oparam reqld The name of the recurring job request

@param startTime The time at which the job will be submitted. The format of

the submit time is yyyy-mm-dd hh:mm:ss.

@param interval The time interval between jobs (For example daily, weekly, monthly)
@Gparam nameValuePairs The space delimited name=value pairs which are used to
modify the xJCL For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded with

an encoding scheme of UTF-8 before being passed in on the request.

@throws InvalidOperationException if the operation is currently not allowed on the job
@throws SchedulerException if an unexpected error is thrown by the job scheduler
while submitting the job

Othrows JCLException if the xJCL for the job is corrupted or not valid.

Othrows InvalidStartDateTimeFormatException if the start date and/or time is not
in the required format

@throws StaleTimeException if the start date and/or time is in the past

based on current time

@throws InvalidIntervalException if the interval specified is not one of the
supported time interval

@throws InvalidJobNameException if job is not found in the xJCL repository.
@throws java.rmi.RemoteException

public void submitModifiableRecurringRequestFromRepository(String jobName, String
reqld, String startTime, String interval, String nameValuePairs )

throws InvalidOperationException, SchedulerException, JCLException,
InvalidStartDateTimeFormatException,

[**

*

L I S R R R S R . I R N

*
~

InvalidIntervalException, StaleTimeException, InvalidJobNameException,
java.rmi.RemoteException;

Note: The following code is not supported.

Submits the job, which is defined by the xJCL and any name/value pairs
specified, to the job scheduler and
saves the xJCL to the xJCL repository.

@param xJCL The xJCL for the job

@param job The name given to the saved job in xJCL repository. This name
can be used when invoking the submitJobFromRepository

method.

@Gparam replace A boolean indicating if the xJCL in the repository
should be replaced, in case a job by that name already exists

in the xJCL repository.

@Gparam nameValuePairs The space delimited name=value pairs which are
used to modify the xJCL For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded
with an encoding scheme of UTF-8 before being passed in on the request.

@return the job ID assigned by the job scheduler to the submitted job

O@throws InvalidOperationException if the job already exists in the xJCL

repository and the replace parameter specified is false

@throws SchedulerException if an unexpected error is thrown by the

job scheduler while submitting the job

@throws JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job

@throws java.rmi.RemoteException

public String saveModifiableJobToRepositoryAndSubmit( String xJCL, String job,

boolean replace, String nameValuePairs )

throws InvalidOperationException, SchedulerException, JCLException,

JobSubmissionException, java.rmi.RemoteException;

[**

*

Note: The following code is not supported.
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Submits the specified job, saved in the xJCL repository, and any name/value
pairs specified to the job scheduler

@param job The name of the job that was stored to the xJCL repository
Oparam nameValuePairs The space delimited name=value pairs which are used to
modify the xJCL (For example. "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded with
an encoding scheme of UTF-8 before being passed in on the request.

@return the job ID assigned by the job scheduler to the submitted job

@throws InvalidJobNameException if job is not found in the xJCL repository.

@throws SchedulerException if an unexpected error is thrown by the job

scheduler while submitting the job

Othrows JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job

Othrows java.rmi.RemoteException

* ok X F 3k X X X X X 3k X X X X X

*
~

public String submitModifiableJobFromRepository( String job, String nameValuePairs )
throws InvalidJobNameException, SchedulerException, JCLException, JobSubmissionException,
java.rmi.RemoteException;

[**
Submits the job, which is defined by the xJCL and any name/value pairs specified,
to the job scheduler

@Gparam xJCL The xJCL for the job

@param nameValuePairs The space delimited name=value pairs which are used to
modify the xJCL (For example "host=myhost port=myport")

Any values that contain special characters or spaces must be URL encoded

with an encoding scheme of UTF-8 before being passed in on the request.
@return the job ID assigned by the job scheduler to the submitted job

Othrows SchedulerException if an unexpected error is thrown by the job

scheduler while submitting the job

@throws JCLException if the xJCL stored in the repository is corrupted or not valid.
@throws JobSubmissionException if an error occurs while submitting the job

@throws java.rmi.RemoteException

* 0% 3k X 3k 3k X 3k % X X X X X X

*
~

public String submitModifiabledob( String xJCL, String nameValuePairs )
throws SchedulerException, JCLException, JobSubmissionException, java.rmi.RemoteException;

[**

* Note: The following code is not supported.

Modify an existing job schedule.

@param reqld The name of the job schedule to be modified
@param xJCL The xJCL for the job
@Gparam startTime The time at which the first job
will be submitted. The format of the submit time is yyyy-mm-dd hh:mm:ss.
@Gparam interval The time interval between jobs
(For example daily, weekly, monthly)
@Gparam nameValuePairs The space delimited name=value

pairs which are used to modify the xJCL (For example "host=myhost port=myport")
Any values that contain special characters or spaces must be URL encoded with
an encoding scheme of UTF-8 before being passed in on the request.

@throws SchedulerException if an unexpected error is thrown
by the job scheduler while processing the command

@throws JCLException if the xJCL for the job is corrupted
or not valid.

@throws InvalidOperationException if the operation is currently not

allowed on the job
@throws InvalidStartDateTimeFormatException if the start date and/or time is
not in the required format

@throws StaleTimeException if the start date and/or time is
in the past based on current time
@throws InvalidIntervalException if the interval specified is not

one of the supported time interval
@throws java.rmi.RemoteException

* o3k X o Sk Xk 3k X X 3k X F 3k X X %k X X %k X X X X X
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*/

public void modifyModifiableRecurringRequest(String reqld, String xJCL,
String startTime, String interval, String nameValuePairs)

throws SchedulerException, JCLException, InvalidOperationException,
InvalidStartDateTimeFormatException, StaleTimeException, InvalidIntervalException,
java.rmi.RemoteException;

[**
Returns a list of job names in the job repository that match the specified
criteria. All conditions must apply for a match to occur.

*
*
*
* @param jobNameFilter SQL filter value to apply to the job names (For example Postings% )
* @param jobDescFilter not used

* @param sortBy - Field used to sort results (For example JOBNAME, TXT)

* @param ascending - flag indicating whether the results should be returned in

* ascending or descending order

* of the sortBy field.

*

*

*

*

*

@return the 1ist of job names that match the specified criteria

@throws SchedulerException if an unexpected error is thrown by the job
scheduler while processing the request
* @throws java.rmi.RemoteException
*
/
public String[] getJobsName(String jobNameFilter, String jobDescFilter,
String sortBy, boolean ascending) throws
SchedulerException,
java.rmi.RemoteException;

~
*
*

Stops the job identified by the job ID

Othrows InvalidOperationException if the operation is currently not
allowed on the job

@throws InvalidJobIDException if no job by the specified job ID exists
in the job scheduler

@throws SchedulerException if an unexpected error is thrown by the job
scheduler while processing the request

@throws java.rmi.RemoteException

E O I R T T R

* @param jobid The ID of the job

*/

public void stopJob( String jobid )

throws InvalidOperationException, InvalidJobIDException, SchedulerException,
java.rmi.RemoteException;

[**

* Stops the jobs identified by the list of job IDs

*

* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while purging the job

* @throws java.rmi.RemoteException

*

* @param jobid The Tist of job IDs to stop

* @return List of return codes. Refer to {@link JobSchedulerConstants

* JobSchedulerConstants} for a list of the possible return codes.
*/

public int[] stopJob( String[] jobid ) throws

SchedulerException,

java.rmi.RemoteException;

~
*
*

Parses the xJCL to produce a map of all symbolic variables used in the xJCL
which are not system properties

@Gparam xJCL The xJCL for the job

@return a map of defaulted name/value pairs; value==null ==> no default value
in substitution-props

Othrows SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command
@throws JCLException if the xJCL stored in the repository is corrupted or not valid.

* %k X F Sk X X X X
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* @throws java.rmi.RemoteException
*

*/

public String getSymbolicVariables( String clientXJCL )
throws SchedulerException, JCLException, java.rmi.RemoteException;

~
*
*

Returns job schedule information in XML format for the given job schedule names.
@Gparam requestid List of job schedule names

@throws SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command

@throws java.rmi.RemoteException

@return Job schedule information in XML format, such as job schedule name,
job name, start time and interval

* % X X 3k X X X X *

*/

public String getRequests(String[] requestid) throws
SchedulerException,

java.rmi.RemoteException;

[**
Returns a Tist of job schedule names that match the specified criteria. A1l conditions
must apply for a match to occur.

@Gparam requestIdFilter SQL filter value to apply to the name of the job schedule

(For example %Postings% )

@param startTimeFilter SQL filter value to apply to the initial submit time of the
jobs. The format of the submit time is yyyy-mm-dd hh:mm:ss.

@param submitterFilter SQL filter value to apply to the submitter

@param intervalFilter List of time periods between job submissions (For example daily,
weekly, monthly)

@Gparam statusFilter List of job states. Refer to

{@1ink JobStatusConstants JobStatusConstants} for a

list of the possible job states.

@param sortBy - Field used to sort results (For example REQUESTID, STARTTIME, INTERVAL)
@Gparam ascending - flag indicating whether the results should be returned in

ascending or descending order

of the sortBy field.

@return the Tist of job schedule names that match the specified criteria
Othrows SchedulerException if an unexpected error is thrown by the job scheduler

while processing the command
@throws java.rmi.RemoteException

* 0% 3k X 3k kX 3k 3k X X %k X 3k 3k X Xk X X X X F

*

/

public String[] getRequestsId(String requestIdFilter, String startTimeFilter,
String submitterFilter, String[] intervalFilter, Integer[] statusFilter,
String sortBy, boolean ascending) throws

SchedulerException,

java.rmi.RemoteException;

[**

* Note: The following code is not supported.
Cancel existing job schedules

@param reqld The Tist of job schedule names to cancel
@return List of return codes. Refer to
% {@1ink JobSchedulerConstants JobSchedulerConstants} for a list of the
* possible return codes.
*
* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while canceling the job
* @throws java.rmi.RemoteException
*
/
public int[] cancelRecurringRequest( String[] reqld ) throws
SchedulerException,
java.rmi.RemoteException;

* % X o
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*
*
*
*
*
*
*
*
*

Returns the compressed job Tog associated with the requested job ID

@param jobid The ID of the job whose log file name is to be returned

@return the file system name for the job log of the specified job

@throws SchedulerException if an unexpected error is thrown by the Job Scheduler while
processing the command

@throws InvalidJobIDException if no job logs for the specified job ID are found by

the Job Scheduler

@throws InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException

*/
pub

~
*
*

* ok X F Sk X X X X F

lic String getJdoblLog( String jobid ) throws SchedulerException,
InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

Returns the job log meta-data associated with the requested job ID
list of distinct job Tog subdirectories for the job ID)

@param jobid The ID of the job whose meta-data is to be returned

@return the job Tog meta-data for the specified job

@throws SchedulerException if an unexpected error is thrown by the Job Scheduler

while processing the command

@throws InvalidJobIDException if no job log meta-data for the specified job ID is
found by the Job Scheduler

Othrows InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException

*/

public String[] getLogMetaData( String jobid ) throws SchedulerException,

InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

~
*
*

E R R N S T I R

*/

Returns the job log part list associated with the requested job ID and Tog subdirectory

Gparam jobid The ID of the job whose part information is to be returned

Gparam TogSubDirName The name of the log subdirectory of the job whose part
information is to be returned

@return the job Tog part information for the specified job

@throws SchedulerException if an unexpected error is thrown by the Job Scheduler

while processing the command

@throws InvalidJobIDException if no part information for the specified job ID is

found by the Job Scheduler

Othrows InvalidOperationException if the operation is currently not allowed on the job
@throws java.rmi.RemoteException

public String[] getLogPartList( String jobid, String logSubDirName ) throws

SchedulerException, InvalidJobIDException, InvalidOperationException,
java.rmi.RemoteException;

~
*
*

* 0% kX 3k kX X 3k X X X X F X

Returns the contents of the job log file associated with the requested job ID,
log subdirectory and part number

Gparam jobid The ID of the job whose part information is to be returned
@Gparam TogSubDirName The name of the log subdirectory of the job whose part
information is to be returned

@Gparam partNumber The name of the job lTog chunk in the log subdirectory whose
part information is to be returned

@return the contents of the job Tog part for the specified job and log subdirectory

Othrows SchedulerException if an unexpected error is thrown by the Job Scheduler

while processing the command

Othrows InvalidJobIDException if no part information for the specified job ID is

found by the Job Scheduler

@throws InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException
*/
public String[] getlLogPart( String jobid, String logSubDirName, String partNumber )

throws SchedulerException, InvalidJobIDException, InvalidOperationException,
java.rmi.RemoteException;
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[**
* Returns the size in bytes of the job log file associated with the requested job ID

@param jobid The ID of the job whose size information is to be returned
@param TogSubDirName The name of the log subdirectory of the job whose size
information is to be returned
@return the size of the job Tog for the specified job
@throws SchedulerException if an unexpected error is thrown by the Job Scheduler
while processing the command
@throws InvalidJobIDException if no size information for the specified job ID is
found by the Job Scheduler
@throws InvalidOperationException if the operation is currently not allowed on the job
* @throws java.rmi.RemoteException
*

/
public String getlLogSize( String jobid, String logSubDirName ) throws SchedulerException,
InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

* % 3k X 3k 3k X X X X

/%
* Returns the age of the job Tog file associated with the requested job ID and Tog

* subdirectory
*

* @param jobid The ID of the job whose age information is to be returned
* @param TogSubDirName The name of the log subdirectory of the job whose age information
* is to be returned
*
* @return the age of the job Tog in days for the specified jobname and log subdirectory
*
* @throws SchedulerException if an unexpected error is thrown by the Job Scheduler
* while processing the command
* @throws InvalidJobIDException if no age information for the specified job ID is
* found by the Job Scheduler
* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws java.rmi.RemoteException
*
/

public int getLogAge( String jobid, String TogSubDirName ) throws SchedulerException,
InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

[**

* Returns the job log list associated with the requested job class

*

* @param jobid The class identifier whose job list information is to be returned

* @param jobClass The class identifier on which to match

* @return a list of all job IDs whose class identifier matches the specified jobClass

* @throws SchedulerException if an unexpected error is thrown by the Job Scheduler

* while processing the command

* @throws InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException

*/

public String[] getJobsByClass( String jobClass ) throws SchedulerException,
InvalidOperationException, java.rmi.RemoteException;

[**
Removes the compressed job log associated with the requested job ID [ this is the
required complimentary action to {@link JobScheduler#getJobLog(String) getJobLog(jobid) ]

@Gparam jobid The ID of the job whose compressed log file is to be removed
@throws SchedulerException if an unexpected error is thrown by the Job Scheduler
while processing the command
@throws InvalidJobIDException if no part information for the specified job ID is
found by the Job Scheduler
@throws InvalidOperationException if the operation is currently not allowed on the job
* @throws java.rmi.RemoteException
*

/
public void removeJobLog( String jobid ) throws SchedulerException,
InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

* % 3k % X X 3k X F

[**
Purges the job log file associated with the requested job ID and log subDirectory

*

*

* @param jobid The ID of the job whose job log is to be purged

* @param TogSubDirName The name of the log subdirectory of the job whose job Tog

92 Developing WebSphere applications



* is to be purged
* @throws SchedulerException if an unexpected error is thrown by the Job Scheduler
* while processing the command
* @throws InvalidJobIDException if no job information for the specified job ID is
* found by the Job Scheduler
* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws java.rmi.RemoteException
*
/
public void purgedobLog( String jobid, String logSubDirName ) throws SchedulerException,
InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

[**
Return the JMX addresses of the scheduler cluster

@return the JMX addresses of the scheduler cluster

Othrows SchedulerException if an unexpected error is thrown by the Job Scheduler

while processing the command

@throws InvalidOperationException if the operation is currently not allowed on the job
@throws java.rmi.RemoteException

* % kX Ok X

*/
public String[] getAdminAddresses() throws SchedulerException, InvalidOperationException,
java.rmi.RemoteException;

[*%

* Retrieves a list of user preferences for the given user ID and the given scope.
* @param userld The user ID used to log into the Job Management Console

* @param prefScope The scope of the preferences within the Job Management Console.
* (For example JobCollectionForm, SavedJobCollectionForm,

* JobScheduleCollectionForm)

* @return a list of user preferences in the format of name=value

*

*

*

*

*

@throws SchedulerException if an unexpected error is thrown by the job scheduler
while processing the command
@throws java.rmi.RemoteException

*/
public String[] getUserPrefs( String userIld, String prefScope ) throws
SchedulerException, java.rmi.RemoteException;

[**

* Saves the list of user preferences for the given user ID and the given scope.

* @param userld The user ID used to log into the Job Management Console

* @param prefScope The scope of the preferences within the Job Management Console.
* (For example JobCollectionForm, SavedJobCollectionForm,

% JobScheduleCollectionForm)

* @param prefNameValue The list of user preferences in the format of name=value

*

* @throws SchedulerException if an unexpected error is thrown by the job scheduler
* while processing the command

* @throws java.rmi.RemoteException

*

*/

public void saveUserPrefs( String userld, String prefScope, String[] prefNameValue)
throws SchedulerException, java.rmi.RemoteException;

/%

* Returns the job log list associated with the requested job class sorted by job Tog age
*

* @param jobClass The class identifier on which to match

* @return a list of all job IDs whose class identifier matches jobClass

* @throws SchedulerException if an unexpected error is thrown by the Job Scheduler

* while processing the command

* @throws InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException

*/

public String[] getJoblLogMetaDataByAgeForClass( String jobClass ) throws
SchedulerException, InvalidOperationException, java.rmi.RemoteException;

[**

* Returns the job log list associated with the requested job class sorted by job log size
*

* @param jobClass The class identifier on which to match
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* @return a list of all job IDs whose class identifier matches jobClass

* @throws SchedulerException if an unexpected error is thrown by the Job Scheduler

* while processing the command

* @throws InvalidOperationException if the operation is currently not allowed on the job

* @throws java.rmi.RemoteException

*
/

public String[] getJoblLogMetaDataBySizeForClass( String jobClass ) throws
SchedulerException, InvalidOperationException, java.rmi.RemoteException;

[**
* Stops user job logging
*
* @param jobid The ID of the job whose application job logging is to be stopped
* @throws SchedulerException if an unexpected error is thrown by the Job Scheduler
* while processing the command
* @throws InvalidJobIDException if the specified job ID is not found by the Job Scheduler
* @throws InvalidOperationException if the operation is currently not allowed on the job
* @throws java.rmi.RemoteException
*
/

public void quiescelLogging( String jobid ) throws SchedulerException,
InvalidJobIDException, InvalidOperationException, java.rmi.RemoteException;

[**

@Gparam jobid The ID of the job
@Gparam Status The status of the job

* % %k X X F

@throws java.rmi.RemoteException

*/

public void sendCheckpointNotification( String jobid, String Status )
throws java.rmi.RemoteException;

[**
Returns true if SAF authorization is enabled.
Supported on z/0S only.

@return true if SAF authorization is enabled, otherwise false.

*
*
*
*
* @throws java.rmi.RemoteException

*/

public boolean isSAF() throws java.rmi.RemoteException;

}

Submitting batch jobs using the job scheduler web services interface
The job scheduler web services interface is used to programmatically submit and manipulate a batch job.

Before you begin

The job scheduler supports programmatic access to its functions over both an EJB interface for Java
Platform, Enterprise Edition (Java EE) applications and a web services interface for both Java EE and
non-Java EE applications. The Web Services Description Language (WSDL) describes the web services
interface for the job scheduler that is listed under the job scheduler web services interface.

Develop and install your batch applications.
About this task

This topic describes how to submit a batch job to the job scheduler. It includes a code example that
demonstrates how to invoke the job scheduler web services interface.

Procedure
1. Create a program for submitting batch work.

The following example demonstrates how to invoke the job scheduler web services interface to submit
a batch job.
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2.

Some statements are split on multiple lines for printing purposes.

import javax.xml.namespace.QName;
import javax.xml.rpc.Call;

import javax.xml.rpc.ParameterMode;
import javax.xml.rpc.Service;

import javax.xml.rpc.ServiceException;
import javax.xml.rpc.ServiceFactory;

import javax.xml.rpc.encoding.XMLType;

Call call = null;
String TrsHostName = "localhost";
String TrsPort = "9080";

private String readXJCL() throws FileNotFoundException, IOException {
// Code to read xJCL file into a String
}

pubTic void submitJdob() {
String endPoint =
"http://"+1rsHostName+":"+1rsPort+"/LongRunningJobSchedulerWebSvcRouter/
services/JobScheduler";
try {
ServiceFactory serviceFactory = ServiceFactory.newInstance();
Service service = serviceFactory.createService(new
QName ("http://longrun.websphere.ibm.com", "JobSchedulerService"));

call = (Call) service.createCall();
call.setProperty(Call.ENCODINGSTYLE_URI_PROPERTY,
"http://schemas.xmlsoap.org/soap/encoding/");
call.setProperty(Call.0PERATION_STYLE_PROPERTY, "wrapped");
call.setPortTypeName (new
QName ("http://Tongrun.websphere.ibm.com", "JobSchedulerService"));
call.setTargetEndpointAddress(endPoint);

//remove all parameters from call object

call.removeAllParameters();

call.setReturnType(XMLType.SOAP_STRING, null);

call.addParameter("arg", XMLType.SOAP_STRING, ParameterMode.IN);
call.setOperationName(new QName("http://longrun.websphere.ibm.com","submitJob"));

String xjcl = readXJCL(); // Method to read xJCL file into a string

call.invoke(new Object[] {xjcl1});

} catch (ServiceException se) {

System.out.printin("Service Exception: " + se.getMessage());
se.printStackTrace();

} catch (java.rmi.RemoteException re) {
System.out.printin("Remote Exception: " + re.getMessage());
re.printStackTrace();

}

}

Run the program to submit batch work.

The job scheduler web services interface

The job scheduler for web services provides the following interfaces for programmatically submitting and

manipulating a batch job from a web services client program:

The following code is the contents of the Web Services Description Language (WSDL) file.

Some code is split on multiple lines for printing purposes.

<?xml version="1.0" encoding="UTF-8"?>
<wsdl:definitions
targetNamespace="http://longrun.websphere.ibm.com"
xmins:impl="http://longrun.websphere.ibm.com"
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xmins:intf="http://longrun.websphere.ibm.com"
xmins:wsd1="http://schemas.xmlsoap.org/wsd1/"
xmins:wsd1soap="http://schemas.xmlsoap.org/wsdl/soap/"
xmins:wsi="http://ws-i.org/profiles/basic/1.1/xsd"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<wsdl:types>
<schema
targetNamespace="http://longrun.websphere.ibm.com"
xmins="http://www.w3.0rg/2001/XMLSchema"
xmins:impl="http://Tongrun.websphere.ibm.com"
xmins:intf="http://longrun.websphere.ibm.com"
xmins:wsd1="http://schemas.xmlsoap.org/wsd1/"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<element name="submitJobFromRepositoryResponse">
<complexType>
<sequence>
<element name="submitJobFromRepositoryReturn" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitJob">
<complexType>
<sequence>
<element name="arg_0 1" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitJobResponse">
<complexType>
<sequence>
<element name="submitJobReturn" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="showAl1Jobs">
<complexType>
<sequence/>
</complexType>
</element>
<element name="showAllJobsResponse">
<complexType>
<sequence>
<element name="showAllJobsReturn" nillable="true" type="impl:ArrayOf_xsd_nillable_string"/>
</sequence>
</complexType>
</element>
I-- Note: The following element is not supported. -->
<element name="saveJobToRepository">
<complexType>
<sequence>
<element name="arg 0 3" nillable="true" type="xsd:string"/>
<element name="arg_1 3" nillable="true" type="xsd:string"/>
<element name="arg 2 3" type="xsd:boolean"/>
</sequence>
</complexType>
</element>

A

<element name="saveJobToRepositoryResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="suspendJob">
<complexType>
<sequence>
<element name="arg_0 4" nillable="true" type="xsd:string"/>
<element name="arg_1l 4" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="suspendJobResponse">
<complexType>
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<sequence/>
</complexType>
</element>
<element name="modifyRecurringRequest">
<complexType>
<sequence>
<element name="arg_0 5" nillable="true" type="xsd:string"/>
<element name="arg_1l 5" nillable="true" type="xsd:string"/>
<element name="arg_2 5" nillable="true" type="xsd:string"/>
<element name="arg_3 5" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="modifyRecurringRequestResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="saveDelayedJobToRepositoryAndSubmit">
<complexType>
<sequence>
<element name="arg 0 6" nillable="true" type="xsd:string"/>
<element name="arg_1 6" nillable="true" type="xsd:string"/>
<element name="arg_2_6" type="xsd:boolean"/>
<element name="arg_3 6" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="saveDelayedJobToRepositoryAndSubmitResponse">
<complexType>
<sequence>

<element name="saveDelayedJobToRepositoryAndSubmitReturn" nillable="true" type="xsd:string"/>

</sequence>

</complexType>

</element>

<element name="getJobStatus">

<complexType>
<sequence>
<element name="arg_0 7" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getJobStatusResponse">

<complexType>
<sequence>
<element name="getJobStatusReturn" type="xsd:int"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="saveJobToRepositoryAndSubmit">
<complexType>
<sequence>
<element name="arg_0 8" nillable="true" type="xsd:string"/>
<element name="arg_1l 8" nillable="true" type="xsd:string"/>
<element name="arg_2 8" type="xsd:boolean"/>
</sequence>
</complexType>
</element>
<element name="saveJobToRepositoryAndSubmitResponse">
<complexType>
<sequence>
<element name="saveJobToRepositoryAndSubmitReturn" nillable="true"
</sequence>
</complexType>
</element>
<element name="resumeJob">
<complexType>
<sequence>
<element name="arg 0 9" nillable="true" type="xsd:string"/>
</sequence>

type="xsd:string"/>
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</complexType>

</element>

<element name="resumeJobResponse">
<complexType>

<sequence/>
</complexType>
</element>
<!-- Note: The following element is not supported. -->

<element name="cancelRecurringRequest">

<complexType>
<sequence>
<element name="arg 0 10" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="cancelRecurringRequestResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="getBatchJobRC">
<complexType>
<sequence>
<element name="arg_0_ 11" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getBatchJobRCResponse">
<complexType>
<sequence>
<element name="getBatchJobRCReturn" type="xsd:int"/>
</sequence>
</complexType>
</element>
<!-- Note: The following element is not supported. -->

<element name="showAllRecurringRequests">
<complexType>
<sequence/>
</complexType>
</element>
<element name="showAl1RecurringRequestsResponse">
<complexType>
<sequence>
<element name="showAlTRecurringRequestsReturn" nillable="true"
type="1imp1:Array0Of_xsd_nillable_string"/>
</sequence>
</complexType>
</element>
<!l-- Note: The following element is not supported. -->

<element name="showJobFromRepository">

<complexType>
<sequence>
<element name="arg_0 13" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="showJobFromRepositoryResponse">

<complexType>
<sequence>
<element name="showJobFromRepositoryReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getJobOutput">

<complexType>
<sequence>
<element name="arg 0 14" nillable="true" type="xsd:string"/>
</sequence>
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</complexType>

</element>

<element name="getJobOutputResponse">

<complexType>
<sequence>
<element name="getJobOutputReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="restartJob">

<complexType>
<sequence>
<element name="arg 0 15" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="restartJobResponse">

<complexType>
<sequence/>

</complexType>

</element>

<l-- Note: The following element is not supported. -->

<element name="getRecurringRequestDetails">

<complexType>
<sequence>
<element name="arg_0 16" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getRecurringRequestDetailsResponse'">

<complexType>
<sequence>
<element name="getRecurringRequestDetailsReturn” nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="submitDelayedJob">

<complexType>
<sequence>
<element name="arg_0_17" nillable="true" type="xsd:string"/>
<element name="arg_1 17" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="submitDelayedJobResponse">

<complexType>
<sequence>
<element name="submitDelayedJobReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="submitDelayedJobFromRepository">

<complexType>
<sequence>
<element name="arg 0 18" nillable="true" type="xsd:string"/>
<element name="arg_ 1 18" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="submitDelayedJobFromRepositoryResponse">

<complexType>
<sequence>
<element name="submitDelayedJobFromRepositoryReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="cancelJob">
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<complexType>
<sequence>
<element name="arg 0 19" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="forcedCancelJob">
<complexType>
<sequence>
<element name="arg_0 19" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="cancelJobResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="forcedCancelJobResponse">
<complexType>
<sequence/>
</complexType>
</element>
<l-- Note: The following element is not supported. -->

<element name="submitRecurringRequestFromRepository">
<complexType>
<sequence>
<element name="arg_0 20" nillable="true" type="xsd:string"/>
<element name="arg_1 20" nillable="true" type="xsd:string"/>
<element name="arg 2 20" nillable="true" type="xsd:string"/>
<element name="arg 3 20" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitRecurringRequestFromRepositoryResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="removeJobFromRepository">
<complexType>
<sequence>
<element name="arg 0 21" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="removeJobFromRepositoryResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="purgeJob">
<complexType>
<sequence>
<element name="arg_0 22" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="purgeJobResponse">
<complexType>
<sequence/>
</complexType>
</element>
<!-- Note: The following element is not supported. -->

<element name="submitRecurringRequest">

<complexType>
<sequence>
<element name="arg 0 23" nillable="true" type="xsd:string"/>
<element name="arg_ 1 23" nillable="true" type="xsd:string"/>
<element name="arg_ 2 23" nillable="true" type="xsd:string"/>
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<element name="arg_3_23" nillable="true" type="xsd:string"/>

</sequence>
</complexType>

</element>

<element name="submitRecurringRequestResponse">
<complexType>
<sequence/>
</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="showRecurringJobs">

<complexType>
<sequence>
<element name="arg_0 24" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="showRecurringJobsResponse">

<complexType>
<sequence>
<element name="showRecurringJobsReturn" nillable="true"

type="imp1:ArrayOf_xsd_nillable_string"/>

</sequence>

</complexType>

</element>

<element name="getJobDetails">

<complexType>
<sequence>
<element name="arg_0 25" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getJobDetailsResponse">

<complexType>
<sequence>
<element name="getJobDetailsReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="submitJobFromRepository">

<complexType>
<sequence>
<element name="arg_0 0" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="submitModifiableJobFromRepository">
<complexType>
<sequence>
<element name="arg_0 26" nillable="true" type="xsd:string"/>
<element name="arg_l 26" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitModifiableJobFromRepositoryResponse'">
<complexType>
<sequence>
<element name="submitModifiableJobFromRepositoryReturn" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitModifiabledob">
<complexType>
<sequence>
<element name="arg 0 27" nillable="true" type="xsd:string"/>
<element name="arg_ 1 27" nillable="true" type="xsd:string"/>
</sequence>
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</complexType>

</element>

<element name="submitModifiableJobResponse">

<complexType>
<sequence>
<element name="submitModifiableJobReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="saveModifiableDelayedJobToRepositoryAndSubmit">
<complexType>
<sequence>
<element name="arg_0 28" nillable="true" type="xsd:string"/>
<element name="arg_1 28" nillable="true" type="xsd:string"/>
<element name="arg_2 28" type="xsd:boolean"/>
<element name="arg_3 28" nillable="true" type="xsd:string"/>
<element name="arg_4 28" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="saveModifiableDelayedJobToRepositoryAndSubmitResponse">
<complexType>
<sequence>
<element name="saveModifiableDelayedJobToRepositoryAndSubmitReturn" nillable="true"
type="xsd:string"/>
</sequence>
</complexType>
</element>
<!-- Note: The following element is not supported. -->

<element name="saveModifiableJobToRepositoryAndSubmit">
<complexType>
<sequence>
<element name="arg_0_29" nillable="true" type="xsd:string"/>
<element name="arg_1l 29" nillable="true" type="xsd:string"/>
<element name="arg_2 29" type="xsd:boolean"/>
<element name="arg_3 29" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="saveModifiableJobToRepositoryAndSubmitResponse">
<complexType>
<sequence>
<element name="saveModifiableJobToRepositoryAndSubmitReturn" nillable="true"
type="xsd:string"/>
</sequence>
</complexType>
</element>
<!-- Note: The following element is not supported. -->

<element name="submitModifiableDelayedJobh">

<complexType>
<sequence>
<element name="arg_0 30" nillable="true" type="xsd:string"/>
<element name="arg_1l 30" nillable="true" type="xsd:string"/>
<element name="arg_2 30" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="submitModifiableDelayedJobResponse">

<complexType>
<sequence>
<element name="submitModifiableDelayedJobReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<!-- Note: The following element is not supported. -->

<element name="submitModifiableDelayedJobFromRepository">
<complexType>
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<sequence>
<element name="arg_0 31" nillable="true" type="xsd:string"/>
<element name="arg 1 31" nillable="true" type="xsd:string"/>
<element name="arg 2 31" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitModifiableDelayedJobFromRepositoryResponse">
<complexType>
<sequence>

<element name="submitModifiableDelayedJobFromRepositoryReturn" nillable="true"

type="xsd:string"/>
</sequence>
</complexType>
</element>

<!-- Note: The following element is not supported. -->

<element name="submitModifiableRecurringRequestFromRepository">

<complexType>

<sequence>
<element name="arg_0 32" nillable="true" type="xsd:string"/>
<element name="arg 1 32" nillable="true" type="xsd:string"/>
<element name="arg 2 32" nillable="true" type="xsd:string"/>
<element name="arg_ 3 32" nillable="true" type="xsd:string"/>
<element name="arg_4 32" nillable="true" type="xsd:string"/>

</sequence>

</complexType>

</element>

<element name="submitModifiableRecurringRequestFromRepositoryResponse">

<complexType>
<sequence/>
</complexType>
</element>

<l-- Note: The following element is not supported. -->

<element name="submitModifiableRecurringRequest">
<complexType>
<sequence>
<element name="arg_0 33" nillable="true" type="xsd:string"/>
<element name="arg 1 33" nillable="true" type="xsd:string"/>
<element name="arg 2 33" nillable="true" type="xsd:string"/>
<element name="arg 3 33" nillable="true" type="xsd:string"/>
<element name="arg_4 33" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="submitModifiableRecurringRequestResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="modifyModifiableRecurringRequest">
<complexType>
<sequence>
<element name="arg_0 34" nillable="true" type="xsd:string"/>
<element name="arg_l 34" nillable="true" type="xsd:string"/>
<element name="arg_2 34" nillable="true" type="xsd:string"/>
<element name="arg_3_34" nillable="true" type="xsd:string"/>
<element name="arg 4 34" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="stopJob">
<complexType>
<sequence>
<element name="arg_0 35" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getJobsName">
<complexType>
<sequence>
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<element name="arg_0 36" nillable="true" type="xsd:string"/>
<element name="arg_l 36" nillable="true" type="xsd:string"/>
<element name="arg 2 36" nillable="true" type="xsd:string"/>
<element name="arg 3 36" type="xsd:boolean"/>
</sequence>
</complexType>
</element>
<element name="getSymbolicVariables">
<complexType>
<sequence>
<element name="arg_0 37" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getSymbolicVariablesResponse">
<complexType>
<sequence>
<element name="getSymbolicVariablesReturn" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getJoblLog">
<complexType>
<sequence>
<element name="arg_0 38" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getJobLogResponse">
<complexType>
<sequence>
<element name="getJobLogReturn" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getLogMetaData">
<complexType>
<sequence>
<element name="arg_0 39" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getLogMetaDataResponse">
<complexType>
<sequence>
<element name="getLogMetaDataReturn" nillable="true" type="impl:ArrayOf xsd_nillable_string"/>
</sequence>
</complexType>
</element>
<element name="getlLogPartList">
<complexType>
<sequence>
<element name="arg_0 40" nillable="true" type="xsd:string"/>
<element name="arg_1 40" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getLogPartListResponse">
<complexType>
<sequence>
<element name="getLogPartListReturn" nillable="true" type="imp1:Array0Of xsd nillable_string"/>
</sequence>
</complexType>
</element>
<element name="getLogPart">
<complexType>
<sequence>
<element name="arg_0 41" nillable="true" type="xsd:string"/>
<element name="arg 1 41" nillable="true" type="xsd:string"/>
<element name="arg 2 41" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
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</element>

<element name="getLogPartResponse">

<complexType>
<sequence>
<element name="getLogPartReturn" nillable="true" type="impl:ArrayOf xsd nillable string"/>
</sequence>

</complexType>

</element>

<element name="getLogSize">

<complexType>
<sequence>
<element name="arg 0 42" nillable="true" type="xsd:string"/>
<element name="arg 1 42" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getLogSizeResponse">

<complexType>
<sequence>
<element name="getlLogSizeReturn" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getLogAge">

<complexType>
<sequence>
<element name="arg_0 43" nillable="true" type="xsd:string"/>
<element name="arg_l 43" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getLogAgeResponse'">

<complexType>
<sequence>
<element name="getLogAgeReturn" type="xsd:int"/>
</sequence>

</complexType>

</element>

<element name="getJobsByClass">

<complexType>
<sequence>
<element name="arg 0 44" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="getJobsByClassResponse">

<complexType>
<sequence>
<element name="getJobsByClassReturn" nillable="true"

type="imp1:ArrayOf xsd nillable string"/>

</sequence>

</complexType>

</element>

<element name="removedoblLog">

<complexType>
<sequence>
<element name="arg_0 45" nillable="true" type="xsd:string"/>
</sequence>

</complexType>

</element>

<element name="removeJobLogResponse">

<complexType>
<sequence/>

</complexType>

</element>

<element name="purgeJoblLog">

<complexType>
<sequence>
<element name="arg 0 46" nillable="true" type="xsd:string"/>
<element name="arg 1 46" nillable="true" type="xsd:string"/>
</sequence>

</complexType>
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</element>
<element name="purgeJobLogResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="getAdminAddresses">
<complexType>
<sequence/>
</complexType>
</element>
<element name="getAdminAddressesResponse">
<complexType>
<sequence>
<element name="getAdminAddressesReturn" nillable="true"
type="imp1:ArrayOf_xsd_nillable_string"/>
</sequence>
</complexType>
</element>
<element name="getJobLogMetaDataByAgeForClass">
<complexType>
<sequence>
<element name="arg 0 48" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getJoblLogMetaDataByAgeForClassResponse">
<complexType>
<sequence>
<element name="getJobLogMetaDataByAgeForClassReturn" nillable="true"
type="imp1:ArrayOf xsd nillable string"/>
</sequence>
</complexType>
</element>
<element name="getJobLogMetaDataBySizeForClass">
<complexType>
<sequence>
<element name="arg_0 49" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="getJoblLogMetaDataBySizeForClassResponse">
<complexType>
<sequence>
<element name="getJobLogMetaDataBySizeForClassReturn" nillable="true"
type="imp1:Array0f_xsd_nillable_string"/>
</sequence>
</complexType>
</element>
<element name="quiescelogging">
<complexType>
<sequence>
<element name="arg_0 50" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="sendCheckpointNotification">
<complexType>
<sequence>
<element name="arg 0 51" nillable="true" type="xsd:string"/>
<element name="arg_ 1 51" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
</element>
<element name="sendCheckpointNotificationResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="quiescelLoggingResponse">
<complexType>
<sequence/>
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</complexType>
</element>
<element name="modifyModifiableRecurringRequestResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="stopJobResponse">
<complexType>
<sequence/>
</complexType>
</element>
<element name="getJobsNameResponse">
<complexType>
<sequence/>
</complexType>
</element>
<complexType name="InvalidJobNameException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="InvalidJobNameException" nillable="true" type="impl:InvalidJobNameException"/>
<complexType name="SchedulerException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="SchedulerException" nillable="true" type="impl:SchedulerException"/>
<complexType name="JCLException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="JCLException" nillable="true" type="impl:JCLException"/>
<complexType name="JobSubmissionException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="JobSubmissionException" nillable="true" type="impl:JobSubmissionException"/>
<complexType name="ArrayOf_xsd_nillable_string">
<sequence>
<element maxOccurs="unbounded" minOccurs="0" name="string" nillable="true"
type="xsd:string"/>
</sequence>
</complexType>
<complexType name="InvalidOperationException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="InvalidOperationException" nillable="true"
type="imp1:InvalidOperationException"/>
<complexType name="InvalidJobIDException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="InvalidJobIDException" nillable="true" type="impl:InvalidJobIDException"/>
<complexType name="InvalidStartDateTimeFormatException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="InvalidStartDateTimeFormatException" nillable="true"
type="1impl:InvalidStartDateTimeFormatException"/>
<complexType name="StaleTimeException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
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<element name="StaleTimeException" nillable="true" type="impl:StaleTimeException"/>
<complexType name="InvalidIntervalException">
<sequence>
<element name="message" nillable="true" type="xsd:string"/>
</sequence>
</complexType>
<element name="InvalidIntervalException" nillable="true" type="impl:InvalidIntervalException"/>
</schema>
</wsd1:types>
<wsd1:message name="showRecurringJobsRequest">
<wsd1:part element="imp1:showRecurringJobs" name="parameters"/>
</wsd1:message>
<wsd1:message name="cancelRecurringRequestResponse">
<wsdl:part element="1impl:cancelRecurringRequestResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitRecurringRequestRequest">
<wsdl:part element="1imp1:submitRecurringRequest" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitModifiableRecurringRequestRequest">
<wsdl:part element="imp1:submitModifiableRecurringRequest" name="parameters"/>
</wsd1:message>
<wsd1:message name="InvalidJobNameException">
<wsdl:part element="1imp1:InvalidJobNameException" name="fault"/>
</wsd1:message>
<wsd1:message name="showAllJobsRequest">
<wsdl:part element="imp1:showA11Jobs" name="parameters"/>
</wsd1:message>
<wsd1:message name="getRecurringRequestDetailsRequest">
<wsdl:part element="1impl:getRecurringRequestDetails" name="parameters"/>
</wsd1:message>
<wsd1:message name="getJobOutputRequest">
<wsdl:part element="1impl:getJobOutput" name="parameters"/>
</wsd1:message>
<wsd]:message name="InvalidStartDateTimeFormatException">
<wsdl:part element="imp1l:InvalidStartDateTimeFormatException" name="fault"/>
</wsd1:message>
<wsd1:message name="resumeJobRequest">
<wsdl:part element="1impl:resumeJob" name="parameters"/>

</wsd1:message>

<wsd1:message name="saveDelayedJobToRepositoryAndSubmitRequest">
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<wsdl:part element="1imp1:saveDelayedJobToRepositoryAndSubmit" name="parameters"/>
</wsd1:message>
<wsd1:message name="saveModifiableDelayedJobToRepositoryAndSubmitRequest">

<wsdl:part element="1impl:saveModifiableDelayedJobToRepositoryAndSubmit" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitDelayedJobResponse">

<wsdl:part element="1imp1:submitDelayedJobResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitModifiableDelayedJobResponse">

<wsdl:part element="1imp1:submitModifiableDelayedJobResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="removeJobFromRepositoryResponse">

<wsdl:part element="imp1:removeJobFromRepositoryResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="StaleTimeException">

<wsdl:part element="imp1:StaleTimeException" name="fault"/>
</wsd1:message>
<wsd1:message name="getJobStatusResponse">

<wsdl:part element="1impl:getJobStatusResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="cancelRecurringRequestRequest">

<wsdl:part element="impl:cancelRecurringRequest" name="parameters"/>
</wsdl:message>
<wsd]:message name="getBatchJobRCResponse">

<wsdl:part element="1imp1:getBatchJobRCResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="getJobDetailsResponse">

<wsdl:part element="1imp1:getJobDetailsResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitJobRequest">

<wsdl:part element="imp1:submitJob" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitModifiableJobRequest">

<wsdl:part element="imp1:submitModifiableJob" name="parameters"/>
</wsdl:message>

<wsd]:message name="purgeJobResponse">
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<wsdl:part element="1imp1:purgeJobResponse" name="parameters"/>
</wsdl:message>
<wsd]:message name="removeJobFromRepositoryRequest">
<wsdl:part element="1imp1:removeJobFromRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="getJobOutputResponse">
<wsdl:part element="1impl:getJobOutputResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitJobFromRepositoryResponse">
<wsdl:part element="1imp1:submitJobFromRepositoryResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitModifiableJobFromRepositoryResponse">
<wsdl:part element="imp1:submitModifiableJobFromRepositoryResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="JCLException">
<wsdl:part element="imp1:JCLException" name="fault"/>
</wsd1:message>
<wsd1:message name="cancelJobResponse">
<wsdl:part element="1imp1:cancelJobResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="forcedCancelJobResponse">
<wsdl:part element="imp1:forcedCancelJobResponse" name="parameters"/>

</wsd1:message>

<wsd1:message name="submitDelayedJobRequest">

<wsdl:part element="imp1:submitDelayedJob" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableDelayedJobRequest">

<wsdl:part element="1imp1:submitModifiableDelayedJob" name="parameters"/>
</wsd1:message>
<wsd1:message name="showAllJobsResponse">

<wsdl:part element="imp1:showAl1JobsResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="showJobFromRepositoryRequest">

<wsdl:part element="imp1:showJobFromRepository" name="parameters"/>
</wsd1:message>

<wsd1:message name="JobSubmissionException">
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<wsdl:part element="imp1:JobSubmissionException" name="fault"/>
</wsd1:message>
<wsd1:message name="showAl1RecurringRequestsResponse">

<wsdl:part element="1imp1:showAl1RecurringRequestsResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="showAl1RecurringRequestsRequest">

<wsdl:part element="imp1:showAl1RecurringRequests" name="parameters"/>
</wsd1:message>
<wsd]:message name="saveDelayedJobToRepositoryAndSubmitResponse">

<wsdl:part element="1imp1:saveDelayedJobToRepositoryAndSubmitResponse" name="parameters"/>
</wsdl:message>
<wsd1:message name="saveModifiableDelayedJobToRepositoryAndSubmitResponse">

<wsdl:part element="impl:saveModifiableDelayedJobToRepositoryAndSubmitResponse"
name="parameters"/>

</wsd1:message>
<wsd]:message name="suspendJobResponse">
<wsd1:part element="imp1:suspendJobResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitJobResponse">
<wsdl:part element="1imp1:submitJobResponse" name="parameters"/>
</wsdl:message>
<wsd]:message name="submitModifiableJobResponse">
<wsdl:part element="1imp1:submitModifiableJobResponse" name="parameters"/>
</wsdl:message>
<wsd]:message name="restartJobResponse">
<wsdl:part element="impl:restartJobResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="saveJobToRepositoryAndSubmitRequest">
<wsdl:part element="1imp1:saveJobToRepositoryAndSubmit" name="parameters"/>
</wsd1:message>
<wsd]:message name="saveModifiableJobToRepositoryAndSubmitRequest">
<wsd1l:part element="impl:saveModifiableJobToRepositoryAndSubmit" name="parameters"/>
</wsd1:message>
<wsd]:message name="restartJobRequest">
<wsdl:part element="impl:restartJob" name="parameters"/>

</wsdl:message>
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<wsd]:message name="submitRecurringRequestResponse">
<wsdl:part element="imp1:submitRecurringRequestResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableRecurringRequestResponse">
<wsdl:part element="1imp1:submitModifiableRecurringRequestResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="purgeJobRequest">
<wsd1:part element="imp1:purgedob" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitDelayedJobFromRepositoryRequest">
<wsdl:part element="1imp1:submitDelayedJobFromRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableDelayedJobFromRepositoryRequest">
<wsdl:part element="1imp1:submitModifiableDelayedJobFromRepository" name="parameters"/>
</wsd1:message>
<wsd]:message name="getSymbolicVariablesRequest">
<wsdl:part element="imp1:getSymbolicVariables" name="parameters"/>
</wsd1:message>
<wsd1:message name="cancelJobRequest">
<wsdl:part element="1impl:cancelJob" name="parameters"/>
</wsdl:message>
<wsd]:message name="forcedCancelJobRequest">
<wsdl:part element="1imp1:forcedCancelJob" name="parameters"/>

</wsd1:message>

<wsd]:message name="getBatchJobRCRequest">
<wsdl:part element="imp1:getBatchJobRC" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobStatusRequest">
<wsdl:part element="1impl:getJobStatus" name="parameters"/>
</wsdl:message>
<wsd1:message name="modifyRecurringRequestResponse">
<wsdl:part element="1imp1:modifyRecurringRequestResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="modifyModifiableRecurringRequestResponse">
<wsd1:part element="imp1:modifyModifiableRecurringRequestResponse" name="parameters"/>

</wsdl:message>
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<wsd]:message name="stopJobResponse">
<wsdl:part element="imp1:stopJobResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="getJobsNameResponse">
<wsdl:part element="1imp1:getJobsNameResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="saveJobToRepositoryResponse">
<wsdl:part element="impl:saveJobToRepositoryResponse" name="parameters"/>
</wsdl:message>
<wsd]:message name="resumeJobResponse">
<wsdl:part element="imp1:resumeJobResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitRecurringRequestFromRepositoryResponse">
<wsdl:part element="1imp1:submitRecurringRequestFromRepositoryResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableRecurringRequestFromRepositoryResponse">

<wsdl:part element="imp]l:submitModifiableRecurringRequestFromRepositoryResponse"
name="parameters"/>

</wsd1:message>
<wsd]:message name="submitRecurringRequestFromRepositoryRequest">

<wsdl:part element="imp1:submitRecurringRequestFromRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableRecurringRequestFromRepositoryRequest">

<wsdl:part element="1imp1:submitModifiableRecurringRequestFromRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="saveJobToRepositoryAndSubmitResponse">

<wsdl:part element="impl:saveJobToRepositoryAndSubmitResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="saveModifiableJobToRepositoryAndSubmitResponse">

<wsdl:part element="1impl:saveModifiableJobToRepositoryAndSubmitResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="submitDelayedJobFromRepositoryResponse">

<wsdl:part element="1imp1:submitDelayedJobFromRepositoryResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableDelayedJobFromRepositoryResponse">

<wsdl:part element="imp1:submitModifiableDelayedJobFromRepositoryResponse" name="parameters"/>
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</wsd1:message>
<wsd]:message name="getSymbolicVariablesResponse">

<wsdl:part element="imp1:getSymbolicVariablesResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="SchedulerException">

<wsdl:part element="imp1:SchedulerException" name="fault"/>
</wsdl:message>
<wsd]:message name="InvalidOperationException">

<wsd1l:part element="impl:InvalidOperationException" name="fault"/>
</wsd1:message>
<wsd1:message name="InvalidIntervalException">

<wsdl:part element="1imp1:InvalidIntervalException" name="fault"/>
</wsd1:message>
<wsd1:message name="showJobFromRepositoryResponse">

<wsdl:part element="1imp1:showJobFromRepositoryResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="InvalidJobIDException">

<wsd1l:part element="impl:InvalidJobIDException" name="fault"/>
</wsd1:message>
<wsd]:message name="submitJobFromRepositoryRequest">

<wsdl:part element="imp1:submitJobFromRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="submitModifiableJobFromRepositoryRequest">

<wsdl:part element="imp1:submitModifiableJobFromRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="modifyRecurringRequestRequest">

<wsdl:part element="imp1:modifyRecurringRequest" name="parameters"/>
</wsd1:message>
<wsd]:message name="modifyModifiableRecurringRequestRequest">

<wsdl:part element="1imp1:modifyModifiableRecurringRequest" name="parameters"/>
</wsd1:message>
<wsd1:message name="stopJobRequest">

<wsdl:part element="1impl:stopJob" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobsNameRequest">

<wsdl:part element="imp1:getJobsName" name="parameters"/>

114  Developing WebSphere applications



</wsd1:message>
<wsd]:message name="suspendJobRequest">

<wsdl:part element="imp1:suspendJob" name="parameters"/>
</wsdl:message>
<wsd]:message name="saveJobToRepositoryRequest">

<wsdl:part element="1impl:saveJobToRepository" name="parameters"/>
</wsd1:message>
<wsd1:message name="getRecurringRequestDetailsResponse">

<wsdl:part element="1impl:getRecurringRequestDetailsResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobDetailsRequest">

<wsdl:part element="imp1:getJobDetails" name="parameters"/>
</wsd1:message>
<wsd]:message name="showRecurringJobsResponse">

<wsdl:part element="1imp1:showRecurringJobsResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="getJobLogRequest">

<wsdl:part element="impl:getJobLog" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobLogResponse">

<wsdl:part element="1impl:getJobLogResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="getLogMetaDataRequest">

<wsdl:part element="1impl:getLogMetaData" name="parameters"/>
</wsd1:message>
<wsdl:message name="getLogMetaDataResponse">

<wsdl:part element="impl:getLogMetaDataResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="getLogPartListRequest">

<wsdl:part element="impl:getLogPartList" name="parameters"/>
</wsd1:message>
<wsd]:message name="getLogPartListResponse">

<wsdl:part element="1impl:getLogPartListResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="getLogPartRequest">

<wsdl:part element="impl:getLogPart" name="parameters"/>
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</wsd1:message>
<wsd]:message name="getLogPartResponse">

<wsdl:part element="1impl:getLogPartResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="getlLogSizeRequest">

<wsdl:part element="impl:getLogSize" name="parameters"/>
</wsdl:message>
<wsd1:message name="getLogSizeResponse">

<wsdl:part element="1impl:getLogSizeResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="getLogAgeRequest">

<wsdl:part element="1impl:getLogAge" name="parameters"/>
</wsd1:message>
<wsd1:message name="getLogAgeResponse">

<wsdl:part element="1impl:getLogAgeResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="getJobsByClassRequest">

<wsdl:part element="impl:getJobsByClass" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobsByClassResponse">

<wsdl:part element="1imp1:getJobsByClassResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="removeJobLogRequest">

<wsdl:part element="1imp1:removeJobLog" name="parameters"/>
</wsd1:message>
<wsd1:message name="removeJoblLogResponse'">

<wsdl:part element="1imp1:removeJobLogResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="purgeJobLogRequest">

<wsdl:part element="imp1:purgeJobLog" name="parameters"/>
</wsd1:message>
<wsd1:message name="purgeJobLogResponse">

<wsdl:part element="1imp1:purgedobLogResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="getAdminAddressesRequest">

<wsdl:part element="impl:getAdminAddresses" name="parameters"/>
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</wsd1:message>
<wsd]:message name="getAdminAddressesResponse">

<wsdl:part element="imp1:getAdminAddressesResponse" name="parameters"/>
</wsdl:message>
<wsd]:message name="getJobLogMetaDataByAgeForClassRequest">

<wsdl:part element="1impl:getJobLogMetaDataByAgeForClass" name="parameters"/>
</wsdl:message>
<wsd1:message name="getJobLogMetaDataByAgeForClassResponse">

<wsd1l:part element="impl:getJobLogMetaDataByAgeForClassResponse" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobLogMetaDataBySizeForClassRequest">

<wsdl:part element="imp1:getJobLogMetaDataBySizeForClass" name="parameters"/>
</wsd1:message>
<wsd]:message name="getJobLogMetaDataBySizeForClassResponse">

<wsdl:part element="1impl:getJobLogMetaDataBySizeForClassResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="quiescelLoggingRequest">

<wsd1l:part element="impl:quiescelLogging" name="parameters"/>
</wsd1:message>
<wsd]:message name="sendCheckpointNotificationRequest">

<wsdl:part element="imp1:sendCheckpointNotification" name="parameters"/>
</wsd1:message>
<wsd]:message name="quiescelLoggingResponse">

<wsdl:part element="1impl:quiescelLoggingResponse" name="parameters"/>
</wsd1:message>
<wsd1:message name="sendCheckpointNotificationResponse">

<wsdl:part element="imp1:sendCheckpointNotificationResponse" name="parameters"/>
</wsd1:message>
<wsd1:portType name="JobScheduler">

<wsd1:operation name="submitJobFromRepository">

<wsdl:input message="imp1:submitJobFromRepositoryRequest"
name="submitJobFromRepositoryRequest"/>

<wsd1:output message="imp1l:submitJobFromRepositoryResponse"
name="submitJobFromRepositoryResponse" />

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>
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<wsdl:fault message="imp1:InvalidJobNameException" name="InvalidJobNameException"/>

</wsd1:operation>

<wsdl:operation name="submitJob">
<wsdl:input message="1imp1:submitJobRequest" name="submitJobRequest"/>
<wsd1:output message="impl:submitJobResponse" name="submitJobResponse"/>
<wsd1:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="1imp1:JobSubmissionException" name="JobSubmissionException"/>
<wsdl:fault message="imp1:JCLException" name="JCLException"/>

</wsd1:operation>

<wsd1:operation name="showAllJobs">
<wsd1:input message="imp1l:showAllJobsRequest" name="showAl1JobsRequest"/>
<wsdl:output message="impl:showAl1JobsResponse" name="showAllJobsResponse"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

</wsd1:operation>

<wsdl:operation name="saveJobToRepository">

<wsdl:input message="impl:saveJobToRepositoryRequest"
name="saveJobToRepositoryRequest"/>

<wsd1:output message="impl:savedobToRepositoryResponse"
name="saveJobToRepositoryResponse" />

<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="suspendJob">
<wsd1:input message="impl:suspendJobRequest" name="suspendJobRequest"/>
<wsd1:output message="impl:suspendJobResponse" name="suspendJobResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="modifyRecurringRequest">

<wsdl:input message="imp1l:modifyRecurringRequestRequest"
name="mod1ifyRecurringRequestRequest"/>

<wsd1:output message="imp1:modifyRecurringRequestResponse"
name="mod1ifyRecurringRequestResponse" />

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidIntervalException" name="InvalidIntervalException"/>

<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

118 Developing WebSphere applications



<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="saveDelayedJobToRepositoryAndSubmit">

<wsdl:input message="impl:saveDelayedJobToRepositoryAndSubmitRequest"
name="saveDelayedJobToRepositoryAndSubmitRequest"/>

<wsd]:output message="impl:saveDelayedJobToRepositoryAndSubmitResponse"
name="saveDelayedJobToRepositoryAndSubmitResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="imp1l:JobSubmissionException" name="JobSubmissionException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>

</wsd1:operation>

<wsdl:operation name="getJobStatus">
<wsdl:input message="impl:getJobStatusRequest" name="getJobStatusRequest"/>
<wsd1:output message="impl:getJobStatusResponse" name="getJobStatusResponse"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

</wsd1:operation>

<wsdl:operation name="saveJobToRepositoryAndSubmit">

<wsdl:input message="impl:saveJobToRepositoryAndSubmitRequest"
name="saveJobToRepositoryAndSubmitRequest" />

<wsdl:output message="impl:saveJobToRepositoryAndSubmitResponse"
name="saveJobToRepositoryAndSubmitResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>
<wsd1:fault message="imp1:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="resumeJob">
<wsd1:input message="impl:resumeJobRequest" name="resumeJobRequest"/>
<wsdl:output message="impl:resumeJobResponse" name="resumeJobResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>

<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
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<wsdl:fault message="1imp1:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="cancelRecurringRequest">

<wsd1:input message="1impl:cancelRecurringRequestRequest"
name="cancelRecurringRequestRequest"/>

<wsdl:output message="impl:cancelRecurringRequestResponse"
name="cancelRecurringRequestResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="getBatchJobRC">
<wsd1:input message="impl:getBatchJobRCRequest" name="getBatchJobRCRequest"/>
<wsdl:output message="impl:getBatchJobRCResponse" name="getBatchJobRCResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="showAllRecurringRequests">

<wsd1:input message="impl:showAl1RecurringRequestsRequest"
name="showAl1RecurringRequestsRequest" />

<wsdl:output message="impl:showAlTRecurringRequestsResponse"
name="showAl1RecurringRequestsResponse" />

<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="showJobFromRepository">

<wsdl:input message="impl:showJobFromRepositoryRequest"
name="showJobFromRepositoryRequest"/>

<wsdl:output message="impl:showJobFromRepositoryResponse"
name="showJobFromRepositoryResponse"/>

<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="impl:InvalidJobNameException" name="InvalidJobNameException"/>
</wsd1:operation>
<wsd1:operation name="getJobOutput">
<wsdl:input message="impl:getJobOutputRequest" name="getJobOutputRequest"/>
<wsd1:output message="impl:getJobOutputResponse" name="getJobOutputResponse"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>

<wsdl:operation name="restartJob">
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<wsd1:input message="impl:restartJobRequest" name="restartJobRequest"/>
<wsdl:output message="impl:restartJobResponse" name="restartJobResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsd1:fault message="1imp1:JobSubmissionException" name="JobSubmissionException"/>
<wsd1:fault message="imp1:JCLException" name="JCLException"/>

</wsd1:operation>

<wsdl:operation name="getRecurringRequestDetails">

<wsdl:input message="1impl:getRecurringRequestDetailsRequest"
name="getRecurringRequestDetailsRequest"/>

<wsdl:output message="impl:getRecurringRequestDetailsResponse"
name="getRecurringRequestDetailsResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="submitDelayedJob">
<wsdl:input message="1imp1:submitDelayedJobRequest" name="submitDelayedJobRequest"/>
<wsd1:output message="imp1:submitDelayedJobResponse" name="submitDelayedJobResponse"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>
<wsd1:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="1imp1:JobSubmissionException" name="JobSubmissionException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="submitDelayedJobFromRepository">

<wsd]:input message="imp1:submitDelayedJobFromRepositoryRequest"
name="submitDelayedJobFromRepositoryRequest"/>

<wsdl:output message="impl:submitDelayedJobFromRepositoryResponse"
name="submitDelayedJobFromRepositoryResponse"/>

<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsd1:fault message="imp1:JCLException" name="JCLException"/>
<wsdl:fault message="imp1l:InvalidJobNameException" name="InvalidJobNameException"/>

</wsd1:operation>
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<wsdl:operation name="cancelJob">
<wsd1:input message="impl:cancelJobRequest" name="cancelJobRequest"/>
<wsdl:output message="impl:cancelJobResponse" name="cancelJobResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsd1:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsd1:fault message="impl:SchedulerException" name="SchedulerException"/>

</wsd1:operation>

<wsdl:operation name="forcedCancelJob">
<wsd1:input message="impl:forcedCancelJobRequest" name="forcedCancelJobRequest"/>
<wsd1:output message="imp1:forcedCancelJobResponse" name="forcedCancelJobResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

</wsd1:operation>

<wsdl:operation name="submitRecurringRequestFromRepository">

<wsd1:input message="imp1:submitRecurringRequestFromRepositoryRequest"
name="submitRecurringRequestFromRepositoryRequest"/>

<wsdl:output message="imp1:submitRecurringRequestFromRepositoryResponse"
name="submitRecurringRequestFromRepositoryResponse"/>

<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidIntervalException" name="InvalidIntervalException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsd1:fault message="imp1:JCLException" name="JCLException"/>

<wsdl:fault message="imp1l:InvalidJobNameException" name="InvalidJobNameException"/>
</wsd1:operation>
<wsdl:operation name="removeJobFromRepository">

<wsdl:input message="1impl:removeJobFromRepositoryRequest"
name="removeJobFromRepositoryRequest"/>

<wsd1:output message="impl:removeJobFromRepositoryResponse"
name="removeJobFromRepositoryResponse"/>

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1l:InvalidJobNameException" name="InvalidJobNameException"/>
</wsd1:operation>
<wsd1:operation name="purgeJob">

<wsdl:input message="impl:purgeJobRequest" name="purgeJobRequest"/>
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<wsdl:output message="impl:purgeJobResponse" name="purgeJobResponse"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="submitRecurringRequest">

<wsdl:input message="impl:submitRecurringRequestRequest"
name="submitRecurringRequestRequest"/>

<wsd1:output message="impl:submitRecurringRequestResponse"
name="submitRecurringRequestResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidIntervalException" name="InvalidIntervalException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>

</wsd1:operation>

<wsdl:operation name="showRecurringJobs">
<wsd1:input message="imp1:showRecurringJobsRequest" name="showRecurringJobsRequest"/>
<wsd1:output message="impl:showRecurringJobsResponse" name="showRecurringJobsResponse"/>
<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsd1:fault message="imp1l:SchedulerException" name="SchedulerException"/>

</wsd1:operation>

<wsd1:operation name="getJobDetails">
<wsd1:input message="impl:getJobDetailsRequest" name="getJobDetailsRequest"/>
<wsdl:output message="impl:getJobDetailsResponse" name="getJobDetailsResponse"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>

</wsd1:operation>

<wsdl:operation name="submitModifiableJobFromRepository">

<wsdl:input message="impl:submitModifiableJobFromRepositoryRequest"
name="submitModifiableJobFromRepositoryRequest"/>

<wsd]:output message="imp1:submitModifiableJobFromRepositoryResponse"
name="submitModifiableJobFromRepositoryResponse"/>

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>
<wsd1:fault message="imp1:JCLException" name="JCLException"/>

<wsdl:fault message="imp1l:InvalidJobNameException" name="InvalidJobNameException"/>

</wsd1:operation>
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<wsd]:operation name="submitModifiableJob">

<wsd]:input message="imp1:submitModifiableJobRequest"
name="submitModifiableJobRequest"/>

<wsd1:output message="imp1:submitModifiableJobResponse"
name="submitModifiableJobResponse"/>

<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>
<wsdl:fault message="imp1:JCLException" name="JCLException"/>

</wsd1:operation>

<wsdl:operation name="saveModifiableDelayedJobToRepositoryAndSubmit">

<wsdl:input message="impl:saveModifiableDelayedJobToRepositoryAndSubmitRequest"
name="saveModifiableDelayedJobToRepositoryAndSubmitRequest"/>

<wsd]:output message="impl:saveModifiableDelayedJobToRepositoryAndSubmitResponse"
name="saveModifiableDelayedJobToRepositoryAndSubmitResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsd1:fault message="impl:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="1imp1:JobSubmissionException" name="JobSubmissionException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsd1:fault message="impl:JCLException" name="JCLException"/>
</wsd1:operation>
<wsd]:operation name="saveModifiableJobToRepositoryAndSubmit">

<wsd]:input message="impl:saveModifiableJobToRepositoryAndSubmitRequest"
name="saveModifiableJobToRepositoryAndSubmitRequest"/>

<wsd1:output message="impl:saveModifiabledobToRepositoryAndSubmitResponse"
name="saveModifiableJobToRepositoryAndSubmitResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>
<wsd1:fault message="imp1:JCLException" name="JCLException"/>

</wsd1:operation>

<wsd]:operation name="submitModifiableDelayedJob">

<wsd]:input message="imp1:submitModifiableDelayedJobRequest"
name="submitModifiableDelayedJobRequest"/>

<wsdl:output message="impl:submitModifiableDelayedJobResponse"
name="submitModifiableDelayedJobResponse"/>

<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>
<wsdl:fault message="imp1:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>
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<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="submitModifiableDelayedJobFromRepository">

<wsdl:input message="impl:submitModifiableDelayedJobFromRepositoryRequest"
name="submitModifiableDelayedJobFromRepositoryRequest"/>

<wsd1:output message="impl:submitModifiableDelayedJobFromRepositoryResponse"
name="submitModifiableDelayedJobFromRepositoryResponse"/>

<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>
<wsd1:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="imp1:JobSubmissionException" name="JobSubmissionException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="imp1:JCLException" name="JCLException"/>

<wsdl:fault message="imp1:InvalidJobNameException" name="InvalidJobNameException"/>
</wsd1:operation>
<wsd1:operation name="submitModifiableRecurringRequestFromRepository">

<wsd1:input message="imp1:submitModifiableRecurringRequestFromRepositoryRequest"
name="submitModifiableRecurringRequestFromRepositoryRequest"/>

<wsdl:output message="imp1:submitModifiableRecurringRequestFromRepositoryResponse"
name="submitModifiableRecurringRequestFromRepositoryResponse"/>

<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidIntervalException" name="InvalidIntervalException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsd1:fault message="imp1:JCLException" name="JCLException"/>

<wsdl:fault message="imp1l:InvalidJobNameException" name="InvalidJobNameException"/>
</wsd1:operation>
<wsdl:operation name="submitModifiableRecurringRequest">

<wsdl:input message="impl:submitModifiableRecurringRequestRequest"
name="submitModifiableRecurringRequestRequest"/>

<wsdl:output message="impl:submitModifiableRecurringRequestResponse"
name="submitModifiableRecurringRequestResponse" />

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidIntervalException" name="InvalidIntervalException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>

<wsdl:fault message="impl:InvalidStartDateTimeFormatException"
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name="InvalidStartDateTimeFormatException"/>
<wsd1:fault message="imp1:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="modifyModifiableRecurringRequest">

<wsd1:input message="imp1l:modifyModifiableRecurringRequestRequest"
name="mod1ifyModifiableRecurringRequestRequest" />

<wsd1:output message="impl:modifyModifiableRecurringRequestResponse"
name="mod1ifyModifiableRecurringRequestResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidIntervalException" name="InvalidIntervalException"/>
<wsdl:fault message="impl:StaleTimeException" name="StaleTimeException"/>

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>

<wsd]:fault message="impl:InvalidStartDateTimeFormatException"
name="InvalidStartDateTimeFormatException"/>

<wsdl:fault message="impl:JCLException" name="JCLException"/>
</wsd1:operation>
<wsd1:operation name="stopJob">
<wsd1:input message="impl:stopJobRequest" name="stopJobRequest"/>
<wsd1:output message="impl:stopJobResponse" name="stopJobResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="getJobsName">
<wsd1:input message="impl:getJobsNameRequest" name="getJobsNameRequest"/>
<wsdl:output message="impl:getJobsNameResponse" name="getJobsNameResponse"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="getSymbolicVariables">

<wsdl:input message="impl:getSymbolicVariablesRequest"
name="getSymbolicVariablesRequest"/>

<wsdl:output message="impl:getSymbolicVariablesResponse"
name="getSymbolicVariablesResponse"/>

<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
<wsdl:fault message="impl:JCLException" name="JCLException"/>
</wsd1:operation>
<wsdl:operation name="getJobLog">
<wsd1:input message="impl:getJobLogRequest" name="getJobLogRequest"/>

<wsd1:output message="impl:getJobLogResponse" name="getJobLogResponse"/>
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<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="getLogMetaData">
<wsd1:input message="impl:getLogMetaDataRequest" name="getLogMetaDataRequest"/>
<wsd1:output message="impl:getLogMetaDataResponse" name="getLogMetaDataResponse"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="getlLogPartList">
<wsdl:input message="impl:getLogPartListRequest" name="getLogPartListRequest"/>
<wsdl:output message="impl:getLogPartListResponse" name="getLogPartListResponse"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="getLogPart">
<wsd1:input message="impl:getLogPartRequest" name="getLogPartRequest"/>
<wsd1:output message="impl:getLogPartResponse" name="getlLogPartResponse"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="getlLogSize">
<wsdl:input message="1impl:getLogSizeRequest" name="getLogSizeRequest"/>
<wsdl:output message="impl:getLogSizeResponse" name="getlLogSizeResponse"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="getLogAge">
<wsd1:input message="impl:getLogAgeRequest" name="getLogAgeRequest"/>
<wsd1:output message="impl:getLogAgeResponse" name="getlLogAgeResponse"/>

<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
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<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="getJobsByClass">
<wsd1:input message="impl:getJobsByClassRequest" name="getJobsByClassRequest"/>
<wsd1:output message="impl:getJobsByClassResponse" name="getJobsByClassResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="removeJoblLog">
<wsd1:input message="1impl:removeJoblLogRequest" name="removeJobLogRequest"/>
<wsdl:output message="1imp1:removeJobLogResponse" name="removeJobLogResponse"/>
<wsdl:fault message="impl:InvalidJobIDException" name="InvalidJobIDException"/>
<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="purgeJoblLog">
<wsdl:input message="1impl:purgeJobLogRequest" name="purgeJoblLogRequest"/>
<wsdl:output message="impl:purgeJoblLogResponse" name="purgeJobLogResponse"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="getAdminAddresses">
<wsdl:input message="impl:getAdminAddressesRequest" name="getAdminAddressesRequest"/>
<wsd1:output message="impl:getAdminAddressesResponse" name="getAdminAddressesResponse"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsd1:operation name="getJobLogMetaDataByAgeForClass">

<wsd1:input message="impl:getJoblLogMetaDataByAgeForClassRequest"
name="getJobLogMetaDataByAgeForClassRequest"/>

<wsd1:output message="impl:getJobLogMetaDataByAgeForClassResponse"
name="getJoblLogMetaDataByAgeForClassResponse"/>

<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="imp1l:SchedulerException" name="SchedulerException"/>

</wsdl1:operation>
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<wsdl:operation name="getJobLogMetaDataBySizeForClass">

<wsdl:input message="imp1l:getJobLogMetaDataBySizeForClassRequest"
name="getJobLogMetaDataBySizeForClassRequest"/>

<wsdl:output message="impl:getJobLogMetaDataBySizeForClassResponse"
name="getJoblLogMetaDataBySizeForClassResponse" />

<wsd1:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsd1:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="quiescelLogging">
<wsd1:input message="impl:quiescelLoggingRequest" name="quiescelLoggingRequest"/>
<wsd1:output message="impl:quiescelLoggingResponse" name="quiescelLoggingResponse"/>
<wsdl:fault message="imp1l:InvalidJobIDException" name="InvalidJobIDException"/>
<wsdl:fault message="impl:InvalidOperationException" name="InvalidOperationException"/>
<wsdl:fault message="impl:SchedulerException" name="SchedulerException"/>
</wsd1:operation>
<wsdl:operation name="sendCheckpointNotification">

<wsd]:input message="impl:sendCheckpointNotificationRequest"
name="sendCheckpointNotificationRequest"/>

<wsdl:output message="impl:sendCheckpointNotificationResponse"
name="sendCheckpointNotificationResponse"/>

</wsd1:operation>
</wsdl1:portType>
<wsd1:binding name="JobSchedulerSoapBinding" type="imp1l:JobScheduler">
<wsdlsoap:binding style="document" transport="http://schemas.xmlsoap.org/soap/http"/>
<wsdl:operation name="submitJobFromRepository">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="submitJobFromRepositoryRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsdl:output name="submitJobFromRepositoryResponse">
<wsdlsoap:body use="Tliteral"/>
</wsd1:output>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="1literal"/>

</wsdl:fault>

Chapter 4. Developing batch applications 129



130

<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="submitJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="submitJobRequest">
<wsd1soap:body use="literal"/>
</wsd1:input>
<wsd1:output name="submitJobResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="1iteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd]:operation name="showAl1Jobs">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="showAllJobsRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd]:output name="showAllJobsResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="1iteral"/>

</wsdl:fault>
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</wsd1:operation>
<wsd1:operation name="saveJobToRepository">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="saveJobToRepositoryRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="saveJobToRepositoryResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsd1:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsd1:operation name="suspendJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="suspendJobRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="suspendJobResponse">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsd]:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Titeral"/>
</wsdl:fault>
<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>

</wsdl:fault>
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</wsd1:operation>
<wsd1:operation name="modifyRecurringRequest">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="modifyRecurringRequestRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="modifyRecurringRequestResponse">
<wsdlsoap:body use="Titeral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidIntervalException">
<wsdlsoap:fault name="InvalidIntervalException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="saveDelayedJobToRepositoryAndSubmit">
<wsdlsoap:operation soapAction=""/>
<wsd]:input name="saveDelayedJobToRepositoryAndSubmitRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsdl:output name="saveDelayedJobToRepositoryAndSubmitResponse">
<wsdlsoap:body use="literal"/>

</wsdl:output>
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<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="litera
</wsdl:fault>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="Tliteral"/>
</wsdl1:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Tliteral"/
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsd1:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" u
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getJobStatus">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getJobStatusRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="getJobStatusResponse'">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsd]:operation name="saveJobToRepositoryAndSubmit">

<wsdlsoap:operation soapAction=""/>

-|||/>

>

se="literal"/>
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<wsd1:input name="saveJobToRepositoryAndSubmitRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="saveJobToRepositoryAndSubmitResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsd1:operation name="resumeJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="resumeJobRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsdl:output name="resumeJobResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="1iteral"/>

</wsdl:fault>
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</wsd1:operation>
<wsdl:operation name="cancelRecurringRequest">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="cancelRecurringRequestRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsd1:output name="cancelRecurringRequestResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getBatchJobRC">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getBatchJobRCRequest">
<wsd1soap:body use="literal"/>
</wsd1:input>
<wsd1:output name="getBatchJobRCResponse'">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="showAl1RecurringRequests">

<wsdlsoap:operation soapAction=""/>
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<wsdl:input name="showAl1RecurringRequestsRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsdl:output name="showAllRecurringRequestsResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsd1:operation name="showJobFromRepository">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="showJobFromRepositoryRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="showJobFromRepositoryResponse'">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsd]:operation name="getJobOutput">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getJobOutputRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd]:output name="getJobOutputResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="literal"/>

</wsdl:fault>
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<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="1literal"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="restartJob">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="restartJobRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsdl:output name="restartJobResponse">
<wsdlsoap:body use="Tliteral"/>
</wsdl:output>
<wsd1:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsd1:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Titeral"/>
</wsdl:fault>
<wsd1:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getRecurringRequestDetails">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getRecurringRequestDetailsRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="getRecurringRequestDetailsResponse">
<wsdlsoap:body use="Tliteral"/>

</wsdl:output>
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<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="submitDelayedJob">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="submitDelayedJobRequest">
<wsd1soap:body use="literal"/>
</wsd1:input>
<wsd1:output name="submitDelayedJobResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>
<wsd1:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Titeral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="submitDelayedJobFromRepository">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="submitDelayedJobFromRepositoryRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
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<wsdl:output name="submitDelayedJobFromRepositoryResponse">
<wsdlsoap:body use="Tliteral"/>
</wsd1:output>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="Tliteral"/>
</wsdl1:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsd1:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="cancelJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="cancelJobRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsd1:output name="cancelJobResponse">
<wsdlsoap:body use="Tliteral"/>
</wsd1:output>
<wsd1:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="literal"/>

</wsdl:fault>
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<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="1iteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="forcedCancelJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="forcedCancelJobRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsdl:output name="forcedCancelJobResponse">
<wsd1soap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsd]:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="1iteral"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>

</wsdl1:operation>

<wsdl:operation name="submitRecurringRequestFromRepository">

<wsdlsoap:operation soapAction=""/>

<wsdl:input name="submitRecurringRequestFromRepositoryRequest">
<wsdlsoap:body use="literal"/>

</wsd1:input>

<wsdl:output name="submitRecurringRequestFromRepositoryResponse">
<wsd1soap:body use="literal"/>

</wsd1:output>

<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>

</wsdl:fault>

<wsdl:fault name="InvalidIntervalException">

<wsdlsoap:fault name="InvalidIntervalException" use="literal"/>
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</wsd1:fault>
<wsdl:fault name="StaleTimeException">

<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">

<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsd1:fault name="JCLException">

<wsdlsoap:fault name="JCLException" use="literal"/>
</wsdl:fault>

<wsdl:fault name="InvalidStartDateTimeFormatException">

<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>

</wsdl:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="Tliteral"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="removeJobFromRepository">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="removeJobFromRepositoryRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd1:output name="removeJobFromRepositoryResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="purgeJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="purgeJobRequest">

<wsdlsoap:body use="1iteral"/>
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</wsd1:input>
<wsdl:output name="purgeJobResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="submitRecurringRequest">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="submitRecurringRequestRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="submitRecurringRequestResponse">
<wsdlsoap:body use="Titeral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidIntervalException">
<wsdlsoap:fault name="InvalidIntervalException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">

<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
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</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="showRecurringJobs">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="showRecurringJobsRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd]:output name="showRecurringJobsResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getJobDetails">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getJobDetailsRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd1:output name="getJobDetailsResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="1iteral"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="submitModifiableJobFromRepository">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="submitModifiableJobFromRepositoryRequest">

<wsdlsoap:body use="1iteral"/>
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</wsd1:input>
<wsd1:output name="submitModifiableJobFromRepositoryResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsd1:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Titeral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="submitModifiableJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="submitModifiableJobRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd1:output name="submitModifiableJobResponse">
<wsdlsoap:body use="literal"/>
</wsd1:output>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="1iteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>

<wsd]:operation name="saveModifiableDelayedJobToRepositoryAndSubmit">
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<wsdlsoap:operation soapAction=""/>
<wsd1:input name="saveModifiableDelayedJobToRepositoryAndSubmitRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="saveModifiableDelayedJobToRepositoryAndSubmitResponse">
<wsdlsoap:body use="Tliteral"/>
</wsd1:output>
<wsd1:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsd1:fault>
<wsd1:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="Tliteral"/>
</wsd1:fault>
</wsd1:operation>
<wsd1:operation name="saveModifiableJobToRepositoryAndSubmit">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="saveModifiableJobToRepositoryAndSubmitRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsdl:output name="saveModifiableJobToRepositoryAndSubmitResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsdl:fault name="InvalidOperationException">

<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
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</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="1iteral"/>
</wsd1:fault>
<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="literal"/>
</wsdl:fault>
<wsd1:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd]:operation name="submitModifiableDelayedJob">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="submitModifiableDelayedJobRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="submitModifiableDelayedJobResponse">
<wsdlsoap:body use="Titeral"/>
</wsdl:output>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsdl:fault>
<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Titeral"/>
</wsd1:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
</wsdl:fault>
</wsd1:operation>

<wsdl:operation name="submitModifiableDelayedJobFromRepository">
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<wsdlsoap:operation soapAction=""/>

<wsd1:input name="submitModifiableDelayedJobFromRepositoryRequest">
<wsdlsoap:body use="1iteral"/>

</wsd1:input>

<wsdl:output name="submitModifiableDelayedJobFromRepositoryResponse">
<wsdlsoap:body use="Tliteral"/>

</wsd1:output>

<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>

</wsdl:fault>

<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>

</wsdl:fault>

<wsdl:fault name="JobSubmissionException">
<wsdlsoap:fault name="JobSubmissionException" use="Tliteral"/>

</wsd1:fault>

<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="1literal"/>

</wsd1:fault>

<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>

</wsdl:fault>

<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="Titeral"/>

</wsd1:fault>

</wsd1:operation>
<wsd1:operation name="submitModifiableRecurringRequestFromRepository">

<wsdlsoap:operation soapAction=""/>

<wsdl:input name="submitModifiableRecurringRequestFromRepositoryRequest">
<wsdlsoap:body use="Tliteral"/>

</wsd1:input>

<wsdl:output name="submitModifiableRecurringRequestFromRepositoryResponse">
<wsdlsoap:body use="1iteral"/>

</wsd1:output>

<wsdl:fault name="InvalidOperationException">

<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
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</wsdl:fault>
<wsdl:fault name="InvalidIntervalException">
<wsdlsoap:fault name="InvalidIntervalException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobNameException">
<wsdlsoap:fault name="InvalidJobNameException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsd1:operation name="submitModifiableRecurringRequest">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="submitModifiableRecurringRequestRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="submitModifiableRecurringRequestResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidIntervalException">
<wsdlsoap:fault name="InvalidIntervalException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="StaleTimeException">

<wsdlsoap:fault name="StaleTimeException" use="1iteral"/>
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</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">
<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="modifyModifiableRecurringRequest">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="modifyModifiableRecurringRequestRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsd1:output name="modifyModifiableRecurringRequestResponse">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidIntervalException">
<wsdlsoap:fault name="InvalidIntervalException" use="Tliteral"/>
</wsd1:fault>
<wsdl:fault name="StaleTimeException">
<wsdlsoap:fault name="StaleTimeException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="Tliteral"/>
</wsd1:fault>
<wsdl:fault name="InvalidStartDateTimeFormatException">

<wsdlsoap:fault name="InvalidStartDateTimeFormatException" use="literal"/>
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</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="stopJob">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="stopJobRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsd]:output name="stopJobResponse">
<wsdlsoap:body use="literal"/>
</wsd1:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsd1l:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getJobsName">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getJobsNameRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd]:output name="getJobsNameResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="T1iteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="getSymbolicVariables">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getSymbolicVariablesRequest">

<wsdlsoap:body use="literal"/>
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</wsd1:input>
<wsdl:output name="getSymbolicVariablesResponse">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
<wsd1:fault name="JCLException">
<wsdlsoap:fault name="JCLException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="getJoblLog">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getJoblLogRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsd]:output name="getJobLogResponse">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsd1:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getLogMetaData">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getLogMetaDataRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="getLogMetaDataResponse'">

<wsdlsoap:body use="1iteral"/>
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</wsdl:output>
<wsd]:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="getlLogPartList">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getLogPartListRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsdl:output name="getLogPartlListResponse">
<wsdlsoap:body use="Titeral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getLogPart">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getLogPartRequest">
<wsdlsoap:body use="literal"/>
</wsdl1:input>
<wsdl:output name="getLogPartResponse">

<wsdlsoap:body use="literal"/>
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</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="getlLogSize">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getlLogSizeRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsd]:output name="getLogSizeResponse">
<wsdlsoap:body use="1iteral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsd1:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getLogAge">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getLogAgeRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="getLogAgeResponse">

<wsdlsoap:body use="1iteral"/>

Chapter 4. Developing batch applications

153



154

</wsdl:output>
<wsd]:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsd]:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="getJobsByClass">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getJobsByClassRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd]:output name="getJobsByClassResponse">
<wsdlsoap:body use="Titeral"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsd1:operation name="removedoblLog">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="removeJoblLogRequest">
<wsd1soap:body use="literal"/>
</wsd1:input>
<wsd1:output name="removeJobLogResponse">
<wsdlsoap:body use="literal"/>
</wsd1:output>
<wsdl:fault name="InvalidOperationException">

<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
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</wsd1:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="literal"/>
</wsd1:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>
<wsdl:operation name="purgedoblLog">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="purgeJobLogRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="purgeJobLogResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsd1:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsd1:fault>
<wsd1:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="Tliteral"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsd1:fault>
</wsd1:operation>
<wsd1:operation name="getAdminAddresses">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="getAdminAddressesRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsdl:output name="getAdminAddressesResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
<wsdl:fault name="InvalidOperationException">

<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
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</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="1iteral"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getJobLogMetaDataByAgeForClass">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getJobLogMetaDataByAgeForClassRequest">
<wsdlsoap:body use="literal"/>
</wsdl1:input>
<wsdl:output name="getJobLogMetaDataByAgeForClassResponse'">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsd1:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="literal"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="getJobLogMetaDataBySizeForClass">
<wsdlsoap:operation soapAction=""/>
<wsd1:input name="getJoblLogMetaDataBySizeForClassRequest">
<wsdlsoap:body use="literal"/>
</wsd1:input>
<wsd1:output name="getJoblLogMetaDataBySizeForClassResponse">
<wsdlsoap:body use="literal"/>
</wsdl:output>
<wsdl:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsdl:fault>
</wsd1:operation>

<wsd1:operation name="quiescelLogging">
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<wsdlsoap:operation soapAction=""/>
<wsdl:input name="quiescelLoggingRequest">
<wsdlsoap:body use="1iteral"/>
</wsd1:input>
<wsdl:output name="quiescelLoggingResponse">
<wsdlsoap:body use="Tliteral"/>
</wsd1:output>
<wsd1:fault name="InvalidOperationException">
<wsdlsoap:fault name="InvalidOperationException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="InvalidJobIDException">
<wsdlsoap:fault name="InvalidJobIDException" use="literal"/>
</wsdl:fault>
<wsdl:fault name="SchedulerException">
<wsdlsoap:fault name="SchedulerException" use="Tliteral"/>
</wsd1:fault>
</wsd1:operation>
<wsdl:operation name="sendCheckpointNotification">
<wsdlsoap:operation soapAction=""/>
<wsdl:input name="sendCheckpointNotificationRequest">
<wsdlsoap:body use="Tliteral"/>
</wsd1:input>
<wsdl:output name="sendCheckpointNotificationResponse">
<wsdlsoap:body use="1iteral"/>
</wsd1:output>
</wsd1:operation>
</wsdl:binding>
<wsdl:service name="JobSchedulerService">
<wsdl:port binding="imp1l:JobSchedulerSoapBinding" name="JobScheduler">

<wsdlsoap:address
location="http://1ocalhost:9080/LongRunningJobScheduleriWebSvcRouter/services/JobScheduler"/>

</wsd1:port>
</wsdl:service>

</wsd1:definitions>
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Chapter 5. Developing applications that use the Bean
Validation API

The Bean Validation API is introduced with the Java Enterprise Edition 6 platform as a standard
mechanism to validate Enterprise JavaBeans in all layers of an application, including, presentation,
business and data access. Before the Bean Validation specification, the JavaBeans were validated in each
layer. To prevent the reimplementation of validations at each layer, developers bundled validations directly
into their classes or copied validation code, which was often cluttered. Having one implementation that is
common to all layers of the application simplifies the developers work and saves time.

Bean Validation

The Bean Validation API is introduced with the Java Enterprise Edition 6 platform as a standard
mechanism to validate JavaBeans in all layers of an application, including presentation, business, and data
access.

Before the Bean Validation specification, JavaBeans were validated in each layer. To prevent the
reimplementation of validations at each layer, developers bundled validations directly into their classes or
copied validation code, which was often cluttered. Having one implementation that is common to all layers
of the application simplifies the developers work and saves time.

The Bean Validation specification defines a metadata model and an API that are used to validate
JavaBeans for data integrity. The metadata source is the constraint annotations defined that can be
overridden and extended using XML validation descriptors. The set of APIs provides an ease of use
programming model allowing any application layer to use the same set of validation constraints. Validation
constraints are used to check the value of annotated fields, methods, and types to ensure that they adhere
to the defined constraint.

Constraints can be built in or user-defined. Several built-in annotations are available in the
javax.validation.constraints package. They are used to define regular constraint definitions and for

composing constraints. For a list of built-in constraints, see the topic, ['Bean validation built-in constraints’]
ﬂ

age 162 | For more details about the Bean Validation metadata model and APIs see the JSR 303 Bean
Validation specification document.

The following example is a simple Enterprise JavaBeans (EJB) class that is decorated with built-in
constraint annotations.
public class Home {

@Size(Max=20)

String builder;

@NotNull @Size(Max=20)

String address;

public String getAddress() f{
return address;
1
public String getBuilder() {
return address;
}
public String setAddress(String newAddress) {

return address = newAddress;
1

public String setBuilder(String newBuilder) {
return builder = newBuilder;
}
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The @Size annotations on builder and address specify that the string value assigned should not be
greater 20 characters. The @NotNull annotation on address indicates that it cannot be null. When the
Home object is validated, the builder and address values are passed to the validator class defined for the
@Size annotation. The address value is also be passed to the @NotNull validator class. The validator
classes handle checking the values for the proper constraints and if any constraint fails validation, a
ConstraintViolation object is created, and is returned in a set to the caller validating the Home object.

Validation APIs

The javax.validation package contains the bean validation APIs that describe how to programmatically
validate JavaBeans.

ConstraintViolation is the class describing a single constraint failure. A set of ConstraintViolation classes is
returned for an object validation. The constraint violation also exposes a human readable message
describing the violation.

ValidationException are raised if a failure happens during validation.

The Validator interface is the main validation APl and a Validator instance is the object that is able to
validate the values of the Java object fields, methods, and types. The bootstrapping API is the mechanism
used to get access to a ValidatorFactory that is used to create a Validator instance. For applications
deployed on the product, bootstrapping is done automatically. There are two ways for applications to get
the validator or the ValidatorFactory. One way is injection, for example, using the @Resource annotation,
and the other way is the java: lookup.

The following example uses injection to obtain a ValidatorFactory and a Validator:

@Resource ValidatorFactory _validatorFactory;
@Resource Validator _validator;

Attention: When using @Resource to obtain a Validator or ValidatorFactory, the authenticationType and
shareable elements must not be specified.

The following example uses JNDI to obtain a ValidatorFactory and a Validator:

ValidatorFactory validatorFactory = (ValidatorFactory)context.lookup("java:comp/ValidatorFactory");
Validator validator = (Validator)context.lookup("java:comp/Validator");

Constraint metadata request APIs

The metadata APIs support tool providers, provides integration with other frameworks, libraries, and Java
Platform, Enterprise Edition technologies. The metadata repository of object constraints is accessed
through the Validator instance of a given class.

XML deployment descriptors
Besides declaring constraints in annotations, support exists for using XML to declare your constraints.

The validation XML description is composed of two kinds of xml files. The META-INF/validation.xml file
describes the bean validation configuration for the module. The other XML file type describes constraints
declarations and closely matches the annotations declaration method. By default, all constraint
declarations expressed through annotations are ignored for classes described in XML. It is possible to
force validation to use both the annotations and the XML constraint declarations by using the
ignore-annotation="false" setting on the bean. The product ensures that application modules deployed
containing a validation.xml file and constraints defined in XML files are isolated from other module
validation.xml and constraint files by creating validator instances specific to the module containing the XML
descriptors.
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Advanced bean validation concepts

The Bean Validation API provides a set of built-in constraints and an interface that enables you to declare
custom constraints. This is accomplished by creating constraint annotations and declaring an annotation
on a bean type, field, or property. Composing constraints is also done by declaring the constant on
another constraint definition.

Custom constraint and validator example

The following example shows creating a CommentChecker constraint that is defined to ensure a comment
string field is not null. The comment text is enclosed by brackets, such as [fex{].

package com.my.company;
import java.lang.annotation.Documented;
import java.lang.annotation.Retention;
import java.lang.annotation.Target;
import static java.lang.annotation.ElementType.METHOD;
import static java.lang.annotation.ElementType.FIELD;
import static java.lang.annotation.RetentionPolicy.RUNTIME;

import javax.validation.Constraint;
import javax.validation.Payload;
@Documented
@Constraint(validatedBy = CommentValidator.class)
@Target({ METHOD, FIELD })
@Retention (RUNTIME)
public @interface CommentChecker {
String message() default "The comment is not valid.";
Class<?>[] groups() default {};
Class<? extends Payload>[] payload() default {};
.

The next example shows the constraint validator that handles validating elements with the
@CommentChecker annotation. The constraint validator implements the ConstraintValidator interface
provided by the Bean Validation API.

package com.my.company

import javax.validation.ConstraintValidator;

import javax.validation.ConstraintValidatorContext;

public class CommentValidator implements ConstraintValidator<CommentChecker, String> {
public void initialize(CommentChecker arg0) {

public boolean isValid(String comment, ConstraintValidatorContext context) {
if (comment == null) {
// Null comment is not allowed, fail the constraint.
return false;
}
if (!comment.contains("[") && !comment.contains("]")) {
// Can't find any open or close brackets, fail the constraint
return false;
}
// Ignore leading and trailing spaces
String trimmedComment = comment.trim();
return // validate '[' prefix condition
trimmedComment.charAt(0) == '[' &&
// validate ']' suffix condition
trimmedComment.charAt (trimmedComment.size()-1) == ']"';

}

After the @ CommentChecker is defined, it can be used to ensure that the comment string field is a valid
comment based on the CommentValidator isValid() implementation. The following example shows the use
of the @ CommentChecker constraint. When the myChecker bean is validated, the comment string is
validated by the CommentValidator class to ensure the constraints defined are met.
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package com.my.company;
public myChecker {

@CommentChecker
String comment = null;

}
Using a different bean validation provider

The product provides a specific bean validation provider, but it might be necessary for an application to
use or require another provider.

This method can be accomplished by using the validator methods to set the provider programmatically and
create a validation factory. Or, by using the validation.xml default-provider element. The specific provider
that is defined and used to create the validation factory and not the default provider provided by the
application server in the default implementation. If you want to ensure that the user-provided
implementation does not conflict with the default implementation, the server or application class loading
parameter, the class loader order should be set to be loaded with local class loader first (parent last). See
additional information in the class loading documentation on how to set this setting.

Validation.xml deployment descriptor and class loading

The Bean Validation specification indicates that if more than one validation.xml file is found in the class
path, a ValidationException occurs. However, WebSphere Application Server supports an environment
where multiple teams develop modules that are assembled and deployed into the Application Server
together. In this environment, all EJB modules within an application are loaded with the same class loader
and it is possible to configure the application class loaders so that all EJB and web archive (WAR)
modules are loaded by a single class loader. Because of this, the product provides support for multiple
validation.xml files in the same class path.

When an application using bean validation and XML descriptors contains multiple EJB modules and web
modules, each validation.xml file is associated with a validation factory that is specific to that module. In
this environment, any constraint-mapping elements that are defined are only looked up in the module
where the validation.xml file is defined. For example, if an EJB module building.jar contains a
META-INF/validation.xml file and the validation.xml file defined the following constraints, both the
META-INF/constraints-house.xml and META-INF/constraints-rooms.xml files must also be located in the
building.jar file:

<constraint-mapping>META-INF/constraints-house.xml</constaint-mapping>
<constraint-mapping>META-INF/constraints-rooms.xml</constraint-mapping>

The exception to this behavior is when all bean validation constraints classes and configuration are visible
to all application modules. It is the case where a single validation.xml file is defined in an EAR file and no
other validation.xml files are visible a modules class path. In this environment any module creating a
validator factory or validator uses the same validation.xml file. This makes it possible for other modules to
create a validator factory that uses the validation.xml file of another module as long the class path has
been configured so that both modules are visible on the same class path and only one validation.xml file is
visible.

For a more detailed understanding about the Bean Validation APIs and metadata see the JSR 303 Bean
Validation specification document.

Bean validation built-in constraints

Use this information to look up information about Bean Validation API built-in constraints.
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The Bean Validation API is supported by constraints that are primarily expressed through annotations. The
constraints are added to a class, field, or method of an Enterprise JavaBeans (EJB) component. The
annotated element value is checked by the constraint.

Constraints can be built in or user defined. Several built-in annotations are available in the
javax.validation.constraints package. They are used to define regular constraint definitions and for
composing constraints.

The following table is a list of constraints and usage.

Table 37. Bean validation built-in constraints. Bean validation built-in constraints

Constraint Usage

@Null Specifies that the configuration property decorated with this annotation must have a null value. This constraint
accepts any type.

@NotNull Specifies that the configuration property decorated with this annotation must not have a null value. That is, the
property is required. This constraint accepts any type.

@AssertTrue Specifies that the configuration property decorated with this annotation must be true. Supported value types are
boolean and Boolean. Null elements are considered valid.

@AssertFalse Specifies that the configuration property decorated with this annotation must be false. Supported value types are
boolean and Boolean. Null elements are considered valid.

@Min Specifies that the configuration property decorated with this annotation must have a value greater than or equal to
the specified minimum. Supported value types are BigDecimal, Biglnteger, byte, short, int, long and their
respective wrappers. Null elements are considered valid.

@Max Specifies that the configuration property decorated with this annotation must have a value less than or equal to
the specified maximum. Supported value types are BigDecimal, Biginteger, byte, short, int, long and their
respective wrappers. Null elements are considered valid.

@DecimalMin Specifies that the configuration property decorated with this annotation must have a value higher or equal to the
specified minimum. Supported value types are BigDecimal, Biglnteger, String, byte, short, int, long and their
respective wrappers. Null elements are considered valid.

@DecimalMax Specifies that the configuration property decorated with this annotation must have a value lower or equal to the
specified maximum. Supported value types are BigDecimal, Biginteger, String, byte, short, int, long and their
respective wrappers. Null elements are considered valid.

@Size Specifies that the configuration property decorated with this annotation must have a value between the specified
boundaries (included). Supported value types are String (string length is evaluated), Collection (collection size is
evaluated), Map (map size is evaluated), Array (array length is evaluated). Null elements are considered valid.

@Digits Specifies that the configuration property decorated with this annotation must have a value within accepted range.
Supported value types are BigDecimal, Biginteger, String, byte, short, int, long and their respective wrappers. Null
elements are considered valid.

@Past Specifies that the configuration property decorated with this annotation must have a date in the past. Now is
defined as the current time according to the virtual machine. The calendar is used if the compared type is of type
Calendar and the calendar is based on the current timezone and the current locale. Supported value types are
java.util.Date, java.util.Calendar. Null elements are considered valid.

@Future Specifies that the configuration property decorated with this annotation must have a date in the future. Now is
defined as the current time according to the virtual machine. The calendar is used if the compared type is of type
Calendar and the calendar is based on the current timezone and the current locale. Supported value types are
java.util.Date, java.util.Calendar. Null elements are considered valid.

@Pattern Specifies that the configuration property decorated with this annotation must match the following regular
expression. The regular expression follows the Java regular expression conventions java.util.regex.Pattern.
Supported type value is String. Null elements are considered valid.

Using bean validation in the product

The Java Enterprise Edition (Java EE) 6 specification includes the Bean Validation API that is a standard
mechanism for validating JavaBeans in all layers of an application.

About this task

Before the Bean Validation specification, JavaBeans were validated in each layer. To prevent the
reimplementation of validations at each layer, developers bundled validations directly into their classes or
copied validation code, which was often cluttered. Having one implementation that is common to all layers
of the application simplifies the developers work and saves time.
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Bean validation is common to all layers of an application. Specifically, web applications have the following
layers:

* Presentation

This layer represents how the user interacts with the application and might be built on a thin client or
rich client.

¢ Business

This layer coordinates the application, processes commands, makes logical decisions and evaluations
and performs calculations. It also moves and processes data between the two other layers. The EJB
contains business logic in WebSphere Application Server.

e Data access

Your data is stored and retrieved from a database or file system at this layer. The business layer
processes the data and sends it in usable form to the user interface. WebSphere Application Server
supports several databases and methods of retrieving data. This layer also defines persistence.

For WebSphere Application Server, these layers are built and administered with several components in the
product that are necessary for developing and deploying applications.

Note: The product provides support for the Bean Validation API in the Java Platform, Enterprise Edition
(Java EE) environment by providing a bean validation service in multiple Java EE technologies
including Java Servlets, Enterprise JavaBeans, Java Persistence API (JPA) 2.0, Java EE Connector
API (JCA) 1.6 and Java ServerFaces (JSF) 2.0. Bean validation provides these technologies a way
to maintain data integrity in an integrated and standard environment.

Enterprise application development involves multiple teams developing numerous applications and
modules that are assembled and deployed in an application server environment. The product ensures that
each application and module data is validated independently. Validation is performed using only the
constraints defined for the application and module.

What to do next
+ Data access resources:
[Bean validation in RAR modules}

The product validates resource adapter archive (RAR) Enterprise JavaBeans (EJB) constraints in
compliance with the JCA version 1.6 specification. Resource adapters can use the built-in bean
validation constraint annotations or provide a bean validation XML configuration to specify the validation
requirements of resource adapter configuration properties to the application server.

« [Using bean validation in JPA|
A new feature defined by the JPA 2.0 specification is the ability to seamlessly integrate with the Bean
Validation API. With minimal effort, JPA 2.0 can be coupled with the validation provider for runtime data
validation. By combining these two technologies, you get a standardized persistence solution with the
added ability to perform standardized data validation.

* Using bean validation with JSF
JSF previously was able do bean validation, but now it provides built-in support of the Bean Validation
specification.

» Using bean validation in web container
The web container provides an instance of ValidatorFactory and makes it available to JSF
implementations by storing it in a servlet context attribute named
javax.faces.validator.beanValidator.ValidatorFactory.

* Using bean validation with the embeddable container.

To use bean validation with the embeddable EJB container, the javax.validation classes must exist in
the class path. That can be done in one of two ways:
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— Include the JPA thin client that is located in the directory ${WAS INSTALL ROOT}\runtimes\
com.ibm.ws.jpa.thinclient 8.0.0.jar in the class path. See the topic, [Running an embeddable]
and the information about JPA, for more information.

— Include a third party bean validation provider Java archive (JAR) file in the class path of the
embeddable EJB container run time.

Bean validation in RAR modules

WebSphere Application Server validates resource adapter archive (RAR) JavaBeans constraints in
compliance with the Java Connector Architecture (JCA) version 1.6 specification.

Resource adapters can specify the validation requirements of configuration properties to the Application
Server through annotations in the source code of the resource adapter, constraint specifications in a
resource adapter validation descriptor, or a mixture of both. In specifying these constraints, resource
adapters can use the built-in bean validation constraints supplied with the Application Server, custom bean
validation constraints supplied either by the application developer or a third party, or a mixture of both.
Resource adapter developers can apply constraints to the fields and JavaBeans-compliant properties of
the following JCA types:

* ResourceAdapter

* ManagedConnectionFactory
* ActivationSpec

* AdministeredObject

At run time, the application server creates instances of bean types declared by the resource adapter. Each
instance is validated immediately upon setting its configuration properties, before placing the instance into
service.

When validating a RAR bean, the Application Server creates an instance of a validator factory according to
the bean validation deployment descriptor discovered by the Application Server. A validator instance is
then obtained from the factory and used to validate the bean instance.

If validation fails, the Application Server throws a constraint violation exception and reports all violations to
the system log. The effects of the exception for each RAR bean type and problem determination
information are documented in the topic, Troubleshooting bean validation in RAR modules.

Note: The Bean Validation specification requires that no more than one validation.xml is visible on the
class path. This requirement is violated whenever two or more stand-alone RARs provide a
validation descriptor. See the section, "RAR bean validation descriptor" in this topic, for more
information. When more than one validation.xml is visible to the Application Server class loaders,
the Application Server or application modules might fail to acquire the default ValidatorFactory and
subsequently cannot perform bean validation. For example, the server cannot validate beans of a
RAR embedded in an application whenever the embedded RAR lacks a validation configuration,
and two or more stand-alone RARs provide configurations. To avoid trouble, install stand-alone
RARs that provide a bean validation descriptor as isolated whenever possible.

Built-in constraint annotations

Note: Use built-in constraint annotations to specify the range and mandatory attributes of configuration
properties rather than provide custom annotations for the same purpose. The following constraints
are useful, but you can use all bean validation built-in constraints. See the topic [Bean validatio
built-in constraints|for a complete list of the constraints.

*+ @Min

Specifies the minimum value of the configuration property decorated with this annotation. The value
must be greater than or equal to the specified minimum.

* @Max
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Specifies the maximum value of the configuration property decorated with this annotation. The value
must less than or equal to the specified maximum.

* @Size
Specifies the range of values of the configuration property decorated with this annotation. The value

must be greater than or equal to the specified minimum and be less than or equal to the specified
maximum.

e @NotNull

Specifies the value of the configuration property decorated with this annotation must not be null. That is,
the property is required.

The following example is a RAR bean class that is decorated with built-in constraint annotations.

The value of the serverName configuration property must not be null, and the value of the instanceCount
property must be at least 1 when the Application Server creates and configures an instance of the
MyConnector class. Otherwise, a constraint validation exception occurs and, in the case of
ResourceAdapter bean, the resource adapter fails to start. See the topic Troubleshooting bean validation
in RAR modules for more information.

package com.my.company;

@Connector(...)
public class MyConnector implements ResourceAdapter, Serializable

@ConfigProperty(type=java.lang.String.class,defaultValue="WAS")
private String serverName;

@NotNul1()
public String getServerName() {return serverName;}

private Integer instanceCount = 0;

@Min(value=1)
public Integer getInstanceCount() {return instanceCount;}

RAR bean validation descriptor

Bean validation constraints can be declared through an XML descriptor supplied by a RAR module. In the
simplest case, a RAR validation descriptor consists of the validation configuration declared in the
validation.xml file and zero or more XML files that declare RAR bean validation constraints. Files
containing constraint declarations are specified in the constraint-mapping elements of the validation
configuration (validation.xml).

You must package the validation descriptor in the META-INF directory of a RAR module. Any custom
constraint annotation classes that are declared in the validation descriptor must also be packaged in the
RAR module.

The following example is a simple RAR validation descriptor that declares constraint metadata like the
code shown in the section, "Built-in constraint annotations."

<?xml version="1.0" encoding="UTF-8"?>
<validation-config
xmins="http://jboss.org/xml/ns/javax/validation/configuration"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://jboss.org/xml/ns/javax/validation/configuration validation-configuration-1.0.xsd">
<constraint-mapping>META-INF/constraints.xml</constraint-mapping>
</validation-config>

The constraints XML file is also located in the META-INF directory and looks like the following:

<constraint-mappings
xmins="http://jboss.org/xml/ns/javax/validation/mapping"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://jboss.org/xml/ns/javax/validation/mapping validation-mapping-1.0.xsd">
<default-package>com.my.company</default-package>
<bean class="MyConnector" ignore-annotations="true">
<field name="serverName">
<valid/>
<!-- @NotNull() -->
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<constraint annotation="javax.validation.constraints.NotNull">
<message>Value is not null</message>
</constraint>
</field>
<field name="instanceCount">
<valid/>
<l-- @Min(1) -->
<constraint annotation="javax.validation.constraints.Min">
<message>Minimum possible value is l</message>
<element name="value">1</element>
</constraint>
</field>
</bean>
<constraint-mapping>

The packaged RAR module, MyResourceAdapter.rar, looks like the following:

my/
company/
MyConnector.class

META-INF
/validation.xml
/constraints.xml

Third-party bean validation

WebSphere Application Server supports using different bean validation implementations. If a resource
adapter requires a bean validation implementation different from the implementation that is provided by the
product, and the RAR provides the bean validation implementation, you must package the JAR file that
contains the bean validation implementation in the RAR module root directory.

The RAR module must also contain a single validation configuration descriptor (validation.xml), which
can be packaged in the META-INF directory of the RAR module, or in the META-INF/services directory of
the bean validation JAR file, but not both.

RAR bean validation configuration discovery

When validating RAR beans, the Application Server bootstraps the bean validation configuration, specific
to the RAR, according to the bean validation descriptor supplied in the RAR META-INF directory. If the
descriptor does not exist, the server bootstraps the configuration using the first validation descriptor
discovered in the RAR class loading context, such as that supplied in a third-party bean validation that is
packaged in the RAR. Finally, the server uses the default validation configuration provided by the product.

The server then creates a validator factory specific to the discovered bean validation configuration and
uses this factory to create validator instances for validating the RAR bean instances. When you deploy a
RAR that supplies a bean validation descriptor, you must take additional steps to ensure that the class
loader that loads the RAR loads the bean validation descriptor and classes packaged in the RAR.

For an embedded RAR, after you have deployed the application that embeds the RAR, you must set the
delegation mode of the application class loader to Parent-Last (Child-First). See the topic Configuring
application class loaders for more information.

For a stand-alone RAR, you must install the RAR as an isolated resource provider. See the topic
Resource Adapter settings for more information.

Bean validation in JPA

Data validation is a common task that occurs in all layers of an application, including persistence. The
Java Persistence API (JPA) 2.0 provides support for the Bean Validation API so that data validation can be
done at run time. This topic includes a usage scenario where bean validation is used in the JPA
environment of a sample digital image gallery application.
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The Bean Validation API provides seamless validation across technologies on Java Enterprise Edition 6
(Java EE 6) and Java Platform, Standard Edition (JSE) environments. In addition to JPA 2.0, these
technologies include JavaServer Faces (JSF) 2.0 and Java EE Connector Architecture (JCA) 1.6. You can
read more about bean validation in the topic, Bean Validation API.

There are three core concepts of bean validation: constraints, constraint violation handling, and the
validator. If you are running applications in an integrated environment like JPA, there is no need to
interface directly with the validator.

Validation constraints are annotations or XML code that are added to a class, field, or method of a
JavaBeans component. Constraints can be built in or user-defined. They are used to define regular
constraint definitions and for composing constraints. The built-in constraints are defined by the bean
validation specification and are available with every validation provider. For a list of built-in constraints, see
the topic, Bean validation built-in constraints. If you need a constraint different from the built-in constraints,
you can build your own user-defined constraint.

Constraints and JPA

The following usage scenario illustrates how a built-in constraint is used in the JPA architecture of a
sample digital image gallery application.

In the first code example, a built-in constraint is added to a simple entity of the JPA model called image.
An image has an ID, image type, file name, and image data. The image type must be specified and the
image file name must include a valid JPEG or GIF extension. The code shows the annotated image entity
with some built-in bean validation constraints applied.

package org.apache.openjpa.example.gallery.model;

import javax.persistence.Entity;

import javax.persistence.EnumType;

import javax.persistence.Enumerated;

import javax.persistence.GeneratedValue;
import javax.persistence.Id;

import javax.validation.constraints.NotNull;
import javax.validation.constraints.Pattern;

@Entity
public class Image {

private long id;

private ImageType type;
private String fileName;
private byte[] data;

@Id

@GeneratedValue

public Tong getId() {
return id;

!

public void setId(long id) {
this.id = id;
1

@NotNul1(message="Image type must be specified.")
@Enumerated (EnumType.STRING)
public ImageType getType() {
return type;
1

public void setType(ImageType type) {
this.type = type;
1
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@Pattern(regexp = ".*\\.jipg|.*\\.jpeg|.*\\.gif",
message="0Only images of type JPEG or GIF are supported.")
public String getFileName() f{
return fileName;
}

public void setFileName(String fileName) {
this.fileName = fileName;
}

public byte[] getData() {
return data;
!

public void setData(byte[] data) {
this.data = data;
}

}

The Image class uses two built-in constraints, @ NotNull and @Pattern. The @NotNull constraint ensures
that an ImageType element is specified and the @Pattern constraint uses regular expression pattern
matching to ensure that the image file name is suffixed with a supported image format. Each constraint
has corresponding validation logic that gets started at run time when the image entity is validated. If either
constraint is not met, the JPA provider throws a ConstraintViolationException with the defined message.
The JSR-303 specification also makes provisions for the use of a variable within the message attribute.
The variable references a keyed message in a resource bundle. The resource bundle supports
environment-specific messages and globalization, translation, and multicultural support of messages.

You can create your own custom validator and constraints. In the previous example, the Image entity used
the @Pattern constraint to validate the file name of the image. However, it did not check constraints on the
actual image data itself. You can use a pattern-based constraint; however, you do not have the flexibility
that you would if you created a constraint specifically for checking constraints on the data. In this case you
can build a custom method-level constraint annotation. The following is a custom or user-defined
constraint called ImageContent.

package org.apache.openjpa.example.gallery.constraint;

import java.lang.annotation.Documented;

import java.lang.annotation.Retention;

import java.lang.annotation.Target;

import static java.lang.annotation.ElementType.METHOD;
import static java.lang.annotation.ElementType.FIELD;
import static java.lang.annotation.RetentionPolicy.RUNTIME;

import javax.validation.Constraint;
import javax.validation.Payload;

import org.apache.openjpa.example.gallery.model.ImageType;

@Documented
@Constraint(validatedBy = ImageContentValidator.class)
@Target({ METHOD, FIELD })
@Retention (RUNTIME)
public @interface ImageContent {
String message() default "Image data is not a supported format.";
Class<?>[] groups() default {};
Class<? extends Payload>[] payload() default {};
ImageType[] value() default { ImageType.GIF, ImageType.JPEG };
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Next, you must create the validator class, ImageContentValidator. The logic within this validator gets
implemented by the validation provider when the constraint is validated. The validator class is bound to the
constraint annotation through the validatedBy attribute on the @ Constraint annotation as shown in the
following code:

package org.apache.openjpa.example.gallery.constraint;
import java.util.Arrays;
import java.util.List;
import javax.validation.ConstraintValidator;
import javax.validation.ConstraintValidatorContext;
import org.apache.openjpa.example.gallery.model.ImageType;
[**
* Simple check that file format is of a supported type
*/
public class ImageContentValidator implements ConstraintValidator<ImageContent, byte[]> {
private List<ImageType> allowedTypes = null;
[**
* Configure the constraint validator based on the image
* types it should support.
* @param constraint the constraint definition
*/
public void initialize(ImageContent constraint) f{
allowedTypes = Arrays.asList(constraint.value());
1

[**
*Validate a specified value.
*/
public boolean isValid(byte[] value, ConstraintValidatorContext context) {
if (value == null) {
return false;
1

// Verify the GIF header is either GIF87 or GIF89
if (allowedTypes.contains(ImageType.GIF)) {
String gifHeader = new String(value, 0, 6);
if (value.length >= 6 &&
(gifHeader.equalsIgnoreCase("GIF87a") ||
gifHeader.equalsIgnoreCase("GIF89a"))) {
return true;

}
}
// Verify the JPEG begins with SOI and ends with EOI
if (allowedTypes.contains(ImageType.JPEG)) {
if (value.length >= 4 8&&
value[0] == Oxff && value[l] == 0xd8 &&
value[value.length - 2] == Oxff && value[value.length -1] == 0xd9) {
return true;

}
}
// Unknown file format
return false;

}

Apply this new constraint to the getData() method on the Image class; for example:

@ImageContent
public byte[] getData() {
return data;
1

When validation of the data attribute occurs, the isValid() method in the ImageContentValidator is started.
This method contains logic for performing simple validation of the format of the binary image data. A
potentially overlooked feature in the ImageContentValidator is that it can also validate for a specific image
type. By definition, it accepts JPEG or GIF formats, but it can also validate for a specific format. For
example, by changing the annotation to the following code example, the validator is instructed to only
permit image data with valid JPEG content:
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@ImageContent (ImageType.JPEG)
public byte[] getData() {
return data;
}

Type-level constraints are also a consideration because you might need to validate combinations of
attributes on an entity. In the previous examples validation constraints were used on individual attributes.
Type-level constraints make it possible to provide collective validation. For example, the constraints
applied to the image entity validate that an image type is set (not null), the extension on the image file
name is of a supported type, and the data format is correct for the indicated type. But, for example, it does
not collectively validate that a file named img0.gif is of type GIF and the format of the data is for a valid
GIF file image. For more information about type-level constraints, see the white paper, OpenJPA Bean
Validation Primer, and the section "Type-level constraints."

Validation groups
Bean validation uses validation groups to determine what type of validation and when validation occurs.

There are no special interfaces to implement or annotations to apply to create a validation group. A
validation group is denoted by a class definition.

Note: When using groups, use simple interfaces. Using a simple interface makes validation groups more
usable in multiple environments. Whereas, if a class or entity definition is used as a validation
group, it might pollute the object model of another application by bringing in domain classes and
logic that do no make sense for the application. By default, if a validation group or multiple groups
is not specified on an individual constraint, it is validated using the javax.validation.groups.Default
group. Creating a custom group is as simple as creating a new interface definition.

For more information about validation groups, read the white paper, OpendJPA Bean Validation Primer, and
the section "Validation groups."

JPA domain model

In addition to the Image entity are Album, Creator and Location persistent types. An Album entity contains
a reference to collection of its Image entities. The Creator entity contains a reference to the album entities
that the image Creator contributed to and a reference to the Image entities created. This provides full
navigational capabilities to and from each of the entities in the domain. An embeddable location, has been
added to image to support storing location information with the image.

The Album and Creator entities have standard built-in constraints. The embeddable location is more
unique in that it demonstrates the use of the @ Valid annotation to validate embedded objects. To embed
location into an image, a new field and corresponding persistent properties are added to the Image class;
for example:

private Location location;

@valid

@Embedded

public Location getlLocation() {
return Tocation;

1

public void setlLocation(Location Tocation) {
this.Tocation = location;
1

The @Valid annotation provides chained validation of embeddable objects within a JPA environment.
Therefore, when image is validated, any constraints on the location it references are also validated. If
@Valid is not specified, the location is not validated. In a JPA environment, chained validation through
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@Valid is only available for embeddable objects. Referenced entities and collections of entities are
validated separately to prevent circular validation.

Bean validation and the JPA environment

The JPA 2.0 specification makes integration with the Bean Validation API simple. In a JSE environment,
bean validation is enabled by default when you provide the Bean Validation APl and a bean validation
provider on your runtime class path. In a Java EE 6 environment, the application server includes a bean
validation provider so there is no need to bundle one with your application. In both environments, you must
use a Version 2.0 persistence.xml file.

A Version 1.0 persistence.xml provides no means to configure bean validation. Requiring a Version 2.0
persistence.xml prevents a pure JPA 1.0 application from incurring the validation startup and runtime
costs. This is important given that there is no standard means for a 1.0-based application to disable
validation. In a Java EE 6 environment, enable validation in an existing 1.0 application by modifying the
root element of your persistence.xml file. The following example represents the persistence.xml file:
<?xml version="1.0" encoding="UTF-8"?>
<persistence xmins="http://java.sun.com/xml/ns/persistence"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/persistence
http://java.sun.com/xml/ns/persistence/persistence 2 _0.xsd"
version="2.0" >

</persistence>
Validation modes

Bean validation provides three modes of operation within the JPA environment:
* Auto

Enables bean validation if a validation provider is available within the class path. Auto is the default.
» Callback

When callback mode is specified, a bean validation provider must be available for use by the JPA
provider. If not, the JPA provider throws an exception upon instantiation of a new JPA entity manager
factory.

* None

Disables bean validation for a particular persistence unit.

Auto mode simplifies deployment, but can lead to problems if validation does not take place because of a
configuration problem.

Note: Use either none or callback mode explicitly for consistent behavior.

Also, if none is specified, JPA optimizes at startup and does not attempt to perform unexpected validation.
Explicitly disabling validation is especially important in a Java EE 6 environment where the container is
mandated to provide a validation provider. Therefore, unless specified, a JPA 2.0 application started in a
container has validation enabled. This process adds additional processing during life cycle events.

There are two ways to configure validation modes in JPA 2.0. The simplest way is to add a
validation-mode element to the persistence.xml with the wanted validation mode as shown in the
following example:

<persistence-unit name="auto-validation">

<!-- Validation modes: AUTO, CALLBACK, NONE -->
<validation-mode>AUTO</validation-mode>

</persistence-unit>
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The other way is to configure the validation mode programmatically by specifying the
javax.persistence.validation.mode property with value auto, callback, or none when creating a new JPA
entity manager factory as shown in the following example:

Map<String, String> props = new HashMap<String, String>();
props.put("javax.persistence.validation.mode", "callback");
EntityManagerFactory emf =
Persistence.createEntityManagerFactory("validation", props);

Validation in the JPA life cycle

Bean validation within JPA occurs during JPA life cycle event processing. If enabled, validation occurs at
the final stage of the PrePersist, PreUpdate, and PreRemove life cycle events. Validation occurs only after
all user-defined life cycle events, since some of those events can modify the entity that is being validated.
By default, JPA enables validation for the default validation group for PrePersist and PreUpdate life cycle
events. If you must validate other validation groups or enable validation for the PreRemove event, you can
specify the validation groups to validate each life cycle event in the persistence.xml as shown in the
following example:

<persistence-unit name="non-default-validation-groups">
<class>my.Entity</class>
<validation-mode>CALLBACK</validation-mode>
<properties>
<property name="javax.persistence.validation.group.pre-persist"
value="org.apache.openjpa.example.gallery.constraint.SequencedImageGroup"/>
<property name="javax.persistence.validation.group.pre-update"
value="org.apache.openjpa.example.gallery.constraint.SequencedImageGroup"/>
<property name="javax.persistence.validation.group.pre-remove"
value="javax.validation.groups.Default"/>
</property>
</persistence-unit>

The following example shows various stages of the JPA life cycle, including persist, update, and remove:

EntityManagerFactory emf =
Persistence.createEntityManagerFactory("BeanValidation");
EntityManager em = emf.createEntityManager();

Location loc = new Location();
loc.setCity("Rochester");
loc.setState("MN");
loc.setZipCode("55901");
Toc.setCountry("USA");

// Create an Image with non-matching type and file extension
Image img = new Image();

img.setType(ImageType.JPEG);
img.setFileName("Winter_01.gif");

loadImage(img);

img.setLocation(loc);

[/ *%% PERSIST #*%x

try {
em.getTransaction().begin();
// Persist the entity with non-matching extension and type
em.persist(img);

} catch (ConstraintViolationException cve) {
// Transaction was marked for rollback, roll it back and
// start a new one
em.getTransaction().rollback();
em.getTransaction().begin();
// Fix the file type and re-try the persist.
img.setType(ImageType.GIF);
em.persist(img);
em.getTransaction().commit();
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/] **% UPDATE ***

try {
em.getTransaction().begin();
// Modify the file name to a non-matching file name
// and commit to trigger an update
img.setFileName("Winter_01.jpg");
em.getTransaction().commit();

} catch (ConstraintViolationException cve) {
// Handle the exception. The commit failed so the transaction
// was already rolled back.
handleConstraintViolation(cve);

// The update failure caused img to be detached. It must be merged back
// into the persistence context.
img = em.merge(img);

/] *** REMOVE ***

em.getTransaction().begin();

try {
// Remove the type and commit to trigger removal
img.setType(ImageType.GIF);
em.remove(img);

} catch (ConstraintViolationException cve) {
// Rollback the active transaction and handle the exception
em.getTransaction().rollback();
handleConstraintViolation(cve);

em.close();
emf.close();

Exceptions
Validation errors can occur in any part of JPA life cycle.

If one or more constraints fail to validate during a life cycle event, a ConstraintViolationException is thrown
by the JPA provider. The ConstraintViolationException thrown by the JPA provider includes a set of
ConstraintViolations that occurred. Individual constraint violations contain information regarding the
constraint, including: a message, the root bean or JPA entity, the leaf bean which is useful when validating
JPA embeddable objects, the attribute which failed to validate, and the value that caused the failure. The
following is a sample exception handling routine:
private void handleConstraintViolation(ConstraintViolationException cve) {
Set<ConstraintViolation<?>> cvs = cve.getConstraintViolations();
for (ConstraintViolation<?> cv : cvs) {
System.out.printIn (M -----mm oo oo m oo ")
System.out.printin("Violation: " + cv.getMessage());
System.out.printIn("Entity: " + cv.getRootBeanClass().getSimpleName());
// The violation occurred on a leaf bean (embeddable)
if (cv.getLeafBean() != null && cv.getRootBean() != cv.getLeafBean()) {
System.out.printIn("Embeddable: " +

cv.getLeafBean().getClass().getSimpleName());
}
System.out.printIn("Attribute: " + cv.getPropertyPath());
System.out.printin("Invalid value: " + cv.getInvalidValue());
}
1

Constraint violation processing is typically simple when using attribute-level constraints. If you are using a
type-level validator with type-level constraints, it can be more difficult to determine which attribute or
combination of attributes failed to validate. Also, the entire object is returned as the invalid value instead of
an individual attribute. In cases where specific failure information is required, use of an attribute-level
constraint or a custom constraint violation might be provided as described in the Bean Validation
specification.
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Sample

The JPA model and image gallery application usage scenario provided in this topic can be implemented
through a sample that is provided in the white paper, OpenJPA Bean Validation primer.
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Chapter 6. Developing Client applications

This page provides a starting point for finding information about application clients and client applications.
Application clients provide a framework on which application code runs, so that your client applications can
access information on the application server.

For example, an insurance company can use application clients to help offload work on the server and to
perform specific tasks. Suppose an insurance agent wants to access and compile daily reports. The
reports are based on insurance rates that are located on the server. The agent can use application clients
to access the application server where the insurance rates are located. More introduction...

Developing client applications

A client application performs business logic and makes use of the framework provided by an underlying
client. Developing the code for a client application depends on the objects and functions you want to
exploit, and the programming model that you want to use.

Before you begin

Install the software development resources needed to develop client applications for use with WebSphere
Application Server. During code development, you do not need access to the WebSphere Application
Server. However, to assemble some types of client applications you need to install files for the client that
provides the framework for the client application. Instead of installing WebSphere Application Server you
can install the Application Client feature, which provides the same resources and clients to aid
development of client applications.

About this task

To use a client application to access a remote object on an application server, develop your client
application code as described in the following steps and the related topics. These topics only describe the
client-specific considerations; they do not describe general client programming models, which you should
already be familiar with. Samples for different types of client applications are provided with the Application
Client.

Procedure

1. Choose the type of client that you want to use as a framework for your client application. Decision
factors for choosing a client include whether you want to run a client application on Java EE or J2SE;
whether you want ease of use with a small installation footprint or full-function with medium-large
footprint; and whether you need licence to copy or redistribute the client. For more information about
choosing the type of client, see[‘Choosing a type of client’ on page 178/

2. Develop the client application code. The following substeps are a high-level general procedure.
Information specific to a type of client is given in the related tasks.

a. Create an instance of the object that you want to access on the remote server. You can use full
Java Naming and Directory Interface (JNDI) support to get a suitable reference to administered
objects from the server's JNDI namespace. Alternatively, you can get suitable references to objects
programmatically without using JNDI.

Using the javax.naming.InitialContext class, the client application program uses the lookup
operation to access the Java Naming and Directory Interface (JNDI) namespace. The InitialContext
class provides the lookup method to locate resources.

You can compare the use of JNDI and programmatic techniques by looking at the samples
provided for the Java EE client and Java thin client in an Application Client installation (for
example, in C:\wac70\samples\src\):
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» Java EE client use of JNDI for BasicCalculatorHome: TechnologySamplesJ2EECTient\
BasicCalculator\com\ibm\websphere\samples\technologysamples\basiccalcclient\
BasicCalculatorClientJ2EE. java

+ Java thin client programmatic retrieval of BasicCalculatorHome: TechnologySamplesThinClient\
BasicCalculator\com\ibm\websphere\samples\technologysamples\basiccalcthinclient\
BasicCalculatorClientThin.java

b. Create a connection to the server. If the server runs with security enabled, you can configure
secure connections.

c. Work with the objects to perform your business requirements. For example, send and receive JMS
messages, update database entries, handle error conditions, and close resources used.

3. Compile or assemble the client application. This creates the JAR or EAR file that you can deploy to
make the client application available for use.

To compile your client application, include the JAR files needed in the CLASSPATH setting for the
javac command; for example, any extra JAR files for the client application's own classes, JAR files for
IBM Thin clients used, and JAR files for JDBC provider classes.

Attention: IBM-provided clients are not packaged with JDBC provider classes. For example, the
WebSphere Application Server Version 7.0 Java Thin application client is not packaged with Apache
Derby 10.2 classes. If your client application needs to use a database class (such as through the JNDI
lookup of a datasource), you must obtain the class files from the database provider and make them
available when compiling and running the client application.

What to do next

After you develop a client application, deploy it into the environment you want it to run.

Choosing a type of client
A client provides the framework for client applications that run separately from your application server.

About this task

Decision factors for choosing a client include whether you want to run a client application on Java
Platform, Enterprise Edition (Java EE) or Java Platform, Standard Edition (J2SE) ; whether you want ease
of use with a small installation footprint or full-function with medium to large footprint; and whether you
need licence to copy or redistribute the client.

A usual first decision to make is do you want a client application that runs on Java EE or J2SE?. This
leads you to choose from the main types of clients, as described in this topic. Otherwise, if you want to run
an ActiveX program, or a Java applet, to interact with enterprise beans on WebSphere Application Server,
your decision is only for one of those types of client.

Procedure
« J2SE

If you want to run a lightweight client application, without the resource and processing cost of the Java
EE platform for WebSphere Application Server on the client machine, then choose either the Java thin
client or the stand-alone thin clients to run on J2SE.

— If you want a client with a small installation footprint, that you can embed into your application, and
that runs under an IBM, Sun, or HP-UX JRE, choose the stand-alone clients. Each client is an
embeddable single jar with small footprint; for example, the Thin Client for JMS with WebSphere
Application Server, com.ibm.ws.sib.client.thin.jms 7.0.0.jar needs about 2 MB of disk space.
For notable restrictions of stand-alone clients, see the client comparison table in [Client applications]

— If you want a full-function client with medium to large footprint, that runs under the IBM JRE supplied,
choose the Java thin client.
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- If you run your client application to use the installed files of Application Client for WebSphere
Application Server, you need about 400 MB of disk space (as part of the Application Client
installation). Choose this option if you intend to copy and redistribute the Java thin client, within
your licensing agreement.

- If you run your client application to use the installed files of the WebSphere Application Server,
you need about 1 GB of disk space (as part of the Application Server installation). Choose this
option if you do not mind the larger footprint, and you want maintenance support for the Java thin
client.

However, the thin clients running on J2SE do not support a Java EE container that provides easy
access to system services for object resolution, security, Reliability Availability and Servicability (RAS),
and other services. Also, thin clients running on J2SE do not initialize any of the services that the client
application might require.

 Java EE

If you want to run a Java client application that makes full use of the Java EE platform features of
WebSphere Application Server, then choose the Java EE client.

— If you run your client application to use the installed files of Application Client for WebSphere
Application Server, you need about 400 MB of disk space (as part of the Application Client
installation). Choose this option if you intend to copy and redistribute the Java EE client, within your
licensing agreement.

— If you run your client application to use the installed files of the WebSphere Application Server, you
need about 1 GB of disk space (as part of the Application Server installation). Choose this option if
you do not mind the larger footprint, and you want maintenance support for the Java EE client.

The Java EE client provides a container that client applications can use to access system services. The
Java EE client also initializes the runtime environment for client applications.

» ActiveX to Enterprise JavaBeans (EJB) Bridge

If you want ActiveX programs to access enterprise beans on WebSphere Application Server, choose this
client.

* Applet client

If you want a browser-based Java client application program that provides a richer and more robust
environment than the one offered by the Applet > Servlet > enterprise bean model, choose this client.

What to do next

Develop your client application to use the type of client that you have chosen.

Installing, updating, rolling back, and uninstalling the Application
Client for IBM WebSphere Application Server

IBM Installation Manager is a common installer for many IBM software products that you use to install,
update, roll back, and uninstall the Application Client for IBM WebSphere Application Server.

Before you begin

Note: Application Client for IBM WebSphere Application Server is now installed by Installation Manager
rather than by the programs based on InstallShield MultiPlatform (ISMP) that are used to install and
uninstall previous versions.

Before you start to use the installation tools, prepare for choosing and installing the variety of options and

features provided by the Application Client. Read through all the steps in this article and read the related

topics before installing the Application Client:

It is recommended that you have 350 MB of temporary disk space available before starting the installation.
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Restrictions:

 EETETE The Installation Manager GUI is not supported on Solaris 10 x64 systems.
Perform the following actions to install or uninstall the product on these systems:

— Use the Installation Manager GUI on a supported system to record a response file
that will allow you to install or uninstall the product silently.

— Edit the recorded response file if necessary.

— Use the response file to install or uninstall the product silently on your system.

* W For any Linux system that is enabled for Security Enhanced Linux (SELinux),
such as Red Hat Enterprise Linux Version 5 or SUSE Linux Enterprise Server Version
11, you must identify the Java shared libraries in the Installation Manager Version 1.4.3
or earlier installation image to the system. Also, you must identify the Java shared
libraries in the Installation Manager Version 1.4.3 or earlier installation after it has been
installed. For example:

chcon -R -t texrel_shlib_t ${IM_Image}/jre_5.0.3.sr8a_20080811b/jre/bin
chcon -R -t texrel_shlib_t ${IM_Install_root}/eclipse/jre_5.0.3.sr8a_20080811b/jre/bin

* Application Client for WebSphere Application Server ships only with the 32-bit
WebSphere Application Server.

 Installation Manager console mode, which is included in Installation Manager Version
1.4.3 and later, does not work with WebSphere Application Server Version 8.0 offerings.

About this task

The Application Client provides resources and clients to aid development of client applications for use with
WebSphere Application Server. The Application Client is a source for the clients (as runtime frameworks)
for client applications, either to run on the Application Client machine or to be distributed with client
applications that are to run on other machines.

To assemble some types of client applications, you need to install the client that provides the framework
for the client application. Instead of installing WebSphere Application Server, you can install the Application
Client feature, which provides the same resources and clients to aid development of client applications.

Similarly, running some types of client applications for use with WebSphere Application Server requires
that the associated client is deployed with the client application. For client applications that only need a
small fraction of the Application Client, you can install the Application Client onto a convenient machine,
such as the machine used to develop the client application, then package the client application with only
the clients that it needs. For example, this means that a standalone client application is deployed on only
the required fraction of the clients provided with the Application Client.

Perform one of these procedures to install, update, roll back, or uninstall the Application Client for IBM
WebSphere Application Server.

Procedure

« [“Installing the Application Client using the GUI” on page 182

« [“Installing the Application Client silently” on page 187

« [“Installing and removing features in the Application Client’ on page 197

* [‘Installing fix packs on the Application Client” on page 203

. “‘Uninstalling fix packs from the Application Client using the Installation Manager GUI” on page 204
* [‘Uninstalling the Application Client using the GUI” on page 204

. “‘Uninstalling the Application Client silently” on page 205|

Results
Notes on logging and tracing:
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* An easy way to view the logs is to open Installation Manager and go
to File > View Log. An individual log file can be opened by selecting it
in the table and then clicking the Open log file icon.

* Logs are located in the Togs directory of Installation Manager's
application data location. For example:

— T Administrative installation:

C:\Documents and Settings\A11 Users\Application Data\IBM\Installation Manager\logs

— I Non-administrative installation:
C:\Documents and Settings\user_name\Application Data\IBM\Installation Manager\logs
- BT TSN ENTTEN TN Administrative
installation:
/var/ibm/InstallationManager/logs
- I TS TS BT Non-administrative
installation:

user_home/var/ibm/InstallationManager/Togs

* The main log files are time-stamped XML files in the 1ogs directory,
and they can be viewed using any standard web browser.

* The Tog.properties file in the Togs directory specifies the level of
logging or tracing that Installation Manager uses. To turn on tracing, for
example, create a Tog.properties file with the following content:

com. ibm.ws=DEBUG
com.ibm.cic.agent.core.Engine=DEBUG
global=DEBUG

Restart Installation Manager as necessary, and Installation Manager
outputs traces.

Notes on troubleshooting:

* BNIZTHM By default, some HP-UX systems are configured to not use
DNS to resolve host names. This could result in Installation Manager not
being able to connect to an external repository.

You can ping the repository, but nslookup does not return anything.

Work with your system administrator to configure your machine to use
DNS, or use the IP address of the repository.

* In some cases, you might need to bypass existing checking mechanisms
in Installation Manager.

— On some network file systems, disk space might not be reported
correctly at times; and you might need to bypass disk-space checking
and proceed with your installation.

To disable disk-space checking, specify the following system property in
the config.ini file in IM_install_root/eclipse/configuration and
restart Installation Manager:

cic.override.disk.space=sizeunit

where size is a positive integer and unit is blank for bytes, k for kilo, m
for megabytes, or g for gigabytes. For example:

cic.override.disk.space=120 (120 bytes)
cic.override.disk.space=130k (130 kilobytes)
cic.override.disk.space=140m (140 megabytes)
cic.override.disk.space=150g (150 gigabytes)
cic.override.disk.space=true

Installation Manager will report a disk-space size of Long.MAX_VALUE.
Instead of displaying a very large amount of available disk space, N/A
is displayed.
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— To bypass operating-system prerequisite checking, add
disable0SPrereqChecking=true to the config.ini file in
IM_install_root/eclipse/configuration and restart Installation
Manager.

If you need to use any of these bypass methods, contact IBM Support for
assistance in developing a solution that does not involve bypassing the
Installation Manager checking mechanisms.

» For more information on using Installation Manager, read the
[Installation Manager Information Center|
Read the release notes to learn more about the latest version of
Installation Manager. To access the release notes, complete the following
task:

— el Click Start > Programs > IBM Installation Manager >
Release Notes.

- BN TS TS BETTTEE Go to the documentation

subdirectory in the directory where Installation Manager is installed, and
open the readme.html file.

Installing the Application Client using the GUI
You can use the Installation Manager GUI to install the Application Client.

Before you begin

Install Installation Manager:
1. Perform one of the following procedures:

« |If you want to use the Installation Manager that is included with this product, perform the following
actions:

a. Obtain the necessary files from the physical media or the web.
There are three basic options for obtaining and installing the product.
— Access the physical media, and use local installation
You can access the product repositories on the product media.
1) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage® site, or using a file containing the most current version of
Installation Manager from the [IBM Installation Manager website].

2) Use Installation Manager to install the product from the product repositories on the media.
— Download the files from the Passport Advantage site, and use local installation

Licensed customers with a Passport Advantage ID and password can download the
necessary product repositories from the Passport Advantage site.

1) Download the files from the Passport Advantage site.
2) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website.

3) Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation

If you have a Passport Advantage ID and password, you can install the product from the
web-based repositories.

1) Install Installation Manager on your system.
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You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website]
2) Use Installation Manager to install the product from the web-based repository located at
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80
Whenever possible, you should use the remote web-based repositories so that you are
accessing the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the
product from the product repositories on the media or local repositories.

— With the Packaging Ultility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple
disks for one product into a repository. You can copy packages from Passport
Advantage into a repository for example. For more information on the Packaging

Utility, go to the IBM Installation Manager Information Center|

b. Change to the location containing the Installation Manager installation files, and run one of the

following commands:

Administrative installation:

— WM install.exe

- TR TS TN BTN -/ install

Non-administrative installation:

— [T userinst.exe

- ETEE BTSN ETTEE BTN - /userinst

Group-mode installation:

T BTN ENTITEN BT - /groupinst

Notes on group mode:

Group mode allows multiple users to use a single instance
of IBM Installation Manager to manage software packages.

e Group mode is not available on Windows
operating systems.

If you do not install Installation Manager using group mode,
you will not be able to use group mode to manage any of
the products that you install later using this Installation
Manager.

Make sure that you change the installation location from the
default location in the current user's home directory to a
location that is accessible by all users in the group.

Set up your groups, permissions, and environment variables
as described in the Group mode road maps in the
[Installation Manager Information Center] before installing in
group mode.

For more information on using group mode, read the Group

mode road maps in the [|[BM Installation Manager]
[Information Center]

The installer opens an Install Packages window.
c. Make sure that the Installation Manager package is selected, and click Next.
d. Accept the terms in the license agreements, and click Next.
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e.

f.

If

The program creates the directory for your installation.

Click Next.

Review the summary information, and click Install.

— If the installation is successful, the program displays a message indicating that installation is
successful.

— If the installation is not successful, click View Log File to troubleshoot the problem.

you already have a version of Installation Manager installed on your system and you want to use it

to install and maintain the product, obtain the necessary product files from the physical media or the
web.
There are three basic options for installing the product.

http://www

Access the physical media, and use local installation

You can access the product repositories on the product media. Use Installation Manager to install
the product from the product repositories on the media.

Download the files from the Passport Advantage site, and use local installation
Licensed customers with a Passport Advantage ID and password can download the necessary
product repositories from the Passport Advantage site.
a. Download the product repositories from the Passport Advantage site.
b. Use Installation Manager to install the product from the downloaded repositories.
Access the live repositories, and use web-based installation
If you have a Passport Advantage ID and password, you can use Installation Manager to install
the product from the web-based repositories. Use Installation Manager to install the product from
the web-based repository located at

.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80
Whenever possible, you should use the remote web-based repositories so that you are accessing
the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the product
from the product repositories on the media or local repositories.

— With the Packaging Utility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple disks
for one product into a repository. You can copy packages from Passport Advantage into a
repository for example. For more information on the Packaging Utility, go to the
[nstallation Manager Information Center

2. Add the product repository to your Installation Manager preferences.

a.

b
c.
d

Start Installation Manager.

In the top menu, click File > Preferences.

Select Repositories.

Perform the following actions:

1) Click Add Repository.

2) Enter the path to the repository.config file in the location containing the repository files.
For example:
* BIITTTM C:\repositories\product_name\local-repositories

' B T BT BT /var/repositories/product_name/local-

repositories

or

http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80

3) Click OK.
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e. Deselect any locations listed in the Repositories window that you will not be using.
f. Click Apply.

g. Click OK.

h. Click File > Exit to close Installation Manager.

About this task
Perform this procedure to use the Installation Manager GUI to install the Application Client.

Procedure
1. Start Installation Manager.

Tip: I BT BTl BT If you installed Installation Manager using group
mode, you can start it in group mode with the ./IBMIM command.

» Group mode allows users to share packages in a common location and manage them with
the same instance of Installation Manager.

» For more information on using group mode, read the Group mode road maps in the
[Installation Manager Information Center|

2. Click Install.

Note: If you are prompted to authenticate, use the IBM ID and password that you registered with on
the program website.

Installation Manager searches its defined repositories for available packages.
3. Perform the following actions.
a. Select Application Client for IBM WebSphere Application Server and the appropriate version.

Note: If you are installing the ILAN version of this product, select Application Client for IBM
WebSphere Application Server (ILAN).

If you already have the Application Client installed on your system, a message displays indicating
that the Application Client is already installed. For a given Installation Manager, you can install
only one Application Client.

Tip: If the Search service repositories during installation and updates option is selected on
the Installation Manager Repository preference page and you are connected to the Internet,
you can click Check for Other Versions and Extensions to search for updates in the
default update repositories for the selected packages. In this case, you do not need to add
the specific service-repository URL to the Installation Manager Repository preference page.

b. Select the fixes to install.
Any recommended fixes are selected by default.

If there are recommended fixes, you can select the option to show only recommended fixes and
hide non-recommended fixes.

c. Click Next.

Note: If you try to install a newer level of the Application Client with a previous version of Installation
Manager, Installation Manager might prompt you to update to the latest level of Installation
Manager when it connects to the repository. Update to the newer version before you continue
if you are prompted to do so. Read the |IBM Installation Manager Information Centerifor
information about automatic updates.

4. Accept the terms in the license agreements, and click Next.

5. Specify the installation root directory for the product binaries, which are also referred to as the core
product files or system files.
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The panel also displays the shared resources directory and disk-space information.

Restrictions:

» Deleting the default target location and leaving an installation-directory field empty
prevents you from continuing.

» Do not use symbolic links as the destination directory.
Symbolic links are not supported.
* Do not use a semicolon in the directory name.

The Application Client cannot install properly if the target directory includes a
semicolon.

EITTEE A semicolon is the character used to construct the class path on
Windows systems.

s TITTTE The maximum path length on the Windows Server 2008, Windows Vista,
and Windows 7 operating systems is 60 characters.

6. Click Next.
7. Select any features that you want to install.
Choose from the following optional features:
» |IBM Developer Kit, Java 2 Technology Edition
This option installs the IBM Developer Kit, Java 2 Technology Edition.

This feature includes a development kit and a runtime-environment package. The
runtime-environment package is always installed with the Java EE and Java thin application client
feature even if this feature is not installed.

— Java 2 Runtime Environment
This option installs the Java 2 runtime environment.

This feature includes the Java 2 runtime environment of IBM Developer Kit, Java 2 Technology
Edition.

— Developer Kit
This option installs the developer Kkit.
This feature includes the developer kit of IBM Developer Kit, Java 2 Technology Edition.
* Samples

This option installs executable and source-code examples of programming in both Java EE and
non-Java EE client environments.

« Standalone Thin Clients, Resource Adapters, and Embeddable Containers

IBM thin clients and resource adapters provide a set of clients and resource adapters for a variety
of technologies, such as JAX-WS, JAX-RPC, JAX-RS, XML, EJB, JPA, JMS, and more. An
embeddable container runs in a standalone Java Platform, Standard Edition environment. For
example, you can use the embeddable EJB container to run enterprise beans outside the
application server.
— Standalone thin clients and resource adapters

This option installs the runtime for standalone thin clients.
— Embeddable EJB container

This option installs the embeddable EJB container.

The embeddable EJB container is a Java Archive (JAR) file that you can use to run enterprise
beans in a standalone Java Platform, Standard Edition environment. You can run enterprise
beans using this embeddable container outside the application server. The embeddable EJB
container is a part of the EJB 3.1 specification and is primarily used for unit testing enterprise
beans business logic.

Tip: You can run the Installation Manager later to modify this installation and add or remove features.
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10.
11.

12.
13.

Click Next.

Enter the host name and port number of the Websphere Application Server to which you want to
connect.

Click Next.
Review the summary information, and click Install.

 If the installation is successful, the program displays a message indicating that installation is
successful.

Note: The program might also display important post-installation instructions as well.
 If the installation is not successful, click View Log File to troubleshoot the problem.
Click Finish.

Click File > Exit to close Installation Manager.

Installing the Application Client silently
You can use Installation Manager to install the Application Client silently.

Before you begin

Install Installation Manager on each of the systems onto which you want to install the product.

1.

Perform one of the following procedures:
« |If you want to use the Installation Manager that is included with this product, perform the following

actions:
a. Obtain the necessary files from the physical media or the web.
There are three basic options for obtaining and installing the product.
— Access the physical media, and use local installation
You can access the product repositories on the product media.
1) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website.

2) Use Installation Manager to install the product from the product repositories on the media.
— Download the files from the Passport Advantage site, and use local installation

Licensed customers with a Passport Advantage ID and password can download the
necessary product repositories from the Passport Advantage site.

1) Download the files from the Passport Advantage site.
2) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website,

3) Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation

If you have a Passport Advantage ID and password, you can install the product from the
web-based repositories.

1) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager websitel

2) Use Installation Manager to install the product from the web-based repository located at

http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80
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Whenever possible, you should use the remote web-based repositories so that you are
accessing the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the
product from the product repositories on the media or local repositories.

— With the Packaging Utility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple
disks for one product into a repository. You can copy packages from Passport
Advantage into a repository for example. For more information on the Packaging
Utility, go to the [IBM Installation Manager Information Center]

b. Change to the location containing the Installation Manager installation files, and run one of the
following commands to install Installation Manager silently:

Administrative installation:
— IITTEM installc.exe -acceptlicense -log log_file_path_and name
- N R DTS BT - /installc -acceptlicense -log
log_file_path_and_name
Non-administrative installation:
— IITIEM userinstc.exe -acceptlicense -log log_file_path_and_name

- I T BT BT . /userinstc -acceptlicense -log
log file path_and name

Group-mode installation:
BT - /groupinstc -acceptlicense

-datalocation application_data_location -log log file path_and_name

Notes on group mode:

— Group mode allows multiple users to use single instance of
IBM Installation Manager to manage software packages.

— e Group mode is not available on Windows
operating systems.

— If you do not install Installation Manager using group mode,
you will not be able to use group mode to manage any of
the products that you install later using this Installation
Manager.

— Make sure that you change the installation location from the
default location in the current user's home directory to a
location that is accessible by all users in the group.

— Set up your groups, permissions, and environment variables
as described in the Group mode road maps in the |Em
[Installation Manager Information Center| before installing in
group mode.

— For more information on using group mode, read the Group
mode road maps in the [IBM Installation Manager|
[Information Center
* If you already have a version of Installation Manager installed on your system and you want to use it
to install and maintain the product, obtain the necessary product files from the physical media or the
web.
There are three basic options for installing the product.

— Access the physical media, and use local installation
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You can access the product repositories on the product media. Use Installation Manager to install
the product from the product repositories on the media.

— Download the files from the Passport Advantage site, and use local installation

Licensed customers with a Passport Advantage ID and password can download the necessary
product repositories from the Passport Advantage site.

a. Download the product repositories from the Passport Advantage site.
b. Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation

If you have a Passport Advantage ID and password, you can use Installation Manager to install
the product from the web-based repositories. Use Installation Manager to install the product from
the web-based repository located at

http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80
Whenever possible, you should use the remote web-based repositories so that you are accessing
the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the product
from the product repositories on the media or local repositories.

— With the Packaging Utility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple disks
for one product into a repository. You can copy packages from Passport Advantage into a
repository for example. For more information on the Packaging Utility, go to the
[nstallation Manager Information Centerl

2. Add the product repository to your Installation Manager preferences.
a. Start Installation Manager.
b. In the top menu, click File > Preferences.
c. Select Repositories.
d. Perform the following actions:
1) Click Add Repository.
2) Enter the path to the repository.config file in the location containing the repository files.
For example:
* BITTTTE C:\repositories\product_name\local-repositories

s BT I BT BT /var/repositories/product_name/local-

repositories

or
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80

3) Click OK.
e. Deselect any locations listed in the Repositories window that you will not be using.
f. Click Apply.
g. Click OK.
h. Click File > Exit to close Installation Manager.

About this task
Using Installation Manager, you can work with response files to install the Application Client silently in a

variety of ways. You can record a response file using the GUI as described in the following procedure, or
you can generate a new response file by hand or by taking an example and modifying it.
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Procedure

1. Optional: Record a response file to install the Application Client: On one of your systems, perform
the following actions to record a response file that will install the Application Client.

a. From a command line, change to the eclipse subdirectory in the directory where you installed
Installation Manager.

b. Start Installation Manager from the command line using the -record option.
For example:

* WM Administrator or non-administrator:

IBMIM.exe -skipInstall "C:\temp\imRegistry"
-record C:\temp\install_response_file.xml

- BN 2T BTN BT Administrator:

./IBMIM -skipInstall /var/temp/imRegistry
-record /var/temp/install_response_file.xml

s BN T BTN BT Non-administrator:

./IBMIM -skipInstall user_home/var/temp/imRegistry
-record user_home/var/temp/install_response_file.xml

Tip: When you record a new response file, you can specify the -skiplnstall parameter. Using this
parameter has the following benefits:

* No files are actually installed, and this speeds up the recording.

* If you use a temporary data location with the -skipInstall parameter, Installation Manager
writes the installation registry to the specified data location while recording. When you start
Installation Manager again without the -skiplnstall parameter, you then can use your
response file to install against the real installation registry.

The -skiplnstall operation should not be used on the actual agent data location used by
Installation Manager. This is unsupported. Use a clean writable location, and re-use that
location for future recording sessions.

For more information, read the [IBM Installation Manager Information Center|
c. Add the appropriate repositories to your Installation Manager preferences.
1) In the top menu, click File > Preferences.
2) Select Repositories.
3) Perform the following actions for each repository:
a) Click Add Repository.

b) Enter the path to the repository.config file in the remote web-based repository or the local
directory into which you unpacked the repository files.

For example:

* Remote repositories:
https://downloads.mycorp.com:8080/WAS_80_repository

or
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80

* Local repositories:
— I C:\repositories\appclient\local-repositories

- T T T BT /var/repositories/appclient/local-

repositories
c) Click OK.
4) Click Apply.
5) Click OK.
d. Click Install.
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Note: If you are prompted to authenticate, use the IBM ID and password that you registered with
on the program website.

Installation Manager searches its defined repositories for available packages.
Perform the following actions.

1) Select Application Client for IBM WebSphere Application Server and the appropriate
version.

Note: If you are installing the ILAN version of this product, select Application Client for IBM
WebSphere Application Server (ILAN).

If you already have the Application Client installed on your system, a message displays

indicating that the Application Client is already installed. For a given Installation Manager, you

can install only one Application Client.

2) Click Next.

f. Accept the terms in the license agreements, and click Next.

g.

h.

Specify the installation root directory for the Application Client binaries, which are also referred to
as the core product files or system files.

The panel also displays the shared resources directory and disk-space information.

Restrictions:

» Deleting the default target location and leaving an installation-directory field empty
prevents you from continuing.

» Do not use symbolic links as the destination directory.
Symbolic links are not supported.
* Do not use a semicolon in the directory name.

The Application Client cannot install properly if the target directory includes a
semicolon.
T A semicolon is the character used to construct the class path on
Windows systems.

s W The maximum path length on the Windows Server 2008, Windows
Vista, and Windows 7 operating systems is 60 characters.

Click Next.

i. Select any features that you want to install.
Choose from the following optional features:

IBM Developer Kit, Java 2 Technology Edition
This option installs the IBM Developer Kit, Java 2 Technology Edition.

This feature includes a development kit and a runtime-environment package. The
runtime-environment package is always installed with the Java EE and Java thin application client
feature even if this feature is not installed.

— Java 2 Runtime Environment
This option installs the Java 2 runtime environment.

This feature includes the Java 2 runtime environment of IBM Developer Kit, Java 2
Technology Edition.

— Developer Kit
This option installs the developer kit.
This feature includes the developer kit of IBM Developer Kit, Java 2 Technology Edition.

* Samples

This option installs executable and source-code examples of programming in both Java EE and
non-Java EE client environments.
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» Standalone Thin Clients, Resource Adapters, and Embeddable Containers

IBM thin clients and resource adapters provide a set of clients and resource adapters for a
variety of technologies, such as JAX-WS, JAX-RPC, JAX-RS, XML, EJB, JPA, JMS, and more.
An embeddable container runs in a standalone Java Platform, Standard Edition environment. For
example, you can use the embeddable EJB container to run enterprise beans outside the
application server.

— Standalone thin clients and resource adapters

This option installs the runtime for standalone thin clients.
— Embeddable EJB container

This option installs the embeddable EJB container.

The embeddable EJB container is a Java Archive (JAR) file that you can use to run enterprise
beans in a standalone Java Platform, Standard Edition environment. You can run enterprise
beans using this embeddable container outside the application server. The embeddable EJB
container is a part of the EJB 3.1 specification and is primarily used for unit testing enterprise
beans business logic.

Tip: You can run the Installation Manager later to modify this installation and add or remove
features.

j. Click Next.

k. Enter the host name and port number of the Websphere Application Server to which you want to
connect.

|. Click Next.
m. Review the summary information, and click Install.

 If the installation is successful, the program displays a message indicating that installation is
successful.

Note: The program might also display important post-installation instructions as well.
 If the installation is not successful, click View Log File to troubleshoot the problem.
Click Finish.

Click File > Exit to close Installation Manager.

Optional: If you are using an authenticated remote repository, create a keyring file for silent
installation.

1) From a command line, change to the eclipse subdirectory in the directory where you installed

Installation Manager.

2) Start Installation Manager from the command line using the -record option.

For example:

* W Administrator or non-administrator:

IBMIM.exe -skipInstall "C:\temp\imRegistry"
-keyring C:\IM\im.keyring
-record C:\temp\keyring_response_file.xml

- B BTSN BTN EESTTEN Administrator:

./IBMIM -skipInstall /var/temp/imRegistry
-keyring /var/IM/im.keyring
-record /var/temp/keyring_response_file.xml

s B BZT3E BTSN BT Non-administrator:

./IBMIM -skipInstall user_home/var/temp/imRegistry
-keyring user_home/var/IM/im.keyring
-record user_home/var/temp/keyring_response_file.xml
3) When a window opens that requests your credentials for the authenticated remote repository,
enter the correct credentials and save them.
4) Click File > Exit to close Installation Manager.

For more information, read the [IBM Installation Manager Information Cented
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2. Use the response files to install the Application Client silently:

a. Optional: Use the response file to install the keyring silently: Go to a command line on each of
the systems on which you want to install the product, change to the eclipse/tools subdirectory in
the directory where you installed Installation Manager, and install the keyring silently.

For example:
* WM Administrator or non-administrator:

imcl.exe -acceptlicense
input C:\temp\keyring_response_file.xml
-Tog C:\temp\keyring_Tog.xml

- ST SRS ENCTSN WETTE Administrator:

./imcl -acceptlicense
input /var/temp/keyring_response_file.xml
-log /var/temp/keyring_log.xml

© TSN WNTZTSS WSS MECTTTE Non-administrator:

./imc1 -acceptlicense
input user_home/var/temp/keyring_response_file.xml
-log user_home/var/temp/keyring_log.xml

b. Use the response file to install the product silently: Go to a command line on each of the
systems on which you want to install the product, change to the eclipse/tools subdirectory in the
directory where you installed Installation Manager, and install the product silently.

For example:
* WM Administrator or non-administrator:

imcl.exe -acceptlicense
input C:\temp\install_response_file.xml
-lTog C:\temp\install_Tog.xml
-keyring C:\IM\im.keyring

- ST EETSN ENEITSN EESTTTE Administrator:

./imc1 -acceptLicense
input /var/temp/install_response_file.xml
-log /var/temp/install_log.xml
-keyring /var/IM/im.keyring

© I TN BTN TS Non-administrator:

./imc1 -acceptlicense
input user_home/var/temp/install_response_file.xml
-log user_home/var/temp/install_Tog.xml
-keyring user_home/var/IM/im.keyring

Notes:

* The relevant terms and conditions, notices, and other information are provided in the
license-agreement files in the T1afiles or product_name/lafiles subdirectory of the
installation image or repository for this product.

* The program might write important post-installation instructions to standard output.
Read the|IBM Installation Manager Information Center| for more information.

Example

The following is an example of a response file for silently installing the Application Client.

<?xml version="1.0" encoding="UTF-8"7>

<l-- ##### Copyright #############AFFFFRAFHARAFAAAFFEARAARARAARAAEAAA A AAHS

# Licensed Materials - Property of IBM (c) Copyright IBM Corp. 2011.

# A1l Rights Reserved. US Government Users Restricted Rights-Use, duplication
# or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
[didgdzsssdzasadasdadasdddagddsasddasddadsddasddsasdiaatadasdadagddsiss et

<!-- ##### Frequently Asked Questions ###################AAH#FRAFFAAAFARIFS
# The latest information about using Installation Manager is

# located in the online Information Center. There you can find

# information about the commands and attributes used in

# silent installation response files.

Installation Manager Information Center can be found at:
http://publib.boulder.ibm.com/infocenter/install/vlr4d/index.jsp

LR
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Question 1. How do I record a response file using Installation Manager?
Answer 1. Start Installation Manager from the command Tine under the
eclipse subdirectory with the record parameter and it will generate a
response file containing actions it performed, repositories it used, and
its preferences settings. Optionally use the -skipInstall parameter if
you do not want the product to be installed to the machine. Specify a

new agentDatalocation location value when doing a new installation. Do

not use an existing agentDatalocation for an installation because it might
damage the installation data and prevent you from modifying, updating,
rolling back, or uninstalling the installed packages.

Windows: IBMIM -record <responseFile> -skipInstall <agentDatalocation>
Linux or UNIX: ./IBMIM -record <responseFile> -skipInstall <agentDatalocation>

For example:
Windows = IBMIM.exe -record c:\temp\responsefiles\WASv8.install.Win32.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry
Linux or UNIX = ./IBMIM -record /home/user/responsefiles/WASv8.install.RHEL64.xmI
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry

Question 2. How do I run Installation Manager silently using response file?

Answer 2. Create a silent installation response file and run the following command
from the eclipse\tools subdirectory in the directory where you installed
Installation Manager:

Windows = imcl.exe -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>

For example:
Windows = imcl.exe -acceptLicense -showProgress
input c:\temp\responsefile\WASv8.install.Win32.xml
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input /home/user/responsefile/WASv8.install.RHEL64.xm]

The -acceptLicense command must be included to indicate acceptance of all
license agreements of all offerings being installed, updated or modified.

The -showProgress command shows progress when running in silent mode.

Additional commands can be displayed by requesting help: IBMIM -help

Question 3. How do I store and pass credentials to repositories that
require authentication?

Answer 3. Installation Manager uses a key ring file to store encrypted
credentials for authenticating with repositories. Follow this two-step
process for creating and using a key ring file with Installation Manager.

First, create a key ring file with your credentials by starting
Installation Manager from the command Tine under eclipse subdirectory
with the keyring parameter.

Use the optional password parameter to password protect your file.

Windows = IBMIM.exe -keyring <path and file name> -password <password>
Linux, UNIX, IBM i and z/0S = ./IBMIM -keyring <path and file name>
-password <password>

Installation Manager will start in graphical mode. Verify that the
repositories to which you need to authenticate are included in the
preferences, File / Preferences / Repositories. If they are not

listed, then click Add Repositories to add the URL or UNC path.
Installation Manager will prompt for your credentials. If the repository

is already in the Tist, then any attempt to access the repository location,
such as clicking the Test Connections button, will also prompt for your
credentials. Enter the correct credential and check the Save password
checkbox. The credentials are saved to the key ring file you specified.

Second, when you start a silent installation, run imcl under eclipse/tools
subdirectory, and provide Installation Manager with the Tocation of the key
ring file and the password if the file is protected. For example:

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# Windows = imcl.exe -acceptLicense -showProgress

# input <path and file name of response file>

# -keyring <path and name of key ring file> -password <password>
#  Linux, UNIX, IBM i and z/0S = ./imc1 -acceptlLicense -showProgress
# input <path and file name of response file>

# -keyring <path and name of key ring file> -password <password>
#

#

[digdssssdsagddaasddapdddagddsapadastadasdadasdssagisagtdsatddaidstasiited
<l-- ##### Agent Input ################ERFF#REF#ERAFAERAFERAAARRAAHEA

Note that the "acceptlLicense" attribute has been deprecated.
Use "-acceptLicense" command Tine option to accept license agreements.

The clean and temporary attributes specify the repositories and other
preferences Installation Manager uses and whether those settings
should persist after the silent installation finishes.

Valid values for clean:

#
#
#
#
#
#
#
#
#
# true = only use the repositories and other preferences that are
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specified in the response file.
false = use the repositories and other preferences that are
specified in the response file and Installation Manager.

#
#
#
#
# Valid values for temporary:

# true = repositories and other preferences specified in the

# response file do not persist in Installation Manager.

# false = repositories and other preferences specified in the
# response file persist in Installation Manager.

#
#

fddssssasastdssddddaapgaddsssssaagdddassddaspsgaadddaaaiddddss it
<agent-input clean="true" temporary="true">

<l-- ##### Repositories #######################HARARAFIFAAARARRAAAFAAAAAAAS
Repositories are locations that Installation Manager queries for
installable packages. Repositories can be local (on the machine

with Installation Manager) or remote (on a corporate intranet or

hosted elsewhere on the internet).

If the machine using this response file has access to the internet,
then include the IBM WebSphere Live Update Repositories in the Tist
of repository locations.

If the machine using this response file cannot access the internet,
then comment out the IBM WebSphere Live Update Repositories and
specify the URL or UNC path to custom intranet repositories and
directory paths to local repositories to use.

S SR SR SR W SR SR SR W SR SR R SR e S

[ARagdsssdisasddasddsasdasagdsaadatasdadasdssagdsaagisaaddasdddadasssted

<server>
<l-- ##### IBM WebSphere Live Update Repositories ####################
# These repositories contain Application Client offerings,
and updates for those offerings

#
#
# To use the secure repository (https), you must have an IBM ID,
# which can be obtained by registering at: http://www.ibm.com/account
# or your Passport Advantage account.
#
# And, you must use a key ring file with your response file.
[zgadzssddaddadagdddasadsasddsaddstsddasddsasadaadddadidadddisd ity
<repository location="http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80" />
<!-- <repository location="https://www.ibm.com/software/rational/repositorymanager/repositories/websphere" /> -->

<!-- ##### Custom Repositories ###################FFAAFFFAAFFRRAF#AAFS

# Uncomment and update the repository location key below

# to specify URLs or UNC paths to any intranet repositories

# and directory paths to local repositories to use.

[dgadassddaadddasdddasadsasddasddstsddaddsasadaasddadidaaddsisd bty
<!-- <repository location='https:\\w3.mycompany.com\repositories\'/> -->
<!-- <repository location='/home/user/repositories/websphere/'/> -->

<!-- ##### Local Repositories ################F#ERFFAAHFFAARAAAAFAAAHS
# Uncomment and update the following line when using a Tocal
# repository Tocated on your own machine to install a
# Application Client offering.
[dgadzssddaddddagdddagadiasddaaddssddadddsadadaadddasdddisd Mt
<!-- <repository Tocation='insert the full directory path inside single quotes'/> -->
</server>

<l-- #####4 Installation Packages ##################FHERFFRARFFREFERAFHRAHS
Install Command

Use the install command to inform Installation Manager of the
installation packages to install.

The modify attribute is optional and can be paired with an install
command to add features or paired with an uninstall command to
remove commands. If omitted, the default value is set to false.
false = indicates not to modify an existing install by adding
or removing features.
true = indicates to modify an existing install by adding or
removing features.

The offering ID attribute is required because it specifies the
offering to be installed. The offering Tisted must be present in
at Teast one of the repositories listed earlier. The example
command below contains the offering ID for the Application Client
for IBM WebSphere Application Server.

The version attribute is optional. If a version number is provided,
then the offering will be installed at the version level specified
as long as it is available in the repositories. If the version
attribute is not provided, then the default behavior is to install
the Tatest version available in the repositories. The version number
can be found in the repository.xml file in the repositories.

For example, <offering ...... version='8.0.0.20110221_2221"' ...... >,

S SR S S SR SR S S S SR S SR SR SR S S SR S S SR S S SR SR S SR SR S
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The profile attribute is required and typically is unique to the
offering. If modifying or updating an existing installation, the

profile attribute must match the profile ID of the targeted installation
of Application Client.

The features attribute is optional. Offerings always have at Teast
one feature; a required core feature which is installed regardless
of whether it is explicitly specified. If other feature names

are provided, then only those features will be installed.

Features must be comma delimited without spaces.

The feature values for Application Client include:
javaruntime,developerkit,embeddablecontainer,
samples,standalonethinclient.resourceadapter.runtime

The installFixes attribute indicates whether fixes available in
repositories are installed with the product. By default, all
available fixes will be installed with the offering.

Valid values for installFixes:
none = do not install available fixes with the offering.
recommended = installs all available recommended fixes with the offering.
all = installs all available fixes with the offering.

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# Interim fixes for offerings also can be installed while they
# are being installed by including the offering ID for the interim
# fix and specifying the profile ID. A commented out example is
# provided in the install command below.
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

Installation Manager supports installing multiple offerings at once.
Additional offerings can be included in the install command,

with each offering requiring its own offering ID, version, profile value,
and feature values.

Profile Command

A separate profile command must be included for each offering Tisted
in the install command. The profile command informs Installation
Manager about offering specific properties or configuration values.

The installlLocation specifies where the offering will be installed.
If the response file is used to modify or update an existing
installation, then ensure the installlLocation points to the
location where the offering was installed previously.

The eclipselocation data key should use the same directory path to
Application Client as the installationlLocation attribute.

Include data keys for product specific profile properties.
[dddgddzasdssaddataddadsddagadsasadaadadssdadasddsasdssaadasaadaiiadasaited

<install modify="'false'>
<offering id='com.ibm.websphere.APPCLIENT.v80"
profile='Application Client for IBM WebSphere Application Server V8.0'
features='javaee.thinclient.core.feature,javaruntime,developerkit,embeddablecontainer' installFixes='none'/>
</install>
<!-- <offering id='PM12345_WAS80' profile='Application Client for IBM WebSphere Application Server V8.0'/> -->

<profile id='Application Client for IBM WebSphere Application Server V8.0'
installLocation="C:\Program Files\IBM\WebSphere\AppClient'>

<data key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\AppClient'/>

<data key='user.import.profile' value='false'/>

<data key='user.select.64bit.image,com.ibm.websphere.APPCLIENT.v80' value='false'/>

<data key='user.appclient.serverHostname' value='localhost'/>

<data key='user.appclient.serverPort' value='2809'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<l-- ##### Shared Data Location ###################F#ERFFRERFAAAHERAAFAAAHS
Uncomment the preference for eclipseCache to set the shared data

Tocation the first time you use Installation Manager to do an
installation.

Eclipse cache location can be obtained from the installed.xml file found in
Linux/Unix: /var/ibm/InstallationManager

Windows: C:\Documents and Settings\A11 Users\Application Data\IBM\Installation Manager
from the following property:

<property name='cachelLocation' value='C:\Program Files\IBM\IMShared'/>

Open the installed.xml file in a text editor because the style sheet

might hide this value if opened in a web browser.

For further information on how to edit preferences, refer to the public Tibrary at:
http://publib.boulder.ibm.com/infocenter/install/vlr4/index.jsp?topic=/com.ibm.silentinstal112.doc/topics/r_silent_prefs.html

After the shared data location is set, it cannot be changed
using a response file or the graphical wizard.

Ensure that the shared data location is a location that can be written

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# to by all user accounts that are expected to use Installation Manager.
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By default, Installation Manager saves downloaded artifacts to
the shared data Tocation. This serves two purposes.

First, if the same product is installed a more than once to the machine,
then the files in the shared data location will be used rather than
downloading them again.

Second, during the rollback process, the saved artifacts are used.
Otherwise, if the artifacts are not saved or are removed, then
Installation Manager must have to access the repositories used to
install the previous versions.

#
#
#
#
#
#
#
#
#
#
#
#
#
# Valid values for preserveDownloadedArtifacts:

# true = store downloaded artifacts in the shared data location

# false = remove downloaded artifacts from the shared data location
#
#

[ERagdsssdisasddaddsasdasagdsaadatasdadasdsragdsaagisaddasddadssysted

<l--
<preference name="'com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files\IBM\IMShared'/>

<preference name="'com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
-

<!-- ##### Preferences Settings ################E##F#ARFFRARAARAHERAAFARAHS
Additional preferences for Installation Manager can be specified.

These preference correspond to those that are located in the graphical
interface under File / Preferences.

If a preference command is omitted from or commented out of the response
file, then Installation Manager uses the preference value that was
previously set or the default value for the preference.

Preference settings might be added or deprecated in new versions of
Installation Manager. Consult the online Installation Manager
Information Center for the latest set of preferences and
descriptions about how to use them.

#
#
#
#
#
#
#
#
#
#
#
#
#
# http://publib.boulder.ibm.com/infocenter/install/vlrd/index.jsp
#

#

[ARagdsssdisaaddasddsasdasagdsaadatasdadasdssagdsaagisagddasdddaidssss it

<l--
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30"'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntIm.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>
-

</agent-input>

Note: In the following list, the optional feature offering names are enclosed in parentheses:
* IBM Developer Kit, Java 2 Technology Edition
— Java 2 Runtime Environment (javaruntime)
— Developer Kit (developerkit)
* Samples (samples)
» Standalone Thin Clients, Resource Adapters, and Embeddable Containers

— Standalone Thin Clients Runtime (standalonethinclient.resourceadapter.runtime)
— Standalone Thin Clients Samples (standalonethinclient.resourceadapter.samples)

— Embeddable EJB Container (embeddablecontainer)

Installing and removing features in the Application Client

You can use Installation Manager to install or remove a feature in the Application Client for IBM

WebSphere Application Server.
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Before you begin

Make sure that your Installation Manager preferences are pointing to the appropriate web-based or local
repositories containing the Application Client for IBM WebSphere Application Server.

About this task

Perform this procedure to use the Installation Manager GUI to install or remove a feature in the Application
Client for IBM WebSphere Application Server.

Note: Like other Installation Manager operations, you can also invoke a modification using one of the
following procedures:

* Using a silent response file

You can record this response file using the GUI and Installation Manager's record mode, or you
can manually create or modify a response file to suit your needs.

e Using the imcl command-line tool
Go to the [Installation Manager Information Center|for more information.

Restriction: The imcl command-line tool in Installation Manager Version 1.4.x and earlier cannot
update the product and remove features at the same time You should update the
package with the same features using the imc1 command and then remove
unwanted features using the imc1 command.

Procedure
1. Stop all servers and applications on the Application Client installation that is being modified.

2. Start Installation Manager.

3. Click Modify.

4. Select the package group to modify.
5. Click Next.

Note: If you are prompted to authenticate, use the IBM ID and password that you registered with on
the program website.

6. Expand Application Client for IBM WebSphere Application Server.

7. Check the appropriate checkbox to install a feature, or clear the appropriate checkbox to remove a
feature if you already have it installed.

* IBM Developer Kit, Java 2 Technology Edition
This option installs the IBM Developer Kit, Java 2 Technology Edition.

This feature includes a development kit and a runtime-environment package. The
runtime-environment package is always installed with the Java EE and Java thin application client
feature even if this feature is not installed.

— Java 2 Runtime Environment
This option installs the Java 2 runtime environment.

This feature includes the Java 2 runtime environment of IBM Developer Kit, Java 2 Technology
Edition.

— Developer Kit
This option installs the developer Kkit.
This feature includes the developer kit of IBM Developer Kit, Java 2 Technology Edition.
e Samples

This option installs executable and source-code examples of programming in both Java EE and
non-Java EE client environments.

198 Developing WebSphere applications


http://publib.boulder.ibm.com/infocenter/install/v1r4/

» Standalone Thin Clients, Resource Adapters, and Embeddable Containers

IBM thin clients and resource adapters provide a set of clients and resource adapters for a variety
of technologies, such as JAX-WS, JAX-RPC, JAX-RS, XML, EJB, JPA, JMS, and more. An
embeddable container runs in a standalone Java Platform, Standard Edition environment. For
example, you can use the embeddable EJB container to run enterprise beans outside the
application server.

— Standalone thin clients and resource adapters

This option installs the runtime for standalone thin clients.
— Embeddable EJB container

This option installs the embeddable EJB container.

The embeddable EJB container is a Java Archive (JAR) file that you can use to run enterprise
beans in a standalone Java Platform, Standard Edition environment. You can run enterprise
beans using this embeddable container outside the application server. The embeddable EJB
container is a part of the EJB 3.1 specification and is primarily used for unit testing enterprise
beans business logic.

8. Click Next.
9. Review the summary information, and click Modify.

 |If the modification is successful, the program displays a message indicating that installation is
successful.

« If the modification is not successful, click View Log File to troubleshoot the problem.
10. Click Finish.
11. Click File > Exit to close Installation Manager.

Example

In the following list, the optional feature offering names are enclosed in parentheses:

* |IBM Developer Kit, Java 2 Technology Edition
— Java 2 Runtime Environment (javaruntime)
— Developer Kit (developerkit)

» Samples (samples)

» Standalone Thin Clients, Resource Adapters, and Embeddable Containers
— Standalone Thin Clients Runtime (standalonethinclient.resourceadapter.runtime)
— Standalone Thin Clients Samples (standalonethinclient.resourceadapter.samples)
— Embeddable EJB container (embeddablecontainer)

T Here is a response file that modifies an existing Application Client for IBM WebSphere
Application Server installation:

<?xml version="1.0" encoding="UTF-8"?>

<l-- ##### Copyright #############AFFFFRAFEFRAFFRAAFEARAAAARAARAAAAAA A RAHS

# Licensed Materials - Property of IBM (c) Copyright IBM Corp. 2011.

# A1l Rights Reserved. US Government Users Restricted Rights-Use, duplication
# or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
[didgdzsssdzasadadadasdsdagddsadddasddaadddasddsagdiaastadasdadagddsiss it

<!-- ##### Frequently Asked Questions ###################AFH#FRAFFAAFF#AHFH
The latest information about using Installation Manager is
located in the online Information Center. There you can find
information about the commands and attributes used in
silent installation response files.

#
#
#
#
#
# Installation Manager Information Center can be found at:

# http://publib.boulder.ibm.com/infocenter/install/vlr4/index.jsp
#

#

#

#

#

#

Question 1. How do I record a response file using Installation Manager?
Answer 1. Start Installation Manager from the command Tine under the
eclipse subdirectory with the record parameter and it will generate a
response file containing actions it performed, repositories it used, and
its preferences settings. Optionally use the -skipInstall parameter if
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you do not want the product to be installed to the machine. Specify a

new agentDatalocation location value when doing a new installation. Do

not use an existing agentDatalocation for an installation because it might
damage the installation data and prevent you from modifying, updating,
rolling back, or uninstalling the installed packages.

Windows: IBMIM -record <responseFile> -skipInstall <agentDatalocation>
Linux or UNIX: ./IBMIM -record <responseFile> -skipInstall <agentDatalocation>

For example:
Windows = IBMIM.exe -record c:\temp\responsefiles\WASv8.install.Win32.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry
Linux or UNIX = ./IBMIM -record /home/user/responsefiles/WASv8.install.RHEL64.xmI
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry

Question 2. How do I run Installation Manager silently using response file?

Answer 2. Create a silent installation response file and run the following command
from the eclipse\tools subdirectory in the directory where you installed
Installation Manager:

Windows = imcl.exe -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>

For example:
Windows = imcl.exe -acceptLicense -showProgress
input c:\temp\responsefile\WASv8.install.Win32.xml
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input /home/user/responsefile/WASv8.install.RHEL64.xm]

The -acceptLicense command must be included to indicate acceptance of all
license agreements of all offerings being installed, updated or modified.

The -showProgress command shows progress when running in silent mode.

Additional commands can be displayed by requesting help: IBMIM -help

require authentication?

Answer 3. Installation Manager uses a key ring file to store encrypted
credentials for authenticating with repositories. Follow this two-step
process for creating and using a key ring file with Installation Manager.

First, create a key ring file with your credentials by starting
Installation Manager from the command Tine under eclipse subdirectory
with the keyring parameter.

Use the optional password parameter to password protect your file.

Windows = IBMIM.exe -keyring <path and file name> -password <password>
Linux, UNIX, IBM i and z/0S = ./IBMIM -keyring <path and file name>
-password <password>

Installation Manager will start in graphical mode. Verify that the
repositories to which you need to authenticate are included in the
preferences, File / Preferences / Repositories. If they are not

listed, then click Add Repositories to add the URL or UNC path.
Installation Manager will prompt for your credentials. If the repository

is already in the Tist, then any attempt to access the repository location,
such as clicking the Test Connections button, will also prompt for your
credentials. Enter the correct credential and check the Save password
checkbox. The credentials are saved to the key ring file you specified.

Second, when you start a silent installation, run imcl under eclipse/tools
subdirectory, and provide Installation Manager with the Tocation of the key
ring file and the password if the file is protected. For example:

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

# Question 3. How do I store and pass credentials to repositories that
#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

# Windows = imcl.exe -acceptLicense -showProgress
# input <path and file name of response file>
# -keyring <path and name of key ring file> -password <password>
#  Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
# input <path and file name of response file>
# -keyring <path and name of key ring file> -password <password>
#
#

[Adigdssssdsspddaadddaadddagddsapddaptadasdadagdssapdsappdaadddandstasiited
<l-- ##### Agent Input ################EFF##EEF#ERAAAERAAERAAARAAAEA

The clean and temporary attributes specify the repositories and other
preferences Installation Manager uses and whether those settings
should persist after the installation finishes.

Valid values for clean:
true = only use the repositories and other preferences that are
specified in the response file.
false = use the repositories and other preferences that are
specified in the response file and Installation Manager.

#
#
#
#
#
#
#
#
#
#
# Valid values for temporary:

# true = repositories and other preferences specified in the
# response file do not persist in Installation Manager.
# false = repositories and other preferences specified in the
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# response file persist in Installation Manager.
#
[didgdzsssdzasadadadaadddagadsasddasddssddasddsagaiastadaadddasddsiss et

<agent-input clean='true' temporary='true'>

<l-- ##### Repositories ###############F#FF#A#HHAAAFFFIFAAARRARAAAFFAAAAARS
Repositories are locations that Installation Manager queries for
installable packages. Repositories can be local (on the machine

with Installation Manager) or remote (on a corporate intranet or

hosted elsewhere on the internet).

If the machine using this response file has access to the internet,
then include the IBM WebSphere Live Update Repositories in the Tist
of repository locations.

If the machine using this response file cannot access the internet,
then comment out the IBM WebSphere Live Update Repositories and
specify the URL or UNC path to custom intranet repositories and
directory paths to local repositories to use.

S oS SR SR SR SR SR SR SR SR R SR SR S

[ARagdsssdissddasddsasdasaasaabatasdataadssaadsaapissgdasdtaidssss it

<server>
<!-- ##### IBM WebSphere Live Update Repositories ####################
# These repositories contain Application Client offerings,
and updates for those offerings

#
#
# To use the secure repository (https), you must have an IBM ID,
# which can be obtained by registering at: http://www.ibm.com/account
# or your Passport Advantage account.
#
# And, you must use a key ring file with your response file.
lidddssassddddddgsasaasasddsddpssdadddaddggasssasadddaddsssadasdbeg
<repository location="http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80" />
<!-- <repository location="https://www.ibm.com/software/rational/repositorymanager/repositories/websphere" /> -->

<l-- ##### Custom Repositories #################ERFFAAHFFAAFFARAFEAAHS

# Uncomment and update the repository location key below

# to specify URLs or UNC paths to any intranet repositories

# and directory paths to local repositories to use.

[zgadzssadaadadadddasadsasddasddssddasddsasadasdadasdidadddisd bty
<!-- <repository location='https:\\w3.mycompany.com\repositories\'/> -->
<!-- <repository location='/home/user/repositories/websphere/'/> -->

<!-- ##### Local Repositories ##################E#FFAAFFFAAHFRREFARAHS
# Uncomment and update the following line when using a Tocal
# repository Tocated on your own machine to install a
# Application Client offering.
[dgadzssddasdadagdddasadsasddasddstsddaddsasadaadddaadddisd
<!-- <repository location='insert the full directory path inside single quotes'/> -->
</server>

<!-- ##### Modify Packages ############1####R#FFHHFHFRAFAAARFARARFRRAHRAS
Install and Uninstall Commands

Use the install and uninstall commands to inform Installation Manager
of the installation packages to install or uninstall.

The modify attribute is optional and can be paired with an install
command to add features or paired with an uninstall command to
remove commands. If omitted, the default value is set to false.
false = indicates not to modify an existing install by adding
or removing features.
true = indicates to modify an existing install by adding or
removing features.

The offering ID attribute is required because it specifies the
offering to be installed. The offering Tisted must be present in
at least one of the repositories listed earlier. The example
command below contains the offering ID for Application Client.

The version attribute is optional. If a version number is provided,

then the offering will be installed or uninstalled at the version level
specified as Tong as it is available in the repositories. If the version
attribute is not provided, then the default behavior is to install or
uninstall the Tatest version available in the repositories. The version
number can be found in the repository.xml file in the repositories.

For example, <offering ... version='8.0.0.20110617_2222'>.

The profile attribute is required and typically is unique to the
offering. If modifying or updating an existing installation, the

profile attribute must match the profile ID of the targeted installation
of Application Client.

The features attribute is optional. Offerings always have at least
one feature; a required core feature which is installed regardless
of whether it is explicitly specified. If other feature names

are provided, then only those features will be installed.

S SR S SHe SR SR S SHe S S SHE SR SR SR S SR SR S S SR S S SR SR SR SR SR S SR SR SR S SR SR SR S
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Features must be comma delimited without spaces.

The feature values for Application Client include:
developerkit,embeddablecontainer,samples,
standalonethinclient.resourceadapter.runtime

In the example that follows, the samples and standalonethinclient.re-
-sourceadapter.runtime features are being added and the embeddablecontainer
and developerkit features are being removed from the specified offering.

The core.feature cannot be removed because they are required features.

The installFixes attribute indicates whether fixes available in
repositories are installed with the product. By default, all
available fixes will be installed with the offering.

Valid values for installFixes:
none = do not install available fixes with the offering.
recommended = installs all available recommended fixes with the offering.
all = installs all available fixes with the offering.

Installation Manager supports modifying multiple offerings at once.
Additional offerings can be included in the install and uninstall commands,
with each offering requiring its own offering ID, version, profile value,
and feature values.

Profile Command

A separate profile command must be included for each offering Tisted
in the install command. The profile command informs Installation
Manager about offering specific properties or configuration values.

The installlLocation specifies where the offering will be installed.
If the response file is used to modify or update an existing
installation, then ensure the installlocation points to the
location where the offering was installed previously.

The eclipselocation data key should use the same directory path to
Application Client as the installationLocation attribute.

Include data keys for product specific profile properties.

S SR S SR R R SR SR R SR SR SR R S SR SR SR SR SR SR S SR SR SR SR SR SR S SR SR S SR SR SR SR SR SR S SR SR S S

[gdizdzssassssdagdaddaddadasdasiasdstiaddaddaddadssdasdasiatdaddadidads it
<install modify="true'>
<offering id='com.ibm.websphere.APPCLIENT.v80"
profile='Application Client for IBM WebSphere Application Server V8.0'
features='samples,standalonethinclient.resourceadapter.runtime'/>
</install>

<uninstall modify="'true'>

<offering id='com.ibm.websphere.APPCLIENT.v80"
profile='Application Client for IBM WebSphere Application Server V8.0'
features="'embeddablecontainer,developerkit'/>

</uninstall>

<profile id='Application Client for IBM WebSphere Application Server V8.0'
installLocation="'C:\Program Files\IBM\WebSphere\AppClient'>

<data key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\AppClient'/>
<data key='user.import.profile' value='false'/>

<data key='user.select.64bit.image,com.ibm.websphere.APPCLIENT.v80' value='false'/>
<data key='user.appclient.serverHostname' value='localhost'/>

<data key='user.appclient.serverPort' value='2809'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<l-- ##### Shared Data Location ###################F#ERFFRARFARARERAAFARAHS
Uncomment the preference for eclipseCache to set the shared data

Tocation the first time you use Installation Manager to do an
installation.

Eclipse cache location can be obtained from the installed.xml file found in
Linux/Unix: /var/ibm/InstallationManager

Windows: C:\Documents and Settings\A11 Users\Application Data\IBM\Installation Manager
from the following property:

<property name='cachelLocation' value='C:\Program Files\IBM\IMShared'/>

Open the installed.xml file in a text editor because the style sheet

might hide this value if opened in a web browser.

For further information on how to edit preferences, refer to the public Tibrary at:
http://publib.boulder.ibm.com/infocenter/install/vir4/index.jsp?topic=/com.ibm.silentinstal112.doc/topics/r_silent_prefs.html

After the shared data location is set, it cannot be changed
using a response file or the graphical wizard.

Ensure that the shared data location is a location that can be written
to by all user accounts that are expected to use Installation Manager.

By default, Installation Manager saves downloaded artifacts to
the shared data Tocation. This serves two purposes.

S SR S SHe SR SR S S S S SHe S SR S SR SR S S SR SR S SR SR S
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First, if the same product is installed a more than once to the machine,
then the files in the shared data location will be used rather than
downloading them again.

Second, during the rollback process, the saved artifacts are used.
Otherwise, if the artifacts are not saved or are removed, then
Installation Manager must have to access the repositories used to
install the previous versions.

#
#
#
#
#
#
#
#
#
# Valid values for preserveDownloadedArtifacts:

# true = store downloaded artifacts in the shared data location

# false = remove downloaded artifacts from the shared data location
#
#

[ERaddsssdisadddasddsasdssagdsaadssapdasasdsragdsaagisaddasdtadssys it

<l--
<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files\IBM\IMShared'/>

<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
-

<!-- ##### Preferences Settings ###################FHARFFAARAFRAFEAAAFARAHS
Additional preferences for Installation Manager can be specified.

These preference correspond to those that are located in the graphical
interface under File / Preferences.

If a preference command is omitted from or commented out of the response
file, then Installation Manager uses the preference value that was
previously set or the default value for the preference.

Preference settings might be added or deprecated in new versions of
Installation Manager. Consult the online Installation Manager
Information Center for the latest set of preferences and
descriptions about how to use them.

#
#
#
#
#
#
#
#
#
#
#
#
#
# http://publib.boulder.ibm.com/infocenter/install/vlrd/index.jsp
#

#

[ARagdsssdisasddadddasddsagdsaadasasdadasdasagdsaagisagdasdddaidssss it

<l--
<preference name="'com.ibm.cic.common.core.preferences.connectTimeout' value='30"'/>
<preference name="'com.ibm.cic.common.core.preferences.readTimeout' value='45'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntIm.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>
-

</agent-input>

Installing fix packs on the Application Client
You can use Installation Manager to update the Application Client to a later version.

Before you begin

Make sure that the web-based or local service repository location is listed and checked or that the Search
service repositories during installation and updates option is selected on the Repositories panel in
your Installation Manager preferences. For more information on using service repositories with Installation
Manager, read the [Installation Manager Information Center}

About this task
Perform this procedure to use Installation Manager to update the Application Client.

Procedure
1. Start Installation Manager.
2. Click Update.

Note: If you are prompted to authenticate, use the IBM ID and password that you use to access
protected IBM software websites.

3. Select the package group to update.
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4. Click Next.

5. Select the version to which you want to update under Application Client for IBM WebSphere
Application Server.

6. Click Next.

7. Accept the terms in the license agreements, and click Next.

8. Select the optional features that you want in your updated installation.

9. Review the summary information, and click Update.

 If the installation is successful, the program displays a message indicating that installation is
successful.

 If the installation is not successful, click View Log File to troubleshoot the problem.
10. Click Finish.
11. Click File > Exit to close Installation Manager.

Uninstalling fix packs from the Application Client using the Installation Manager
GUI

You can use Installation Manager to roll back the Application Client to an earlier version.
Before you begin

During the rollback process, Installation Manager must access files from the earlier version of the package.
By default, these files are stored on your computer when you install a package. If you change the default
setting or delete the files using the Remove Saved Files option, Installation Manager requires access to
the repository that was used to install the earlier version.

About this task
Perform this procedure to use Installation Manager to roll back the Application Client to an earlier version.

Procedure
1. Start Installation Manager.
2. Click Roll Back.

Note: If you are prompted to authenticate, use the IBM ID and password that you use to access
protected IBM software websites.

3. Select the package group to roll back.
4. Click Next.

5. Select the version to which you want to roll back under Application Client for IBM WebSphere
Application Server.

6. Click Next.
7. Review the summary information, and click Roll Back.

« If the rollback is successful, the program displays a message indicating that the rollback is
successful.

 If the rollback is not successful, click View Log File to troubleshoot the problem.
8. Click Finish.
9. Click File > Exit to close Installation Manager.

Uninstalling the Application Client using the GUI
Use the Installation Manager GUI to uninstall the Application Client.
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Procedure
1. Uninstall the Application Client.
a. Stop all servers and applications on the Application Client installation that contains the product.
b. Start Installation Manager.
c. Click Uninstall.
d. In the Uninstall Packages window, perform the following actions.

1) Select Application Client for IBM WebSphere Application Server and the appropriate
version.

Note: If you are uninstalling the ILAN version of this product, select Application Client for
IBM WebSphere Application Server (ILAN).

2) Click Next.
Review the summary information.
f. Click Uninstall.
« If the uninstallation is successful, the program displays a message that indicates success.
 If the uninstallation is not successful, click View log to troubleshoot the problem.
g. Click Finish.
h. Click File > Exit to close Installation Manager.
2. Optional: Uninstall IBM Installation Manager.

o

Important: Before you can uninstall IBM Installation Manager, you must uninstall all of the packages
that were installed by Installation Manager.

Read [Uninstalling Installation Managerin the Installation Manager information center for information
about performing this procedure.

Uninstalling the Application Client silently
You can use Installation Manager to uninstall the Application Client silently.

Before you begin

Optional: Perform or record the installation of Installation Manager and installation of the Application
Client to a temporary installation registry on one of your systems so that you can use this
temporary registry to record the uninstallation without using the standard registry where
Installation Manager is installed.

Read the following for more information:
« [Installing the Application Client using the GUI” on page 182
« [Installing the Application Client silently” on page 187]

About this task

Using Installation Manager, you can work with response files to uninstall the Application Client silently in a
variety of ways. You can record a response file using the GUI as described in the following procedure, or
you can generate a new response file by hand or by taking an example and modifying it.

Procedure
1. Stop all servers and applications on the Application Client installation that contains the product.

2. Optional: Record a response file to uninstall the Application Client: On one of your systems,
perform the following actions to record a response file that will uninstall the Application Client:

a. From a command line, change to the eclipse subdirectory in the directory where you installed
Installation Manager.
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b. Start Installation Manager from the command line using the -record option.
For example:

* WM Administrator or non-administrator:

IBMIM.exe -skipInstall "C:\temp\imRegistry"
-record C:\temp\uninstall_response_file.xml

- BT EETEN ENTITEN EESTTTEE Administrator:

./IBMIM -skipInstall /var/temp/imRegistry
-record /var/temp/uninstall_response_file.xml

- B IS TS BT Non-administrator:

./IBMIM -skipInstall user_home/var/temp/imRegistry
-record user_home/var/temp/uninstall_response_file.xml

Tip: If you choose to use the -skipInstall parameter with a temporary installation registry created
as described in "Before you begin," Installation Manager uses the temporary installation
registry while recording the response file. It is important to note that when the -skipInstall
parameter is specified, no packages are installed or uninstalled. All of the actions that you
perform in Installation Manager simply update the installation data that is stored in the
specified temporary registry. After the response file is generated, it can be used to uninstall
the Application Client, removing the Application Client files and updating the standard
installation registry.

The -skiplnstall operation should not be used on the actual agent data location used by
Installation Manager. This is unsupported. Use a clean writable location, and re-use that
location for future recording sessions.

For more information, read the IBM Installation Manager Information Center|
c. Click Uninstall.
d. In the Uninstall Packages window, perform the following actions.

1) Select Application Client for IBM WebSphere Application Server and the appropriate
version.

Note: If you are uninstalling the ILAN version of this product, select Application Client for
IBM WebSphere Application Server (ILAN).

2) Click Next.

e. Review the summary information.

f. Click Uninstall.
 If the uninstallation is successful, the program displays a message that indicates success.
 If the uninstallation is not successful, click View log to troubleshoot the problem.

g. Click Finish.

h. Click File > Exit to close Installation Manager.

Use the response file to uninstall the Application Client silently: From a command line on each of
the systems from which you want to uninstall the Application Client, change to the eclipse/tools
subdirectory in the directory where you installed Installation Manager and use the response file that
you created to silently uninstall the Application Client.

For example:
* WM Administrator or non-administrator:

imcl.exe
input C:\temp\uninstall_response_file.xml
-Tog C:\temp\uninstall_log.xml

- NI EETEE BTSN EETTTEM Administrator:

./imcl
input /var/temp/uninstall_response_file.xml
-lTog /var/temp/uninstall_log.xml

s N W TS BT Non-administrator:
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/imcl
input user_home/var/temp/uninstall_response_file.xm]
-log user_home/var/temp/uninstall_log.xml

Go to the IBM Installation Manager Information Center| for more information.
4. Optional: Uninstall IBM Installation Manager.

Important: Before you can uninstall IBM Installation Manager, you must uninstall all of the packages

that were installed by Installation Manager.

Read the IBM Installation Manager Information Center|for information about using the uninstall script to

perform this procedure.

Example

The following is an example of a response file for silently uninstalling the Application Client:

<

<
#
#
#
#

<
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

<
#
#
#
#
#

?xml version="1.0" encoding="UTF-8"?7>

L-- ##### Copyright #############A##FIAHF#EAFFRRAFAAAAAAAAAAARAA AR A AR RS
Licensed Materials - Property of IBM (c) Copyright IBM Corp. 2011.

A11 Rights Reserved. US Government Users Restricted Rights-Use, duplication
or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
[dagdssssdsasadasdddasgddagadsagadaadadasdsdagdsssaissgadasdadadada st

!-- ##### Frequently Asked Questions ###################AA###RAFE#AAFARAFH
The latest information about using Installation Manager is

located in the online Information Center. There you can find

information about the commands and attributes used in

silent installation response files.

Installation Manager Information Center can be found at:
http://publib.boulder.ibm.com/infocenter/install/vlr4d/index.jsp

Question 1. How do I record a response file using Installation Manager?
Answer 1. Start Installation Manager from the command Tine under the
eclipse subdirectory with the record parameter and it will generate a
response file containing actions it performed, repositories it used, and
its preferences settings. Optionally use the -skipInstall parameter if
you do not want the product to be installed to the machine. Specify a

new agentDatalocation location value when doing a new installation. Do

not use an existing agentDatalocation for an installation because it might
damage the installation data and prevent you from modifying, updating,
rolling back, or uninstalling the installed packages.

Windows: IBMIM -record <responseFile> -skipInstall <agentDatalocation>
Linux or UNIX: ./IBMIM -record <responseFile> -skipInstall <agentDatalocation>

For example:
Windows = IBMIM.exe -record c:\temp\responsefiles\WASv8.install.Win32.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry
Linux or UNIX = ./IBMIM -record /home/user/responsefiles/WASv8.install.RHEL64.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry

Question 2. How do I run Installation Manager silently using response file?

Answer 2. Create a silent installation response file and run the following command
from the eclipse\tools subdirectory in the directory where you installed
Installation Manager:

Windows = imcl.exe -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>

For example:
Windows = imcl.exe -acceptLicense -showProgress
input c:\temp\responsefile\WASv8.install.Win32.xml
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input /home/user/responsefile/WASv8.install.RHEL64.xm]

The -acceptLicense command must be included to indicate acceptance of all
license agreements of all offerings being installed, updated or modified.

The -showProgress command shows progress when running in silent mode.

Additional commands can be displayed by requesting help: IBMIM -help

[ERagdsssddsddsasddsasddsapdsaadstapdasasdssagdssagisaddasdtadssysited
|- ##### Agent Input ###############EFFF#RFFARRAAARRAFARAAFRRAAA RS

The clean and temporary attributes specify the repositories and other
preferences Installation Manager uses and whether those settings

should persist after the uninstall finishes.

Valid values for clean:
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#
#
#
#
#
#
#
#
#
#
#
#

true = only use the repositories and other preferences that are
specified in the response file.

false = use the repositories and other preferences that are
specified in the response file and Installation Manager.

Valid values for temporary:
true = repositories and other preferences specified in the
response file do not persist in Installation Manager.
false = repositories and other preferences specified in the
response file persist in Installation Manager.

[Ragdsssddsssddaddsasddsasdssapdsapdatasdasapdsapdsaadiaaddaidssysited

<agent-input clean='true' temporary='true'>

<l-- ##### Repositories ####################H###EHFF#AAAFRARAARAHARRAAARHAH

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

Repositories are locations that Installation Manager queries for
installable packages. Repositories can be local (on the machine
with Installation Manager) or remote (on a corporate intranet or
hosted elsewhere on the internet).

If the machine using this response file has access to the internet,
then include the IBM WebSphere Live Update Repositories in the Tist
of repository locations.

If the machine using this response file cannot access the internet,
then comment out the IBM WebSphere Live Update Repositories and
specify the URL or UNC path to custom intranet repositories and
directory paths to local repositories to use.

[Ragdsssdissaddasddsasddtasdssapasasdadasdasagdsspgdsaadiaadddaidsts it

<server>

<l-- ##### IBM WebSphere Live Update Repositories ####################
# These repositories contain Application Client offerings,
and updates for those offerings

#
#
# To use the secure repository (https), you must have an IBM ID,
# which can be obtained by registering at: http://www.ibm.com/account
# or your Passport Advantage account.
#
# And, you must use a key ring file with your response file.
liddgssasadddsddsassaddadddsggpsssadddaddgsssssasdddsdssssadia i
<repository location="http://www.ibm.com/software/repositorymanager/com.ibm.websphere.APPCLIENT.v80" />
<!-- <repository location="https://www.ibm.com/software/rational/repositorymanager/repositories/websphere" /> -->

<!-- ##### Custom Repositories #################E#IFAAFFFRARAARAFERAFS

# Uncomment and update the repository Tocation key below

# to specify URLs or UNC paths to any intranet repositories

# and directory paths to local repositories to use.

[ddgadsasadasdadadddagddsasddsadddtsddatsddaddaasadaadidaadddisd bty
<!-- <repository location='https:\\w3.mycompany.com\repositories\'/> -->
<!-- <repository location='/home/user/repositories/websphere/'/> -->

<!-- ##### Local Repositories ##################ERIFAAHAFRARAARAFERARS
# Uncomment and update the following line when using a Tocal
# repository Tocated on your own machine to install a
# Application Client offering.
[3ddaddssadaadddagdddagdddasddsadddtgddsddddagadaadadasdadisd s
<!-- <repository Tocation='insert the full directory path inside single quotes'/> -->

</server>

<!-- ##### Uninstall Packages #####################F#HHFF#RRAFERAFFRAFAAES

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

Uninstall Command

Use the uninstall command to inform Installation Manager of the
installation packages to uninstall.

The modify attribute is optional and can be paired with an install
command to add features or paired with an uninstall command to
remove commands. If omitted, the default value is set to false.
false = indicates not to modify an existing install by adding
or removing features.
true = indicates to modify an existing install by adding or
removing features.

The offering ID attribute is required because it specifies the
offering to be uninstalled. The example command below contains the
offering ID for Application Client.

The version attribute is optional. If a version number is provided,
then the offering will be uninstalled at the version Tevel specified
If the version attribute is not provided, then the default behavior is
to uninstall the latest version. The version number can be found in
the repository.xml file in the repositories.

For example, <offering ... version='8.0.0.20110617_2222'>.

The profile attribute is required and must match the package group
name for the offering to be uninstalled.
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The features attribute is optional. If there is no feature attribute,
then all features are uninstalled. If features are specified, then
only those features will be uninstalled.

Features must be comma delimited without spaces.

The feature values for Application Client include:
Jjavaruntime,developerkit,samples,
standalonethinclient.resourceadapter.runtime,embeddablecontainer

Installation Manager supports uninstalling multiple offerings at once.
Additional offerings can be included in the uninstall command,

and feature values.
Profile Command

A separate profile command must be included for each offering listed
in the install command. The profile command informs Installation
Manager about offering specific properties or configuration values.

The installlLocation specifies where the offering will be installed.
If the response file is used to modify or update an existing
installation, then ensure the installlocation points to the
location where the offering was installed previously.

The eclipselLocation data key should use the same directory path to
Application Client as the installationLocation attribute.

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# Include data keys for product specific profile properties.
#

#

<uninstall modify='false'>
<offering id="'com.ibm.websphere.APPCLIENT.v80'
profile='Application Client for IBM WebSphere Application Server V8.0'

with each offering requiring its own offering ID, version, profile value,

[ARagdsasdisasddaddsasdasagdssadasasdadasdssagdsaagasaddasdddaidssss it

features='javaee.thinclient.core.feature,javaruntime,developerkit,samples,standalonethinclient.resourceadapter.runtime,embeddablecontainer'/>

</uninstall>

<profile id="Application Client for IBM WebSphere Application Server V8.0'
installLocation="'C:\Program Files\IBM\WebSphere\AppClient'>

<data key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\AppClient'/>

<data key='user.import.profile' value='false'/>

<data key='user.select.64bit.image,com.ibm.websphere.APPCLIENT.v80' value='false'/>

<data key='user.appclient.serverHostname' value='localhost'/>
<data key='user.appclient.serverPort' value='2809'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<!-- ##### Shared Data Location ######################FF#RAH##REF#RRAAAERAH

Uncomment the preference for eclipseCache to set the shared data
lTocation the first time you use Installation Manager to do an
installation.

Linux/Unix: /var/ibm/InstallationManager

from the following property:
<property name='cacheLocation' value='C:\Program Files\IBM\IMShared'/>

Open the installed.xml file in a text editor because the style sheet
might hide this value if opened in a web browser.

After the shared data location is set, it cannot be changed
using a response file or the graphical wizard.

Ensure that the shared data location is a location that can be written
to by all user accounts that are expected to use Installation Manager.

By default, Installation Manager saves downloaded artifacts to
the shared data Tocation. This serves two purposes.

First, if the same product is installed a more than once to the machine,
then the files in the shared data Tocation will be used rather than
downloading them again.

Second, during the rollback process, the saved artifacts are used.
Otherwise, if the artifacts are not saved or are removed, then
Installation Manager must have to access the repositories used to
install the previous versions.

Valid values for preserveDownloadedArtifacts:
true = store downloaded artifacts in the shared data Tocation

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# false = remove downloaded artifacts from the shared data location
#

#

<l--

Eclipse cache location can be obtained from the installed.xml file found in

Windows: C:\Documents and Settings\A11 Users\Application Data\IBM\Installation Manager

For further information on how to edit preferences, refer to the public Tibrary at:
http://publib.boulder.ibm.com/infocenter/install/vlrd/index.jsp?topic=/com.ibm.silentinstal112.doc/topics/r_silent_prefs.html

[dagdsastdsasddasdddasdddagddaapadasdadasdadagdsappisagddastddandssasted
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<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files\IBM\IMShared'/>
<preference name="'com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
-

<!-- ##### Preferences Settings #################H#FHARFFAARAAAARAAAAHARAFS
Additional preferences for Installation Manager can be specified.

These preference correspond to those that are located in the graphical
interface under File / Preferences.

If a preference command is omitted from or commented out of the response
file, then Installation Manager uses the preference value that was
previously set or the default value for the preference.

Preference settings might be added or deprecated in new versions of
Installation Manager. Consult the online Installation Manager
Information Center for the latest set of preferences and
descriptions about how to use them.

#
#
#
#
#
#
#
#
#
#
#
#
#
# http://publib.boulder.ibm.com/infocenter/install/vlr4/index.jsp
#

#

[ARagdsssddssasdasadsaddtasdssapasaadatadasasdssadsaapiasataidstyited

<l--
<preference name="'com.ibm.cic.common.core.preferences.connectTimeout' value='30"'/>
<preference name="'com.ibm.cic.common.core.preferences.readTimeout' value='45'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntIm.auth.enableIntegrated.win32' value='true'/>
<preference name="'com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name="'com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>

-

</agent-input>

Developing stand-alone thin client applications

Develop the application code, then assemble the code into a client application that you can deploy on a
client machine.

About this task

Procedure
» Getting server objects and resources.

A stand-alone client application can get suitable server objects and resources (like connection factories,
JMS queues, and data sources) programmatically without using JNDI. Alternatively, a client application
can use full JNDI support provided by the Thin Client for EJB.

» Compiling stand-alone thin client applications. To compile your client application, include the JAR files
needed in the CLASSPATH setting for the javac command; for example, any extra JAR files for the
client application's own classes, JAR files for IBM Thin clients used, and JAR files for JDBC provider
classes.

For the stand-alone thin clients, the following JAR files are provided in the /runtimes/ directory of either
an Application Client installation or Application Server installation:

Table 38. JAR files for stand-alone thin clients. The product provides JAR files for stand-alone thin clients
descriptions.

JAR file Description

com.ibm.jaxws.thinclient_8.0.0.jar IBM Thin Client for Java API for XML-based Web Services (JAX-WS). This file enables a Java
SE client application to use the JAX-WS programming model to invoke web services that are
hosted by the application server. You must use the endorsed APIs JAR file when starting Java
because the Thin Client for JAX-WS requires APIs that are more current than what is available in
JDKs to support JAX-WS 2.2 and JAXB 2.2 implementations.

com.ibm.ws.ejb.thinclient_8.0.0.jar Thin Client for Enterprise Java Beans (EJB) . This file enables a Java SE client application to
access remote Enterprise Java Beans on a server through Java Naming and Directory Interface
(JNDI) look up. If this file is running with a non-IBM product JRE on a non-IBM product platform,
the IBM ORB implementation library, com.ibm.ws.orb_8.0.0.jar, is also needed.
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Table 38. JAR files for stand-alone thin clients (continued). The product provides JAR files for stand-alone thin
clients descriptions.

JAR file Description

com.ibm.ws.jpa.thinclient_8.0.0.jar IBM Thin Client for Java Persistence API (JPA). This file allows a Java SE client application to
use the Java Persistence API (JPA) to store and retrieve persistent data without the use of an
application server.

com.ibm.ws.messagingClient.jar With the com.ibm.ws.ejb.thinclient_8.0.0.jar file, this file enables a Java SE client application to
use WebSphere MQ messaging provider JMS resources from the WebSphere Application Server
JNDI namespace. WebSphere MQ client jar files are also needed, and must be obtained from
the WebSphere MQ product.

com.ibm.ws.orb_8.0.0.jar The IBM ORB implementation library. This file is needed if the IBM Thin Client for EJB is running
with a non-IBM product JRE on a non-IBM product platform.

com.ibm.ws.sib.client.thin.jms_8.0.0.jar IBM Thin Client for Java Messaging Service (JMS). This file enables a Java SE client application
to use JMS resources of the default messaging provider. For languages other than US English,
you also need the additional language files from sibc.nls.zip, which provides language-specific
resource bundles.

com.ibm.ws.sib.client_ExpeditorDRE_8.0.0.jar The JMS Client packaged for Lotus® Expeditor.

com.ibm.ws.webservices.thinclient_8.0.0.jar IBM Thin Client for Java API for XML-based RPC (JAX-RPC). This file enable a Java SE client
application to use the JAX-RPC programming model to invoke web services that are hosted by
the application server.

If you are running two or more of these stand-alone thin clients together, you must obtain all the clients
that you are using from the same installation of Application Client for WebSphere Application Server, the
same installation of the WebSphere Application Server product, or the same service refresh.

What to do next

After developing and compiling a stand-alone thin client application, you can deploy and run the client
application.

Using JMS resources

If you are using JMS resources with the Thin Client for JMS with WebSphere Application Server, you can
choose either to obtain these resources programmatically or using the Java Naming and Directory
Interface (JNDI). Stand-alone Java SE JMS thin client applications that connect to an external WebSphere
MQ queue manager can get administratively-created WebSphere MQ messaging provider JMS resources
from the WebSphere Application Server Java Naming and Directory Interface (JNDI) namespace.

About this task

If you are using the Thin Client for JMS with WebSphere Application Server, you can obtain suitable JMS
connection factories and references to JMS queues or topics programmatically without using JNDI.
Alternatively, full JNDI support might be obtained from the Thin Client for EJB with WebSphere Application
Server. For further information, refer to the Using JMS resources with the Thin Client for JMS with
WebSphere Application Server topic.

If you are using a stand-alone Java SE JMS thin client application that connects to an external
WebSphere MQ queue manager and want to obtain administratively-created WebSphere MQ messaging
provider JMS resources from the WebSphere Application Server JNDI namespace, refer to the Obtaining
WebSphere MQ JMS resources in the thin client environment topic.

Developing a Java EE client application

This topic provides the steps that are required to develop code for a Java Platform, Enterprise Edition
(Java EE) client application.

Chapter 6. Developing Client applications 211



About this task

Procedure

1. Write the client application program. Write the Java EE client application on any development machine.
At this stage, you do not require access to the WebSphere Application Server.

2. Assemble the client application JAR file using an assembly tool.

The JNDI namespace knows what to return on a lookup because of the information assembled by the
assembly tool.

Assemble the client application on any development machine with the assembly tool installed.

When you assemble your client application, provide the required information to initialize the runtime
environment for your client application. For information about how to provide the required information,
see the documentation for the assembly tool.

When you configure resources for use by your client application, consider the following items:

* Resource environment references are different than resource references. Resource environment
references enables your client application to use a logical name to look up a resource bound into
the server JNDI namespace. A resource reference enables your application to use a logical name to
look up a local Java EE resource. The Java EE specification does not specify a particular
implementation of a resource. The following table contains supported resource types and identifies
the resources to which the WebSphere Application Server provides a client implementation.

Table 39. Supported resource types and resource identifiers. Supported resource types

Resource Type Client Configuration Notes® Client implementation
provided by WebSphere
Application Server
javax.sql.DataSource Supports specification of any No
data source implementation
class
java.net.URL Supports specification of Provided by Java Runtime
custom protocol handlers Environment files
javax.mail.Session Supports custom protocol Yes - POP3/POPSS,
configuration SMTP/SMTPS, IMAP/IMAPS
javax.jms.QueueConnectionFactory, Supports configuration of Yes - WebSphere embedded
javax.jms.TopicConnectionFactory, javax.jms.Queue, = WebSphere embedded messaging
javax.jms.Topic messaging, IBM MQ Series
and other JMS providers

3. Assemble the Enterprise Archive (EAR) file.
The application is contained in an enterprise archive (EAR file). The EAR file is composed of:
» Enterprise bean, application client, and user-defined modules or JAR files
* Web applications or WAR files
* Metadata describing the applications or application XML files

What to do next

After developing the Java EE client application code, deploy the application onto the client machines
where the client application is to run.

Java EE client application class loading
When you run your Java Platform, Enterprise Edition (Java EE) application client, a hierarchy of class
loaders is created to load classes used by your application.

The following list describes the hierarchy of class loaders:
» The Application Client for WebSphere Application Server (Application Client) run time sets this value to
the WAS_LOGGING environment variable.
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* The extensions class loader class loader is a child to the bootstrap class loader. This class loader
contains JAR files in the java/jre/1ib/ext directory or those JAR files defined by the -Djava.ext.dirs
parameter on the Java command. The Application Client client run time does not set -Djava.ext.dirs
parameters. So it uses the JAR files in the java/jre/1ib/ext directory.

* The system class loader class loader contains JAR files and classes that are defined by the -classpath
parameter on the Java command. The Application Client run time sets this parameter to the
WAS_CLASSPATH environment variable.

* The WebSphere class loader class loader loads the Application Client run time and any classes placed
in the Application Client user directories. The directories used by this class loader are defined by the
WAS_EXT_DIRS environment variable. The WAS BOOTCLASSPATH, WAS_CLASSPATH, and the WAS_EXT DIRS
environment variables are set in the fgpp_server root|/bin/setupCmdLine script for WebSphere
Application Server installations, or in thelapp _server rootl/bin/setupClient script for client installations.

As the Java EE application client run time initializes, additional class loaders are created as children of the
WebSphere class loader. If your client application uses resources such as Java DataBase Connectivity
(JDBC) API, Java Message Service (JMS) API, or Uniform Resource Locator (URL), a different class
loader is created to load each of those resources. Finally, the Application Client run time sets the
WebSphere class loader to load classes within the EAR file by processing the client JAR manifest
repeatedly. The system class path, defined by the CLASSPATH environment variable is never used and is
not part of the hierarchy of class loaders.

To package your client application correctly, you must understand which class loader loads your classes.
When the Java code loads a class, the class loader used to load that class is assigned to it. Any classes
subsequently loaded by that class will use that class loader or any of its parents, but it will not use children
class loaders.

In some cases the Application Client run time can detect when your client application class is loaded by a
different class loader from the one created for it by the Application Client run time. When this detection
occurs, you see the following message:

WSCLO205W: The incorrect class loader was used to load [0]

This message occurs when your client application class is loaded by one of the parent class loaders in the
hierarchy. This situation is typically caused by having the same classes in the EAR file and on the hard
drive. If one of the parent class loaders locates a class, that class loader loads it before the Application
Client run time class loader. In some cases, your client application still functions correctly. In most cases,
however, you receive "class not found" exceptions.

Configuring the classpath fields

When packaging your Java EE client application, you must configure various class path fields. Ideally, you
should package everything required by your application into your EAR file. This is the easiest way to
distribute your Java EE client application to your clients. However, you should not package such resources
as JDBC APIs, JMS APIs, or URLs. In the case of these resources, use class path references to access
those classes on the hard drive. You might also have other classes installed on your client machines that
you do not need to redistribute. In this case, you also want to use classpath references to access the
classes on the hard drive, as described below.

Referencing classes within the EAR file

WebSphere product Java EE applications do not use the system class path. Use the MANIFEST Class
path entry to refer to other JAR files within the EAR file. Configure these values using an assembly tool.
For example, if your client application needs to access the path of the EJB JAR file, add the deployed
enterprise bean module name to your application client class path. The format of the Class path field for
each of the different modules (Application Client, EJB, Web) is the same:

* The values must refer to JAR and class files that are contained within the EAR file.

* The values must be relative to the root of the EAR file.
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* The values cannot refer to absolute paths in the file systems.
* Multiple values must be separated by spaces, not colons or semicolons.

Attention: This is the Java method for allowing applications to function platform independent.

Typically, you add modules (JAR files) to the root of the EAR file. In this case, you only need to specify the
name of the module (JAR file) in the Class path field. If you choose to add a module with a path, you need
to specify the path relative to the root of the EAR file.

For referencing class files, you must specify the directory relative to the root of the EAR file. With an
assembly tool, you can add individual class files to the EAR file. It is recommended that these additional
class files are packaged in a JAR file. Add this JAR file to the module Class path fields. If you add class
files to the root of the EAR file, add ./ to the module Class path fields.

Consider the following example directory structure in which the file myapp.ear contains an application
client JAR file named myclient.jar and a mybeans.jar EJB module. Additional classes reside in classi.jar
and utility/class2.zip files. A class file named xyz.class is not packaged in a JAR file but is in the root of
the EAR file. Specify ./ mybeans.jar utility/class2.zip classl.jar as the value of the Classpath
property. The search order is: myapp.ear/myclient.jar myapp.ear/xyz.class myapp.ear/mybeans.jar
myapp.ear/utility/class2.zip myapp.ear/classl.jar

Referencing classes that are not in the EAR file

Use the launchClient -CCclasspath parameter. This parameter is specified at run time and takes
platform-specific class path values, which means multiple values are separated by semi-colons or colons.
The client and the server are similar in this respect.

Resource class paths

When you configure resources used by your client application using the Application Client Resource
Configuration Tool, you can specify class paths that are required by the resource. For example, if your
application is using a JDBC to a DB2® database, add db2java.zip to the class path field of the database
provider. These class path values are platform-specific and require semi-colons or colons to separate
multiple values.

On WebSphere Application Server for i5/0S®, if you use the IBM Developer Kit for Java JDBC provider to
access DB2/400, you do not have to add the db2_classes.jar file to the class path. However, if you use
the IBM Toolbox for Java JDBC provider, specify the location of the jt400.jar file.

Using the launchClient API

If you use the launchClient command, the WebSphere class loader hierarchy is created for you. However,
if you use the launchClient API, you must perform this setup yourself. Copy the TaunchClient shell
command in defining the Java system properties.

Assembling Java EE client applications
Application client projects contain programs that run on networked client systems. An application client
project is deployed as a Java archive (JAR) file.

About this task

Assemble a client module to contain client application code. Group enterprise beans, web components,
and resource adapter code in separate modules.

Use an assembly tool to assemble an application client module in any of the following ways:
* Import an existing application client JAR file.
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» Create a new application client module.

Procedure
1. Start an assembly tool.

2. If you have not done so already, configure the assembly tool for work on Java Platform, Enterprise
Edition (Java EE) modules. Ensure that Java EE capability is enabled.

3. Migrate application client JAR files created with the Assembly Toolkit, Application Assembly Tool (AAT)
or a different tool to an assembly tool. To migrate files, import your application client JAR files to the
assembly tool.

4. Create a new client application.
5. Verify the contents of the new client application in either of the following ways:
* In the Project Explorer view, expand Application Client Projects and view the new module.

« Click Window > Show View > Navigator to see the associated files for the application client
module in a Navigator view.

What to do next

After you finish assembling all of your application's modules, you are ready to deploy your application.

Developing a Java thin client application

Develop the application code, then assemble the code into a client application that you can deploy on a
client machine.

About this task

To develop a Java thin client application, you developing the application code, generate the client bindings
needed for the enterprise bean and CORBA objects, and package these pieces together to install on the
client machine.

With the Java thin client, the client application must code explicitly the fully-qualified location for each
resource that it uses. For example, a Java thin client application that looks up an enterprise bean Home
contains the following code:

java.lang.Object ejbHome =

initialContext.lookup("the/fully/qualified/path/to/actual/home/in/namespace/MyEJBHome");
MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome, MyEJBHome.class);

The Java thin client application must know the fully-qualified physical location of the enterprise bean Home
in the namespace. If this location changes, the thin client application must also change the value placed
on the lookup() statement.

To compile a Java thin client application, include the client jars file needed by the application in the
CLASSPATH setting for the javac command.

Developing ActiveX client application code

This topic provides an outline for developing an ActiveX Windows program, such as Visual Basic,
VBScript, and Active Server Pages, to use the WebSphere ActiveX to EJB bridge to access enterprise
beans.
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Before you begin

Important: This topic assumes that you are familiar with ActiveX programming and developing on the
Windows platform. For information about the programming concepts of ActiveX application
clients and the ActiveX to EJB bridge, refer to the ActiveX to Enterprise JavaBeans™ (EJB)
Bridge topic, and related topics.

Consider the information given in ActiveX to EJB bridge as good programming guidelines.

About this task

To use the ActiveX to EJB bridge to access a Java class, develop your ActiveX program to complete the
following steps:

Procedure
1. Create an instance of the XJB.JClassFactory object.

2. Create Java virtual machine (JVM) code within the ActiveX program process, by calling the XJBInit()
method of the XJB.JClassFactory object. After the ActiveX program has created an XJB.JClassFactory
object and called the XJBInit() method, the JVM code is initialized and ready for use.

3. Create a proxy object for the Java class, by using the XJB.JClassFactory FindClass() and
Newlnstance() methods. The ActiveX program can use the proxy object to access the Java class,
object fields, and methods.

4. Call methods on the Java class, using the Java method invocation syntax, and access Java fields as
required.

5. Use the helper functions to do the conversion in cases where automatic conversion is not possible.
You can convert between the following data types:
» Java Byte and Visual Basic Byte
 Visual Basic Currency types and Java 64-bit

6. Implement methods to handle any errors returned from the Java class. In Visual Basic or VBScript, use
the Err.Number and Err.Description fields to determine the actual Java error.

Example
+ [Viewing a System.out message]
« [ActiveX client application using helper methods for data type conversion|

Viewing a System.out message: The ActiveX to Enterprise JavaBeans (EJB) bridge does not have a
console available to view Java System.out messages. To view these messages when running a
stand-alone client program (such as Visual Basic), redirect the output to a file.

The following example illustrates how to redirect output to a file:

launchClientXJB.bat MyProgram.exe > output.txt
» To view the System.out messages when running a Service program such as Active Server Pages,
override the Java System.out OutputStream object to FileOutputStream. For example, in VBScript:

'Redirect system.out to a file

" Assume that oXJB is an initialized XJB.JClassFactory object
Dim c1sSystem

Dim 00S

Dim oPS

Dim oArgs

' Get the System class
Set clsSystem = oXJB.FindClass("java.lang.System")

" Create a FileOutputStream object
Create a PrintStream object and assign to it our FileQutputStream
Set oArgs = oXJB.GetArgsContainer oArgs.AddObject "java.io.OutputStream", 00S

216 Developing WebSphere applications



Set oPS = oXJB.NewInstance(oXJB.FindClass("java.io.PrintStream"), oArgs)

" Set our System OutputStream to our file
clsSystem.setOut oPS

ActiveX client application using helper methods for data type conversion. Generally, data type
conversion between ActiveX (Visual Basic and VBScript) and Java methods occurs automatically, as
described in ActiveX to EJB bridge, converting data types. However, the byte helper function and currency
helper function are provided for cases where automatic conversion is not possible.

» Byte helper function

Because the Java Byte data type is signed (-127 through 128) and the Visual Basic Byte data type is
unsigned (0 through 255), convert unsigned Bytes to a Visual Basic Integers, which look like the Java
signed byte. To make this conversion, you can use the following helper function:

Private Function GetIntFromJavaByte(Byte jByte) as Integer
GetIntFromJavaByte = (CInt(jByte) + 128) Mod 256 - 128
End Function

* Currency helper function

Visual Basic 6.0 cannot properly handle 64-bit integers like Java methods can (as the Long data type).
Therefore, Visual Basic uses the Currency type, which is intrinsically a 64-bit data type. The only side
effect of using the Currency type (the Variant type VT_CY) is that a decimal point is inserted into the
type. To extract and manipulate the 64-bit Long value in Visual Basic, use code like the following
example. For more details on this technique for converting Currency data types, see Q189862,
"HOWTO: Do 64-bit Arithmetic in VBA", on the Microsoft Knowledge Base.

" Currency Helper Types

Private Type MungeCurr
Value As Currency

End Type

Private Type Munge2long
LoValue As Long
HiValue As Long

End Type

" Currency Helper Functions
Private Function CurrToText(ByVal Value As Currency) As String
Dim Temp As String, L As Long
Temp = Format$(Value, "#.0000")
L = Len(Temp)
Temp = Left§(Temp, L - 5) & Right$(Temp, 4)
Do While Len(Temp) > 1 And Left$(Temp, 1) = "0"
Temp = Mid$(Temp, 2)

Loop

Do While Len(Temp) > 2 And Left$(Temp, 2) = "-0"
Temp = "-" & Mid§(Temp, 3)

Loop

CurrToText = Temp
End Function

Private Function TextToCurr(ByVal Value As String) As Currency
Dim L As Long, Negative As Boolean
Value = Trim$(Value)
If Left$(Value, 1) = "-" Then
Negative = True
Value = Mid$(Value, 2)

End If
L = Len(Value)
If L <4 Then
TextToCurr = CCur(IIf(Negative, "-0.", "0.") & _
Right$("0000" & Value, 4))
Else

TextToCurr = CCur(IIf(Negative, "-", "") & _
Left$(Value, L - 4) & "." & Right$(Value, 4))
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End If
End Function

' Java Long as Currency Usage Example
Dim LC As MungeCurr
Dim L2 As Munge2lLong

' Assign a Currency Value (really a Java Long)
' to the MungeCurr type variable
LC.Value = cyTestln

' Coerce the value to the MungeZ2long type variable
LSet L2 = LC

' Perform some operation on the value, now that we
' have it available in two 32-bit chunks
L2.LoValue = L2.LoValue + 1

' Coerce the Munge value back into a currency value
LSet LC = L2
cyTestIn = LC.Value

What to do next

After you develop the ActiveX client application code, deploy and run the ActiveX application.

Example: Using an ActiveX client application to access a Java class or object
This reference topic provides an example of using Java proxy objects with the ActiveX to Enterprise
JavaBeans (EJB) bridge.

To use Java proxy objects with the ActiveX to Enterprise JavaBeans (EJB) bridge:

» After an ActiveX client program (Visual Basic, VBScript, or Active Server Pages (ASP)) has initialized
the XJB.JClassFactory object and thereby, the Java virtual machine (JVM), the client program can
access Java classes and initialize Java objects. To complete this action, the client program uses the
XJB.JClassFactory FindClass() and NewlInstance() methods.

* In Java programming, two ways exists to access Java classes: direct invocation through the Java
compiler and through the Java Reflection interface. Because the ActiveX to Java bridge needs no
compilation and is a complete run-time interface to the Java code, the bridge depends on the latter
Reflection interface to access its classes, objects, methods and fields. The XJB.JClassFactory
FindClass() and NewlInstance() methods behave very similarly to the Java Class.forName() and the
Method.invoke() and Field.invoke() methods.

* XJB.JClassFactory.FindClass() takes the fully qualified class name as its only parameter and returns a
Proxy Object (JClassProxy). You can use the returned Proxy object like a normal Java Class object and
call static methods and access static fields. You can also create a Class Instance (or object), as
described below. For example, the following Visual Basic code extract returns a Proxy object for the
java.lang.Integer Java class:

Dim clsMyString as Object
Set clsMyString = oXJB.FindClass("java.lang.Integer")

» After the proxy is created, you can access its static information directly. For example, you can use the
following code extract to convert a decimal integer to its hexadecimal representation:

Dim strHexValue as String
strHexValue = c1sMyString.toHexString(CLng(255))

» The equivalent Java syntax is: static String toHexString(int i). Because ints units in Java
programming are really 32-bit (which translates to Long in Visual Basic), the CLng() function converts
the value from the default int to a long. Also, even though the toHexString() function returns a
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java.lang.String, the code extract does not return an Object proxy. Instead, the returned java.lang.String
is automatically converted to a native Visual Basic string.

To create an object from a class, you use the JClassFactory.NewlInstance() method. This method
creates an Object instance and takes whatever parameters your class constructor needs. Once the
object is created, you have access to all of its public instance methods and fields. For example, you can
use the following Visual Basic code extract to create an instance of the java.lang.Integer string:

Dim oMyInteger as Object
set oMyInteger = oXJB.NewInstance(CLng(255))

Dim strMyInteger as String
strMyInteger = oMyInteger.toString

Example: ActiveX client application calling Java methods
In the ActiveX to Enterprise Java Beans (EJB) bridge, methods are called using the native language

method invocation syntax.

The following differences between Java invocation and ActiveX Automation invocation exist:
* Unlike Java methods, ActiveX does not support method (and constructor) polymorphism; that is, you

cannot have two methods in the same class with the same name.

Java methods are case-sensitive, but ActiveX Automation is not case-sensitive.

To compensate for Java polymorphic behavior, give the exact parameter types to the method call. The
parameter types determine the correct method to invoke. For a listing of correct types to use, see
ActiveX to EJB bridge, converting data types.

For example, the following Visual Basic code fails if the CLng() method was not present or the
toHexString syntax was incorrectly typed as ToHexString:

Dim strHexValue as String

strHexValue = c1sMyString.toHexString(CLng(255))

Sometimes it is difficult to force some development environments to leave the case of your method calls
unchanged. For example, in Visual Basic if you want to call a method close() (lowercase), the Visual
Basic code capitalizes it "Close()". In Visual Basic, the only way to effectively work around this
behavior is to use the CallByName() method. For example:

0.Close(123) 'Incorrect...
Cal1ByName(o, "close", vbMethod, 123) 'Correct...

or in VBScript, use the Eval function:

0.Close(123) "Incorrect...

Eval("o.Close(123)") 'Correct...

The return value of a function is always converted dynamically to the correct type. However, you must
take care to use the set keyword in Visual Basic. If you expect a non-primitive data type to return, you
must use set. (If you expect a primitive data type to return, you do not need to use set.) See the
following example for more explanation:

Set oMyObject = o.getObject

iMyInt = o.getInt

In some cases, you might not know the type of object returning from a method call, because wrapper
classes are converted automatically to primitives (for example, java.lang.Integer returns an ActiveX
Automation Long). In such cases, you might need to use your language built-in exception handling
techniques to try to coerce the returned type (for example, On Error and Err.Number in Visual Basic).
Methods with character arguments

Because ActiveX Automation does not natively support character types supported by Java methods, the
ActiveX to EJB bridge uses strings (byte or VT_I1 do not work because characters have multiple bytes
in Java code). If you try to call a method that takes a char or java.lang.Character type you must use the
JMethodArgs argument container to pass character values to methods or constructors. For more
information about how this argument container is used, see Methods with "Object" Type as Argument
and Abstract Arguments.
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» Methods with "Object" Type as Argument and Abstract Arguments

Because of the polymorphic nature of Java programming, the ActiveX to Java bridge uses direct
argument type mapping to find a method. This method works well in most cases, but sometimes
methods are declared with a Parent or Abstract class as an argument type (for example,
java.lang.Object). You need the ability to send an object of arbitrary type to a method. To acquire this
ability, you must use the XJB.JMethodArgs object to coerce your parameters to match the parameters
on your method. You can get a JMethodArgs instance by using the JClassFactory.GetArgsContainer()
method.

The JMethodArgs object is a container for method parameters or arguments. This container enables
you to add parameters to it one-by-one and then you can send the JMethodArgs object to your method
call. The JClassProxy and JObjectProxy objects recognize the JMethodArgs object and attempt to find
the correct method and let the Java language coerce your parameters appropriately.

For example, to add an element to a Hashtable object the method syntax is Object put(Object key,
Object value). In Visual Basic, the method usage looks like the following example code:
Dim oMyHashtable as Object

Set oMyHashtable = _
oXJB.NewInstance(oXJB.FindClass("java.utility.Hashtable"))

" This Tine will not work. The ActiveX to EJB bridge cannot find a method
" called "put" that has a short and String as a parameter:
oMyHashtable.put 100, "Dogs"

oMyHashtable.put 200, "Cats"

" You must use a XJB.JMethodArgs object instead:

Dim oMyHashtableArgs as Object

Set oMyHashtableArgs = oXJB.GetArgsContainer
oMyHashtableArgs.AddObject ("java.lang.0Object", 100)
oMyHashtableArgs.AddObject ("java.lang.0Object", "Dogs")

oMyHashtable.put oMyHashTableArgs

' Reuse the same JMethodArgs object by clearing it.
oMyHashtableArgs.Clear

oMyHashtableArgs.AddObject ("java.lang.0Object", 200)
oMyHashtableArgs.AddObject ("java.lang.0Object", "Cats")

oMyHashtable.put oMyHashTableArgs

ActiveX client programming best practices

The best way to access Java components is to use the Java language. It is recommended that you do as
much programming as possible in the Java language and use a small simple interface between your COM
Automation container (for example, Visual Basic) and the Java code. This interface avoids any overhead
and performance problems that can occur when moving across the interface.

best-practices: The following topics are covered:
* Visual Basic guidelines
» CScript and Windows Scripting Host
» Active Server Pages guidelines
» J2EE guidelines

Visual Basic guidelines

The following guidelines are intended to help optimize your use of the ActiveX to EJB bridge with Visual

Basic:

* Launch the Visual Basic replication through the TaunchClientXJB.bat file. If you want to run your Visual
Basic application through the Visual Basic debugger, run the Visual Basic integrated development
environment (IDE) within the ActiveX to EJB bridge environment. After you create your Visual Basic
project, you can launch it from a command line; for example, TaunchClientXJB MyApplication.vbp. You
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can also launch the Visual Basic application alone in the ActiveX to EJB environment, by changing the
Visual Basic shortcut on the Windows Start menu so that the TaunchClientXJB.bat file precedes the call
to the VB6.EXE file.

» Exit the Visual Basic IDE before debugging programs.

Because the Java virtual machine (JVM) code attaches to the running process, you must exit the Visual
Basic editor before debugging your program. If you run the process, then exit your program within the
Visual Basic IDE, the JVM code continues to run and you reattach the same JVM code when XJBInit()
is called by the debugger. This causes problems if you try to update XJBInit() arguments (for example,
classpath) because the changes are not be applied until you restart the Visual Basic program.

+ Store the XJB.JClassFactory object globally.

Because you cannot unload or reinitialize the JVM code, cache the resulting XJB.JClassFactory object
as a global variable. The overhead of treating this object as a global variable or passing a single
reference around is much less than recreating a new XJB.JClassFactory object and calling the XJBInit()
argument more than once.

CScript and Windows Scripting Host

The following guidelines intend to help optimize your use of the ActiveX to EJB bridge with CScript and
Windows Scripting Host (WSH):
* Launch in ActiveX to EJB environment.

Launch the VBScript files in the ActiveX to EJB bridge environment, to run VBScript files in .vbs files.
Two common ways exist to launch your script:

— TaunchClientXJB MyScript.vbs

— TaunchClientXJB cscript MyScript.vbs

Active Server Pages guidelines

The following guidelines intend to help optimize your use of the ActiveX to EJB bridge with Active Server
Pages software:
» Use the ActiveX to EJB Helper functions from the Active Server Pages Application.

Because Active Server Pages (ASP) code typically use VBScript, you can use the included helper
functions in any VBScript environment with minor changes. For more information about these helper
functions, see Helper functions for data type conversion. To run outside of the ASP environment,
remove or change all references to the Server, Request, Response, Application and Session objects; for
example, change Server.CreateObject to CreateObject.

» Set JRE path globally in system.

The XJB.JClassFactory object must be able to find the Java run time dynamic link library (DLL) when
initializing. In Internet Information Server, you cannot specify a path for its processes independently; you
must set the process paths in the system PATH variable. You can only have a single JVM version
available on a machine using the ASP application. Also, remember that after you change the system
PATH variable you must reboot the Internet Information Server machine so that the Internet Information
Server can see the change.

» Set the system TEMP environment variable.

If the system TEMP environment variable is not set, Internet Information Server stores all temporary
files in the WINNT directory, which is usually not desired.
» Use high isolation or an isolated process.

When using the ActiveX to Java bridge with Active Server Pages software, creating your web application
in its own process is recommended. You can only load one JVM instruction in a single process and if
you want to have more than one application running with different JVM environment options (for
example, different classpaths), then you need to have separate processes.

» Use the Application Unload option.

When debugging your application, use Unload when viewing your ASP application properties in the
Internet Information Server administration console to unload the process from memory and thereby
unload the JVM code.

Chapter 6. Developing Client applications 221



Run one process per application.

Use only one ASP application per J2EE application or JVM environment, in your ASP environment. If
you need separate class paths or JVM settings, you need separate ASP applications (virtual directories
with high isolation or an isolated process).

Store the XJB.JClassFactory object in application scope.

Because of the one-to-one relationship required between a JVM instruction and a process, and because
the JVM code can never detach or shut down from a process independently, cache the
XJB.JClassFactory object at application scope and call the XJBInit() method only once.

Because the ActiveX to EJB bridge employs a free-threaded marshaler, take advantage of the
multi-threaded nature of Internet Information Server and the ASP environment. If you choose to
reinitialize the XJB.JClassFactory object at Page scope (local variables), then the XJBInit() method can
only initialize your local XJB.JClassFactory variable. It is more efficient to use the XJBInit() method
once.

Use VBScript conversion functions.

Because VBScript code only supports variant data types, use the CStr(), CByte(), CBool(), CCur(),
CInt(), Clng(), CSng() and CDbl() functions to tell the activeX to EJB bridge which data type you are
using; for example oMyObject.Foo(CDb1(1.234)).

J2EE guidelines

The following guidelines are intended to help optimize your use of the ActiveX to EJB bridge with the J2EE
environment;
+ Store client container objects globally.

Because you can only have one JVM instruction per process, and a single J2EE client container
(com.ibm.websphere.client.applicationclient.launchClient) per JVM instruction, initialize your J2EE client
container only once and reuse it. For ASP applications, store the J2EE client container in an application
level variable and initialize it only once (either on the Application_OnStart() event in the global.asa file
or by checking to see if it ISEmpty()).

A side effect to storing the client container object globally is that you cannot change the client container
parameters without destroying the object and creating a new one. These parameters include the EAR
file, BootstrapHost, class path, and so on. If you run a Visual Basic application and want to change the
client container parameters, you must end the application and restart it. If you run an Active Server
Pages application, you must first unload the application from Internet Information Server (see "Use the
Application Unload Button" under Active Server Pages guidelines). Then load the Active Server Pages
application with the different client container parameters. The parameters set the first time the Active
Server Pages application loads. Since the client container is stored on the Internet Information Server,
all the browser clients share the parameters using the Active Server Pages application. This behavior is
normal for Active Server Pages code, but can be confusing when you try to run to different WebSphere
Application Servers using the same Active Server Pages application, which is not supported.

Reuse custom temporary directory for EAR file extraction.

By default, the client container launches and extracts the application .ear file to your temp directory and
then sets up the thread class loader to use the extracted EAR file directory and the JAR files included in
the client JAR manifest. This process is time consuming and because of some limitations with JVM
shutdown through Java Native Interface (JNI) and file locking, these files are never cleaned up.

Specifically, each time the client container launch() method is called, it extracts the EAR file to a random
directory name in your temporary directory on your hard drive. The current Java thread class loader is
then changed to point to this extracted directory which in turn locks the files within. In a normal J2EE
Java client, these files automatically clean up after the application exits. This cleanup occurs when the
client container shutdown hook is called (which never happens in the ActiveX to EJB bridge), which
leaves the temporary directory there.

To avoid these problems, you can specify a directory to extract the EAR file by setting the
com.ibm.websphere.client.applicationclient.archivedir Java system property before calling the client
container launch() method. If the directory does not exist or is empty, you extract the EAR file normally.
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If the EAR file was previously extracted, the directory is reused. This feature is particularly important for
server processes (for example, ASP), which can stop and restart, potentially calling the launchClient()
method several times.

If you need to update your EAR file, delete the temporary directory first. The next time you create the
client container object, it extracts the new EAR file to the temporary directory. If you do not delete the
temporary directory or change the system property value to point to a different temporary directory, the
client container reuses the currently extracted EAR file, and does not use your changed EAR file.

Note: When specifying the com.ibm.websphere.client.applicationclient.archivedir property, ensure that
the directory you specify is unique for each EAR file you use. For example, do not point
MyEarl.ear and MyEar2.ear files to the same directory.

If you choose not to use this system property, go regularly to your Windows temp directory and delete
the WSTMP* subdirectories. Over a relatively short period of time, these subdirectories can waste a
significant amount of space on the hard drive.

ActiveX client programming, tips for passing arrays
Arrays are very similar between Java and Automation containers like Visual Basic and VBScript. This topic
provides some important points to consider when passing arrays back and forth between these containers.

Here are some important points to consider when passing arrays back and forth between these containers:

» Java arrays cannot mix types. All Java arrays contain a single type, so when passing arrays of variants
to a Java array, you must make sure that all of the elements in the variant array are of the same base
type. For example, in Visual Basic code:

Dim VariantArray(1) as Variant
VariantArray(0) = CLng(123)
VariantArray(1) = CDb1(123.4)

oMyJavaObject.foo(VariantArray) I1legal!
VariantArray(0) = CLng(123)

VariantArray(1) = CLng(1234)
oMyJavaObject.foo(VariantArray) This works

» Arrays of primitive types are converted using the rules defined in primitive data type conversion.

» Arrays of Java objects are handled through arrays of JObjectProxy objects.

* Arrays of JObjectProxy objects must be fully initialized and of the correct associated Java type. When
initializing an array in Visual Basic (for example, Dim oJavaObjects(1) as Object), you must set each
object to a JObjectProxy object before you send the array to a Java object. The bridge is unable to
determine the type of null or empty object values.

* When receiving an array from a Java method, the lower-bound is always zero. Java methods only
support zero-based arrays.

* Nested or multidimensional arrays are treated as zero-based multidimensional arrays in Visual Basic
and VBScript containers.

» Uninitialized arrays or Array Types are unsupported. When calling a Java method that takes an array of
objects as a parameter, you must fully initialize the array of JObjectProxy objects.

ActiveX client programming, Java field programming tips

Using the ActiveX to Enterprise JavaBeans (EJB) bridge to access Java fields has the same case
sensitivity issue that it has when invoking methods. Field names must use the same case as the Java field
syntax.

Visual Basic code has the same problem with unsolicited case changing on fields as it does with methods.
(For more information about this problem, see ActiveX to EJB bridge, calling Java methods). You might
use the CallByName() function to set a field in the same way that you call a method in some cases. For
fields, use VBLet for primitive types and VBSet for objects. For example:

0.MyField = 123 "Incorrect...
CallByName(o, "MyField", vbLet, 123) 'Correct...
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or in VBScript:

0.MyField = 123 "Incorrect...
Eval("o.myField = 123") '"Correct...

ActiveX client programming, JClassProxy and JObjectProxy classes

The majority of tasks for accessing your Java classes and objects are handled with the JClassProxy and
JObjectProxy objects. This topic provides reference information about the object classes of the ActiveX to
Enterprise Java Beans (EJB) bridge.

JClassFactory is the object used to access the majority of Java Virtual Machine (JVM) features. This
object handles JVM initialization, accesses classes and creates class instances (objects). Use the
JClassProxy and JObjectProxy objects to access the majority of your Java classes and objects:

XJBInit(String astrdavaParameterArray())

Initializes the JVM environment using an array of strings that represent the command line parameters
you normally send to the java.exe file.

If you have invalid parameters in the XJBInit() string array, the following error is displayed:

Error: 0x6002 "XJBJINI::Init() Failed to create VM" when calling XJBInit()

If you have C++ logging enabled, the activity log displays the invalid parameter.
JClassProxy FindClass(String strClassName)

Uses the current thread class loader to load the specified fully qualified class name and returns a
JClassProxy object representing the Java Class object.

JObjectProxy Newlnstance()

Creates a Class instance for the specified JClassProxy object using the parameters supplied to call the
Class constructor. For more information about using the JMethodArgs method, see ActiveX to EJB
bridge, calling Java methods.

JObjectProxy NewInstance(JClassFactory obj, Variant vArgl, Variant vArg2, Variant vArg3, ...)
JObjectProxy NewInstance(JClassFactory obj, JMethodArgs args)

* JMethodArgs GetArgsContainer()

Returns a JMethodArgs object (Class instance).

You can create a JClassProxy object from the JClassFactory.FindClass() method and from any Java
method call that normally return a Java Class object. You can use this object as if you had direct access
to the Java Class object. All of the class static methods and fields are accessible as are the
java.lang.Class methods. In case of a clash between static method names of the reflected user class
and those of the java.lang.Class (for example, getName()), the reflected static methods would execute
first.

For example, the following is a static method called getName(). The java.lang.Class object also has a
method called getName():
— In Java:

class foof

foo(){};

public static String getName(){return "abcdef";}
public static String getName2(){return "ghijk1";}
pubTic String toString2(){return "xyz";}

}

— In Visual Basic:

Dim c1sFoo as Object
set clsFoo = oXJB.FindClass("foo")
clsFoo.getName() ' Returns "abcdef" from the static foo class
clsFoo.getName2() ' Returns "ghijkl" from the static foo class
clsFoo.toString() ' Returns "class foo" from the java.lang.Class object.
oFoo = oXJB.NewInstance(clsFoo)
oFoo.toString() ' Returns some text from the java.lang.Object's

" toString() method which foo inherits from.
oFoo.toString2() ' Returns "xyz" from the foo class instance
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You can create a JObjectProxy object from the JClassFactory.NewInstance() method, and can be
created from any Java method call that normally returns a Class instance object. You can use this

object as if you had direct access to the Java object and can access all the static methods and fields

of the object. All of object instance methods and fields are accessible (including those accessible
through inheritance).

The JMethodArgs object is created from the JClassFactory.GetArgsContainer() method. Use this
object as a container for method and constructor arguments. You must use this object when
overriding the object type when calling a method (for example, when sending a java.lang.String
JProxyObiject type to a constructor that normally takes a java.lang.Object type).

You can use two groups of methods to add arguments to the collection: Add and Set. You can use
Add to add arguments in the order that they are declared. Alternatively, you can use Set to set an
argument based on its position in the argument list (where the first argument is in position 1).

For example, if you had a Java Object Foo that took a constructor of Foo (int, String, Object), you
could use a JMethodArgs object as shown in the following code extract:

Dim oArgs as Object
set oArgs = oXJB.GetArgsContainer()

oArgs.AddInt(CLng(12345))
0Args.AddString("Apples")
oArgs.AddObject ("java.lang.0Object", oSomeJObjectProxy)

Dim c1sFoo as Object

Dim oFoo as Object

set clsFoo = oXJB.FindClass("com.mypackage.foo")
set oFoo = oXJB.NewInstance(clsFoo, 0Args)

' To reuse the oArgs object, just clear it and use the add method

' again, or alternatively, use the Set method to reset the parameters
' Here, we will use Set

oArgs.SetInt (1, CLng(22222))

oArgs.SetString(2, "Bananas")

oArgs.SetObject (3, "java.lang.Object", oSomeOtherJObjectProxy)

Dim oFoo2 as Object
set oF002 = oXJB.NewInstance(clsFoo, oArgs)

AddObiject (String strObjectTypeName, Object oArg)

Adds an arbitrary object to the argument container in the next available position, casting the object to
the class name specified in the first parameter. Arrays are specified using the traditional [] syntax; for
example:

AddObject("java.lang.0Object[][]", oMy2DArrayOfFooObjects)

or

AddObject ("int[]", oMyArrayOfInts)
AddByte (Byte byteArg)

Adds a primitive byte value to the argument container in the next available position.
AddBoolean (Boolean bArg)

Adds a primitive boolean value to the argument container in the next available position.
AddShort (Integer iArg)

Adds a primitive short value to the argument container in the next available position.
Addint (Long IArg)

Adds a primitive int value to the argument container in the next available position.
AddLong (Currency cyArg)

Adds a primitive long value to the argument container in the next available position.
AddFloat (Single fArg)

Adds a primitive float value to the argument container in the next available position.
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AddDouble (Double dArg)

Adds a primitive double value to the argument container in the next available position.
AddChar (String strArg)

Adds a primitive char value to the argument container in the next available position.
AddString (String strArg)

Adds the argument in string form to the argument container in the next available position.
SetObject (Integer iArgPosition, String strObjectTypeName, Object 0Arg)

Adds an arbitrary object to the argument container in the specified position casting it to the class name
or primitive type name specified in the second parameter. Arrays are specified using the traditional []
syntax; for example:

SetObject (1, "java.lang.Object[][]", oMy2DArrayOfFooObjects)

or

SetObject (2, "int[]", MyArrayOfInts)
SetByte (Integer iArgPosition, Byte byteArg)

Sets a primitive byte value to the argument container in the position specified.
SetBoolean (Integer iArgPosition, Boolean bArg)

Sets a primitive boolean value to the argument container in the position specified.
SetShort (Integer iArgPosition, Integer iArg)

Sets a primitive short value to the argument container in the position specified.
Setint (Integer iArgPosition, Long IArg)

Sets a primitive int value to the argument container in the position specified.
SetLong (Integer iArgPosition, Currency cyArg)

Sets a primitive long value to the argument container in the position specified.
SetFloat (Integer iArgPosition, Single fArg)

Sets a primitive float value to the argument container in the position specified.
SetDouble (Integer iArgPosition, Double dArg)

Sets a primitive double value to the argument container in the position specified.
SetChar (Integer iArgPosition, String strArg)

Sets a primitive char value to the argument container in the position specified.
SetString (Integer iArgPosition, String strArg)

Sets a java.lang.String value to the argument container in the position specified.
Object Item(Integer iArgPosition)

Returns the value of an argument at a specific argument position.
Clear()

Removes all arguments from the container and resets the next available position to one.
Long Count()

Returns the number of arguments in the container.

ActiveX client programming, Java virtual machine initialization tips

Initialize the Java virtual machine (JVM) code with the ActiveX to Enterprise Java Beans (EJB) bridge. For
an ActiveX client program (Visual Basic, VBScript, or ASP) to access Java classes or objects, the first step
that the program must do is to create Java virtual machine (JVM) code within its process.

To create JVM code, the ActiveX program calls the XJBInit() method of the XJB.JClassFactory object.
When an XJB.JClassFactory object is created and the XJBInit() method called, the JVM is initialized and
ready to use.

To enable the XJB.JClassFactory to find the Java run-time description definition language (DLL) when
initializing, the Java Runtime Environment (JRE) bin and bin\classic directories must exist in the
system path environment variable.

The XJBInit() method accepts only one parameter: an array of strings. Each string in the array
represents a command line argument that for a Java program you would normally specify on the
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Java.exe command line. This string interface is used to set the class path, stack size, heap size and
debug settings. You can get a listing of these parameters by typing java -? from the command line.

* If you set a parameter incorrectly, you receive a 0x6002 "Failed to initialize VM" error message.

* Due to the current limitations of Java Native Interface (JNI), you cannot unload or reinitialize the JVM
code after it has loaded. Therefore, after the XJBInit() method has been called once, subsequent calls
have no effect other than to create a duplicate JClassFactory object for you to access. It is best to store
your XJB.JClassFactory object globally and continue to reuse that object.

» The following Visual Basic extract shows an example of initializing JVM code:

Dim oXJB as Object

set 0XJB = CreateObject("XJB.JClassFactory")

Dim astrJavalnitProps(0) as String

astrJavalnitProps(0) = _
"-Djava.class.path=.;c:\myjavaclasses;c:\myjars\myjar.jar"

0XJB.XJBInit(astrJavalnitProps)

ActiveX to Java primitive data type conversion values

All primitive Java data types are automatically converted to native ActiveX Automation types. However, not
all Automation data types are converted to Java types (for example, VT_DATE). Variant data types are
used for data conversion.

Variant data types are a requirement of any Automation interface, and are used automatically by Visual
Basic and VBScript. The tables below provide details about how primitive data types are converted
between Automation types and Java types.

Table 40. ActiveX to Java primitive data type conversion. Conversion details for primitive data types

Visual Basic Type Variant Type Java Type Notes

Byte VT_H byte Byte in Visual Basic is
unsigned, but is signed in
Java data type.

Boolean VT_BOOL boolean

Integer VT_I2 short

Long VT_l4 int

Currency VT_CY long

Single VT_R4 float

Double VT_R8 double

String VT_BSTR java.lang.String

String VT_BSTR char

Date VT_DATE n/a

Example: ActiveX client application using helper methods for data type conversion:

Generally, data type conversion between ActiveX (Visual Basic and VBScript) and Java methods occurs
automatically, as described in ActiveX to EJB bridge, converting data types. However, the byte helper
function and currency helper function are provided for cases where automatic conversion is not possible:
» Byte helper function

Because the Java Byte data type is signed (-127 through 128) and the Visual Basic Byte data type is
unsigned (0 through 255), convert unsigned Bytes to a Visual Basic Integers, which look like the Java
signed byte. To make this conversion, you can use the following helper function:
Private Function GetIntFromJavaByte(Byte jByte) as Integer
GetIntFromJavaByte = (CInt(jByte) + 128) Mod 256 - 128
End Function
» Currency helper function
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Visual Basic 6.0 cannot properly handle 64-bit integers like Java methods can (as the Long data type).
Therefore, Visual Basic uses the Currency type, which is intrinsically a 64-bit data type. The only side
effect of using the Currency type (the Variant type VT_CY) is that a decimal point is inserted into the
type. To extract and manipulate the 64-bit Long value in Visual Basic, use code like the following
example. For more details on this technique for converting Currency data types, see Q189862,
"HOWTO: Do 64-bit Arithmetic in VBA", on the Microsoft Knowledge Base.

" Currency Helper Types

Private Type MungeCurr
Value As Currency

End Type

Private Type Munge2lLong
LoValue As Long
HiValue As Long

End Type

" Currency Helper Functions
Private Function CurrToText(ByVal Value As Currency) As String
Dim Temp As String, L As Long
Temp = Format$(Value, "#.0000")
L = Len(Temp)
Temp = Left§(Temp, L - 5) & Right$(Temp, 4)
Do While Len(Temp) > 1 And Left$(Temp, 1) = "0"
Temp = Mid$(Temp, 2)

Loop

Do While Len(Temp) > 2 And Left$(Temp, 2) = "-0"
Temp = "-" & Mid$(Temp, 3)

Loop

CurrToText = Temp
End Function

Private Function TextToCurr(ByVal Value As String) As Currency
Dim L As Long, Negative As Boolean
Value = Trim§(Value)
If Left$(Value, 1) = "-" Then
Negative = True
Value = Mid$(Value, 2)

End If
L = Len(Value)
If L <4 Then
TextToCurr = CCur(IIf(Negative, "-0.", "0.") & _
Right$("0000" & Value, 4))
Else
TextToCurr = CCur(IIf(Negative, "-", "") & _
Left§(Value, L - 4) & "." & Right$(Value, 4))
End If

End Function

' Java Long as Currency Usage Example
Dim LC As MungeCurr
Dim L2 As MungeZ2lLong

' Assign a Currency Value (really a Java Long)
' to the MungeCurr type variable
LC.Value = cyTestln

' Coerce the value to the Munge2long type variable
LSet L2 = LC

' Perform some operation on the value, now that we
' have it available in two 32-bit chunks
L2.LoValue = L2.LoValue + 1

228 Developing WebSphere applications



' Coerce the Munge value back into a currency value
LSet LC = L2
cyTestIn = LC.Value

ActiveX client programming, handling error codes

All exceptions thrown in Java code are encapsulated and thrown again as a COM error through the
ISupportErrorinfo interface and the EXCEPINFO structure of IDispatch::Invoke(), the Err object in Visual
Basic and VBScript. Because there are no error numbers associated with Java exceptions, whenever a
Java exception is thrown, the entire stack trace is stored in the error description text and the error number
assigned is 0x6003.

In Visual Basic or VBScript, you need to use the Err.Number and Err.Description fields to determine the
actual Java error. Non-Java errors are thrown as you would expect via the IDispatch interface; for
example, if a method cannot be found, then error 438 "Object doesn't support this property or method" is
thrown.

Table 41. Error numbers and descriptions.. Error numbers and descriptions in VBScript

Error number Description

0x6001 Java Native Interface (JNI) error

0x6002 Initialization error

0x6003 Java exception. Error description is the Java Stack Trace.
Ox6FFF General Internal Failure

ActiveX client programming, threading tips

The ActiveX to Enterprise JavaBeans (EJB) bridge supports both free-threaded and apartment-threaded
access and implements the Free Threaded Marshaler to work in a hybrid environment such as Active
Server Pages (ASP). Each thread created in the ActiveX process is mirrored in the Java environment
when the thread communicates through the ActiveX to EJB bridge.

When all references to Java objects (there are no JObjectProxy or JClassProxy objects) are loaded in an
ActiveX thread, the ActiveX to EJB bridge detaches the thread from the Java virtual machine (JVM) code.
Therefore, you must be careful that any Java code that you access from a multithreaded Windows
application is thread safe. Visual Basic code and VBScript applications are both essentially single
threaded. Therefore, Visual Basic and VBScript applications do not have threading issues in the Java
programs they access. Active Server Pages and multithreaded C and C++ programs can have issues.

Consider the following scenario:

1. A multithreaded Windows Automation Container (our ActiveX Process) starts. It exists on Thread A.

2. The ActiveX Process initializes the ActiveX to EJB bridge, which starts the JVM code. The JVM
attaches to the same thread and internally calls it Thread 1.

3. The ActiveX Process starts two threads: B and C.

4. Thread B in the ActiveX Process uses the ActiveX to EJB bridge to access an object that was created
in Thread A. The JVM attaches to thread B and calls it Thread 2.

5. Thread C in the ActiveX Process never talks to the JVM code, so the JVM never needs to attach to it.
This is a case where the JVM code does not have a one-to-one relationship between ActiveX threads
and Java threads.

6. Thread B later releases all of the JObjectProxy and JClassProxy objects that it used. The Java Thread
2 is detached.

7. Thread B again uses the ActiveX to EJB bridge to access an object that was created in Thread A. The
JVM code attaches again to the thread and calls it Thread 3.
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Table 42. Thread scenario.. Thread scenario

ActiveX process JVM access by ActiveX process
Thread A - Created in 1 Thread 1 - Attached in 2
Thread B - Created in 4 Thread 2 - Attached in 4, detached in 6 Thread 3 -

Attached in 7

Thread C - Created in 4

Threads and Active Server Pages

Active Server Pages (ASP) in Microsoft Internet Information Server is a multithreaded environment. When
you create the XJB.JClassFactory object, you can store it in the Application collection as an
Application-global object. All threads within your ASP environment can now access the same ActiveX to
EJB bridge object. Active Server Pages by default creates 10 Apartment Threads per ASP process per
CPU. This means that when your ActiveX to EJB bridge object is initialized any of the 10 threads can call
this object, not just the thread that created it.

If you need to simulate single-apartment behavior, you can create a Single-Apartment Threaded ActiveX
dynamic link library (DLL) in Visual Basic code and encapsulate the ActiveX to the EJB bridge object. This
encapsulation guarantees that all access to the JVM object is on the same thread. You need to use the
<OBJECT> tag to assign the XJB.JClassFactory to an Application object and must be aware of the
consequences of introducing single-threaded behavior to a web application.

The Microsoft KnowlegeBase has several articles about ASP and threads, including:

* Q243543 INFO: Do Not Store STA Objects in Session or Application

* Q243544 INFO: Component Threading Model Summary Under Active Server Pages
* Q243548 INFO: Design Guidelines for VB Components Under ASP

Example: Enabling logging and tracing for activeX client applications
The ActiveX to EJB bridge provides two logging and tracing formats: Windows Application Event Log and
Java Trace Log.

* Windows Event Log

The Windows Application Event Log shows JNI errors, Java console error messages, and XJB
initialization messages. This log is most useful for determining XJBInit() errors and any unusual
exceptions that do not come from the Java environment. By default, critical error logging will be enabled
and debug and event logging is disabled.

To enable or disable logging of certain event types to the Windows Event Log, specify one or more
parameters to XJBInit(). If more than one parameter is set, they will be processed in the order in which
they appear in the input string array to the XJBInit() method. Once the XJBInit() method is initialized,
these parameters can no longer be set/reset for the life of the process. Using Java
java.lang.System.setProperty() to set these values also has no effect.
— -Dcom.ibm.ws.client.xjb.native.logging.debug=enabledldisabled
Enables or disables debug level messages from displaying in the Windows operating system event
log. This level of logging is most useful and shows most internal errors, user programming issues or
configuration problems.
— -Dcom.ibm.ws.client.xjb.native.logging.event=enabledIdisabled
Enables or disables event level messages from appearing in the Windows operating system event
log.
— -Dcom.ibm.ws.client.xjb.native.logging.*=enabledldisabled
Enables or disables both event and debug level messages from appearing in the Windows operating
system event log. It is not possible to disable some critical error messages from being displayed in
the error log. Only debug and event level messages can be disabled.

To view the Windows application event log with the Event Viewer, complete the following steps:
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1. Click Start > Control Panel.
2. Double-click Administrative Tools.
3. Double-click Event Viewer.

All ActiveX to EJB bridge events display the text WebSphere XJB in the source column and in the
application log.

When using the Event Viewer, you can get help information by clicking the menu choice Action > Help.
» Java trace log

The Java trace log displays information that you can use to debug method calls, class lookups, and
argument coercion problems. Because the Java portion of the bridge mirrors the function of the COM
IDispatch interface, the information in the trace log is similar to what you have come to expect from an
IDispatch interface. To understand the trace log, you need a fundamental understanding of IDispatch.

To enable user-logging, add the following parameters to the XJBInit() input string array:

"-DtraceString=com.ibm.ws.client.xjb.*=event=enabled"
"-DtraceFile=C:\MyTrace.txt"

Example: Viewing a System.out message

The ActiveX to Enterprise JavaBeans (EJB) bridge does not have a console available to view Java
System.out messages. To view these messages when running a stand-alone client program (such as
Visual Basic), redirect the output to a file.

This example redirects output to a file:

launchClientXJB.bat MyProgram.exe > output.txt
» To view the System.out messages when running a Service program such as Active Server Pages, you
need to override the Java System.out OutputStream object to FileOutputStream. For example, in
VBScript:
'Redirect system.out to a file
" Assume that oXJB is an initialized XJB.JClassFactory object
Dim cTsSystem
Dim 00S
Dim oPS
Dim oArgs

' Get the System class
Set clsSystem = oXJB.FindClass("java.lang.System")

" Create a FileOutputStream object

" Create a PrintStream object and assign to it our FileOutputStream
Set oArgs = o0XJB.GetArgsContainer o0Args.AddObject "java.io.OutputStream", 00S
Set oPS = oXJB.NewInstance(oXJB.FindClass("java.io.PrintStream"), oArgs)

" Set our System OutputStream to our file
c1sSystem.setOut oPS

Developing applet client code
Applet clients are capable of communicating over the HTTP protocol and the RMI-IIOP protocol.

About this task

Unlike typical applets that reside on either web servers or WebSphere Application Servers and can only
communicate using the HTTP protocol, applet clients are capable of communicating over the HTTP
protocol and the RMI-IIOP protocol. This additional capability gives the applet direct access to enterprise
beans.

Standard applets require the HTML <APPLET> tag to identify the applet to the browser. If you replace the

<0BJECT> and <EMBED> tags, make sure that you specify appropriate values for <OBJECT> and <EMBED> tags,
especially the <OBJECT classid and <EMBED type values.
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In the code for your applet client, when you initialize an instance of the InitialContext class, you must set
properties to specify the computer name, domain, and port, and to identify this program (the client) as an
applet.

Example
« |Applet client tag requirements|
* |Applet client code requirementsl

Applet client tag requirements: Standard applets require the HTML <APPLET> tag to identify the applet to
the browser. The <APPLET> tag invokes the Java virtual machine (JVM) of the browser. It can also be
replaced by <OBJECT> and <EMBED> tags. The following code example illustrates the applet code using the
<APPLET> tag:

<APPLET code="MyAppletClass.class" archive="Applet.jar, EJB.jar" width="600" height="500" >
</APPLET>

The following code example illustrates the applet code using the <OBJECT> and <EMBED> tags.

<OBJECT classid="c1sid: 8AD9C840-044E-11D1-B3E9-00805F499D93"
width="600" height="500">

<PARAM NAME=CODE VALUE=MyAppletClass.class>

<PARAM NAME="archive" VALUE='Applet.jar, EJB.jar'>

<PARAM TYPE="application/x-java-applet;version=1.5.0">
<PARAM NAME="scriptable" VALUE="false">

<PARAM NAME="cache-option" VALUE="PTugin">

<PARAM NAME="cache-archive" VALUE="Applet.jar, EJB.jar">
<COMMENT>

<EMBED type="application/x-java-applet;version=1.5.0" CODE=MyAppletClass.class
ARCHIVE="Applet.jar, EJB.jar" WIDTH="600" HEIGHT="500"
scriptable="false">

<NOEMBED>

</COMMENT>

</NOEMBED>WebSphere Java Application/Applet Thin Client for
Windows is required.

</EMBED>

</0BJECT>

Attention: To successfully invoke the applet client in WebSphere Application Server version 6.1 or later,
the <OBJECT classid and <EMBED type values need to be those shown in the preceding example.

For more information about the <APPLET> tag, see the Sun Microsystems article, Using applet, object and
embed Tags.

Applet client code requirements: The code used by an applet to talk to an enterprise bean is the same as
that used by a stand-alone Java program or a servlet, except for one additional property called
java.naming.applet. This property informs the InitialContext and the Object Request Broker (ORB) that
this client is an applet rather than a stand-alone Java application or servlet. The following code example
illustrates the applet code using the <APPLET> tag:

When you initialize an instance of the InitialContext class, the first two lines in this code snippet illustrate
what both a stand-alone Java program and a servlet issue to specify the computer name, domain, and
port. In this example, <yourserver.yourdomain.com> is the computer name and domain where WebSphere
Application Server resides, and 900 is the configured port. After the bootstrap values
(<yourserver.yourdomain.com>:900) are defined, the client to server communications occur within the
underlying infrastructure. In addition to the first two lines for applets, you must add the third line to your
code, which identifies this program as an applet, for example:

prop.put(Context.INITIAL _CONTEXT_FACTORY, "com.ibm.websphere.naming.WsnInitialContextFactory");

prop.put(Context.PROVIDER_URL, "iiop://<yourserver.yourdomain.com>:900)
prop.put(Context.APPLET, this);
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Example: Applet client tag requirements

Standard applets require the HTML <APPLET> tag to identify the applet to the browser. The <APPLET> tag
invokes the Java virtual machine (JVM) of the browser. It can also be replaced by <OBJECT> and <EMBED>
tags.

The following code example illustrates the applet code using the <APPLET> tag.

<APPLET code="MyAppletClass.class" archive="Applet.jar, EJB.jar" width="600" height="500" >
</APPLET>

The following code example illustrates the applet code using the <OBJECT> and <EMBED> tags.

<OBJECT classid="c1sid: 8AD9C840-044E-11D1-B3E9-00805F499D93"
width="600" height="500">

<PARAM NAME=CODE VALUE=MyAppletClass.class>

<PARAM NAME="archive" VALUE='Applet.jar, EJB.jar'>

<PARAM TYPE="application/x-java-applet;version=1.5.0">
<PARAM NAME="scriptable" VALUE="false">

<PARAM NAME="cache-option" VALUE="PTugin">

<PARAM NAME="cache-archive" VALUE="Applet.jar, EJB.jar">
<COMMENT>

<EMBED type="application/x-java-applet;version=1.5.0" CODE=MyAppletClass.class
ARCHIVE="Applet.jar, EJB.jar" WIDTH="600" HEIGHT="500"
scriptable="false">

<NOEMBED>

</COMMENT>

</NOEMBED>WebSphere Java Application/Applet Thin Client for
Windows is required.

</EMBED>

</0BJECT>

Attention: To successfully invoke the applet client in WebSphere Application Server version 6.1 or later,
the <OBJECT classid and <EMBED type values need to be those shown in the preceding example.

For more information about the <APPLET> tag, see the Sun Microsystems article, Using applet, object and
embed Tags.

Example: Applet client code requirements

The code used by an applet to talk to an enterprise bean is the same as that used by a stand-alone Java
program or a servlet, except for one additional property called java.naming.applet. This property informs
the InitialContext and the Object Request Broker (ORB) that this client is an applet rather than a
stand-alone Java application or servlet.

When you initialize an instance of the InitialContext class, the first two lines in this code snippet illustrate
what both a stand-alone Java program and a servlet issue to specify the computer name, domain, and
port. In this example, <yourserver.yourdomain.com> is the computer name and domain where WebSphere
Application Server resides, and 900 is the configured port. After the bootstrap values
(<yourserver.yourdomain.com>:900) are defined, the client to server communications occur within the
underlying infrastructure. In addition to the first two lines for applets, you must add the third line to your
code, which identifies this program as an applet, for example:

prop.put(Context.INITIAL_CONTEXT_FACTORY, "com.ibm.websphere.naming.WsnInitialContextFactory");

prop.put(Context.PROVIDER_URL, "iiop://<yourserver.yourdomain.com>:900)
prop.put(Context.APPLET, this);

Running the Pluggable Application Client code

This topic provides steps for installing and using the Pluggable Application Client.
Before you begin

Remember: The Pluggable Application Client is available only on Windows systems.
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Both Java Platform, Enterprise Edition (Java EE) application clients and Thin application clients can
access JMS resources provided by the default messaging provider.

Important: The Pluggable Application Client is deprecated. It is replaced by the stand-alone thin client,
IBM Thin Client for EJB.

Procedure
1. Install the Pluggable Application Client.

Read r‘lnstalling and uninstalling the Pluggable Application Client for WebSphere Application Server’1 for
more information,

2. Set the Java application pluggable client environment by using the setupClient command.

3. Add your specific Java client application JAR files to the CLASSPATH and start your Java client
application from this environment, after setting the environment variables.

4. Run a Java command to invoke your client application.

"%JAVA_HOME%\bin\java" %WAS_LOGGING% -Djava.security.auth.login.config=
"%app_client_root%\properties\wsjaas_client.conf"

-classpath "%WAS_CLASSPATH%;<list_of your_application_jars_and classes>

-Djava.ext.dirs="%JAVA JRE%\Tib\ext;%WAS_EXT DIRS%;%WAS_HOME%\plugins;%WAS HOME%\1ib\WMQ\java\lib"
-Djava.naming.provider.url=iiop://<your_application_client_machine_name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory
-Djava.endorsed.dirs="%WAS_ENDORSED_DIRS%"

%CLIENT_ROOT% %CLIENTSAS% %CLIENTSSL% <fully qualified class_name_to_run>

Installing and uninstalling the Pluggable Application Client for WebSphere
Application Server

IBM Installation Manager is a common installer for many IBM software products that you use to install and
uninstall the Pluggable Application Client for WebSphere Application Server.

Before you begin

Note: The Pluggable Application Client for WebSphere Application Server is now installed by Installation
Manager rather than by the programs based on InstallShield MultiPlatform (ISMP) that are used to
install and uninstall previous versions.

Important: The Pluggable Application Client is deprecated. It is replaced by the standalone thin client,
IBM Thin Client for EJB.

The Pluggable Application Client runs only on the Windows platform and requires that you have previously
installed the Sun Java Runtime Environment (JRE) Version 1.6.0 or later. In all other aspects, the
Pluggable Application Client and the IBM Thin Client for EJB are similar.

About this task

Perform one of these procedures to install or uninstall the Pluggable Application Client for IBM WebSphere
Application Server.

Procedure

+ [“Installing the Pluggable Application Client using the GUI"|

* [‘Installing the Pluggable Application Client silently” on page 238

. “‘Uninstalling the Pluggable Application Client using the GUI” on page 247|
 [‘Uninstalling the Pluggable Application Client silently” on page 247|

Installing the Pluggable Application Client using the GUI:
You can use the Installation Manager GUI to install the Pluggable Application Client.
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Before you begin

Install Installation Manager:
1. Perform one of the following procedures:

» |If you want to use the Installation Manager that is included with this product, perform the following
actions:

a. Obtain the necessary files from the physical media or the web.
There are three basic options for obtaining and installing the product.
— Access the physical media, and use local installation
You can access the product repositories on the product media.
1) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager websitel

2) Use Installation Manager to install the product from the product repositories on the media.
— Download the files from the Passport Advantage site, and use local installation

Licensed customers with a Passport Advantage ID and password can download the
necessary product repositories from the Passport Advantage site.

1) Download the files from the Passport Advantage site.
2) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website.
3) Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation

If you have a Passport Advantage ID and password, you can install the product from the
web-based repositories.

1) Install Installation Manager on your system.
You can install Installation Manager using the product media, using a file obtained from

the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website].

2) Use Installation Manager to install the product from the web-based repository located at
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80

Whenever possible, you should use the remote web-based repositories so that you are
accessing the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the
product from the product repositories on the media or local repositories.

— With the Packaging Ultility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple
disks for one product into a repository. You can copy packages from Passport
Advantage into a repository for example. For more information on the Packaging
Utility, go to the IBM Installation Manager Information Center]

b. Change to the location containing the Installation Manager installation files, and as an
administrator, run the following command:

— WM install.exe
- T BTSN ENTITEN BT - /install

The installer opens an Install Packages window.
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c. Make sure that the Installation Manager package is selected, and click Next.
d. Accept the terms in the license agreements, and click Next.

The program creates the directory for your installation.
e. Click Next.

f. Review the summary information, and click Install.

— If the installation is successful, the program displays a message indicating that installation is
successful.

— If the installation is not successful, click View Log File to troubleshoot the problem.
If you already have a version of Installation Manager installed on your system and you want to use it
to install and maintain the product, obtain the necessary product files from the physical media or the
web.
There are three basic options for installing the product.
— Access the physical media, and use local installation

You can access the product repositories on the product media. Use Installation Manager to install
the product from the product repositories on the media.

— Download the files from the Passport Advantage site, and use local installation

Licensed customers with a Passport Advantage ID and password can download the necessary
product repositories from the Passport Advantage site.

a. Download the product repositories from the Passport Advantage site.
b. Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation

If you have a Passport Advantage ID and password, you can use Installation Manager to install
the product from the web-based repositories. Use Installation Manager to install the product from
the web-based repository located at

http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80

Whenever possible, you should use the remote web-based repositories so that you are accessing
the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the product
from the product repositories on the media or local repositories.

— With the Packaging Utility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple disks
for one product into a repository. You can copy packages from Passport Advantage into a
repository for example. For more information on the Packaging Utility, go to the
[nstallation Manager Information Center

2. Add the product repository to your Installation Manager preferences.

a.

b.
c.
d

236

Start Installation Manager.

In the top menu, click File > Preferences.

Select Repositories.

Perform the following actions:

1) Click Add Repository.

2) Enter the path to the repository.config file in the location containing the repository files.
For example:
* BIITTEM C:\repositories\product_name\local-repositories

s BTN I BT BT /var/repositories/product_name/local-

repositories

or
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3) Click OK.

e. Deselect any locations listed in the Repositories window that you will not be using.

Click Apply.

g. Click OK.
h. Click File > Exit to close Installation Manager.

About this task

Perform this procedure to use the Installation Manager GUI to install the Pluggable Application Client.

Procedure

1.
2.

Start Installation Manager.
Click Install.

Note: If you are prompted to authenticate, use the IBM ID and password that you registered with on
the program website.

Installation Manager searches its defined repositories for available packages.
Perform the following actions.

a. Select Pluggable Application Client for IBM WebSphere Application Server and the
appropriate version.

Attention: Pluggable Application Client has limitations when running on Windows Server 2008
as a non-administrator user. Specifically, the versioninfo.bat and historyinfo.bat files that are
located in the ..\PTugClient\bin directory return invalid path errors. The errors occur because of
the inability of non-administrator users to access Oracle JRE components due to user
permissions.

Note: If you are installing the ILAN version of this product, select Pluggable Application Client
for IBM WebSphere Application Server (ILAN).

If you already have the Pluggable Application Client installed on your system, a message displays
indicating that the Pluggable Application Client is already installed. For a given Installation
Manager, you can install only one Pluggable Application Client.

Tip: If the Search service repositories during installation and updates option is selected on
the Installation Manager Repository preference page and you are connected to the Internet,
you can click Check for Other Versions and Extensions to search for updates in the
default update repositories for the selected packages. In this case, you do not need to add
the specific service-repository URL to the Installation Manager Repository preference page.

b. Select the fixes to install.
Any recommended fixes are selected by default.

If there are recommended fixes, you can select the option to show only recommended fixes and
hide non-recommended fixes.

c. Click Next.

Note: If you try to install a newer level of the Pluggable Application Client with a previous version of
Installation Manager, Installation Manager might prompt you to update to the latest level of
Installation Manager when it connects to the repository. Update to the newer version before

ou continue if you are prompted to do so. Read the|IBM Installation Manager Information|
for information about automatic updates.

Accept the terms in the license agreements, and click Next.

Specify the installation root directory for the product binaries, which are also referred to as the core
product files or system files.
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10.
11.
12.
13.

14.
15.

The panel also displays the shared resources directory and disk-space information.

Restrictions:

» Deleting the default target location and leaving an installation-directory field empty
prevents you from continuing.

» Do not use a semicolon in the directory name.

The Pluggable Application Client cannot install properly if the target directory
includes a semicolon.

A semicolon is the character used to construct the class path on Windows systems.
Click Next.
Optional: Select Pluggable Application Client Samples if you want to install the samples.

Tip: You can run the Installation Manager later to modify this installation and add or remove the
feature.

Click Next.

Enter the host name and port number of the Websphere Application Server to which you want to
connect, and click Next.

Enter the location of the SUN JRE to use with the clients.

Optional: Enter the location of the SUN SDK to use when compiling the sample clients.
Click Next.

Review the summary information, and click Install.

« If the installation is successful, the program displays a message indicating that installation is
successful.

Note: The program might also display important post-installation instructions as well.
« If the installation is not successful, click View Log File to troubleshoot the problem.
Click Finish.
Click File > Exit to close Installation Manager.

Installing the Pluggable Application Client silently:

You can use Installation Manager to install the Pluggable Application Client silently.

Before you begin

Install Installation Manager on each of the systems onto which you want to install the product.

1.

Perform one of the following procedures:
» If you want to use the Installation Manager that is included with this product, perform the following

actions:
a. Obtain the necessary files from the physical media or the web.
There are three basic options for obtaining and installing the product.
— Access the physical media, and use local installation
You can access the product repositories on the product media.
1) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager websitel

2) Use Installation Manager to install the product from the product repositories on the media.
— Download the files from the Passport Advantage site, and use local installation
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Licensed customers with a Passport Advantage ID and password can download the
necessary product repositories from the Passport Advantage site.

1) Download the files from the Passport Advantage site.
2) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the IBM Installation Manager website}

3) Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation

If you have a Passport Advantage ID and password, you can install the product from the
web-based repositories.

1) Install Installation Manager on your system.

You can install Installation Manager using the product media, using a file obtained from
the Passport Advantage site, or using a file containing the most current version of
Installation Manager from the [IBM Installation Manager website|

2) Use Installation Manager to install the product from the web-based repository located at
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80

Whenever possible, you should use the remote web-based repositories so that you are
accessing the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the
product from the product repositories on the media or local repositories.

— With the Packaging Utility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple
disks for one product into a repository. You can copy packages from Passport
Advantage into a repository for example. For more information on the Packaging
Utility, go to the [IBM Installation Manager Information Center|

b. Change to the location containing the Installation Manager installation files, and run one of the
following commands to install Installation Manager silently:

Administrative installation:
installc.exe -acceptlLicense -log log file path_and_name

Non-administrative installation:
userinstc.exe -acceptlLicense -log log file_path_and name

* If you already have a version of Installation Manager installed on your system and you want to use it
to install and maintain the product, obtain the necessary product files from the physical media or the
web.

There are three basic options for installing the product.
— Access the physical media, and use local installation

You can access the product repositories on the product media. Use Installation Manager to install
the product from the product repositories on the media.

— Download the files from the Passport Advantage site, and use local installation

Licensed customers with a Passport Advantage |D and password can download the necessary
product repositories from the Passport Advantage site.

a. Download the product repositories from the Passport Advantage site.
b. Use Installation Manager to install the product from the downloaded repositories.
— Access the live repositories, and use web-based installation
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If you have a Passport Advantage ID and password, you can use Installation Manager to install
the product from the web-based repositories. Use Installation Manager to install the product from
the web-based repository located at

http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80

Whenever possible, you should use the remote web-based repositories so that you are accessing
the most up-to-date installation files.

Notes:

— If you do not have a Passport Advantage ID and password, you must install the product
from the product repositories on the media or local repositories.

— With the Packaging Utility, you can create and manage packages for installation
repositories. You can copy multiple packages into one repository or copy multiple disks
for one product into a repository. You can copy packages from Passport Advantage into a
repository for example. For more information on the Packaging Utility, go to the
[nstallation Manager Information Center

2. Add the product repository to your Installation Manager preferences.
a. Start Installation Manager.
b. In the top menu, click File > Preferences.
c. Select Repositories.
d. Perform the following actions:
1) Click Add Repository.
2) Enter the path to the repository.config file in the location containing the repository files.

For example:

C:\repositories\product_name\local-repositories

or
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80
3) Click OK.
e. Deselect any locations listed in the Repositories window that you will not be using.
f. Click Apply.
g. Click OK.

h. Click File > Exit to close Installation Manager.
About this task

Using Installation Manager, you can work with response files to install the Pluggable Application Client
silently in a variety of ways. You can record a response file using the GUI as described in the following
procedure, or you can generate a new response file by hand or by taking an example and modifying it.

Procedure

1. Optional: Record a response file to install the Pluggable Application Client: On one of your
systems, perform the following actions to record a response file that will install the Pluggable
Application Client.

a. From a command line, change to the eclipse subdirectory in the directory where you installed
Installation Manager.

b. Start Installation Manager from the command line using the -record option.

For example:
IBMIM.exe -skipInstall "C:\temp\imRegistry" -record C:\temp\install_response_file.xml

Tip: When you record a new response file, you can specify the -skiplnstall parameter. Using this
parameter has the following benefits:
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* No files are actually installed, and this speeds up the recording.

» If you use a temporary data location with the -skiplnstall parameter, Installation Manager
writes the installation registry to the specified data location while recording. When you start
Installation Manager again without the -skiplnstall parameter, you then can use your
response file to install against the real installation registry.

The -skipInstall operation should not be used on the actual agent data location used by
Installation Manager. This is unsupported. Use a clean writable location, and re-use that
location for future recording sessions.

For more information, read the [IBM Installation Manager Information Center}
c. Add the appropriate repositories to your Installation Manager preferences.
1) In the top menu, click File > Preferences.
2) Select Repositories.
3) Perform the following actions for each repository:
a) Click Add Repository.

b) Enter the path to the repository.config file in the remote web-based repository or the local
directory into which you unpacked the repository files.

For example:

* Remote repositories:
https://downloads.mycorp.com:8080/WAS_80_repository

or
http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80
* Local repositories:

C:\repositories\plugclient\local-repositories

c) Click OK.

4) Click Apply.
5) Click OK.
d. Click Install.

Note: If you are prompted to authenticate, use the IBM ID and password that you registered with
on the program website.

Installation Manager searches its defined repositories for available packages.
e. Perform the following actions.

1) Select Pluggable Application Client for IBM WebSphere Application Server and the
appropriate version.

Note: If you are installing the ILAN version of this product, select Pluggable Application
Client for IBM WebSphere Application Server (ILAN).

If you already have the Pluggable Application Client installed on your system, a message
displays indicating that the Pluggable Application Client is already installed. For a given
Installation Manager, you can install only one Pluggable Application Client.

2) Click Next.
f. Accept the terms in the license agreements, and click Next.

g. Specify the installation root directory for the Pluggable Application Client binaries, which are also
referred to as the core product files or system files.

The panel also displays the shared resources directory and disk-space information.

Restrictions:

» Deleting the default target location and leaving an installation-directory field empty
prevents you from continuing.
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* Do not use a semicolon in the directory name.

The Pluggable Application Client cannot install properly if the target directory
includes a semicolon.

A semicolon is the character used to construct the class path on Windows
systems.

h. Click Next.
i. Optional: Select Pluggable Application Client Samples if you want to install the samples.

Tip: You can run the Installation Manager later to modify this installation and add or remove the
feature.

j- Click Next.

k. Enter the host name and port number of the Websphere Application Server to which you want to
connect, and click Next.

Enter the location of the SUN JRE to use with the clients.

Optional: Enter the location of the SUN SDK to use when compiling the sample clients.
Click Next.

Review the summary information, and click Install.

© = 3

 If the installation is successful, the program displays a message indicating that installation is
successful.

Note: The program might also display important post-installation instructions as well.
 If the installation is not successful, click View Log File to troubleshoot the problem.
p. Click Finish.
g. Click File > Exit to close Installation Manager.

r. Optional: If you are using an authenticated remote repository, create a keyring file for silent
installation.

1) From a command line, change to the eclipse subdirectory in the directory where you installed
Installation Manager.

2) Start Installation Manager from the command line using the -record option.

For example:

IBMIM.exe -skipInstall "C:\temp\imRegistry"
-keyring C:\IM\im.keyring
-record C:\temp\keyring_response_file.xml

3) When a window opens that requests your credentials for the authenticated remote repository,
enter the correct credentials and save them.

4) Click File > Exit to close Installation Manager.
For more information, read the IBM Installation Manager Information Center|
2. Use the response files to install the Pluggable Application Client silently:

a. Optional: Use the response file to install the keyring silently: Go to a command line on each of
the systems on which you want to install the Pluggable Application Client, change to the
eclipse/tools subdirectory in the directory where you installed Installation Manager, and install the
keyring silently.

For example:

imcl.exe -acceptlicense
input C:\temp\keyring_response_file.xml
-Tog C:\temp\keyring_Tog.xml

b. Use the response file to install the Pluggable Application Client silently: Go to a command
line on each of the systems on which you want to install the Pluggable Application Client, change
to the eclipse/tools subdirectory in the directory where you installed Installation Manager, and
install the Pluggable Application Client silently.

For example:
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imcl.exe -acceptlicense
input C:\temp\install_response_file.xml
-log C:\temp\install_Tog.xml
-keyring C:\IM\im.keyring
Notes:

* The relevant terms and conditions, notices, and other information are provided in the
license-agreement files in the 1afiles or product_name/l1afiles subdirectory of the
installation image or repository for this product.

» The program might write important post-installation instructions to standard output.
Read the|IBM Installation Manager Information Center| for more information.

|_Windows |

Example

The following is an example of a response file for silently installing the Pluggable Application Client.

<?xml version="1.0" encoding="UTF-8"7>

<l-- ##### Copyright #############AFFFFRAFHARAFHARAFEARAARARAARAAAAAA A ARAH

# Licensed Materials - Property of IBM (c) Copyright IBM Corp. 2011.

# A1l Rights Reserved. US Government Users Restricted Rights-Use, duplication
# or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
[ddggdssasdsasadasdadasdsdagddsasddasddassddasgdsaiadasdadasdadagdssids et

<!-- ##### Frequently Asked Questions ###################AFH#FRAFFAAFF#RAFH
The latest information about using Installation Manager is

located in the online Information Center. There you can find

information about the commands and attributes used in

silent installation response files.

Installation Manager Information Center can be found at:
http://publib.boulder.ibm.com/infocenter/install/vlr4d/index.jsp

Question 1. How do I record a response file using Installation Manager?
Answer 1. Start Installation Manager from the command 1ine under the
eclipse subdirectory with the record parameter and it will generate a
response file containing actions it performed, repositories it used, and
its preferences settings. Optionally use the -skipInstall parameter if
you do not want the product to be installed to the machine. Specify a

new agentDatalocation location value when doing a new installation. Do

not use an existing agentDatalocation for an installation because it might
damage the installation data and prevent you from modifying, updating,
rolling back, or uninstalling the installed packages.

Windows: IBMIM -record <responseFile> -skipInstall <agentDatalocation>
Linux or UNIX: ./IBMIM -record <responseFile> -skipInstall <agentDatalocation>

For example:
Windows = IBMIM.exe -record c:\temp\responsefiles\WASv8.install.Win32.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry
Linux or UNIX = ./IBMIM -record /home/user/responsefiles/WASv8.install.RHEL64.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry

Question 2. How do I run Installation Manager silently using response file?

Answer 2. Create a silent installation response file and run the following command
from the eclipse\tools subdirectory in the directory where you installed
Installation Manager:

Windows = imcl.exe -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>

For example:
Windows = imcl.exe -acceptLicense -showProgress
input c:\temp\responsefile\WASv8.install.Win32.xml
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input /home/user/responsefile/WASv8.install.RHEL64.xm]

The -acceptLicense command must be included to indicate acceptance of all
license agreements of all offerings being installed, updated or modified.

The -showProgress command shows progress when running in silent mode.

Additional commands can be displayed by requesting help: IBMIM -help

Question 3. How do I store and pass credentials to repositories that
require authentication?

Answer 3. Installation Manager uses a key ring file to store encrypted
credentials for authenticating with repositories. Follow this two-step
process for creating and using a key ring file with Installation Manager.

SR S SR O SR SR SR R SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR S SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR SR S

First, create a key ring file with your credentials by starting
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Installation Manager from the command 1ine under eclipse subdirectory
with the keyring parameter.
Use the optional password parameter to password protect your file.

Windows = IBMIM.exe -keyring <path and file name> -password <password>
Linux, UNIX, IBM i and z/0S = ./IBMIM -keyring <path and file name>
-password <password>

Installation Manager will start in graphical mode. Verify that the
repositories to which you need to authenticate are included in the
preferences, File / Preferences / Repositories. If they are not

listed, then click Add Repositories to add the URL or UNC path.
Installation Manager will prompt for your credentials. If the repository

is already in the Tist, then any attempt to access the repository location,
such as clicking the Test Connections button, will also prompt for your
credentials. Enter the correct credential and check the Save password
checkbox. The credentials are saved to the key ring file you specified.

Second, when you start a silent installation, run imcl under eclipse/tools
subdirectory, and provide Installation Manager with the location of the key
ring file and the password if the file is protected. For example:

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# Windows = imcl.exe -acceptlLicense -showProgress

# input <path and file name of response file>

# -keyring <path and name of key ring file> -password <password>
#  Linux, UNIX, IBM i and z/0S = ./imcl -acceptLicense -showProgress
# input <path and file name of response file>

# -keyring <path and name of key ring file> -password <password>
#

#

[ARagdsssdisssddadddasddtagdssapatasdadasdatagdssadsaagiaaddaidsts g
<l-- ##### Agent Input #################FFEFREFFRRAFAERAFARAAFERAAAEH

Note that the "acceptLicense" attribute has been deprecated.
Use "-acceptLicense" command Tine option to accept license agreements.

The clean and temporary attributes specify the repositories and other
preferences Installation Manager uses and whether those settings
should persist after the installation finishes.

#

#

#

#

#

#

#

#

# Valid values for clean:

# true = only use the repositories and other preferences that are
# specified in the response file.

# false = use the repositories and other preferences that are
# specified in the response file and Installation Manager.
#

#

#

#

#

#

#

#

Valid values for temporary:
true = repositories and other preferences specified in the
response file do not persist in Installation Manager.
false = repositories and other preferences specified in the
response file persist in Installation Manager.

[ddgdzdasdssaddataddaddddagadsasadsadadssdddasddsasdssaddasaddaddddas it
<agent-input clean="true" temporary="true">

<l-- ##### Repositories ###############RMFF#ARFHARIFRARAARARAARAHAAAAHAAHS
Repositories are locations that Installation Manager queries for
installable packages. Repositories can be local (on the machine
with Installation Manager) or remote (on a corporate intranet or
hosted elsewhere on the internet).

#
#
#
#
#
# If the machine using this response file has access to the internet,
# then include the IBM WebSphere Live Update Repositories in the Tist
# of repository locations.
#
#
#
#
#
#
#

If the machine using this response file cannot access the internet,
then comment out the IBM WebSphere Live Update Repositories and
specify the URL or UNC path to custom intranet repositories and
directory paths to local repositories to use.

[dagdszsddsspddaadddasdddagddsapddastadasdadagdssagdsaptdaatddaiddtasiited

<server>
<l-- ##### IBM WebSphere Live Update Repositories ####################
# These repositories contain Pluggable Application Client for
# WebSphere Application Server offerings, and updates for those offerings.
#

# To use the secure repository (https), you must have an IBM ID,
# which can be obtained by registering at: http://www.ibm.com/account
#
# And, you must use a key ring file with your response file.
lfdggssasddddsddsasaddadddsdssstadddddddssssaaadddsdtitaddaabreg
<repository location="http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80" />
<!-- <repository location="https://www.ibm.com/software/rational/repositorymanager/repositories/websphere" /> -->

<l-- ##### Custom Repositories ###############F###IFAAFFFRAHFAAEHFRAFS
# Uncomment and update the repository Tocation key below
# to specify URLs or UNC paths to any intranet repositories
# and directory paths to local repositories to use.
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#FFEA AR R AR A AR AR RA AR AR AR AR AR AR A AR AR A AR AR AR A AR AARAAE >
<!-- <repository location='https:\\w3.mycompany.com\repositories\'/> -->
<!-- <repository location='/home/user/repositories/websphere/'/> -->

<!-- ##### Local Repositories ################FRIFIFFFFFFARARARARFFIAE
# Uncomment and update the following Tine when using a local
# repository located on your own machine to install a
# Pluggable Application Client offering.
liddaaaaassdddaasddasaapgggassddaapsigdddasssapaasgaaddds s
<!-- <repository location='insert the full directory path inside single quotes'/> -->

</server>

<!-- ##### Install Packages #######################F#AF#FRARFRAFFRHEH

S SR S SHe SR SR S S S S SHe S SR S S SR SR S R SR SHR S SR SR S SR SR SHR SR SR SR SR SR SR SHE SR SR SR SR SR SR SR SR SR SR SR SR SR SR S SR SR S SR SR SR SR SR SR S SR SR S S SR SR SR SR SR S SR SR SR SR SR SR S

Install Command

Use the install command to inform Installation Manager of the
installation packages to install.

The modify attribute is optional and can be paired with an install
command to add features or paired with an uninstall command to
remove commands. If omitted, the default value is set to false.
false = indicates not to modify an existing install by adding
or removing features.
true = indicates to modify an existing install by adding or
removing features.

The offering ID attribute is required because it specifies the
offering to be installed. The offering lTisted must be present in

at least one of the repositories listed earlier. The example

command below contains the offering ID for the Pluggable Application
Client.

The version attribute is optional. If a version number is provided,
then the offering will be installed at the version level specified
as long as it is available in the repositories. If the version
attribute is not provided, then the default behavior is to install
the latest version available in the repositories. The version number
can be found in the repository.xml file in the repositories.

For example, <offering ... version='8.0.0.20110617_2222'>.

The profile attribute is required and typically is unique to the
offering. If modifying or updating an existing installation, the

profile attribute must match the profile ID of the targeted installation
of Pluggable Application Client.

The features attribute is optional. Offerings always have at least
one feature; a required core feature which is installed regardless
of whether it is explicitly specified. If other feature names

are provided, then only those features will be installed.

Features must be comma delimited without spaces.

The feature values for Pluggable Application Client include:
pluggableclient.samples

The installFixes attribute indicates whether fixes available in
repositories are installed with the product. By default, all
available fixes will be installed with the offering.

Valid values for installFixes:
none = do not install available fixes with the offering.
recommended = installs all available recommended fixes with the offering.
all = installs all available fixes with the offering.

Interim fixes for offerings also can be installed while they

are being installed by including the offering ID for the interim
fix and specifying the profile ID. A commented out example is
provided in the install command below.

Installation Manager supports installing multiple offerings at once.
Additional offerings can be included in the install command,

with each offering requiring its own offering ID, version, profile value,
and feature values.

Profile Command

A separate profile command must be included for each offering Tisted
in the install command. The profile command informs Installation
Manager about offering specific properties or configuration values.

The installlLocation specifies where the offering will be installed.
If the response file is used to modify or update an existing
installation, then ensure the installlLocation points to the
location where the offering was installed previously.

The eclipseLocation data key should use the same directory path to
Pluggable Application Client as the installationLocation attribute.

Include data keys for product specific profile properties.
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#H##### AR H AR AR A AR AR AR AR AR AR AR AR AR AR AR >
<install modify="'false'>
<offering id="'com.ibm.websphere.PLUGCLIENT.v80'
profile='Pluggable Application Client for IBM WebSphere Application Server V8.0'
features='pluggableclient.core.feature' installFixes="'none'/>
<!-- <offering id='PM12345_WAS80' profile='Pluggable Application Client for IBM WebSphere Application Server V8.0'/> -->
</install>

<profile id='Pluggable Application Client for IBM WebSphere Application Server V8.0'
installLocation="C:\Program Files\IBM\WebSphere\PlugClient'>

<data key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\PlugClient'/>

<data key='user.import.profile' value='false'/>

<data key='user.select.64bit.image,com.ibm.websphere.PLUGCLIENT.v80' value='false'/>

<data key='user.appclient.serverHostname' value='localhost'/>

<data key='user.appclient.serverPort' value='2809'/>

<data key='user.plugclient.sunJreHome' value='C:\Program Files\Java\jre6'/>

<data key='user.plugclient.sunJdkHome' value='C:\Program Files\Java\jdkl.6.0_21'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<l-- ##### Shared Data Location ###############RARI#FFFFFAAAARRAAAFFFAAAARS
Uncomment the preference for eclipseCache to set the shared data
location the first time you use Installation Manager to do an
installation.

Eclipse cache location can be obtained from the installed.xml file found in
C:\Documents and Settings\A11 Users\Application Data\IBM\Installation Manager
from the following property:

<property name='cacheLocation' value='C:\Program Files\IBM\IMShared'/>

Open the installed.xml file in a text editor because the style sheet

might hide this value if opened in a web browser.

For further information on how to edit preferences, refer to the public library at:
http://publib.boulder.ibm.com/infocenter/install/vir4/index.jsp?topic=/com.ibm.silentinstal112.doc/topics/r_silent_prefs.html

After the shared data lTocation is set, it cannot be changed
using a response file or the graphical wizard.

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

#

# Ensure that the shared data location is a location that can be written
# to by all user accounts that are expected to use Installation Manager.
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

By default, Installation Manager saves downloaded artifacts to
the shared data Tocation. This serves two purposes.

First, if the same product is installed a more than once to the machine,
then the files in the shared data location will be used rather than
downloading them again.

Second, during the rollback process, the saved artifacts are used.
Otherwise, if the artifacts are not saved or are removed, then
Installation Manager must have to access the repositories used to
install the previous versions.

Valid values for preserveDownloadedArtifacts:
true = store downloaded artifacts in the shared data location
false = remove downloaded artifacts from the shared data Tocation

[dagdssssdsasddaadddasdddagdssapddasdadasdadagdssagdsagdiaadddaidstssiited

<l--
<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files\IBM\IMShared'/>
<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>

-—

<l-- ##### Preferences Settings #################H#FHERFFRARAARAHERAAHAAAHS
Additional preferences for Installation Manager can be specified.

These preference correspond to those that are located in the graphical
interface under File / Preferences.

If a preference command is omitted from or commented out of the response
file, then Installation Manager uses the preference value that was
previously set or the default value for the preference.

Preference settings might be added or deprecated in new versions of
Installation Manager. Consult the online Installation Manager
Information Center for the latest set of preferences and
descriptions about how to use them.

#
#
#
#
#
#
#
#
#
#
#
#
#
# http://publib.boulder.ibm.com/infocenter/install/vlr4/index.jsp
#

#

[digdssssdsagddaasddapdddagddsapadastadasdadagdssapdsagtdaatddandstas it

<l--

<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30'/>

<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45'/>

<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>

<preference name='offering.service.repositories.areUsed' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>

<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
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<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enablelntegrated.win32' value="'true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsknabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>

-

</agent-input>
Uninstalling the Pluggable Application Client using the GUI:
Use the Installation Manager GUI to uninstall the Pluggable Application Client.

Procedure
1. Uninstall the Pluggable Application Client.
a. Stop all servers and applications on the Pluggable Application Client installation.
b. Start Installation Manager.
¢. Click Uninstall.
d. In the Uninstall Packages window, perform the following actions.

1) Select Pluggable Application Client for IBM WebSphere Application Server and the
appropriate version.

Note: If you are uninstalling the ILAN version of this product, select Pluggable Application
Client for IBM WebSphere Application Server (ILAN).

2) Click Next.
Review the summary information.
f. Click Uninstall.
 If the uninstallation is successful, the program displays a message that indicates success.
 If the uninstallation is not successful, click View log to troubleshoot the problem.
g. Click Finish.
h. Click File > Exit to close Installation Manager.
2. Optional: Uninstall IBM Installation Manager.

o

Important: Before you can uninstall IBM Installation Manager, you must uninstall all of the packages
that were installed by Installation Manager.

Read [Uninstalling Installation Manager in the Installation Manager information center for information
about performing this procedure.

Uninstalling the Pluggable Application Client silently:
You can use Installation Manager to uninstall the Pluggable Application Client silently.
Before you begin

Optional: Perform or record the installation of Installation Manager and installation of the Pluggable
Application Client to a temporary installation registry on one of your systems so that you can
use this temporary registry to record the uninstallation without using the standard registry where
Installation Manager is installed.

Read the following for more information:
* [Installing the Pluggable Application Client using the GUI” on page 234
« [lInstalling the Pluggable Application Client silently” on page 238|
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About this task

Using Installation Manager, you can work with response files to uninstall the Pluggable Application Client
silently in a variety of ways. You can record a response file using the GUI as described in the following
procedure, or you can generate a new response file by hand or by taking an example and modifying it.

Procedure
1. Stop all servers and applications on the Pluggable Application Client installation that contains the
product.

2. Optional: Record a response file to uninstall the Pluggable Application Client: On one of your
systems, perform the following actions to record a response file that will uninstall the Pluggable
Application Client:

a.

b.

From a command line, change to the eclipse subdirectory in the directory where you installed
Installation Manager.

Start Installation Manager from the command line using the -record option.
For example:

IBMIM.exe -skipInstall "C:\temp\imRegistry"
-record C:\temp\uninstall_response_file.xml

e.

g.
h.

Tip: If you choose to use the -skipInstall parameter with a temporary installation registry created
as described in "Before you begin," Installation Manager uses the temporary installation
registry while recording the response file. It is important to note that when the -skipInstall
parameter is specified, no packages are installed or uninstalled. All of the actions that you
perform in Installation Manager simply update the installation data that is stored in the
specified temporary registry. After the response file is generated, it can be used to uninstall
the Pluggable Application Client, removing the Pluggable Application Client files and updating
the standard installation registry.

The -skiplnstall operation should not be used on the actual agent data location used by
Installation Manager. This is unsupported. Use a clean writable location, and re-use that
location for future recording sessions.

For more information, read the|IBM Installation Manager Information Center
Click Uninstall.
In the Uninstall Packages window, perform the following actions.

1) Select Pluggable Application Client for IBM WebSphere Application Server and the
appropriate version.

Note: If you are uninstalling the ILAN version of this product, select Pluggable Application
Client for IBM WebSphere Application Server (ILAN).

2) Click Next.

Review the summary information.

Click Uninstall.

 If the uninstallation is successful, the program displays a message that indicates success.
 If the uninstallation is not successful, click View log to troubleshoot the problem.

Click Finish.

Click File > Exit to close Installation Manager.

3. Use the response file to uninstall the Pluggable Application Client silently: From a command line
on each of the systems from which you want to uninstall the Pluggable Application Client, change to
the eclipse/tools subdirectory in the directory where you installed Installation Manager and use the
response file that you created to silently uninstall the Pluggable Application Client.

For example:
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imcl.exe
input C:\temp\uninstall_response_file.xml
-log C:\temp\uninstall_log.xml

Go to the IBM Installation Manager Information Center| for more information.

4. Optional: Uninstall IBM Installation Manager.

Important: Before you can uninstall IBM Installation Manager, you must uninstall all of the packages

that were installed by Installation Manager.

Read the IBM Installation Manager Information Center|for information about using the uninstall script to

perform this procedure.

Example

The following is an example of a response file for silently uninstalling the Pluggable Application Client.

<?xml version="1.0" encoding="UTF-8"7>

<l-- ##### Copyright #############HFFF#RAFFFRAFARAFFEARAAAAAAARAAAARA AR S

# Licensed Materials - Property of IBM (c) Copyright IBM Corp. 2011.

# A1l Rights Reserved. US Government Users Restricted Rights-Use, duplication
# or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
[ddggdssasdsasadasdadasdsdagddsadddasddassddasddsasdiaagadasdadagddsiss it

<!-- ##### Frequently Asked Questions ###################AFH#FRAFF#AFF#AHFH
The latest information about using Installation Manager is

located in the online Information Center. There you can find

information about the commands and attributes used in

silent installation response files.

Installation Manager Information Center can be found at:
http://publib.boulder.ibm.com/infocenter/install/vlr4d/index.jsp

Question 1. How do I record a response file using Installation Manager?
Answer 1. Start Installation Manager from the command Tine under the
eclipse subdirectory with the record parameter and it will generate a
response file containing actions it performed, repositories it used, and
its preferences settings. Optionally use the -skipInstall parameter if
you do not want the product to be installed to the machine. Specify a

new agentDatalocation location value when doing a new installation. Do

not use an existing agentDatalocation for an installation because it might
damage the installation data and prevent you from modifying, updating,
rolling back, or uninstalling the installed packages.

Windows: IBMIM -record <responseFile> -skipInstall <agentDatalocation>
Linux or UNIX: ./IBMIM -record <responseFile> -skipInstall <agentDatalocation>

For example:
Windows = IBMIM.exe -record c:\temp\responsefiles\WASv8.install.Win32.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry
Linux or UNIX = ./IBMIM -record /home/user/responsefiles/WASv8.install.RHEL64.xml
-skipInstall c:\temp\skipInstall\WebSphere_Temp_Registry

Question 2. How do I run Installation Manager silently using response file?

Answer 2. Create a silent installation response file and run the following command
from the eclipse\tools subdirectory in the directory where you installed
Installation Manager:

Windows = imcl.exe -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input <response_file_path_and_name> -log <log_file_path_and_name>

For example:
Windows = imcl.exe -acceptLicense -showProgress
input c:\temp\responsefile\WASv8.install.Win32.xml
Linux, UNIX, IBM i and z/0S = ./imc1 -acceptLicense -showProgress
input /home/user/responsefile/WASv8.install.RHEL64.xm]

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# The -acceptLicense command must be included to indicate acceptance of all

# license agreements of all offerings being installed, updated or modified.
# The -showProgress command shows progress when running in silent mode.

# Additional commands can be displayed by requesting help: IBMIM -help

#
#

[ERagdsssddsddsasddsasddsapdsaadstapdasasdssagdssagisaddasdtadssysited

<l-- ##### Agent Input ####################EFFARERAARAAAARAAARRAAAEH

# The clean and temporary attributes specify the repositories and other
# preferences Installation Manager uses and whether those settings

# should persist after the uninstall finishes.

#

# Valid values for clean:
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true = only use the repositories and other preferences that are
specified in the response file.

false = use the repositories and other preferences that are
specified in the response file and Installation Manager.

#
#
#
#
#
# Valid values for temporary:

# true = repositories and other preferences specified in the

# response file do not persist in Installation Manager.

# false = repositories and other preferences specified in the
# response file persist in Installation Manager.

#

#

fddsssdasasgggasddddapsaggddssssapaspddasadddasspagaadddaaadaddddsted
<agent-input clean='true' temporary='true'>

<l-- ##### Repositories ###############FFFFFF##HARAFFFFFAAARARRAAAIFARAAARE
Repositories are locations that Installation Manager queries for
installable packages. Repositories can be local (on the machine
with Installation Manager) or remote (on a corporate intranet or
hosted elsewhere on the internet).

#
#
#
#
#
# If the machine using this response file has access to the internet,
# then include the IBM WebSphere Live Update Repositories in the Tist
# of repository locations.
#
#
#
#
#
#
#

If the machine using this response file cannot access the internet,
then comment out the IBM WebSphere Live Update Repositories and
specify the URL or UNC path to custom intranet repositories and
directory paths to local repositories to use.

[Ragdsssdissaddasddsasddtasdssapasasdadasdasagdsspgdsaadiaadddaidsts it

<server>

<l-- ##### IBM WebSphere Live Update Repositories ####################

# These repositories contain Pluggable Application Client for WebSphere
# Application Server offerings, and updates for those offerings.

#
# To use the secure repository (https), you must have an IBM ID,
# which can be obtained by registering at: http://www.ibm.com/account
# or your Passport Advantage account.

# And, you must use a key ring file with your response file.
liddgssasadddsddsassaddadddsggpsssadddaddgsssssasdddsdssssadia i

<repository location="http://www.ibm.com/software/repositorymanager/com.ibm.websphere.PLUGCLIENT.v80" />

<!-- <repository location="https://www.ibm.com/software/rational/repositorymanager/repositories/websphere" /> -->

<!-- ##### Custom Repositories #################E#IFAAFFFRARAARAFERAFS

# Uncomment and update the repository Tocation key below

# to specify URLs or UNC paths to any intranet repositories

# and directory paths to local repositories to use.

[ddgadsasadasdadadddagddsasddsadddtsddatsddaddaasadaadidaadddisd bty
<!-- <repository location='https:\\w3.mycompany.com\repositories\'/> -->
<!-- <repository location='/home/user/repositories/websphere/'/> -->

<!-- ##### Local Repositories ##################ERIFAAHAFRARAARAFERARS
# Uncomment and update the following line when using a Tocal
# repository Tocated on your own machine to install a
# Pluggable Application Client offering.
[3ddaddssadaadddagdddagdddasddsadddtgddsddddagadaadadasdadisd s
<!-- <repository Tocation='insert the full directory path inside single quotes'/> -->
</server>

<l-- ##### Uninstall Packages ##############R##F#R#FFRAFHAARAARARFRRARAAAS
Uninstall Command

Use the uninstall command to inform Installation Manager of the
installation packages to uninstall.

The modify attribute is optional and can be paired with an install
command to add features or paired with an uninstall command to
remove commands. If omitted, the default value is set to false.
false = indicates not to modify an existing install by adding
or removing features.
true = indicates to modify an existing install by adding or
removing features.

The offering ID attribute is required because it specifies the
offering to be uninstalled. The example command below contains the
offering ID for Pluggable Application Client.

The version attribute is optional. If a version number is provided,
then the offering will be uninstalled at the version Tevel specified
If the version attribute is not provided, then the default behavior is
to uninstall the latest version. The version number can be found in
the repository.xml file in the repositories.

For example, <offering ... version='8.0.0.20110617_2222'>.

The profile attribute is required and must match the package group

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# name for the offering to be uninstalled.
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#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

The features attribute is optional. If there is no feature attribute,
then all features are uninstalled. If features are specified, then
only those features will be uninstalled.

Features must be comma delimited without spaces.

The feature values for Pluggable Application Client include:
pluggableclient.samples

Installation Manager supports uninstalling multiple offerings at once.
Additional offerings can be included in the uninstall command,

with each offering requiring its own offering ID, version, profile value,
and feature values.

Profile Command

A separate profile command must be included for each offering listed
in the install command. The profile command informs Installation
Manager about offering specific properties or configuration values.

The installlLocation specifies where the offering will be installed.
If the response file is used to modify or update an existing
installation, then ensure the installlocation points to the
location where the offering was installed previously.

The eclipselLocation data key should use the same directory path to
Pluggable Application Client as the installationLocation attribute.

Include data keys for product specific profile properties.

The user.plugclient.sundreHome and user.plugclient.sunJdkHome keys
specify the installation location of Java Runtime Environment (JRE)
and Software Development Kit (SDK) in system. Customer can select
their own JRE and SDK to install Pluggable Application Client.

[Ragdsssdisasddadddasddsagdsaadasapdadasdssagdsaagisagddasdddaidssys it

<uninstall modify='false'>
<offering id="'com.ibm.websphere.PLUGCLIENT.v80'

profile='Pluggable Application Client for IBM WebSphere Application Server V8.0'
features='pluggableclient.core.feature,pluggableclient.samples'/>

</uninstall>

<profile id='Pluggable Application Client for IBM WebSphere Application Server V8.0'
installLocation="C:\Program Files\IBM\WebSphere\PlugClient'>

<data key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\PlugClient'/>

<data key='user.import.profile' value='false'/>

<data key='user.select.64bit.image,com.ibm.websphere.PLUGCLIENT.v80"' value='false'/>

<data key='user.appclient.serverHostname' value='localhost'/>
<data key='user.appclient.serverPort' value='2809'/>
<data key='user.plugclient.sunJreHome' value='C:\Program Files\Java\jre6'/>

<data key='user.plugclient.sunJdkHome' value='C:\Program Files\Java\jdkl.6.0_21'/>

<data key='cic.selector.nl' value='en'/>
</profile>

<!-- ##### Shared Data Location ###################F#EFF#AFF#REF#RAAHHEHHH

S SR S S SR SR S S S SR SHe e SR S S S SR SHe SR SR S S SR SR S SR SR SR S SR SR S SR Sk

Uncomment the preference for eclipseCache to set the shared data
lTocation the first time you use Installation Manager to do an
installation.

Eclipse cache location can be obtained from the installed.xml file found in

Linux/Unix: /var/ibm/InstallationManager

Windows: C:\Documents and Settings\A11 Users\Application Data\IBM\Installation Manager

from the following property:
<property name='cacheLocation' value='C:\Program Files\IBM\IMShared'/>

Open the installed.xml file in a text editor because the style sheet
might hide this value if opened in a web browser.

For further information on how to edit preferences, refer to the public Tibrary at:

http://publib.boulder.ibm.com/infocenter/install/vir4/index.jsp?topic=/com.ibm.silentinstal112.doc/topics/r_silent_prefs.html

After the shared data location is set, it cannot be changed
using a response file or the graphical wizard.

Ensure that the shared data location is a location that can be written
to by all user accounts that are expected to use Installation Manager.

By default, Installation Manager saves downloaded artifacts to
the shared data Tocation. This serves two purposes.

First, if the same product is installed a more than once to the machine,
then the files in the shared data Tocation will be used rather than
downloading them again.

Second, during the rollback process, the saved artifacts are used.
Otherwise, if the artifacts are not saved or are removed, then
Installation Manager must have to access the repositories used to
install the previous versions.

Valid values for preserveDownloadedArtifacts:
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# true = store downloaded artifacts in the shared data location

# false = remove downloaded artifacts from the shared data location

#

[didgdddasdzasadasdadaadadagddsasadasddssddasdddasadsagadaadadagdddidd it

<l--

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files\IBM\IMShared'/>

<preference name="'com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
-

<!-- ##### Preferences Settings #################A#FHARFFAARIFRARAAAAHARAFS
Additional preferences for Installation Manager can be specified.

These preference correspond to those that are located in the graphical
interface under File / Preferences.

If a preference command is omitted from or commented out of the response
file, then Installation Manager uses the preference value that was
previously set or the default value for the preference.

Preference settings might be added or deprecated in new versions of
Installation Manager. Consult the online Installation Manager
Information Center for the latest set of preferences and
descriptions about how to use them.

#
#
#
#
#
#
#
#
#
#
#
#
#
# http://publib.boulder.ibm.com/infocenter/install/vlrd/index.jsp
#

#

[Ragdsssdisssddandddasddsagdssapasapdadasdasagdssagisaagiasdddaidstssted

<l--
<preference name="'com.ibm.cic.common.core.preferences.connectTimeout' value='30"'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>

-

</agent-input>

Example: Enabling logging and tracing for application clients

The ActiveX to EJB bridge provides two logging and tracing formats: Windows Application Event Log and
Java Trace Log.

* Windows Event Log

The Windows Application Event Log shows JNI errors, Java console error messages, and XJB
initialization messages. This log is most useful for determining XJBInit() errors and any unusual
exceptions that do not come from the Java environment. By default, critical error logging will be enabled
and debug and event logging is disabled.

To enable or disable logging of certain event types to the Windows Event Log, specify one or more
parameters to XJBInit (). If more than one parameter is set, they will be processed in the order in which
they appear in the input string array to the XJBInit() method. Once the XJBInit() method is initialized,
these parameters can no longer be set/reset for the life of the process. Using Java
java.lang.System.setProperty() to set these values also has no effect.

- -Dcom.ibm.ws.c]1'ent.ij.nat1’ve.1ogging.debug=enab1ed|d1’sab1ed

Enables or disables debug level messages from displaying in the Windows operating system event
log. This level of logging is most useful and shows most internal errors, user programming issues or
configuration problems.

— —Dcom.ibm.ws.c]1'ent.ij.nat1’ve.1ogging.event=enab1ed|d1’sab]ed

Enables or disables event level messages from appearing in the Windows operating system event
log.

- -Dcom.ibm.ws.c]1'ent.ij.nat1've.1ogg1'ng.*=enab1ed|d1'sab1ed
Enables or disables both event and debug level messages from appearing in the Windows operating
system event log. It is not possible to disable some critical error messages from being displayed in
the error log. Only debug and event level messages can be disabled.

Viewing the Windows application event log with the event viewer:
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To open the event viewer in the Windows operating system:

1. Click Start > Settings > Control Panel.

2. Double-click Administrative Tools.

3. Double-click Event Viewer.

All ActiveX to EJB bridge events display the text WebSphere XJB in the source column and in the

application log. For information about using Event Viewer, click the Action menu in Event Viewer, and
then click Help.

To open the even viewer in the Windows operating system, click Start > Programs > Administrative
Tools > Event Viewer. All ActiveX to EJB bridge events have the text WebSphere XJB in the source
column and display in the application log. For information about using Event Viewer, click the Help
menu in Event Viewer.

Java trace log

The Java trace log displays information that you can use to debug method calls, class lookups, and
argument coercion problems. Since the Java portion of the bridge mirrors the function of the COM
IDispatch interface, the information in the trace log is similar to what you have come to expect from an
IDispatch interface. To understand the trace log, you need a fundamental understanding of IDispatch.
To enable user-logging, add the following parameters to the XJBInit() input string array:

"-DtraceString=com.ibm.ws.client.xjb.*=event=enabled"
"-DtraceFile=C:\MyTrace.txt"
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Chapter 7. Deploying client applications

Deploying a client application depends on installing appropriate supporting files on the client machine,
usually some configuring actions, and adding the program files for the client application. When the client
application has been deployed, the application can run.

About this task

The steps required to deploy and run a client application depend on the type of client and the
programming model used.

You can install an application client JAR file using the administrative console, wsadmin AdminApp install,
or update commands. Install the client module only on a Version 8.0 deployment target (such as server,
cluster, and so on).

Complete one or more of the following tasks:

Procedure

* Deploy the client application

* Run an ActiveX client application

» Deploy and run a Java EE client application

* Run the IBM Thin Client for Enterprise JavaBeans

Deploying applet client code

Applet clients are capable of communicating over the HTTP protocol and the RMI-IIOP protocol.
Before you begin

Applet clients have the following setup requirements:

* These clients are available on the Windows platforms. Check the prerequisites page for information on
platform support and product prerequisites.

* The browser installation precedes the client code installation.

About this task

Unlike typical applets that are on web servers or WebSphere Application Servers and can only
communicate over the HTTP protocol, applet clients can communicate over the HTTP protocol and the
RMI-IIOP protocol. This additional capability gives the applet direct access to enterprise beans.

The applet container is the web browser and the Java plug-in combination. You must first install the
Application Client for WebSphere Application Server so that the browser recognizes the IBM product Java

plug-in.

Procedure
1. Install the Application Client for WebSphere Application Server.
2. Configure required Java runtime parameters.
a. Click Start > Control panel .
b. Select the IBM Control Panel for Java
c. On the Advanced tab, enter the following parameter values in the Java Runtime Parameters field.
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-Xmx512M

-Djava.security.policy=<app_client_root>\properties\client.policy
-Dwas.install.root=<app_client_root>
-Djava.ext.dirs=<app_client_root>\java\jre\lib\ext;

<app_client_root>\1ib;

<app_client_root>\plugins;

<app_client_root>\Tib\ext;

<app_client_root>\installedConnectors\
-Djava.class.path=<app_client_root>\properties

-Dcom. ibm.CORBA.ConfigURL=file:<app_client_root>\properties\sas.client.props
-Dcom.ibm.SSL.ConfigURL=file:<app_client_root>\properties\ssl.client.props

Note: These parameter entries are automatically placed into the WebSphere Application Server
control panel for the Java plug-in user who installed the WebSphere Application Server
Application Client provided you are using a Java SE Development Kit (JDK) prior to JDK 1.5. If
the applet is being run by a user other than the person who installed the client, then that user
must enter the parameter entries.

For JDK 1.5 and later, this automatic parameter feature is removed.
» The Java Runtime Parameters field is similar to the command prompt when using command line
options. Therefore, you can enter most options available from the command prompt (for example,
-cp, classpath, and others) in this field as well.

3. Configure use of secure sockets layer (SSL) for secure access to resources. By default, the applet
client is configured to have security enabled. If you have administrative security turned on at the server
from which you are accessing resources, then you can use SSL when needed. If you decide that the
security requirements for applet client applications differ from other types of client applications, then
you can create special copies of client property files for applets to use.

Running an ActiveX client application

To run an ActiveX client application that is to use the ActiveX to Enterprise Java Beans (EJB) bridge, you
must perform some initial configuration to set appropriate environment variables and to enable the ActiveX
to EJB bridge to find its XJB.JAR file and the Java run time. This initial configuration sets up the
environment within which the ActiveX client application can run.

About this task

To perform the required configuration, complete one or more of the following tasks:

Procedure
1. Start an ActiveX application and configure service programs.
2. Start an ActiveX application and configuring non-service programs

Starting an ActiveX application and configuring service programs

To run an ActiveX service program such as Active Server Page (ASP) that is to use the ActiveX to the
Enterprise Java Bean (EJB) bridge, some initial configuration (to set appropriate environment variables
and to enable the ActiveX to EJB bridge to find its XJB.JAR file and the Java run time) is necessary. This
configuration sets up the environment within which the ActiveX service program can run.

Before you begin
The XJB.JClassFactory must find the Java run time dynamic link library (DLL) when initializing. In a
service program such as Internet Information Server you cannot specify a path for its processes

independently; you must set the process paths in the system PATH variable. This limitation means that you
can only have a single Java virtual machine (JVM) version available on a machine using ASP.
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About this task

To add the Java Runtime Environment (JRE) directories to your system path, complete one of the
following task.

Procedure

On Windows XP systems, complete the following steps:

Open the Control Panel, then double-click the System icon.

Click the Advanced tab on the System Properties window.

Click Environment Variables.

Edit the Path variable in the System Variables window.

Add the following information to the beginning of the path that is displayed in the Variable Value field:

\WebSphere\AppC11ent\Java\Jre\b1n C:\WebSphere\AppClient\Java\jre\bin\classic;

where C:\WebSphere\AppClient is the directory in which you installed the Java client in the WebSphere
product.

Click OK in the Edit System Variable window to apply the changes.

Click OK in the Environment Variables window.

Click OK in the System Properties window.

Restart Windows XP.

QorODOA

© N>

What to do next

After you change the system PATH variable you must reboot the Internet Information Server machine so
that Internet Information Server can see the change.

Starting an ActiveX application and configuring non-service programs

To run an ActiveX program initiated from an icon or command line (a non-service program) that is to use
the ActiveX to the Enterprise Java Beans (EJB) bridge, you must perform some initial configuration to set
appropriate environment variables and to enable the ActiveX to EJB bridge to find its XJB.JAR file and the
Java run-time environment. This uses a batch file to set up the environment within which the ActiveX
program can run.

About this task
To perform the required configuration, complete the following steps:

Procedure

1. Edit the setupCmdLineXJB.bat file to specify appropriate values for the environment variables required
by the ActiveX to EJB bridge. For more information about these environment variables, see ActiveX to
EJB bridge, environment and configuration. For more information about creating a JVM for an ActiveX
program, see ActiveX to EJB bridge, initializing the Java virtual machine (JVM). After the ActiveX
program has created an XJB.JClassFactory object and called the XJBInit() method, the JVM is
initialized and ready for use.

2. Start the ActiveX client application by using one of the following methods:
» Use the TaunchClientXJB.bat file to start the application. For example:

TaunchClientXJB MyApplication.exe parml parm2

or

TaunchClientXJB MyApplication.vbp
* Use the setupCmdLineXJB.bat file to create an environment in which to run the application, then start
the application from within that environment.
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setupCmdLineXJB.bat, launchClientXJB.bat and other ActiveX batch
files

This topic provides reference information about the aids that client applications and client services can use
to access the ActiveX to EJB bridge. These enable the ActiveX to Enterprise JavaBeans (EJB) bridge to
find its XJB.JAR file and the Java run-time environment.

Location

The include file is located in the was_client_home\aspIncludes directory. You can include the file into your
Active Server Pages (ASP) application with the following syntax in your ASP page:

<-- #include virtual ="/WSASPIncludes/setupASPXJB.inc" -->

This syntax assumes that you have created a virtual directory in Internet Information Server called
WSASPIncludes that points to the was _client _home\aspIncludes directory.

Usage notes

The following batch files are provided for client applications to use the ActiveX to EJB bridge:
+ setupCmdLineXJB.bat

Sets the client environment variables.
« launchClientXJB.bat

Calls the setupCmdLineXJB.bat file and launches the application you specify as its arguments; for
example:

TaunchClientXJB.bat myapp.exe parml parm2

or

TaunchClientXJB MyApplication.vbp
* Active Server Pages (ASP) include file

An include file is provided for ASP users to automatically set the following page-level (local)

environment variables:

— com_ibm_websphere_javahome. Path to the Java run-time directory installed with the WebSphere
advanced server client.

— com_ibm_websphere_washome. Path to the WebSphere advanced server client directory.

— com_ibm_websphere_namingfactory. Sets the Java java.naming.factory.initial system property.

— com_ibm_websphere_computername. (Optional) Name of the computer where the WebSphere
Advanced Server Client is installed. If you intend to talk to a single specific computer, you are
recommended to change this value to become the server name that you intend to access.

+ System settings

To enable the ActiveX to EJB bridge to access the Java run-time dynamic link library (DLL), the
following directories must exist in the system PATH environment variable:

was_client_home\java\jre\binswas client_home\java\jre\bin\classic

Where was_client_home is the name of the directory where you installed the WebSphere Application
Server client (for example, C:\WebSphere\AppClient).

Note: This technique enables only one Java run time to activate on a machine, therefore all client

services on that machine must use the same Java run time. Client applications do not have this
limitation because they each have their own private, non-system scope.
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Deploying and running a Java EE client application

You can use the launchClient command to run a Java Enterprise Edition (EE) client application in an
Application Client installation or in a WebSphere Application Server node. Alternatively, you can use Java
Web Start on a remote client machine to download and run a Java EE client application, including Thin
client application, with a single click from a web browser on that machine.

Procedure
1. Deploy and run a Java EE client application for use with the launchClient command.

After deploying a Java EE client application onto a machine with an Application Client installation or in
a WebSphere Application Server node, you can start the application by using the launchClient
command on that machine.

a. Deploy the Java EE client application
b. Start the Java EE client application
2. Deploy and run a Java EE client application by using Java Web Start.
a. Prepare the Java EE client application ready to be deployed by remote action.

b. Use Java Web Start on a remote client machine to download and run the Java EE client
application.

Deploying a Java EE client application

Deploying a Java EE client application onto the client machines where it is to run includes distributing the
EAR file for the client application and configuring resource references for use by the client application.

Before you begin

To run a deployed Java EE client application, the application needs access to a Application Client
installation or a WebSphere Application Server installation.

For information about installing the Application Client on a client machine, refer to the Installing Application
Client for WebSphere Application Server topic.

Attention: Application Client for WebSphere Application Server ships only with the 32-bit WebSphere
Application Server.

About this task

Use this topic only if you later want to use the want to launchClient command to run the Java client
application on an Application Client installation or in a WebSphere Application Server node.

If you want to download and run a Java EE client application remotely, you can use the Java Web Start to
deploy the application onto the remote client machine with a single click from a Web browser on the client
machine. For information about using Java Web Start to deploy Java EE client applications, see
“Downloading and running a Java EE client application by using Java Web Start”.

Procedure
1. Distribute the EAR file.
The client machines configured to run a client application must have access to the EAR file.

 If all the machines in your environment share the same image and platform, run the Application
Client Resource Configuration Tool (ACRCT) on one machine to configure the external resources,
then distribute the configured EAR file to the other machines.

 If your environment is set up with a variety of client installations and platforms, run the ACRCT for
each unique configuration.
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* You can either distribute an EAR file to the correct client machines, or make it available on a
network drive.

» Distributing EAR files is the responsibility of the system and network administrator.

2. Configure the resources for the application client. This generally involves using the Application Client
Resource Configuration Tool (ACRCT) to configure references for the resources that the application is
to use, including resource adapters, resource providers, data sources, and Java Message Service
resources. These configurations are stored in the client JAR file within the application EAR file. The
client runtime uses these configurations to resolve and create an instance of the resources for the
client application.

For some types of resources, other actions are needed; for example, to install a resource adapter and
define environment variable needed to start the client application. More information about the actions
for different types of resources is given in other configuring resources topics.

If you plan to deploy the client application on z/OS, run the ACRCT on Windows. You can also run the
ACRCT for distributed platforms locally.

If the client application defines the local resources, but the resources are installed in a different
location, run the ACRCT (clientConfig command) on the local machine to change the configuration in
the EAR file. For example, the EAR file can contain a DB2 resource, configured as C:\DB2. If, however,
you installed DB2 in the D:\Program Files\DB2 directory, use the ACRCT to create a local version of
the EAR file.

What to do next

After deploying the Java EE client application, use the launchClient command to run the client application.
Starting the Application Client Resource Configuration Tool and opening an EAR
file

You can perform many tasks by starting the Application Client Resource Configuration Tool (ACRCT).
Many of these tasks also involve then opening an EAR file.

Before you begin
Attention: This task only applies to Java Platform, Enterprise Edition (Java EE) application clients.
About this task

Use these steps to start the Application Client Resource Configuration Tool. When you start the tool, one
of the most common tasks that you perform is opening and modifying the components of EAR files.

Procedure
1. Open a command prompt and change to the|app server root\bin directory.
2. Run the clientConfig.bat file.

Note: T WET™E@ When running the clientConfig.bat file, run the script using the
administrator account that was created when you installed the operating system.
3. Open an EAR file within the Application Client Resource Configuration Tool (ACRCT):
a. Click File > Open.
b. Select the file then click Open.
4. Save your changes to the file and close the tool:
a. Click File > Save.
b. Click File > Exit.

Deploying a resource adapter for a Java EE client application
A Java EE client application can use a resource adapter to connect to an enterprise information system
(EIS). To use a resource adapter, you need to install it, configure it, and configure related resources.
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About this task

The resource adapter support provided for Java EE client applications is a subset of the support provided
for application servers. A client resource adapter is used in a non-managed environment and must conform
to the J2EE Connector Architecture Specification Version 1.5 or higher. Only outbound connections to the
EIS are supported through the ManagedConnectionFactory interfaces. The inbound messaging support
(from the EIS), life cycle management, and work management aspects of the specification are not
supported on the client.

When running Java EE application clients, the launchClient script specifies a system property called
com.ibm.ws.client.installedConnector, which is set to the same value as the
CLIENT_CONNECTOR_INSTALL_ROOT variable. This is the default location for installed resource
adapters and can be overridden for each launchClient call by specifying the -CCD parameter. When the
client container is activated, all resource adapter subdirectories under the specified default location for the
resource adapters directory are added to the classpath. This action allows the client application to use the
resource adapters without using the ACRCT to specify any of the client resources.

Procedure
1. Install the resource adapter archive (RAR) file

For a client application to use a resource adapter, the RAR file must be installed in the directory
specified by the environment variable, CLIENT_CONNECTOR_INSTALL_ROOQT, defined when the
setupCmdLine script runs. The launchClient tool, Application Client Resource Configuration Tool
(ACRCT) and clientRAR tool all use this variable to find the default location of all installed resource
adapters.
To install a RAR file for a client application, use the |clientRAR tool

2. Configure the resource adapter and its resources for the client application Use the Application Client
Resource Configuration Tool (ACRCT) to define the resource adapter, connection factories, and
administered objects in the EAR file for the client application. The client application uses this
configuration to resolve and create an instance of the resource adapter and the other resources.
a. |Configure the resource adapter
b. [Configure a connection factory|

c. [Configure administered objects|

clientRAR tool:
This topic describes the command line syntax for the client resource adapter installation tool.

If this tool is used to add or delete resource adapters on the server, then only the client can use the
resource adapter. If the resource adapter is installed on the server using the wsadmin tool or the
administrative console, then do not use the clientRAR tool remove it. Only resource adapters that are
installed using the clientRAR tool should be removed using the clientRAR tool.

The command line invocation syntax for the clientRAR tool follows:
clientRAR [-help | -?] [-CRDcom.ibm.ws.client.installedConnectors=<dir>] <task> <archive>

where

-help, -7

Print the usage information.
-CRDcom.ibm.ws.client.installedConnectors

The directory where resource adapters are installed.
This will override the system property of the same name
(com.ibm.ws.client.installedConnectors).

<task>
The task to perform: add - install, delete - uninstall.
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<archive>
if task=add then this is the fully qualified name of the resource adapter archive file.
If task=delete then this is the filename of the resource adapter archive to be uninstalled.

The following examples demonstrate correct syntax.

e On Windows operating systems:
* clientRAR add c:\rars\myrar.rar
» clientRAR delete myrar.rar

B TS TS T On UNIX and Linux operating systems:

» ./clientRAR add /usr/rars/myrar.rar
« /clientRAR delete myrar.rar

Configuring resource adapters for the client:

Use the Application Client Resource Configuration Tool (ACRCT) to configure resource adapters for the
client.

Procedure
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure new resource adapters. The EAR file contents
display in a tree view.

Select the JAR file in which you want to configure the new resource adapters from the tree.
Expand the JAR file to view its contents.

Right-click the Resource Adapters folder, and click New.

Configure the resource adapter settings in the resulting property dialog.

Click OK.

Click File > Save on the menu bar to save your changes.

© N o O~

Resource adapters for the client:

A resource adapter is a system-level software driver that a Java application uses to connect to an
enterprise information system (EIS). A resource adapter plugs into an application client and provides
connectivity between the EIS and the enterprise application.

Important: This topic is not relevant to the WebSphere MQ resource adapter. WebSphere MQ classes
are picked up automatically by the client container (for both stand alone and with a
WebSphere Application Server installation).

The resource adapter support for the Java EE client applications is a subset of the support for the server.
For any resource adapter installed using the clientRAR tool, the client resource adapter is used in a
non-managed environment and must conform to the Java EE Connector Architecture Specification Version
1.5 or higher. Only outbound connections to the EIS are supported through the
ManagedConnectionFactory interfaces. The inbound messaging support (from the EIS), life cycle
management, and work management aspects of the specification are not supported on the client.

For a client application to use a resource adapter, it must be installed in the directory specified by the
environment variable, CLIENT_CONNECTOR_INSTALL_ROOT, defined when the setupCmdLine script
runs. The launchClient tool, Application Client Resource Configuration Tool (ACRCT) and clientRAR tool all
use this variable to find the default location of all installed resource adapters. To install a resource adapter
in the client, use the clientRAR tool. Once the resource adapter is installed, it must be configured using
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the ACRCT. The client configuration tool adds the resource adapter configuration to the EAR file. Then,
connection factories and administered objects are defined.

When running Java EE application clients, the TaunchClient script specifies a system property called
com.ibm.ws.client.installedConnector, which is set to the same value as the
CLIENT_CONNECTOR_INSTALL_ROOT variable. This is the default location for installed resource adapters and
can be overridden for each TaunchClient call by specifying the -CCD parameter. When the client container
is activated, all resource adapter subdirectories under the specified default location for the resource
adapters directory are added to the classpath. This action allows the client application to use the resource
adapters without using the ACRCT to specify any of the client resources.

Using resource adapters is a new mechanism for easily extending client applications.
Resource adapter settings:

Use this panel to view or change the configuration properties of the resource adapter. These configuration
properties control how resource adapters are created.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Adapter. Right-click
Resource Adapter and click New. The following fields appear on the General tab.

Name:
The name by which this Resource Adapter is known for administrative purposes within IBM WebSphere

Application Server. The name must be unique within the Resource Adapters across the product
administrative domain.

Data type String

Description:

A description of this resource adapter for administrative purposes within IBM WebSphere Application
Server.

Data type String

Class Path:

Any additional class path. The path to the resource adapter directory is automatically added.

Data type String
Default The path to your Resource Adapter directory.

Native Path:

The native path where the Resource Adapter is located. Enter any additional native class path here.

Data type String

Resource Adapter Name:
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A mandatory field that points to an installed resource adapter subdirectory. The entry does not represent
the full directory name for the resource adapter. The full directory name is the installed resource adapter
path, plus the resource adapter name.

Data type String

Installed Resource Adapter Path:

The directory where resource adapters are installed. If you do not complete this field, then the default
takes effect.

If you specify the value, ${CONNECTOR_INSTALL ROOT}, then this value replaces the value of the
CLIENT_CONNECTOR_INSTALL_ROOT variable on the machine on which the client application runs. This action
allows the application to run easily on different machines, where the client installation might be in different
locations.

Data type String
Default ${CONNECTOR_INSTALL_ROOT}

Configuring new connection factories for resource adapters for the client:

Use the Application Client Resource Configuration Tool (ACRCT) to configure new connection factories for
resource adapters for the client.

About this task
Compilete this task to configure new connection factories for resource adapters.

Procedure
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure new connection factories. The EAR file contents
display in a tree view.

Select the JAR file in which you want to configure the new connection factories from the tree.
Expand the JAR file to view its contents.

Click the Resource Adapters folder.

Expand the resource adapter for which you want to create connection factories.

Right-click the Connection Factories folder and click New.

Configure the connection factory properties in the resulting property dialog.

Click OK.

Click File > Save on the menu bar to save your changes.
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Resource adapter connection factory settings:

Use this panel to view or change the configuration properties of the selected resource adapter connection
factory.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Adapters. Right-click the
Connection Factories folder, and click New. The following fields appear on the General tab.

Name:
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The name by which this connection factory is known for administrative purposes within WebSphere
Application Server. The name must be unique within the resource adapter connection factories across the
product administrative domain.

Data type String

Description:

An optional description of this connection factory for administrative purposes within IBM WebSphere
Application Server.

Data type String

JNDI Name:

The JNDI name that is used to match this resource adapter connection factory definition to the deployment
descriptor. This entry should be a resource-ref name.

Data type String

User Name:

The User Name used, with the Password property, for authentication if the calling application does not
provide a userid and password explicitly when getting a connection. If this field is used, then the Properties
field UserName is ignored.

If you specify a value for the User Name property, you must also specify a value for the Password
property.

The connection factory User Name and Password properties are used if the calling application does not
provide a userid and password explicitly when getting a connection.

Data type String

Password:

Specifies an encrypted password. If you complete this field, then the Password field in the Properties box
is ignored.

If you specify a value for the UserName property, you must also specify a value for the Password
property.

Data type String

Re-Enter Password:
Confirms the password.
Type:

A drop-down list of all the connectionFactoryInterfaces as defined for the factories in the Resource
Adapter Archive.
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For each Type, there is a set of properties specified in the Properties box. This set of properties is
constructed by retrieving the properties from each connection definition object. For any existing connection
factories that are displayed for updating, this list of properties is overlaid with the properties specified for
the objects. When the Type field is changed, the properties also change to reflect the correct properties for
that type.

Data type String

Configuring administered objects for resource adapters for the client:
This section helps you configure new administered objects for the client.
Before you begin

Before you configure new administered objects, you must complete the following prerequisites:
1. Install the Resource Adapter Archive file (RAR) using the |clientRAR tool

2. [Configure the resource adapter for the .ear file, using the Application Client Resource Configuration
Tool (ACRCT) tool.

About this task
Complete this task to configure new administered objects for installed resource adapters.

Procedure
1. [Start the Application Client Resource Configuration Tool (ACRCT)]

2. Open the EAR file for which you want to configure new administered objects. The EAR file contents
display in a tree view.

Select the JAR file in which you want to configure the new administered objects from the tree.
Expand the JAR file to view its contents.

Click the Resource Adapters folder.

Expand the resource adapter for which you want to create administered objects.

Right-click the Administered Objects folder and click New.

Configure the administered object properties in the resulting property dialog.

Click OK.

Click File > Save on the menu bar to save your changes.
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Administered objects settings:
Use this panel to view or change the configuration properties of the selected administered objects.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Adapters >
resource_adapter_instance. Right-click Administered Objects and click New. The following fields appear
on the General tab.

The settings for administered objects are handled similarly to connection factories. When updating
administered objects, use the same panels that you used to create administered objects.

Name:

The name by which this administered object is known for administrative purposes within IBM WebSphere
Application Server. The name must be unique within the resource adapter administered objects across the
product administrative domain.
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Data type String

Description:

An optional description of this connection factory for administrative purposes within IBM WebSphere
Application Server.

Data type String

JNDI Name:

This entry is a resource-env-ref name, a message-destination-ref name (if the message-destination-
ref has no link), or a message-destination link.

Data type String

Type:

A drop-down list of all the administered object class-interface pairs as defined for the admin objects in the
Resource Adapter Archive (RAR) file.

For each Type, there is a set of properties specified in the Properties box. This set of properties is
constructed by retrieving the properties from each administered object definition. For any existing
administered objects that are displayed for updating, this list of properties is overlaid with the properties
specified for the objects. When the Type field is changed, the properties also change to reflect the correct
properties for that type.

Data type String

Enabling client use of data sources

If a Java EE client application accesses a database directly, you must provide the database drivers on the
client machine, and configure the data source provider (JDBC provider) and data sources. Instead of
accessing the database directly, it is recommended that your client application access the database
through an enterprise bean.

About this task

WebSphere Application Server and the Application Client for WebSphere Application Server do not provide
client database drivers to be used directly from a Java EE client application. You can contact your
database vendor to get client database driver code and licenses.

Data sources configured on the server and looked up on the client do not participate in global transactions.

Instead of accessing the database directly, it is recommended that your client application access the
database through an enterprise bean. This technique eliminates the need to have database drivers on the
client machine, because the database access is handled by the enterprise bean running on WebSphere
Application Server. It also enables the client application to take advantage of the pooling and additional
database functions provided by the server.

For a current list of data source providers that are supported on WebSphere Application Server, see the
IVVebSphere Application Server prerequisite website|.
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Procedure

1.

For direct access from a client to the database, install the client database drivers on the client
machine. For information about installing database drivers, see the documentation provided by your
database vendor.

Configure a data source provider and a data source for the client application Use the Application Client
Resource Configuration Tool (ACRCT) to define the data source provider and a data source in the
EAR file for the client application. The client application uses this configuration to resolve and create
an instance of the data source provider and data source.

a. |Configure a new data source provided This provider describes the JDBC database implementation
for your client application.

b. |Configuring a new data sourcel This describes the client properties of the database your client
application uses.

Configuring new data source providers (JDBC providers) for application clients:

You can create new data source providers, also known as JDBC providers, for your application client using
the Application Client Resource Configuration Tool (ACRCT).

Before you begin

During this task, you create new data source providers, also known as JDBC providers, for your
application client. In a separate administrative task, install the Java code for the required data source
provider on the client machine on which the application client resides.

About this task

Use this task to connect application clients to relational databases.

Procedure

1.

Start the Application Client Resource Configuration Tool (ACRCT) and open the EAR file for which you
want to configure the new data source provider. The EAR file contents display in a tree view.

2. Select the JAR file in which you want to configure the new data source provider from the tree.
3. Expand the JAR file to view its contents.
4. Click the Data Source Providers folder. Do one of the following:
* Right-click the folder and click New Provider.
» Click Edit > New on the menu bar.
5. Configure the data source provider properties in the resulting property dialog.
6. Click OK when you finish.
7. Click File > Save on the menu bar to save your changes.
Example

You can configure data source provider and data source settings.

Configuring data source provider and data source settings|

The following code examples illustrates how to use configure data source provider and data source
settings:

<resources.jdbc:JDBCProvider xmi:id="JDBCProvider_1" name="jdbcProvider:name"
description="jdbcProvider:description" implementationClassName="jdbcProvider:
ImplementationClass">

<classpath>jdbcProvider:classPath</classpath>

<factories xmi:type="resources.jdbc:WAS40DataSource" xmi:id="WAS40DataSource 1"
name="jdbcFactory:name" jndiName="jdbcFactory:jndiName"
description="jdbcFactory:description" databaseName="jdbcFactory:databasename">
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<propertySet xmi:id="J2EEResourcePropertySet 13">
<resourceProperties xmi:id="J2EEResourceProperty 13" name="jdbcFactory:customName"
value="jdbcFactory:customValue"/>
<resourceProperties xmi:id="J2EEResourceProperty 14" name="user"
value="jdbcFactory:user"/>
<resourceProperties xmi:id="J2EEResourceProperty 15" name="password"
value="{xor}NTs9PBk+PCswLSZ1MT4y0g=="/>
</propertySet>
</factories>
<propertySet xmi:id="J2EEResourcePropertySet 14">
<resourceProperties xmi:id="J2EEResourceProperty 16" name="jdbcProvider:customName"
value="jdbcProvider:customeValue"/>
</propertySet>
</resources.jdbc:JDBCProvider>
* Required fields:
— Data Source Provider Properties page: name
— Data Source Properties page: name, jndiName

* Special cases:

— The user name and password fields have no equivalent XMI tags. You must specify these fields in

the custom properties.
— The password is encrypted when you use the Application Client Resource Configuration Tool
(ACRCT). If you do not use the ACRCT the field cannot be encrypted.

Example: Configuring data source provider and data source settings:
You can configure data source provider and data source settings.

The purpose of this article is to help you to configure data source provider and data source settings.
* Required fields:

— Data Source Provider Properties page: name

— Data Source Properties page: name, jndiName
* Special cases:

— The user name and password fields have no equivalent XMl tags. You must specify these fields in

the custom properties.
— The password is encrypted when you use the Application Client Resource Configuration Tool
(ACRCT). If you do not use the ACRCT the field cannot be encrypted.
* Example:

<resources.jdbc:JDBCProvider xmi:id="JDBCProvider_ 1" name="jdbcProvider:name"
description="jdbcProvider:description" implementationClassName="jdbcProvider:
ImplementationClass">

<classpath>jdbcProvider:classPath</classpath>

<factories xmi:type="resources.jdbc:WAS40DataSource" xmi:id="WAS40DataSource 1"
name="jdbcFactory:name" jndiName="jdbcFactory:jndiName"
description="jdbcFactory:description" databaseName="jdbcFactory:databasename">
<propertySet xmi:id="J2EEResourcePropertySet 13">

<resourceProperties xmi:id="J2EEResourceProperty 13" name="jdbcFactory:customName"
value="jdbcFactory:customValue"/>

<resourceProperties xmi:id="J2EEResourceProperty 14" name="user"
value="jdbcFactory:user"/>

<resourceProperties xmi:id="J2EEResourceProperty 15" name="password"
value="{xor}NTs9PBk+PCswLSZ1MT4y0g=="/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 14">

<resourceProperties xmi:id="J2EEResourceProperty 16" name="jdbcProvider:customName"
value="jdbcProvider:customeValue"/>

</propertySet>

</resources.jdbc:JDBCProvider>

Data source provider settings for application clients:
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Use this page to create a data source under a JDBC provider which provides the specific JDBC driver
implementation class.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Data Source Providers >
and click New. The following fields appear on the General tab:

Name:

Specifies the display name for the data source.

For example you can set this field to Test Data Source.

Data type String

Description:

Specifies a text description for the resource.

Data type String

Class Path:
A list of paths or . jar file names which together form the location for the resource provider classes.
Implementation class:

Use this setting to perform database specific functions.

Data type String
Default Dependent on JDBC driver implementation class
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
Configuring new data sources for application clients:

Learn how to create date sources for application clients.

About this task

During this task, you create new data sources for your application client.

Procedure

1. Click the data source provider for which you want to create a data source in the tree. Take one of the
following actions as needed:
« |Configure a new data source provider
» Click an existing data source provider.
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2. Expand the data source provider to view its Data Sources folder.

3. Click the data source folder. Take one of the following actions as needed:
* Right click the data source folder and click New Factory.
» Click Edit > New on the menu bar.

4. Configure the data source properties in the displayed fields.
5. Click OK when you finish.
6. Click File > Save on the menu bar to save your changes.

Data source properties for application clients:

Use this page to create or modify the data sources.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Data Source Providers > Data source
provider instance. Right-click Data Sources and click New. The following fields are displayed on the
General tab:

Name:

Specifies the display name of this data source.

Data type String

Description:

Specifies a text description of the data source.

Data type String

JNDI Name:

The application client run time uses this field to retrieve configuration information.
Database Name:

The name of the database to which you want to connect.

User:

Use the user ID with the Password property, for authentication if the calling application does not provide a
user ID and password explicitly.

If you specify a value for the User ID property, then you must also specify a value for the Password
property. The connection factory User ID and Password properties are used if the calling application does
not provide a user ID and password explicitly.

Password:

Use the password with the User ID property, for authentication if the calling application does not provide a
user ID and password explicitly.

If you specify a value for the Password property, then you must also specify a value for the User ID
property.
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Re-Enter Password:
Confirms the password.
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Configuring mail providers and sessions for application clients
You can edit the configurations of mail sessions and providers for your application clients using the
Application Client Resource Configuration Tool (ACRCT).

About this task

Use the Application Client Resource Configuration Tool (ACRCT) to edit the configurations of mail sessions
and providers for your application clients to use.

Procedure
1. Start the ACRCT.
2. Open an EAR file.

3. Locate the mail objects in the tree that is displayed for the EAR file. For example, if your file contains
mail sessions, expand Resources > application.jar > Mail Providers >
java_mail_provider_instance > Mail Sessions.

In this example, java_mail_provider _instance is a particular mail provider.
Results
The mail session instances are located in the JavaMail Sessions folder.
Example

You can configure mail provider and mail session settings.
« [Configuring mail provider and mail session settings for application clients]

The following code examples illustrates how to configure mail provider and mail session settings for
application clients:

<resources.mail:MailProvider xmi:id="builtin_mailprovider" name="Built-in Mail Provider" description="The built-in mail provider">
<factories xmi:type="resources.mail:MailSession"
xmi:id="MailSession_1207766754834" name="MailSession"
jndiName="mail/session" description="Sample mail session" category="Sample"
mailTransportHost="smtp.coldmail.com" mailTransportUser="transportUser"
mailTransportPassword="{xor}Lz4sLChvLTs="
mailFrom="smith@coldmail.com" mailStoreHost="imap.coldmail.com" mailStoreUser="storeUser"
mailStorePassword="{xor}Lz4sLChvLTs="
debug="true" strict="true"
mailTransportProtocol="builtin_smtp" mailStoreProtocol="builtin_imap">
<propertySet xmi:id="J2EEResourcePropertySet_1207766778585">
<resourceProperties xmi:id="J2EEResourceProperty 1207766778585" name="key" type="java.lang.String" value="value" required="false"/>
</propertySet>
</factories>
<protocolProviders xmi:id="builtin_smtp" protocol="smtp" classname="com.sun.mail.smtp.SMTPTransport" type="TRANSPORT"/>
<protocolProviders xmi:id="builtin_pop3" protocol="pop3" classname="com.sun.mail.pop3.POP3Store" type="STORE"/>
<protocolProviders xmi:id="builtin_imap" protocol="1imap" classname="com.sun.mail.imap.IMAPStore" type="STORE"/>
<protocolProviders xmi:id="builtin_smtps" protocol="smtps" classname="com.sun.mail.smtp.SMTPSSLTransport" type="TRANSPORT"/>
<protocolProviders xmi:id="builtin_pop3s" protocol="pop3s" classname="com.sun.mail.pop3.POP3SSLStore" type="STORE"/>
<protocolProviders xmi:id="builtin_imaps" protocol="imaps" classname="com.sun.mail.imap.IMAPSSLStore" type="STORE"/>
</resources.mail:MailProvider>

272 Developing WebSphere applications



* Required fields:
— Mail Provider Properties page: name, and at least one protocol provider
— Mail Session Properties page: name, jndiName, outgoing server and protocol, and/or incoming server
and protocol
* Special cases:
— If you use the ACRCT tool, the password field will be encrypted. You cannot encrypt the password
field if you do not use the ACRCT tool.
Mail provider settings for application clients:
Use this page to implement the JavaMail APl and create mail sessions.
To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Mail Providers > and click
New. The following fields appear on the General tab:
Name:
The name of the JavaMail resource provider.
Description:
An optional description for the resource provider.

Class Path:

Specifies a list of paths or JAR file names which together form the location for the resource provider
classes.

Protocol:
Specifies the name of the protocol.
Classname:

Specifies the name of the class implementing the protocol. Leave this field blank if you want to use the
default implementation.

Type:
This menu contains the following two values: TRANSPORT or STORE.
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Mail session settings for application clients:

Use this page to configure mail session properties.
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To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Mail Providers > mail provider
instance. Right-click Mail Sessions and click New. The following fields appear on the General tab:
Name:

Represents the administrative name of the JavaMail session object.

Description:

Provides an optional description for your administrative records.

JNDI Name:

The application client run time uses this field to retrieve configuration information.

Mail Transport Host:

Specifies the server to connect to when sending mail.

Mail Transport Protocol:

Specifies the transport protocol to use when sending mail.

Mail Transport User:

Specifies the user ID to use when the mail transport host requires authentication.

Mail Transport Password:

Specifies the password to use when the mail transport host requires authentication.

Enable strict Internet address parsing:

Specifies whether the recipient addresses must be parsed strictly in compliance with RFC 822, which is a
specifications document issued by the Internet Architecture Board.

This setting is not generally used for most mail applications. RFC 822 syntax for parsing addresses
effectively enforces a strict definition of a valid email address. If you select this setting, JavaMail will
adhere to RFC 822 syntax and reject recipient addresses that do not parse into valid email addresses (as
defined by the specification). If you do not select this setting, JavaMail will not adhere to RFC 822 syntax
and will accept recipient addresses that do not comply with the specification. By default, this setting is
deselected. You can view the RFC 822 specification at the following URL for the World Wide Web
Consortium (W3C): http://www.w3.org/Protocols/rfc822/.

Re-Enter Password:

Confirms the password.

Mail From:

Specifies the mail originator.

Mail Store Host:

Specifies the mail account host (or "domain") name.
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Mail Store User:

Specifies the user ID of the mail account.

Mail Store Password:

Specifies the password of the mail account.

Re-Enter Password:

Confirms the password.

Mail Store Protocol:

Specifies the protocol to be used when receiving mail.
Mail Debug:

When true, JavaMail interaction with mail servers, along with these mail session properties are printed to
the stdout file.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a nhame that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring mail provider and mail session settings for application clients:

You can configure mail provider and mail session settings. This topic provides the required fields, special
cases, and an example.

The purpose of this topic is to help you configure mail provider and mail session settings.
* Required fields:
— Mail Provider Properties page: name, and at least one protocol provider
— Mail Session Properties page: name, jndiName, outgoing server and protocol, and/or incoming server
and protocol
» Special cases:
— If you use the ACRCT tool, the password field will be encrypted. You cannot encrypt the password
field if you do not use the ACRCT tool.
* Example:

<resources.mail:MailProvider xmi:id="builtin_mailprovider" name="Built-in Mail Provider" description="The built-in mail provider">
<factories xmi:type="resources.mail:MailSession"
xmi:id="MailSession_1207766754834" name="MailSession"
jndiName="mail/session" description="Sample mail session" category="Sample"
mailTransportHost="smtp.coldmail.com" mailTransportUser="transportUser"
mailTransportPassword="{xor}Lz4sLChvLTs="
mailFrom="smith@coldmail.com" mailStoreHost="imap.coldmail.com" mailStoreUser="storeUser"
mailStorePassword="{xor}Lz4sLChvLTs="
debug="true" strict="true"
mailTransportProtocol="builtin_smtp" mailStoreProtocol="builtin_imap">
<propertySet xmi:id="J2EEResourcePropertySet_1207766778585">
<resourceProperties xmi:id="J2EEResourceProperty 1207766778585" name="key" type="java.lang.String" value="value" required="false"/>
</propertySet>
</factories>
<protocolProviders xmi:id="builtin_smtp" protocol="smtp" classname="com.sun.mail.smtp.SMTPTransport" type="TRANSPORT"/>
<protocolProviders xmi:id="builtin_pop3" protocol="pop3" classname="com.sun.mail.pop3.POP3Store" type="STORE"/>
<protocolProviders xmi:id="builtin_imap" protocol="imap" classname="com.sun.mail.imap.IMAPStore" type="STORE"/>
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<protocolProviders xmi:id="builtin_smtps" protocol="smtps" classname="com.sun.mail.smtp.SMTPSSLTransport" type="TRANSPORT"/>

<protocolProviders xmi:id="builtin_pop3s" protocol="pop3s" classname="com.sun.mail.pop3.POP3SSLStore" type="STORE"/>

<protocolProviders xmi:id="builtin_imaps" protocol="imaps" classname="com.sun.mail.imap.IMAPSSLStore" type="STORE"/>
</resources.mail:MailProvider>

Configuring new mail sessions for application clients
You can use the Application Client Resource Configuration Tool (ACRCT) to configure new mail sessions
for your application client.

Before you begin

During this task, you configure new mail sessions for your application client. The mail sessions are
associated with the pre-configured default mail provider supplied by the product.

Procedure

1. IStart the Application Client Resource Configuration Tool (ACRCT) and open the EAR file[ The EAR file
contents are displayed in a tree view.

2. Select the JAR file in which you want to configure the new JavaMail session.
Expand the JAR file to view its contents.

4. Click Mail Providers > Mail Provider > Mail Sessions. Complete one of the following actions:
* Right click the Mail Sessions folder and select New Factory.
» Click Edit > New on the menu bar.

5. Configure the Mail Session properties in the displayed fields.
6. Click OK.
7. Click File > Save on the menu bar to save your changes.

w

Configuring new URL providers for application clients

You can create URL providers and URLs for your client application using the Application Client Resource
Configuration Tool (ACRCT).

Before you begin

During this task, you create URL providers and URLs for your client application. In a separate
administrative task, you must install the Java code for the required URL provider on the client machine on
which the client application resides.

About this task

Procedure
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure the new URL provider. The EAR file contents
display in a tree view.

3. Select the JAR file in which you want to configure the new URL provider from the tree.
4. Expand the JAR file to view the contents.

5. Click the folder called URL Providers. Complete one of the following actions:
* Right click the folder and select New.
» Click Edit > New on the menu bar.

6. Configure the URL provider properties in the resulting property dialog.
Click OK.
8. Click File > Save on the menu bar to save your changes.

N
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Example
« [Configuring URL and URL provider settings for application clients|

This code example illustrates how to configure URL and URL provider settings for application clients:

<resources.url:URLProvider xmi:id="URLProvider_1" name="urlProvider:name"
description="urlProvider:description"
streamHandTerClassName="ur1Provider:streamHandlerClass"
protocol="url1Provider:protocol">
<classpath>urlProvider:classpath</classpath>
<factories xmi:type="resources.url:URL" xmi:id="URL_1" name="urlFactory:name"
jndiName="ur1Factory:jndiName" description="urlFactory:description"
spec="urlFactory:url">
<propertySet xmi:id="J2EEResourcePropertySet 18">
<resourceProperties xmi:id="J2EEResourceProperty 20" name="urlFactory:customName"
value="urlFactory:customValue"/>
</propertySet>
</factories>
<propertySet xmi:id="J2EEResourcePropertySet 19">
<resourceProperties xmi:id="J2EEResourceProperty 21" name="urlProvider:customName"
value="ur1Provider:customvValue"/>
</propertySet>
</resources.url:URLProvider>
* Required fields:

— URL Properties page: name, jndiName, url

— URL Provider Properties page: name

URLs for application clients:

A Uniform Resource Locator (URL) is an identifier that points to an electronically accessible resource, such
as a directory file on a machine in a network, or a document stored in a database.

URLs appear in the format scheme:scheme_information.

You can represent a scheme as http, ftp, file, or another term that identifies the type of resource and
the mechanism by which you can access the resource.

In a web browser location or address box, a URL for a file available using HyperText Transfer Protocol
(HTTP) starts with http:. An example is http://www.ibm.com. Files available using File Transfer Protocol
(FTP) start with ftp:. Files available locally start with file:.

The scheme_information commonly identifies the Internet machine making a resource available, the path
to that resource, and the resource name. The scheme_information for HTTP, FTP and File generally starts
with two slashes (//), then provides the Internet address separated from the resource path name with one
slash (/). For example,

http://www.ibm.com/software/webservers/appserv/library.html.

For HTTP and FTP, the path name ends in a slash when the URL points to a directory. In such cases, the
server generally returns the default index for the directory.

URL providers for the Application Client Resource Configuration Tool:
A URL provider implements the function for a particular URL protocol, such as HyperText Transfer Protocol
(HTTP). This provider, comprised of a pair of classes, extends the java.net.URLStreamHandler and

java.net.URLConnection classes.

Configuring URL providers and sessions using the Application Client Resource Configuration
Tool:
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You can edit the configurations of URL providers and URLs to be used by your application clients using
the Application Client Resource Configuration Tool (ACRCT).

Before you begin

Use the Application Client Resource Configuration Tool (ACRCT) to edit the configurations of URL
providers and URLs to be used by your application clients.

About this task

Procedure
1. [Start the ACRCT]
2. Open an EAR file.

3. Locate the URL objects in the tree that displays. For example, if your file contains URL providers and
URLs, expand Resources > application > .jar > URL Providers > url_provider_instance

where url_provider_instance is a particular URL provider.

4. If you expand the tree further, you will also see the URLs folders containing the URL instances for
each URL provider instance.

URL settings for application clients:

Use this page to implement the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP).

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > URL Providers > URL provider
instance. Right-click URLs and click New. The following fields appear on the General tab.

This provider, comprised of classes, extends the java.net.URLStreamHandler and java.net.URLConnection
classes.

Name:

The administrative name for the URL.

Description:

This is an optional description of the URL for your administrative records.

JNDI Name:

The application client run time uses this field to retrieve configuration information.
URL:

A Uniform Resource Locator (URL) name that points to an Internet or intranet resource. For example:
http://www.ibm.com.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.
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You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
URL provider settings for application clients:

Use this page create new URL providers.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right click URL Providers, and click
New. The following fields appear on the General tab.

A URL provider implements the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP). This provider, comprised of classes, extends the java.net.URLStreamHandler and
java.net.URLConnection classes.

Name:

Administrative name for the URL.

Description:

Optional description of the URL, for your administrative records.

Class Path:

A list of paths or JAR file names which together form the location for the resource provider classes.
Protocol:

Protocol supported by this stream handler. For example, nntp, smtp, ftp, and so on.

To use the default protocol, leave this field blank.

Stream handler class:

Fully qualified name of a User-defined Java class that extends the java.net.URLStreamHandler for a
particular URL protocol, such as FTP.

To use the default stream handler, leave this field blank.
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring URL and URL provider settings for application clients:
You can configure URL and URL provider settings. This topic provides the required fields and an example.
The purpose of this article is to help you to configure URL and URL provider settings.

* Required fields:
— URL Properties page: name, jndiName, url
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— URL Provider Properties page: name
* Example:
<resources.url:URLProvider xmi:id="URLProvider 1" name="urlProvider:name"
description="urlProvider:description"
streamHandTerClassName="ur1Provider:streamHandlerClass"
protocol="ur1Provider:protocol">
<classpath>urlProvider:classpath</classpath>
<factories xmi:type="resources.url:URL" xmi:id="URL_1" name="urlFactory:name"
jndiName="ur1Factory:jndiName" description="urlFactory:description"
spec="urlFactory:url">
<propertySet xmi:id="J2EEResourcePropertySet 18">
<resourceProperties xmi:id="J2EEResourceProperty 20" name="urlFactory:customName"
value="urlFactory:customValue"/>
</propertySet>
</factories>
<propertySet xmi:id="J2EEResourcePropertySet 19">
<resourceProperties xmi:id="J2EEResourceProperty 21" name="urlProvider:customName"
value="ur1Provider:customValue"/>
</propertySet>
</resources.url:URLProvider>

Configuring new URLs with the Application Client Resource Configuration Tool
You can use URLs for your client application using the Application Client Resource Configuration Tool
(ACRCT).

Before you begin
During this task, you create URLs for your client application.
About this task

Procedure

1. Click the URL provider for which you want to create a URL in the tree. Complete one of the following:
« |Configure a new URL provider)
« Click an existing URL provider.

2. Expand the URL provider to view the URLs folder.

3. Click the URL folder. Complete one of the following actions:
* Right click the folder and click New.
* Click Edit -> New on the menu bar.

4. Configure the URL properties in the displayed fields.
5. Click OK when you finish.
6. Click File > Save in the menu bar to save your changes.

Configuring Java messaging client resources

To configure Java messaging client resources, you create new JMS provider configurations for your
application client. The application client can use a messaging service through the Java Message Service
APIs. A JMS provider provides two kinds of J2EE factories. One is a JMS connection factory, and the
other is a JMS destination factory.

Before you begin
In a separate administrative task, install the Java Message Service (JMS) client on the client machine
where the application client resides. The messaging product vendor must provide an implementation of the

JMS client. For more information, see your messaging product documentation.

Attention: When completing this task, you can either create a new messaging provider, or you can use
an existing one.
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Procedure
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure the new JMS provider. The EAR file contents are in
the displayed tree view.

3. Select the JAR file in which you want to configure the new JMS provider from the tree.
4. Expand the JAR file to view its contents.

5. Optionally right-click Messaging Providers and select New, if you want to create and use a new
messaging provider.

6. Configure the JMS provider properties in the resulting property dialog.
7. Click OK.
8. Click File > Save.

Asynchronous messaging in WebSphere Application Server using JUS:

WebSphere Application Server supports asynchronous messaging as a method of communication based
on the Java Message Service (JMS) programming interface. The JMS interface provides a common way
for Java programs (clients and Java Platform, Enterprise Edition (Java EE) applications) to create, send,
receive, and read asynchronous requests as JMS messages.

This topic provides a generic overview of asynchronous messaging using the JMS support provided by
WebSphere Application Server.

The base support for asynchronous messaging using the JMS API provides the common set of JMS
interfaces and associated semantics that define how a JMS client can access the facilities of a JMS
provider. This support enables WebSphere product Java EE applications, as JMS clients, to exchange
messages asynchronously with other JMS clients, by using JMS destinations (queues or topics). A Java
EE application can use JMS queue destinations for point-to-point messaging and JMS topic destinations
for publish and subscribe messaging. A Java EE application can explicitly poll for messages on a
destination, and then retrieve messages for processing by business logic beans (enterprise beans).

With the base JMS and XA support, the Java EE application uses standard JMS calls to process
messages, including any responses or outbound messaging. An enterprise bean can handle responses
acting as a sender bean, or within the enterprise bean that receives the incoming messages. Optionally,
this process can use two-phase commit within the scope of a transaction. This level of function for
asynchronous messaging is called bean-managed messaging, and gives an enterprise bean complete
control over the messaging infrastructure, for example, connection and session pool management. The
common container has no role in bean-managed messaging.

WebSphere Application Server also supports automatic asynchronous messaging using message-driven
beans (a type of enterprise bean defined in the Enterprise JavaBeans (EJB) 2.0 specification) and JMS
listeners (part of the JMS application server facilities). Messages are automatically retrieved from JMS
destinations, optionally within a transaction, then sent to the message-driven bean in a Java EE
application, without the application having to explicitly poll JMS destinations.

Java Message Service providers for clients:

Client applications can use messaging resources from three main types of Java Message Service (JMS)
providers in WebSphere Application Server: The WebSphere Application Server default messaging
provider (which uses service integration as the provider), the WebSphere MQ messaging provider (which
uses your WebSphere MQ system as the provider) and third-party messaging providers (which use
another company's product as the provider).

IBM WebSphere Application Server supports asynchronous messaging through the use of a JMS provider
and its related messaging system. JMS providers must conform to the JMS specification version 1.1. To
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use message-driven beans the JMS provider must support the optional Application Server Facility (ASF)
function defined within that specification, or support an inbound resource adapter as defined in the JCA
specification version 1.5.

Default messaging provider
If you mainly want to use messaging between applications in WebSphere Application Server,
perhaps with some interaction with a WebSphere MQ system, the default messaging provider is
the natural choice. This provider is based on service integration technologies and is fully integrated
with the WebSphere Application Server runtime environment.

WebSphere MQ messaging provider
If your business also uses WebSphere MQ, and you want to integrate WebSphere Application
Server messaging applications into a predominately WebSphere MQ network, choose the
WebSphere MQ messaging provider, which allows you to define resources for connecting to any
queue manager on the WebSphere MQ network.

Third-party messaging provider
You can configure any third-party messaging provider that supports the JMS Version 1.1 unified
connection factory. You might want to do this, for example, because of existing investments.

Note: In WebSphere Application Server 7.0, the Version 5 default messaging provider is deprecated.

Note: For backwards compatibility with earlier releases, WebSphere Application Server Version 7 supports
the (deprecated) Version 5 default messaging provider and the Version 6 WebSphere MQ
messaging provider. This support enables your applications that still use these resources to
communicate with Version 5 and Version 6 nodes in Version 7 mixed cells.

WebSphere applications can use messaging resources provided by any of these JMS providers. However
the choice of provider is most often dictated by requirements to use or integrate with an existing
messaging system. For example, you may already have a messaging infrastructure based on WebSphere
MQ. In this case you may either connect directly using the included support for WebSphere MQ as a JMS
provider, or configure a service integration bus with links to a WebSphere MQ network and then access
the bus through the default messaging provider.

Configuring new JMS providers with the Application Client Resource Configuration Tool:

You can create new Java Message Service (JMS) provider configurations for the Application Client. The
Application Client makes use of a messaging service through the JMS interfaces.

About this task

During this task, you create new Java Message Service (JMS) provider configurations for the Application
Client. The Application Client makes use of a messaging service through the JMS interfaces. A JMS
provider provides two kinds of Java Platform, Enterprise Edition (Java EE) resources. One is a JMS
connection factory, and the other is a JMS destination.

In a separate administrative task, you must install the JMS client on the client machine where your
particular application client resides. The messaging product vendor must provide an implementation of the
JMS client. For more information, see your messaging product documentation.

Procedure

1. Start the Application Client Resource Configuration Tool and open the EAR file for which you want to
configure the new JMS provider. The EAR file contents are displayed in a tree view.

2. From the tree, select the JAR file in which you want to configure the new JMS provider.
3. Expand the JAR file to view its contents.
4. Right-click Messaging Providers. Complete one of the following actions:

» Right click the folder and select New.
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* On the menu bar, click Edit > New.
5. In the resulting property dialog, configure the JMS provider properties.
6. Click OK when finished.
7. Click File > Save on the menu bar to save your changes.

Example

The following code example illustrates how to configure JMS Provider, JMS Connection Factory and JMS
Destination settings for application clients.

<resources.jms:JMSProvider xmi:id="JMSProvider_3" name="genericJMSProvider:name"
description="genericJMSProvider:description"
externallnitialContextFactory="genericJMSProvider:contextFactoryClass"
externalProviderURL="genericJMSProvider:providerUrl">
<classpath>genericJMSProvider:classpath</classpath>

<factories xmi:type="resources.jms:GenericJMSDestination"
xmi:id="GenericJMSDestination_1" name="jmsDestination:name"
jndiName="jmsDestination:jndiName" description="jmsDestination:description"
externalJNDIName="jmsDestination:externaldndiName" type="QUEUE">

<propertySet xmi:id="J2EEResourcePropertySet 15">

<resourceProperties xmi:id="J2EEResourceProperty 17" name="jmsDestination:customName"
value="jmsDestination:customValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms:GenericJMSConnectionFactory"
xmi:id="GenericJMSConnectionFactory 1" name="jmsCF:name" jndiName="jmsCF:jndiName"
description="jmsCF:description" userID="jmsCF:user" password="{xor}NTIsHB11MT4y0g=="
externalJNDIName="jmsCF:externaldndiName" type="QUEUE">

<propertySet xmi:id="J2EEResourcePropertySet 16">

<resourceProperties xmi:id="J2EEResourceProperty 18" name="jmsCF:customName"
value="jmsCF:customValue"/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 17">

<resourceProperties xmi:id="J2EEResourceProperty 19"
name="genericJMSProvider:customName" value="genericJMSProvider:customValue"/>
</propertySet>

</resources.jms:JMSProvider>

Required fields include:

* JMS Provider Properties page: name, and at least one protocol provider

» JMS Connection Factory Properties page: name, jndiName, destination type
» JMS Destination Properties page: name, jndiName, destination type

Special cases:
* The destination type must be QUEUE, or TOPIC.

JMS provider settings for application clients:

Use this page to configure properties of the Java Message Service (JMS) provider, if you want to use a
JMS provider other than the default messaging provider or the WebSphere MQ as a JMS provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right click Messaging Providers, and
click New. The following fields appear on the General tab.

Name:

The name by which the JMS provider is known for administrative purposes.

Data type String
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Description:

A description of the JMS provider, for administrative purposes.

Data type String

Class Path:

A list of paths or . jar file names which together form the location for the resource provider classes.
Context factory class:

The Java class name of the initial context factory for the JMS provider.

For example, for an LDAP service provider the value has the form: com.sun.jndi.1dap.LdapCtxFactory.

Data type String

Provider URL:
The JMS provider URL for external JNDI lookups.

For example, an LDAP URL for a JMS provider has the form: 1dap://hostname.company.com/contextName.

Data type String

Custom Propetrties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Default Provider connection factory settings:

Use this panel to view or change the configuration properties of the selected JMS connection factory for
use with the internal product Java Message Service (JMS) provider that is installed with WebSphere
Application Server. These configuration properties control how connections are created between the JMS
provider and the service integration bus that it uses

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Messaging Providers > Default
Provider. Right-click Connection Factories and click New. The following fields appear on the General
tab.

Settings that have a default value display the appropriate value. Any settings that have fixed values have a
drop down menu.

Name:
The name of the connection factory.
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Data type String

Description:

A description of this connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String

JNDI Name:

The JNDI name that is used to match this Resource Adapter connection factory definition to the
deployment descriptor. This entry is a resource-ref name.

Data type String

User Name:
The User Name used with the Password property for connecting to an application.

If you specify a value for the User Name property, you must also specify a value for the Password
property.
The connection factory User ID and Password properties are used if the calling application does not

provide a userid and password explicitly. If a user name and password are specified, then an
authentication alias is created for the factory where the password is encrypted.

Data type String

Password:
The password used to authenticate connection to an application.

If you specify a value for the User Name property, you must also specify a value for the Password
property.

Data type String

Re-Enter Password:
Confirms the password.
Bus Name:

The name of the bus to which the connection factory connects.

Data type String

Client Identifier:

The name of the client. Required for durable topic subscriptions.
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Data type String

Nonpersistent Messaging Reliability:
The reliability applied to nonpersistent JMS messages sent using this connection factory.

If you want different reliability delivery options for individual JMS destinations, you can set this property to
As bus destination. The reliability is then defined by the Reliability property of the bus destination to which
the JMS destination is assigned.

Default ReliablePersistent

Range . - .
9 None There is no message reliability for nonpersistent

messages. If a nonpersistent message cannot be
delivered, it is discarded.

Best effort nonpersistent
Messages are never written to disk, and are
thrown away if memory cache overruns.

Express nonpersistent
Messages are written asynchronously to
persistent storage if memory cache overruns, but
are not kept over server restarts.

Reliable nonpersistent
Messages can be lost if a messaging engine
fails, and can be lost under normal operating
conditions.

Reliable persistent
Messa